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Chapter 1. Introduction to IBM Workplace 
Services Express on the iSeries 
server

This chapter introduces you to the IBM Workplace strategy, specifically IBM Workplace 
Services Express on the IBM Eserver iSeries server. It discusses the business value of 
Workplace Services Express and presents other products in the Workplace family.

1
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1.1  The IBM Workplace strategy
Before you start to understand the specifics of Workplace Services Express, it is important to 
have a good understanding of the IBM Workplace strategy. This strategy is about integration 
and collaboration between people, processes, and information. The IBM way to achieve this 
strategy is through a service-oriented architecture (SOA), which all the products in the 
Workplace family follow. An SOA is a way of designing software systems to provide services 
to end-user applications or other services. From a business perspective, it is a set of business 
aligned IT services that support an organization’s business process goals and objectives.

The Workplace strategy empowers people, offering them access to information and 
resources, anytime and anywhere. It gives you the power to work in a connected world, with 
the tools that match your role in the organization. This way of collaboration allows for better 
and faster decisions, which in turn increases productivity and reduces costs in the workplace.

The IBM Workplace strategy integrates collaboration with business processes. It offers you 
access to e-mail, instant messaging, and other information, in the same tool used to manage 
your business processes, avoiding application switching and improving productivity. The 
merging of traditional and collaborative applications is central to the Workplace strategy. 

In summary, the IBM Workplace strategy revolutionizes the way you work, bringing you 
together with the resources that you need, when you need them. For small and medium 
business, IBM Workplace Services Express is the solution of choice for a J2EE collaborative 
environment with an integrated portal.

For more information about IBM Workplace, refer to the IBM Workplace Web site at:

http://www.ibm.com/software/info/workplace/index.jsp

1.1.1  IBM Workplace offerings
Built on an SOA, IBM Workplace offerings can address the needs for transforming 
organizations of all sizes. The products are designed specifically for small, medium, and large 
enterprises. They span from flexible tools and innovative technologies, to a broad set of 
solutions. With IBM Workplace offerings, organizations can deploy an online environment with 
a flexible set of componentized capabilities that can be used to adapt quickly to meet specific 
business needs.

The IBM Workplace environment helps to consolidate and present the resources that you 
need, including business processes, collaboration capabilities, information, documents, and 
productivity tools, all through a unified Workplace interface. And, the Workplace environment 
can be tailored to each user’s or team’s business role. The integrated environment keeps 
resources close at hand and in the appropriate business context. The result? Users can work 
conveniently, securely, and more efficiently within a single Workplace environment, instead of 
continuously switching between multiple applications.

The Workplace strategy provided by IBM is the new front end of computing. It’s an approach 
based on an SOA that helps organizations integrate all of their business processes to achieve 
a more productive, secure environment that is designed according to the roles within the 
organization.

The products in the IBM Workplace family help organizations increase their productivity while 
working in a collaborative environment. Such an environment integrates all of the business 
processes as well as the people, information, and other resources needed to work.
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Figure 1-1 illustrates how the different products fit within the IBM Workplace family.

Figure 1-1   IBM Workplace product offerings

As shown in Figure 1-1, there are four components that compose the IBM Workplace 
offerings:

� Products for Small Businesses and Departments

These are the IBM Express products such as Lotus Domino Express and WebSphere 
Portal Express. For more information about IBM Express software, refer to the IBM 
Redpaper IBM Express Software Buying and Selling Guide, REDP-3975.

� Solutions

IBM Workplace Solutions are role-based frameworks to help clients apply IBM Workplace 
technologies faster and more productively. These solutions leverage the industry 
expertise, insights, and analysis of various business applications that IBM provides. The 
solutions are designed to provide “shortcuts” for creating a high performance, role-based 
work environment, helping to accelerate time-to-value. IBM Workplace Solutions draw on 
the rich portfolio of IBM software products and services, as well as on independent 
software vendor (ISV) applications and other IBM Business Partner skills, to enable clients 
to address some of their most pressing business issues.

To learn more about IBM Workplace Solutions, see the following Web site:

http://www.ibm.com/software/info/workplace/solutions.jsp

� Products for the Enterprise

Products for the Enterprise are the products that exist for the enterprise. Examples of such 
products are Lotus Domino, WebSphere Portal, and Workplace Collaboration Services.

Tools and Technology
Workplace Templates
Workplace Designer

Workplace Client Technology
Lotus Domino Designer

Solutions
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Business Controls and Reporting, Procurement, 
HR Managers, Branch Banking, Sales Managers…
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IBM Workplace 
Services Express

Lotus Domino Express

WebSphere Portal 
Express
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� Tools and Technology

These are the various client tools and technologies that support the various IBM 
Workplace products and solutions. Such examples include Workplace templates and the 
Workplace Designer.

1.2  IBM Workplace Services Express
IBM Workplace Services Express is a collaborative portal designed for small and medium 
business. It’s easy to install, deploy, and configure. It offers instant collaboration, access to 
Lotus Domino or Microsoft® Exchange e-mail, instant messaging, collaborative team spaces 
and centralized document libraries, all through a portal environment, personalized to an 
organization’s needs and roles.

IBM Workplace Services Express offers the following capabilities out of the box:

� Integrated portal: Based on WebSphere Portal, Workplace Services Express offers a full 
collaborative portal.

� Centralized document management: On the server, IBM Workplace Services Express 
stores all the documents, making them available to all users, based on their security 
settings. You access these documents from either the Workplace portal or through the 
IBM Desktop Components, which is a tool to integrate the Workplace Document Libraries 
with Windows® Explorer, a Microsoft Office environment, or both.

� Productivity center: IBM Workplace Services Express offers online editors for rich-text 
documents, presentations, and spreadsheets. You can convert the documents created 
with these editors to other formats as shown in Table 1-1.

Table 1-1   Conversion formats for online documents

� Instant messaging and presence awareness: IBM Workplace Services Express offers 
you the option to create instant messaging contact lists. This way, whenever a user is 
available to chat, you can start a new conversation. Presence awareness is also available 
through the portal. For example, every time you refer to a user, if that user is online, you 
can start a new conversation by clicking the referenced user’s name.

� Collaborative team spaces: Workplace Services Express offers dynamically created 
environments that can be customized to map a team’s role inside an organization. These 
collaborative spaces, called team spaces, offer members a space to share documents, 
group calendars, and participate in discussion groups and chats. Included with Workplace 
Services Express are different templates that you can easily deploy, and if needed, modify 
to satisfy a more specific requirement.

� Search: You can search through documents, team spaces, and applications. You can also 
define your own data sources to search, such as intranet Web sites. And you can search 
for people in your own organization’s directory. After you find a person, you can take 
collaborative actions, such as sending an e-mail or starting a chat session.

� Mail: IBM Workplace Services Express offers portlets to access existing mail servers, for 
example Lotus Domino, Microsoft Exchange, Post Office Protocol Version 3 (POP3), and 
Internet Message Access Protocol (IMAP) servers, through a portal-based interface. For 

Workplace 
format

Target format

Rich text Lotus WordPro, Microsoft Word, and Adobe Portable Document Format (PDF)

Spreadsheet Lotus 1-2-3® and Microsoft Excel®

Presentation Lotus Freelance Graphics® and Microsoft PowerPoint®
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more information about Workplace Services Express integration with Domino, see 
Chapter 6, “Integrating the Domino portlets” on page 173.

� Drag and drop customization: Adding a portlet to a page is as simple as dragging it from 
the palette and dropping it in the desired place. This way, you can customize your private 
pages and have a personalized experience.

� Back-end integration: IBM Workplace Services Express is integrated easily with 
back-end applications. You can accomplish this integration with existing portlets or by 
building new portlets. You can also download portlets from the IBM Workplace Solution 
Catalog, available at:

http://catalog.lotus.com/wps/portal/wse

IBM Workplace Services Express offers you a centralized collaborative environment, with 
easy deployment and administration, that helps you achieve better productivity and quicker 
results.

1.2.1  The business value of Workplace Services Express
IBM Workplace Services Express gives organizations the opportunity to implement a 
collaborative environment that is easy to install, administer, and use. It provides quick access 
to resources, people, and documents, which increases productivity. The following list provides 
some examples that show the business advantages of implementing Workplace Services 
Express:

� Workplace Services Express offers a low, total cost of ownership (TCO). Workplace 
Services Express is a single server deployment. No external servers or software are 
needed to run Workplace Services Express on the iSeries, therefore lowering the TCO.

� The time to set up a new client is zero. The client only needs a Web browser, which 
significantly reduces the demands on the IT department.

� All documents needed for work are located on the server, eliminating the risk of lost or 
corrupted documents on personal computers. Having all documents on the server also 
reduces traffic on internal mail networks, because the documents are not required to be 
sent by e-mail to all employees. Access to documents is as simple as accessing the 
appropriate document library, either from a Web browser or from the employee’s Windows 
Explorer.

� Workplace Services Express comes preloaded, with ready-to-use templates for team 
spaces and lists, reducing the time needed to deploy new applications. These templates 
allow teams to start collaborating in a few minutes.

� Integrated instant messaging provides a quick way to access people, either from a Contact 
List portlet or from any other place that a person is referenced, such as from a document 
library.

� Workplace Services Express leverages current investments. It integrates with your current 
Lotus Domino or Microsoft Exchange messaging servers. It also integrates with Microsoft 
Windows and Microsoft Office to enhance collaboration, offering access to online 
document libraries from Microsoft Office products and Windows Explorer.

� Workplace Services Express is licensed as either user based or processor based. This 
flexibility makes it possible for you to choose the best licensing method for your current 
environment and budget.

� Workplace Services Express is built on top of the industry’s most recognized portal server, 
IBM WebSphere Portal. This means that you can work with the collaborative applications 
offered by Workplace Services Express, as well as with other applications that can be 
installed on top of WebSphere Portal.
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1.3  Why iSeries?
Running IBM Workplace Services Express on the IBM Eserver iSeries offers a competitive 
advantage over other platforms. Some of those advantages are provided in the following list:

� In a typical Workplace Services Express environment, information has to be exchanged 
between the Workplace Services Express server and other servers, such as an HTTP 
server, a database server, and a Lightweight Directory Access Protocol (LDAP) server. 
The IBM Eserver iSeries server already has a DB2® Universal Database™ database 
manager, an HTTP server, and an LDAP server. Therefore it is possible to run a full 
Workplace Services Express environment on a single system, lowering the TCO of the 
deployment and improving performance.

� Installing Workplace Services Express on the IBM Eserver iSeries server offers a major 
advantage over other platforms by offering the Create IBM Workplace wizard, which is 
located in the IBM Web Administration for iSeries. This wizard gathers all necessary data 
and validates it before starting to configure a Workplace Services Express instance. After 
gathering the data, it configures a Workplace Services Express instance along with the 
required HTTP server, DB2 Universal Database databases, and LDAP directory. This 
wizard simplifies the configuration process and reduces the risk of configuration errors.

For more information about installing and configuring Workplace Services Express on the 
iSeries server, see Chapter 4, “Installing and configuring Workplace Services Express” on 
page 71.

� Because IBM Workplace Services Express is based on WebSphere Portal, you can use it 
to provide a new front end to typical iSeries applications, through the use of such tools as 
the iSeries Access for Web portlet, IBM WebFacing Tool, and IBM WebSphere Host 
Access Transformation Services (HATS).

To learn more about integrating Workplace Services Express with iSeries Access, see 
Chapter 7, “Integrating iSeries Access for Web portlets” on page 207.

� As opposed to typical 32-bit operating systems, IBM i5/OS® does not have a 4 GB 
address space limit. Also, the Java™ Virtual Machine (JVM™) present on the iSeries is 
64-bit, making it more powerful and scalable than other platforms.

� It is possible to run more than one Workplace Services Express instance on a single 
iSeries server or logical partition (LPAR). An organization can deploy their production 
environment along with their testing and development environments on a single iSeries 
server. 

For more information about Workplace Services Express on the IBM Eserver iSeries server, 
see the IBM Workplace for iSeries Web site at:

http://www.ibm.com/servers/eserver/iseries/software/workplace/
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1.3.1  Workplace Services Express architecture on iSeries
Figure 1-2 illustrates the architecture of Workplace Services Express on the IBM ^® 
iSeries server. 

Figure 1-2   High level architecture of Workplace Services Express on the iSeries server

Workplace Services Express installs on top of WebSphere Application Server, along with 
DB2 Universal Database, the HTTP server, and the LDAP directory, which are already 
installed on the iSeries. This arrangement makes it possible for the iSeries Create Workplace 
wizard to perform all the configuration needed to set up Workplace Services Express.

Although an LDAP directory is required to run Workplace Services Express, the Directory 
Server present on the iSeries server is not the only option. You can also integrate Workplace 
Services Express with a Domino Directory. You can also do this from the iSeries Create 
Workplace wizard. For more information about the supported LDAP directories, see 2.5, 
“Supported LDAP directories” on page 30.

1.4  Comparison of Workplace Collaboration Services and 
Workplace Services Express

IBM Workplace Collaboration Services is an innovative product from the IBM Workplace 
family of products that helps transform the way people work. Workplace Collaboration 
Services is a completely integrated collaborative environment that includes a wide range of 
capabilities. These capabilities include e-mail, calendaring and scheduling, online awareness, 
instant messaging, learning, team spaces, Web conferencing, and document and Web 
content management. With Workplace Collaboration Services, organizations can deploy a 
single collaboration solution for the enterprise right out of the box. They have the flexibility to 
deploy one, two, or more capabilities in any combination, all running within a single, fully 
integrated IBM Workplace collaboration environment.

The functions present in Workplace Services Express are a subset of those functions present 
in Workplace Collaboration Services. One important difference is that Workplace Services 
Express includes a WebSphere Portal license, which entitles you to unlimited portal use. 
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plates
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Table 1-2 compares the functions that are available on Workplace Services Express and 
Workplace Collaboration Services.

Table 1-2   Comparison of Workplace Collaboration Services and Workplace Services Express

For more information about running Workplace Collaboration Services on the iSeries server, 
see the IBM Redbook Deploying IBM Workplace Collaboration Services on the IBM Eserver 
iSeries Server, SG24-6640.

1.5  Naming conventions and servers used for this redbook
Throughout this redbook, we provide explanations, details, and window captures of our 
implementation of Workplace Services Express on the iSeries server. In this section, we 
explain the naming conventions and different servers used to create this redbook.

In our environment, we had two iSeries servers called rchas12 and rchas55. On these iSeries 
servers, we configured several Domino and Workplace Services Express servers. The 
Domino servers are called:

� itsodom70, which is a Domino 7.0 server
� itsodom6, which is a Domino 6.5.3 server
� dom654, which is a Domino 6.5.4 server

For the Workplace Services Express servers, the naming convention was itsowsen, with n 
indicating the number of the server, for example itsowse1.

Function Workplace Collaboration Services Workplace Services Express

E-mail and Calendar X X1

1. This functionality is not available by default, but can be enabled with an existing mail infra-
structure.

Instant Messaging X X

Team Spaces X X

Web Conferencing X

Distance Learning X

Document Management X X

Web Content Management X

Workplace Client Support X

Portal license included X

Licensing method Per processor User or processor

Note: Because of the multiple Domino and Workplace Services Express servers used, you 
might see different window captures of different Workplace Services Express servers 
through out this redbook.
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Chapter 2. Hardware and software 
prerequisites

This chapter describes the hardware and software prerequisites for running IBM Workplace 
Services Express Version 2.5 on the iSeries server. Before you can install and configure 
Workplace Services Express, you must install and configure the necessary hardware and 
software requirements. This chapter discusses the following prerequisites to make sure your 
iSeries server meets all the Workplace Services Express requirements:

� Hardware requirements
� Software requirements
� Required program temporary fixes (PTFs)
� i5/OS configuration and network requirements
� Supported Lightweight Directory Access Protocol (LDAP) directories
� Supported HTTP servers
� Client requirements

2

Tip: For the latest information about these prerequisites, see the Workplace Services 
Express Release Notes, which are available on the Lotus Documentation Web site:

http://www.lotus.com/products/product5.nsf/wdocs/productdoc
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2.1  iSeries server hardware requirements
A new IBM Eserver i5 server must meet the following minimum processor and memory 
requirements. For existing systems, contact your IBM representative to determine capacity 
requirements for your organization’s deployment.

� Eserver i5 model 520 1-way (2400 CPW)

� 4 GB main storage

� 15 GB of disk space for installation of Workplace Services Express and WebSphere 
Application Server V5.0.2 Enterprise Enablement

� 4 GB of disk space for each Workplace Services Express server configured

� Additional disk space must be sized based on the Workplace Services Express application 
being used. Refer to the Workplace Services Express release notes for the latest 
information.

2.1.1  IBM eServer Workload Estimator
To size your iSeries server based on your business needs, we recommend that you use the 
IBM Eserver Workload Estimator, which can help you estimate your system correctly. The 
Workload Estimator is an interactive Java-based tool for sizing an iSeries server for mixed 
workloads. You can access the IBM ~ Workload Estimator on the Web at:

http://www-912.ibm.com/wle/EstimatorServlet

For many existing systems, you can import IBM Performance Management (PM/400) data 
directly into the Workload Estimator and use it to analyze your company growth and server 
needs. The Workload Estimator provides recommendations for estimating an appropriate 
configuration for a server running one or more workloads associated with On Demand 
Business or collaboration, such as Workplace Services Express.

Using the Workload Estimator, you can try different scenarios and print the results for 
comparison. The Workload Estimator does not replace the advice given by an IBM 
representative or Business Partner who is experienced with Workplace Services Express 
requirements. If you are new to or are not familiar with sizing methodologies, we strongly 
recommend that you obtain expert assistance before you select a final iSeries server 
configuration.

Note: The name Eserver i5 merely refers to the POWER5™ line of servers within the 
iSeries server family. Also, with OS/400 V5R3, the operating system has been renamed to 
i5/OS. Therefore, throughout this redbook, we use the terms OS/400 and i5/OS 
interchangeably to refer to OS/400 V5R3.

Important: At the time this redbook was written, Workplace Services Express information 
was not yet available in the Workload Estimator. This information will be made available at 
some point in the future.

Tip: Before you start using the Workload Estimator for the first time, we recommend that 
you carefully read the help documentation. This opens automatically in a separate Web 
browser window and is available through the tutorial provided with the Workload Estimator 
tool. You can download the tutorials as PDF files.
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The recommendation or Selected System reported by the Workload Estimator includes the 
model, processor, interactive feature, CPW capacity, memory, and the number and capacity 
of disk storage (direct access storage device (DASD)) necessary to support the set of 
workloads defined by the user. When the Workload Estimator provides a sizing 
recommendation, it always defaults to recommend the latest technology systems that are 
currently available.

Detailed resource requirements for each Workload Estimator recommendation are given. 
However, it is important to remember that, as with every performance estimate (whether a 
rule of thumb or a sophisticated model), you must always treat it as an estimate and not a 
detailed capacity planner. This is particularly true with a robust system such as the iSeries 
server that offers so many different capabilities, where each installation has unique 
performance characteristics and demands.

The sizing recommendations that are generated by the Workload Estimator are based on 
benchmark measurements and performance tests from well-defined repeatable workloads. To 
arrive at a recommended system, the Workload Estimator goes through a series of questions 
to collect the necessary information to calculate the resource requirements of your solution.

As you become more familiar with the Workload Estimator, you can provide more specific 
information for particular workloads, thereby leading to a more accurate estimation. The 
Workload Estimator is continually updated to implement the latest versions and releases of 
the workloads. New function is added on a regular basis to keep the information and 
projections current. Periodically review the following Web site to keep up-to-date with the 
most accurate information about Workload Estimator:

http://www-912.ibm.com/estimator/html/whatsNew.html

2.2  i5/OS software requirements
Table 2-1 lists the licensed program software for i5/OS that is required to run Workplace 
Services Express. Notice that IBM Workplace Services Express 2.5 for i5/OS requires i5/OS 
V5R3 or later. OS/400 V5R2 is not supported.

Table 2-1   i5/OS software requirements for Workplace Services Express Version 2.5

Note: The IBM Web Administration for iSeries Create IBM Workplace wizard also verifies 
that the required license program software is installed prior to configuring a Workplace 
Services Express server. Refer to 4.3.2, “Using the iSeries Create IBM Workplace wizard” 
on page 85, for more information. Make sure that you have the latest 5722-DG1 group PTF 
installed before you use the iSeries Create IBM Workplace wizard to configure a 
Workplace Services Express server.

Licensed program product Option Description

5722SS1 *BASE OS/400 V5R3

12 OS/400 - Host Servers

30 OS/400 - Qshell Interpreter

33 OS/400 - Portable Application Solution Environment 
(PASE)

43 OS/400 - Additional Fonts

5722AC3 *BASE Cryptographic Access Provider 128-bit
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1. For instructions on how to install WebSphere Application Server V5.0 option 10, Enterprise
Enablement, see the following section.

2. iSeries Access for Web is required only if you want to give users access to existing i5/OS ap-
plications using the iSeries Access portlets. See Chapter 7, “Integrating iSeries Access for Web
portlets” on page 207, for details.

3. iSeries Tools for Developers PRPQ must be installed only if you intend to use virtual network
computing (VNC) for document rendering. See 9.5.4, “X virtual frame buffer verses virtual net-
work computing” on page 299, for more information. To obtain and install 5799-PTL iSeries
Tools for Developers PRPQ, see 2.2.2, “Installing iSeries Tools for Developers PRPQ” on
page 13. 

2.2.1  Installing WebSphere Application Server V5.0, Enterprise Enablement
IBM Workplace Services Express requires functionality that is not available with standard 
versions of WebSphere Application Server on i5/OS. To add this functionality, you must install 
IBM Enterprise Enablement for WebSphere Application Server for iSeries (WebSphere 
Application Server V5.0 option 10, Enterprise Enablement).

WebSphere Application Server V5.0 option 10, Enterprise Enablement, is provided as part of 
the Workplace Services Express bundle of CDs. Before you install IBM Enterprise 
Enablement, you must install:

� Option 1, WebSphere Application Server V5.0 Client development and runtime
� Option 2, WebSphere Application Server V5.0 Application server runtime
� The WebSphere Application Server V5.0 group PTF (SF99287 for i5/OS V5R3)

5722DG1 *BASE IBM HTTP Server for iSeries

5722JC1 *BASE IBM Toolbox for Java

5722JV1 *BASE IBM Developer Kit for Java

5 Developer Toolkit 1.3

6 Developer Toolkit 1.4

5722TC1 *BASE TCP/IP Connectivity Utilities for iSeries

5722XH2 2 *BASE iSeries Access For Web 2(optional)

5733WS5 *BASE WebSphere Application Server V5.0

1 WebSphere Application Server V5.0 Client 
development and runtime

2 WebSphere Application Server V5.0 Application 
server runtime

10 WebSphere Application Server V5.0 Enterprise 
Enablement 1

5799PTL 3 *BASE iSeries Tools for Developers PRPQ (optional)

Important: As part of the IBM Workplace Services Express installation, a runtime version 
of WebSphere Portal is also installed. WebSphere Portal is not required prior to installing 
Workplace Services Express on the iSeries server. 

Licensed program product Option Description 
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To install WebSphere Application Server V5.0 option 10, Enterprise Enablement, from a PC 
workstation connected to your iSeries server, perform the following steps:

1. If your WebSphere Application Server subsystem is running, enter the following End 
Subsystem (ENDSBS) CL command on an i5/OS command line to end it:

ENDSBS SBS(QEJBAS5)

2. Insert the WebSphere Application Server V5.0 Enterprise Enablement CD into your PC 
workstation’s CD-ROM drive. The WebSphere Application Server V5.0 Enterprise 
Enablement installation program starts automatically.

3. In the signon window that opens, when prompted, enter your iSeries server name, user ID, 
and password. Then click OK.

4. Select the language for the installation and click Next.

5. In the WebSphere Application Server V5.0 Enterprise Enablement Welcome window that 
opens, click Next.

6. Review the license agreement. Select I accept the terms of the licensing agreement 
and click Next.

7. The next window asks which version of WebSphere Application Server V5.0 Enterprise 
Enablement you want to install. Select WebSphere Application Server V5.0 Enterprise 
Enablement to install the Base Edition. Click Next.

8. View the installation summary information and click Next.

9. When WebSphere Application Server V5.0 Enterprise Enablement finishes installing, in 
the confirmation window that opens, indicating a successful installation, click Finish.

2.2.2  Installing iSeries Tools for Developers PRPQ

To install iSeries Tools for Developers PRPQ:

1. Download 5799-PTL iSeries Tools for Developers PRPQ from the following IBM Software 
Web site:

http://www.software.ibm.com

2. Click the Trials and betas link in the left navigation column. On the Trials and betas Web 
page, in the Search for selection box, type 5799PTL, and click Search.

3. Follow the installation instructions for 5799-PTL iSeries Tools for Developers PRPQ 
provided on the following Web site:

http://www.ibm.com/servers/enable/site/porting/tools/install.html

You can find ordering information for 5799-PTL iSeries Tools for Developers PRPQ on the 
Web at:

http://www.ibm.com/servers/enable/site/porting/tools/faqs.html

Important: You must install iSeries Tools for Developers PRPQ only if you intend to use 
VNC for document rendering. See 9.5.4, “X virtual frame buffer verses virtual network 
computing” on page 299, for more information. Also, you are not required to install iSeries 
Tools for Developers PRPQ if the 5722-DG1 PTF SI20496 is installed.
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2.2.3  Displaying the installed software on the iSeries server
To determine which software is currently installed on your iSeries server, perform the 
following steps:

1. Sign onto your iSeries server.

2. Enter the Display Software Resources (DSPSFWRSC) CL command and press Enter.

3. On the Display Software Resources display (Figure 2-1), verify the software that is 
installed.

Figure 2-1   Display Software Resources display

 Display Software Resources                           
                                                             System: RCHAS12  
 Resource                                                                       
    ID     Option  Feature  Description                                         
 5722999   *BASE    5050    Licensed Internal Code                              
 5722SS1   *BASE    5050    Operating System/400                                
 5722SS1   *BASE    2924    Operating System/400                                
 5722SS1   1        5050    OS/400 - Extended Base Support                      
 5722SS1   1        2924    OS/400 - Extended Base Support                      
 5722SS1   2        5050    OS/400 - Online Information                         
 5722SS1   2        2924    OS/400 - Online Information                         
 5722SS1   3        5050    OS/400 - Extended Base Directory Support            
 5722SS1   3        2924    OS/400 - Extended Base Directory Support            
 5722SS1   12       5050    OS/400 - Host Servers                               
 5722SS1   12       2924    OS/400 - Host Servers                               
 5722SS1   30       5050    OS/400 - Qshell                                     
 5722SS1   30       2924    OS/400 - Qshell                                     
 5722SS1   31       5050    OS/400 - Domain Name System                         
                                                                        More... 
 Press Enter to continue.                                                       
                                                                                
 F3=Exit   F11=Display libraries/releases   F12=Cancel                          
 F19=Display trademarks 
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4. On the same display, press F11 (Display libraries/releases) to view the release level of the 
product installed. See Figure 2-2.

Figure 2-2   Display Software Resources display showing the installed release

You can also use iSeries Navigator to verify the currently installed licensed software on your 
system. From iSeries Navigator, click My Connections → servername → Configuration 
and Service → Software → Installed Products as shown in Figure 2-3. The panel on the 
right shows the currently installed software on your system.

Figure 2-3   Using iSeries Navigator to display installed licensed software

For more information, refer to the IBM ~ iSeries Information Center for Version 5 
Release 3 (V5R3) at:

http://publib.boulder.ibm.com/iseries/v5r3/ic2924/index.htm

                           Display Software Resources                           
                                                             System: RCHAS12  
 Resource                   Feature                                             
    ID     Option  Feature   Type    Library     Release                        
 5722999   *BASE    5050     *CODE   QSYS        V5R3M0 L00                     
 5722SS1   *BASE    5050     *CODE   QSYS        V5R3M0 L00                     
 5722SS1   *BASE    2924     *LNG    QSYS        V5R3M0 L00                     
 5722SS1   1        5050     *CODE   QSYS2       V5R3M0                         
 5722SS1   1        2924     *LNG    QSYS2       V5R3M0                         
 5722SS1   2        5050     *CODE   QHLPSYS     V5R3M0                         
 5722SS1   2        2924     *LNG    QHLPSYS     V5R3M0                         
 5722SS1   3        5050     *CODE   QSYSDIR     V5R3M0                         
 5722SS1   3        2924     *LNG    QSYSDIR     V5R3M0                         
 5722SS1   12       5050     *CODE   QIWS        V5R3M0                         
 5722SS1   12       2924     *LNG    QIWS        V5R3M0                         
 5722SS1   30       5050     *CODE   QSHELL      V5R3M0                         
 5722SS1   30       2924     *LNG    QSHELL      V5R3M0                         
 5722SS1   31       5050     *CODE   QDNS        V5R3M0                         
                                                                        More... 
 Press Enter to continue.                                                       
                                                                                
 F3=Exit   F11=Display descriptions   F12=Cancel   F19=Display trademarks 
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2.3  Program temporary fixes
System updates and fixes on the iSeries server are applied through a PTF. The PTFs that are 
required to be loaded on the system depend on the version and release of OS/400 that is 
used and the software products that are installed on the system. This section covers the 
minimum PTFs that are required to perform the configuration steps covered in this redbook.

Running IBM Workplace Services Express Version 2.5 on the iSeries server requires both 
group PTF packages and individual PTFs. Each group PTF package and individual PTF 
includes specific installation instructions. Also, the IBM Web Administration for iSeries Create 
IBM Workplace wizard verifies that the required group PTFs and individual PTFs are installed 
prior to configuring a Workplace Services Express server.

2.3.1  Group PTFs
You must verify that the required group PTFs are installed on your iSeries server. A group 
PTF provides a logical set of PTFs that affect a specific function. It can span across many 
products. Typically you install group PTFs after you install the required licensed software 
products and before you install any individual PTFs.

Table 2-2 lists the required group PTFs for i5/OS V5R3 that you must apply before you can 
install Workplace Services Express Version 2.5 on i5/OS. Verify that your iSeries server has 
the latest levels of these group PTFs installed.

Table 2-2   Required i5/OS V5R3 group PTFs for Workplace Services Express Version 2.5

Note: Always make sure the latest OS/400 Cumulative PTF package is installed on your 
iSeries server.

Group PTF Description Minimum level

SF99530 Cumulative PTF package 5102

SF99503 DB2 Universal Database for iSeries 4

SF99287 WebSphere Application Server V5.0 (Base Edition) 7

SF99282 WebSphere Portal Express/Express Plus Service Pack 3

SF99269 Java 5

SF99099 IBM HTTP Server for iSeries 7

SF99288 WebSphere Application Server V5.0 (Network Deployment)
(This is only required if WebSphere Application Server 
Network Deployment (5733-WS5 Option 5) is installed.)

1

SF99173 IBM Business Solutions
(This is only required if IBM Business Solutions (5722-BZ1) 
is installed.)

1

SF99295 WebSphere MQ for iSeries Version 5, Release 3
(This is only required if WebSphere MQ for iSeries 
(5724-B41) is installed.)

1
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The WebSphere Portal Express/Express Plus Service Pack group PTF (SF99282) includes 
the WebSphere Application Server group PTF. This group PTF also includes several PTFs for 
products other than the WebSphere Application Server product.

Refer to the following link regarding Preventive Service Planning (PSP) information for the 
WebSphere Portal Express/Express Plus Service Pack Group PTF SF99282:

http://www-912.ibm.com/a_dir/as4ptf.nsf/0/137eb683e8bf962f86256eb1001605ef?OpenDocument

Verifying group PTFs
To verify the correct group PTF levels are installed on your system, perform the following 
steps:

1. Sign onto your iSeries server.

2. Enter the Work with PTF Groups (WRKPTFGRP) CL command on a command line and press 
Enter.

3. In the Work with PTF Groups display (Figure 2-4), which lists the group PTF installed on 
your system as well the level, verify that each group PTF shows a status of Installed. 

Figure 2-4   Work with PTF Groups (WRKPTFGRP) initial display

Important: You must apply the WebSphere Portal Express/Express Plus Service Pack 
Group PTF (SF99282) after WebSphere Application Server V5.0 Enterprise Enablement 
(5733-WS5, option 10) is installed. After installing WebSphere Application Server V5.0 
Enterprise Enablement (5733-WS5, option 10), it has been observed that several of the 
group PTFs change to an uninstalled status. Installing the WebSphere Portal 
Express/Express Plus Service Pack Group PTF (SF99282) changes these group PTFs 
back to an installed status.

                              Work with PTF Groups                              
                                                             System: RCHAS12  
 Type options, press Enter.                                                     
   4=Delete   5=Display   6=Print   8=Display special handling PTFs             
   9=Display related PTF groups                                                 
                                                                                
 Opt  PTF Group             Level  Status                                       
      SF99530                5102 Installed                                    
      SF99503                   4 Installed                                    
      SF99287                   7 Installed                                    
      SF99282                   3 Installed                                    
      SF99269                   5 Installed                                    
      SF99099                   6 Installed                                    
                                                                                
                                                                         Bottom 
 F3=Exit   F6=Print   F11=Display descriptions   F12=Cancel                     
 F22=Display entire field 
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4. The initial Work with PTF Groups display provides limited information. For a more 
descriptive display of the group PTF information, press F11 (Display descriptions) and you 
see the group PTF descriptions like the example in Figure 2-5.

Figure 2-5   Work with PTF Groups (WRKPTFGRP) display, using F11 to display the descriptions

You can also use iSeries Navigator to verify the installed group PTFs on your system. From 
iSeries Navigator, click My Connections → servername → Configuration and Service → 
Fixes Inventory → Fix Groups as shown in Figure 2-6.

Figure 2-6   Using iSeries Navigator to display the installed group PTFs

For more information, refer to the following Web sites:

� All group PTFs for the different OS/400 and i5/OS releases

http://www-912.ibm.com/s_dir/sline003.NSF/GroupPTFs?OpenView&view=GroupPTFs

� Methods and instructions for ordering group PTFs

http://www.ibm.com/servers/eserver/support/iseries/fixes/orderfix.html

� Fix Central

http://www-912.ibm.com/eserver/support/fixes/fcgui.jsp

                              Work with PTF Groups                              
                                                             System:   RCHAS12  
 Type options, press Enter.                                                     
   4=Delete   5=Display   6=Print   8=Display special handling PTFs             
   9=Display related PTF groups                                                 
                                                                                
 Opt  PTF Group             Text                                                
      SF99530               CUMULATIVE PTF PACKAGE C4272530                     
      SF99503               DB2 UDB FOR ISERIES                                 
      SF99287               WEBSPHERE APP SERVER V5.0 (BASE EDITION)            
      SF99282               WEBSPHERE PORTAL EXPRESS/EXPRESS PLUS SERVICE PACK  
      SF99269               JAVA                                                
      SF99099               IBM HTTP SERVER FOR ISERIES                         
                                                                                
                                                                         Bottom 
 F3=Exit   F6=Print   F11=Display status   F12=Cancel                           
 F22=Display entire field 
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2.3.2  Required individual i5/OS V5R3 PTFs
Table 2-3 lists the required individual i5/OS V5R3 PTFs for IBM Workplace Services Express 
2.5. To review the cover letters for these required PTFs, refer to the following Web site:

http://www-912.ibm.com/a_dir/as4ptf.nsf/as4ptfhome

The IBM Web Administration for iSeries Create IBM Workplace wizard verifies that the 
required group PTFs and individual PTFs are installed prior to configuring a Workplace 
Services Express server. Refer to 4.3.2, “Using the iSeries Create IBM Workplace wizard” on 
page 85, for details.

Refer to the following Web site for information and instructions on ordering individual PTFs:

http://www.ibm.com/servers/eserver/support/iseries/fixes/orderfix.html

Table 2-3   Required individual i5/OS V5R3 PTFs for Workplace Services Express Version 2.5

Important: Install the required individual PTFs after you install the required group PTFs 
(see 2.3.1, “Group PTFs” on page 16).

Product PTF number

5722-999 MF34851

MF34853

MF34854

MF34855

MF34856

MF34923

5722-SS1 SI14360

SI14668

SI14875

SI15032

SI15608

SI15974

SI16692

SI16999

SI17063

SI17274

SI17276

SI14360

SI14668

SI14875

SI15032

SI17277
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Verifying individual PTFs
To determine if the required individual PTFs are installed on your iSeries server, perform the 
following steps:

1. Sign onto your iSeries server.

2. Enter the following Display Program Temporary Fix (DSPPTF) CL command on an i5/OS 
command line and press Enter:

DSPPTF LICPGM(productID)

In this example, for product ID, we type 5722SS1.

5722-SS1 (continued) SI17308

SI17314

SI17480

SI17551

SI17684

SI16999 (recommended)

SI18345

SI18367

SI18796

5733-WS5 SI17024

5799-PTL SI09622

5772-DG1 SI15323

SI18732

5722-AC3 SI18370

Important: PTF SI17980 (product 5722-DG1) includes the IBM Web Administration for 
iSeries Create IBM Workplace wizard. This individual PTF is part of the IBM HTTP Server 
for iSeries group PTF, SF99099 level 5.

Product PTF number 
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In the Display PTF Status display, you see the PTFs that have been applied for a particular 
product. Figure 2-7 shows the PTFs installed for i5/OS V5R3.

Figure 2-7   Displaying PTF status for i5/OS V5R3 (5722SS1)

You can also use iSeries Navigator to verify the installed individual PTFs on your system. 
From iSeries Navigator, click My Connections → servername → Configuration and 
Service → Fixes Inventory → licensed program as shown in Figure 2-8.

Figure 2-8   Using iSeries Navigator to display installed individual PTFs

                               Display PTF Status                               
                                                             System:   RCHAS12  
 Product ID  . . . . . . . . . . . . . :   5722SS1                              
 IPL source  . . . . . . . . . . . . . :   ##MACH#B  ##SERV#P                   
 Release of base option  . . . . . . . :   V5R3M0 L00                           
                                                                                                                                                               
 Type options, press Enter.                                                     
   5=Display PTF details   6=Print cover letter   8=Display cover letter        
                                                                                
      PTF                                                   IPL                 
 Opt  ID       Status                                       Action              
      TC04272  Temporarily applied                          None                
      TC04209  Permanently applied                          None                
      TC04153  Superseded                                   None                
      TC04118  Superseded                                   None                
      TC04083  Superseded                                   None                
      TCP0039  Temporarily applied                          None                
      TCP0038  Superseded                                   None                
      TCP0037  Superseded                                   None                
      TCP0036  Superseded                                   None                
                                                                        More... 
 F3=Exit   F11=Display alternate view   F17=Position to   F12=Cancel                                                                                           
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2.4  i5/OS configuration and network requirements
This section explains the i5/OS configuration and network requirements. These include the 
installation and configuration user profiles, system values, the HTTP administration server, 
and the network requirements.

2.4.1  Installation and configuration user profiles
To install and configure IBM Workplace Services Express for i5/OS, you need the following 
user profiles with the specified special authorities:

� A valid user ID and password on the i5/OS server

This user profile must at have least *ALLOBJ, *IOSYSCFG, and *JOBCTL special 
authorities to install and configure a Workplace Services Express server on the iSeries 
server.

� An existing database user profile with at least *USER authority and a maximum storage 
parameter set to *NOMAX on the iSeries server where the DB2 Universal Database to be 
used is located

This profile is specified as the database owner in the IBM Web Administration for iSeries 
Create Workplace wizard. We recommend that you do not use this user profile for any 
other purpose or you could encounter problems. You cannot change the database user 
after a Workplace Services Express server is created.

2.4.2  Verifying the i5/OS time zone
Before you install the IBM Workplace Services Express software, make sure the time zone 
system value is set correctly. The i5/OS system value of QTIMZON specifies the time zone 
information used to calculate local system time. You can use the Change System Value 
(CHGSYSVAL) CL command to set the QTIMZON system value.

Before you change the QTIMZON system value, verify the current time zone setting by using 
the following Work with System Values (WRKSYSVAL) CL command:

WRKSYSVAL SYSVAL(QTIMZON)

Note: If the user profile you are using to configure a Workplace Services Express 
server has *SECADM special authority, you can create the database owner user profile 
when using the IBM Web Administration for iSeries Create IBM Workplace wizard.
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If you must change the QTIMZON system value, select it by using option 2 (Change) to 
access the Change System Value display (Figure 2-9). Or enter the following CHGSYSVAL 
command, which in this example, changes the time zone value to Central Standard Time:

CHGSYSVAL SYSVAL(QTIMZON) VALUE(QN0600CST)

Figure 2-9   Changing the QTIMZON system value

2.4.3  Verifying that the HTTP Administration server is active
The HTTP Administration server must be active in order to access the IBM Web 
Administration for iSeries Create IBM Workplace wizard. Perform the following steps to verify 
that the HTTP Administration server is active:

 Change System Value                               
                                                                                
 System value . . . . . :   QTIMZON                                             
 Description  . . . . . :   Time zone 
                                                                                
 Type choice, press Enter.                                                      
                                                                                
   Time zone  . . . . . .   QN0600CST      Name                                 
                                                                                
                                                                                
 Associated settings:                                                           
   Offset . . . . . :   -06:00                                                  
   Full name  . . . :   Central Standard Time                                   
   Abbreviated name :   CST                                                     

 F3=Exit   F4=Prompt   F5=Refresh   F12=Cancel 
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1. Start the HTTP Administration server on i5/OS using either of the following options:

– Enter the following Start TCP/IP Server (STRTCPSVR) CL command:

STRTCPSVR SERVER(*HTTP) HTTPSVR(*ADMIN)

– From iSeries Navigator, click My Connections → servername → Network → 
Servers → TCP/IP. In the right pane, right-click HTTP Administration and click Start 
(Figure 2-10).

Figure 2-10   Starting the HTTP Administration server from iSeries Navigator

2. Access IBM Web Administration for iSeries. Point your Web browser to the following URL, 
where server-hostname is the fully qualified host name of your iSeries server:

http://server-hostname:2001

In this example, we use:

http://rchas12.rchland.ibm.com:2001

3. When prompted, enter a valid i5/OS user profile and password with at least *ALLOBJ, 
*IOSYSCFG, and *JOBCTL special authorities. Click OK.
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4. In the iSeries Tasks Web page (Figure 2-11), click the IBM Web Administration for 
iSeries link.

Figure 2-11   iSeries Tasks page

2.4.4  Network requirements
The configuration of an IBM Workplace Services Express server on the iSeries server 
requires a static TCP/IP address and a fully-qualified host name. This allows the Workplace 
Services Express server to use well-known ports on that TCP/IP address for functions such 
as instant messaging.

You also need a static TCP/IP address for the external HTTP server, which might or might not 
be on the same system as the Workplace Services Express server. The IBM Web 
Administration Create IBM Workplace wizard allows you to create a local external HTTP 
server on the same TCP/IP address on the same iSeries server on which the Workplace 
Services Express server is being created.

Before you start the configuration of a Workplace Services Express server, determine the 
dedicated static TCP/IP address and the fully qualified host name to use.

Note: The options listed on the iSeries Tasks Web page depend on the products that 
are installed on your iSeries server.
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Determining the availability of a static TCP/IP address
A Workplace Services Express server on i5/OS requires the use of a static TCP/IP address. 
Perform the following steps to determine an available TCP/IP address:

1. From an i5/OS command line, enter the Configure TCP/IP (CFGTCP) CL command and 
press Enter.

2. On the Configure TCP/IP menu, type option 1 (Work with TCP/IP interfaces), and press 
Enter.

3. On the Work with TCP/IP Interfaces display (Figure 2-12), all the currently configured 
TCP/IP addresses on the iSeries server are displayed. From here, you have the options to 
add, change, remove, display, start, or end the TCP/IP interfaces.

Figure 2-12   Work with TCP/IP Interfaces display

You can also use iSeries Navigator to verify whether an available static TCP/IP address is 
defined on your system. Using iSeries Navigator, select My Connections → servername → 
Network → TCP/IP Configuration → IPv4 → Interfaces as shown in Figure 2-13.

Figure 2-13   Using iSeries Navigator to determine available TCP/IP addresses

 Work with TCP/IP Interfaces                           
                                                             System:   RCHAS12  
 Type options, press Enter.                                                     
   1=Add   2=Change   4=Remove   5=Display   9=Start   10=End                   
                                                                                
      Internet         Subnet              Line      Line                       
 Opt  Address          Mask             Description  Type                       
                                                                                
      10.10.10.1       255.255.255.128  ETHLINE      *ELAN                      
      10.10.10.2       255.255.255.128  ETHLINE      *ELAN                      
      10.10.10.3       255.255.255.128  ETHLINE      *ELAN                      
      10.10.10.4       255.255.255.128  ETHLINE      *ELAN                      
      127.0.0.1        255.0.0.0        *LOOPBACK    *NONE                      

                                                                         Bottom 
 F3=Exit      F5=Refresh   F6=Print list   F11=Display interface status         
 F12=Cancel   F17=Top      F18=Bottom 

Note: You must have at least one TCP/IP address other than 127.0.0.1 defined on your 
system.
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The currently configured TCP/IP addresses on the iSeries server are displayed in the right 
pane.

Verifying the fully qualified host name
Each IBM Workplace Services Express server on the iSeries server requires a static TCP/IP 
address and a fully-qualified host name. If the host name is listed in the i5/OS host table, it is 
required that the fully qualified host name is the first item listed after the IP address.

Along with the i5/OS host table, adding the fully-qualified host name to your Domain Name 
System (DNS) server or servers should ensure remote and client name resolution. For client 
and server connections, you must have name resolution for the Workplace Services Express 
server.

Perform the following steps to verify whether your system is configured with a fully-qualified 
host name:

1. From an i5/OS command line, enter the Configure TCP/IP (CFGTCP) CL command and 
press Enter.

2. On the Configure TCP/IP menu that is displayed, type option 12 (Change TCP/IP domain 
information), and press Enter.

3. On the Change TCP/IP Domain (CHGTCPDMN) display, verify the fully qualified host 
name of your iSeries server. In Figure 2-14, the fully qualified host name in our example is 
RCHAS12.RCHLAND.IBM.COM.

Figure 2-14   Verifying the fully qualified host name of the iSeries server

Note: We recommend that you update the i5/OS local host table with the fully-qualified 
host name of the Workplace Services Express server. The name resolution of the 
Workplace Services Express server by a DNS server is also a supported configuration.

                        Change TCP/IP Domain (CHGTCPDMN)                        
                                                                                
 Type choices, press Enter.                                                     
                                                                                
 Host name  . . . . . . . . . . .   'RCHAS12'                                   
                                                                                
 Domain name  . . . . . . . . . .   'RCHLAND.IBM.COM'                           
                                                                                                                                                                
                                                                                
 Domain search list . . . . . . .   *DFT                                        
                                                                                                                                                                
                                                                                
 Host name search priority  . . .   *LOCAL        *REMOTE, *LOCAL, *SAME        
 Domain name server:                                                            
   Internet address . . . . . . .   '10.10.244.100'                              
                                    '10.10.244.200'                              
                                                                                                                                                                
                                                                         Bottom 
 F3=Exit   F4=Prompt   F5=Refresh   F10=Additional parameters   F12=Cancel      
 F13=How to use this display        F24=More keys 
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Using an available static TCP/IP address and a fully-qualified host name for the Workplace 
Services Express server, perform the following steps to update the i5/OS local host table:

1. From an i5/OS command line, enter the Configure TCP/IP (CFGTCP) CL command and 
press Enter.

2. On the Configure TCP/IP menu that is displayed, type option 10 (Work with TCP/IP host 
table entries), and press Enter.

3. On the Work with TCP/IP Host Table Entries display, type option 1 (Add), and press Enter.

4. On the Add TCP/IP Host Table Entry (ADDTCPHTE) display, add the TCP/IP address with 
the fully-qualified host name listed first.
Figure 2-15 shows an example of the host table entries for a Workplace Services Express 
server called ITSOWSE1. Notice that the fully qualified host name is added first.

Figure 2-15   Adding a TCP/IP host table entry

Add TCP/IP Host Table Entry (ADDTCPHTE) 

Type choices, press Enter. 

Internet address . . . . . . . . > '10.10.10.1 
Host names: 
Name . . . . . . . . . . . . . > ITSOWSE1.RCHLAND.IBM.COM
Name . . . . . . . . . . . . . > ITSOWSE1

Text 'description' . . . . . . .   'IBM Workplace Services Express server' 

                                                                         Bottom 
 F3=Exit   F4=Prompt   F5=Refresh   F12=Cancel   F13=How to use this display    
 F24=More keys 
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5. Confirm that the fully qualified host name resolves to the correct IP address by typing the 
following PING CL command from an i5/OS command line:

ping ITSOWSE1.RCHLAND.IBM.COM

Replace ITSOWSE1.RCHLAND.IBM.COM with the fully qualified host name that you 
assigned to your Workplace Services Express server. See Figure 2-16.

Figure 2-16   Verifying the TCP/IP host table entry

Port assignments
Before you install and configure an IBM Workplace Services Express server on your iSeries 
server, it is important to verify that the ports required for the installation and configuration are 
available for use.

Table 2-4 lists some of the more common ports used by a Workplace Services Express 
server. Make sure that these port numbers are available on the IP address which you 
assigned to the Workplace Services Express server. The Workplace Services Express server 
binds these ports to the dedicated IP address.

Table 2-4   Ports bound to the specific host name used by a Workplace Services Express server

 Command Entry                         RCHAS12  
                                                           Request level:   1   
 Previous commands and messages:                                                
    > ping ITSOWSE1.RCHLAND.IBM.COM                                             
      Verifying connection to host system ITSOWSE1.RCHLAND.IBM.COM at address   
       10.10.10.1.                                                              
      PING reply 1 from 10.10.10.1 took 0 ms. 256 bytes. TTL 64.                 
      PING reply 2 from 10.10.10.1 took 0 ms. 256 bytes. TTL 64.                 
      PING reply 3 from 10.10.10.1 took 0 ms. 256 bytes. TTL 64.                 
      PING reply 4 from 10.10.10.1 took 0 ms. 256 bytes. TTL 64.                 
      PING reply 5 from 10.10.10.1 took 0 ms. 256 bytes. TTL 64.                 
      Round-trip (in milliseconds) min/avg/max = 0/0/0.                         
      Connection verification statistics: 5 of 5 successful (100 %).            
                                                                                
                                                                                
                                                                         Bottom 
 Type command, press Enter.                                                     
 ===>                                                                           
F3=Exit   F4=Prompt   F9=Retrieve   F10=Include detailed messages              
 F11=Display full      F12=Cancel    F13=Information Assistant   F24=More keys 

Port number Application Description

25 SMTP Simple Mail Transfer Protocol (SMTP), a protocol to send e-mail 
between servers

80 HTTP Hypertext Transfer Protocol (HTTP)

5060 SIP Session Initiated Protocol (SIP), a protocol used for Internet 
conferencing and instant messaging

5061 SIP SIP Transport Layer Security (TLS)

8080 SIP HTTP, Server1 application server

8081 SIP HTTP, WebSphere_Portal application server
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A Workplace Services Express server also requires a block of 100 consecutive ports, which 
are bound across all IP addresses configured on your iSeries server. The iSeries Create IBM 
Workplace wizard automatically determines an available port block when configuring a 
Workplace Services Express server.

Port conflicts
Make sure that you do not have port conflicts on the TCP/IP address that you have chosen for 
you Workplace Services Express server. This is especially true for the system SMTP server. 
If you are not using the i5/OS SMTP server, you can end the server by using the following End 
TCP/IP Server (ENDTCPSVR) CL command:

ENDTCPSVR SERVER(*SMTP)

Also, if you are not using the i5/OS SMTP server, do not set it to autostart when starting 
TCP/IP on your iSeries server.

If you are using the i5/OS SMTP server, you can bind it to a specific TCP/IP address by 
performing the following steps:

1. Using iSeries Navigator, click My Connections → servername → Network → 
Servers → TCP/IP.

2. From the right pane, right-click SMTP and select Properties.

3. From the SMTP Properties window, click the Bindings tab and select a specific TCP/IP 
address to bind the system SMTP server to.

2.5  Supported LDAP directories
Workplace Services Express requires the use of an LDAP directory. The following LDAP 
directories are supported for use with Workplace Services Express 2.5:

� IBM Domino Enterprise Server V6.0.x or V6.5.x
� IBM Directory Server V5.1 (which is shipped with IBM i5/OS V5R3)
� Microsoft Active Directory 2000
� Microsoft Active Directory 2003
� Novell eDirectory 8.7.3
� Sun™ One Directory Server V5.2 with Fix Pack 3

For more information about configuring a supported LDAP directory for use with Workplace 
Services Express, see Chapter 3, “Preparing the directory server for Workplace Services 
Express” on page 35.

Important: At the time this redbook was written, Workplace Services Express only 
supports IBM Domino Enterprise Server V6.0.x or V6.5.x. However, because of the 
similarities between Domino Versions 6.5.4 and 7.0, we anticipate that Domino Version 7.0 
will be supported in the future. Therefore, we indicate any differences between Domino 
V6.5.x and V7.x as applicable throughout this redbook. For a list of the supported Domino 
versions, see the Technical specification at a glance Web site at:

http://www.lotus.com/products/product5.nsf/wdocs/wsetechspecs

Note: The IBM Web Administration for iSeries Create IBM Workplace wizard verifies 
whether a valid LDAP directory server has been specified during the configuration of a 
Workplace Services Express server. Refer to 4.3.2, “Using the iSeries Create IBM 
Workplace wizard” on page 85, for more information.
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2.6  Supported HTTP servers
A separate, external HTTP server is required for instant messaging and presence awareness. 
Workplace Services Express comes with an internal HTTP server provided by WebSphere 
Application Server. However using an external HTTP server can improve performance.

Workplace Services Express supports the following local or remote HTTP servers running on 
i5/OS:

� IBM HTTP Server for iSeries 2.0.49
� IBM Lotus Domino Server for iSeries Release 5.0.12 or later

Workplace Services Express also supports the following remote HTTP servers running on 
other platforms:

� HTTP Server (powered by Apache) 1.3.26 and 1.3.28
� IBM HTTP Server 1.3.26.1 and 1.3.26.2
� IBM HTTP Server 2.0.42.1 and 2.0.42.2
� IBM Lotus Domino Enterprise Server (as Web server) 5.0.9a 
� Microsoft IIS 5.0 
� Sun ONE™ Web Server (formerly iPlanet™), Enterprise Edition 6.0 with Service Pack 4 

2.7  Client requirements
To deploy IBM Workplace Services Express in your client environment, the client software 
and operating system must meet several requirements.

The following operating systems are supported for Web browser clients:

� Microsoft Windows 2000 Professional with Service Pack 2
� Microsoft Windows XP with Service Pack 1
� Red Hat Enterprise Linux® WS 3.0 with Update 3
� SuSE Linux Desktop 1.0

The following Web browsers are supported by the Web browser client:

� Microsoft Internet Explorer 6.0 with Service Pack 1

This browser is supported only on Microsoft Windows 2000 or XP with the Sun Java™ 
Runtime Environment (JRE) 1.4.2 or with Microsoft Java Virtual Machine (JVM) 1.1 
installed.

� Mozilla 1.4

This browser is supported on Linux platforms and on Microsoft Windows 2000 or XP with 
Sun JRE 1.4.2 installed.

� Mozilla Firefox 1.0

This browser is supported on Linux platforms and on Microsoft Windows 2000 or XP with 
Sun JRE 1.4.2 installed.

Important: When you use the IBM Web Administration for iSeries Create IBM Workplace 
wizard to configure a Workplace Services Express server, it automatically configures a 
new IBM HTTP Server (powered by Apache) for iSeries. If you plan to use any other HTTP 
server, you must manually configure that HTTP server after you configure the Workplace 
Services Express server. For more information, see the Workplace Services Express 
Information Center at:

http://publib.boulder.ibm.com/infocenter/wseic/v2r5/index.jsp
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2.8  Planning for Workplace Services Express
Planning your Workplace Services Express environment is a necessary task. The decisions 
made during installation and configuration might be difficult or impossible to change after the 
system is in use. In this section, we explain why it is important to understand what is involved 
in deploying Workplace Services Express on your iSeries server.

Prior to installing Workplace Services Express, consider the number of people who will use it, 
the amount of data you expect to manage, the types of servers you will host, and the 
third-party components you plan to use with Workplace Services Express. Answer the 
following questions to gain an understanding of what is needed before you begin:

� What are your user requirements for collaborative systems?
� Will there be a pilot installation and testing period?
� Do you have an LDAP directory in place?
� Do you have experience with all the Workplace Services Express components?
� Will Workplace Services Express be integrated with other collaborative products, such as 

Lotus Domino?

Sometimes, answering one question leads to new ones. It is a good practice to go through 
these questions and any that might come up, prior to starting the installation of Workplace 
Services Express.

To help you size your Workplace Services Express server, answer the following questions:

� How many users do you plan to deploy the system for?

� What are your requirements for team collaboration?

– How many team collaboration users will you have?
– How many team spaces will exist?
– What is the peak number of concurrent team space users that you expect to have?
– What is the average size of the data which will be stored in each team space?

� What are your requirements for document management?

– How many document management users will you have?
– What is the peak number of concurrent document management users that you expect 

to have?
– What is the average size of document data that you expect to store per user?

2.8.1  Recommended skills
IBM Workplace Services Express is comprised of core IBM software such as:

� WebSphere Application Server
� WebSphere Portal Server
� DB2 Universal Database

For these reasons, we recommend that an organization gather together personnel with 
working experience in these areas in order to make the initial installation and configuration of 
Workplace Services Express on your iSeries server a success.

LDAP administration
LDAP knowledge is one of the most critical areas of expertise required for a successful 
deployment of Workplace Services Express. Your LDAP directory is key to all Workplace 
Services Express functionality. If your organization currently has an LDAP directory in place, 
you might have to update it so that it can be used with Workplace Services Express. If your 
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organization does not currently have an LDAP directory in place, then you need the skills to 
design a proper directory that suits the needs of your organization and grow with it.

For more information, see Chapter 3, “Preparing the directory server for Workplace Services 
Express” on page 35.

WebSphere administration
WebSphere Application Server is the engine behind Workplace Services Express. 
WebSphere Portal Server handles the presentation of Workplace Services Express to the 
administrator and the end user. An experienced WebSphere administrator plays a key role in 
your deployment process. Most of the problems which you might encounter using Workplace 
Services Express can be fixed by reviewing the WebSphere Application Server and 
WebSphere Portal Server logs for error information.

Relational database administration
Storage of data is a central part of Workplace Services Express. All data related to a 
Workplace Services Express server is stored in DB2 Universal Database for iSeries. You 
need a person with medium to high administration skills in this area to manage the databases 
and perform daily administrative tasks such as backup and recovery.

Operating system administration
Workplace Services Express requires i5/OS V5R3. An administrator needs an understanding 
of i5/OS to set up and maintain the Workplace Services Express environment. This includes 
working with the Qshell Interpreter environment and many of the i5/OS TCP/IP utilities.

Network administration and security
The Workplace Services Express environment depends on network connections. Consult 
with an experienced network administrator before you deploy Workplace Services Express to 
ensure that server-to-server and client-to-server communications perform optimally. This is 
important for efficient communication, but also for secure transmission inside and outside the 
organization. You need network skills to configure your DNS server, host names, and TCP/IP 
addresses.

2.8.2  Understanding your environment
A full understanding of your organization’s hardware and software topology is essential when 
deploying Workplace Services Express. This might require you to bring together those 
responsible for each of the technologies that Workplace Services Express relies on. Outline 
the goals for your deployment and the impact which they will have on your current 
environment. Consider these questions when reviewing the environment:

� Will Workplace Services Express replace any existing system?
� Is an LDAP directory in place?
� Can the current network handle the traffic needs of the server and client systems?
� Who has responsibility for each aspect of the environment?
� What applications will Workplace Services Express interact with?

Pilot system
After you complete the plan for deployment, we recommend that you implement a pilot 
system. The pilot allows administrators to correct any potential problems in the deployment 
plan. It is also beneficial to see how end users will interact with the system. A preproduction 
pilot makes the move to a production system much smoother.
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Chapter 3. Preparing the directory server for 
Workplace Services Express

This chapter describes the fundamental role that directory services plays within Workplace 
Services Express on iSeries. It discusses the following topics:

� Understanding the importance of your directory server
� Selecting your directory service provider
� Preparing your directory server to configure a Workplace Services Express server

In addition, this chapter provides checklists to help ensure that you have configured your 
directory server properly.

3

Note: Directory servers use the Lightweight Directory Access Protocol (LDAP). In this 
chapter, the terms directory server, LDAP server, and LDAP directory are synonymous 
and are used interchangeably.
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3.1  The importance of your directory (LDAP) server
Your directory server is the starting point for your Workplace Services Express server. All user 
information is stored in the LDAP directory. Everything from authentication, authority, and 
data access is determined from the information received from the directory server. If the 
information stored in the directory server is invalid, the function of Workplace Services 
Express is compromised. Due to the dependence on the LDAP server, configuring your 
directory server properly before you configure your first Workplace Services Express server is 
important.

In this chapter, we provide in-depth information to help you confirm that your directory 
configuration will work with Workplace Services Express, as well as checklists to help you 
along the way.

3.1.1  LDAP and Workplace Services Express terminology
Before you read this chapter, there are some LDAP terms and concepts used that you should 
be familiar with. This section provides a quick reference for you to use as you review your 
directory server’s configuration.

� Suffix: The top entry in your LDAP directory information tree

This can also be referred to as the base entry or the root. There can be several suffixes in 
an LDAP directory, each representing the top of a separate directory information tree.

� Users container: The container in your LDAP directory where information about 
Workplace Services Express users is stored

� Groups container: The container in your LDAP directory where information about 
Workplace Services Express groups is stored

Initially only one group is created, the administrative users group with a single member, 
which is the Workplace Services Express administrator user. To grant administrative 
privileges to other users, add them to the administrative users group.

� LDAP administrator: A user account in your directory server that has read/write authority 
to the directory server

Use of this account is needed during the configuration of the Workplace Services Express 
server.

� Workplace Services Express administrator: The administrator account that is selected 
or created when the Workplace Services Express server is configured

This account is used to configure portlets. It is also used to run scripts to modify the 
Workplace Services Express configuration and to access the LDAP server after the initial 
configuration of the server.

Important: If you do not configure security as part of the configuration process for 
Workplace Services Express on iSeries, a self-contained directory service based upon 
WebSphere Member Manager is deployed. This is considered to be the internal directory 
server. The internal directory server is not designed for use beyond a typical sandbox 
implementation consisting of a few users. Those users can be self registered via the Sign 
up link on the Workplace Services Express home page. Since the purpose of this redbook 
is to configure Workplace Services Express for a production environment, we assume that 
you will use an LDAP server for your directory service provider.

 

 

 

36 Deploying IBM Workplace Services Express on the IBM Eserver iSeries Server



 

3.1.2  Supported LDAP servers
Workplace Services Express on iSeries Version 2.5 supports the following LDAP servers:

� IBM Domino Enterprise Server V6.0.x or V6.5.x
� IBM Directory Server V5.1 (which is shipped with i5/OS V5R3)
� Microsoft Active Directory 2000
� Microsoft Active Directory 2003
� Novell eDirectory 8.7.3
� Sun One Directory Server V5.2 with Fix Pack 3

Refer to the IBM Workplace Services Express Release Notes for more specific version and 
service pack details. You can find the release notes and other Workplace Services Express 
product documentation on the Web at:

http://www.lotus.com/products/product5.nsf/wdocs/productdoc

3.1.3  iSeries server, the one system solution for Workplace Services Express
The architecture of Workplace Services Express varies based on the platform on which the 
solution is deployed. On the iSeries, deploying Workplace Services Express has been 
simplified. All of the technologies that are required to run a Workplace Services Express 
deployment can run on the same system. Here are a few examples of the technologies that 
are supported concurrently on the same iSeries server:

� DB2 Universal Database
� IBM Directory Server
� IBM HTTP Server
� Lotus Domino 
� WebSphere Application Server
� WebSphere Portal Server
� Workplace Services Express

As you can see from the list, you have a choice of two directory servers when seeking a one 
system solution for Workplace Services Express, using either Lotus Domino or IBM Directory 
server.

3.1.4  Choosing a directory server
Choosing a directory server is an important decision. If you have an existing LDAP 
infrastructure which is supported for use with Workplace Services Express, your decision is 
easy. Continue to use your existing directory server.

If you have an existing Domino infrastructure, this chapter helps you to configure your 
Domino server to use the LDAP functionality that is part of Domino. If you are using the IBM 
Directory Server that is part of the i5/OS operating system, continue to use this with your 
Workplace Services Express server. If you do not have an existing LDAP server, you might 
use any of the supported servers. Since LDAP is configured for you automatically within 

Important: At the time this redbook was written, Workplace Services Express supports 
only IBM Domino Enterprise Server V6.0.x or V6.5.x. However, because of the similarities 
between Domino Versions 6.5.4 and 7.0, we anticipate that Domino Version 7.0 will be 
supported in the future. Therefore, we indicate any differences between Domino V6.5.x 
and V7.x as applicable throughout this redbook. For a list of the supported Domino 
versions, see the Technical specification at a glance Web site at:

http://www.lotus.com/products/product5.nsf/wdocs/wsetechspecs
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i5/OS, consider using this as your LDAP server. (Refer to Appendix B, “Setting up IBM 
Directory Server for i5/OS” on page 343, for additional information.) If you are planning on 
migrating to Domino or want to use the Domino Collaboration portlets with your Workplace 
Services Express server, consider configuring a Domino server now and using it as your 
directory server.

You can see that a number of options are available to you. To help you understand what you 
must do before you can configure your first Workplace Services Express server, refer to 
Table 3-1 as a checklist to follow when preparing your directory server.

Table 3-1   Checklist of setup tasks for your directory server

3.2  Read/write or read-only access to the directory server
Before you can run the iSeries Create IBM Workplace wizard, you must determine whether 
you will allow read-only or read/write access to your directory server. The following sections 
provide a brief explanation about read/write access versus read-only access to help you 
make this decision.

3.2.1  Read/Write access
If you do not have an existing LDAP tree, have little LDAP experience, or want the iSeries 
Create IBM Workplace wizard to correctly create and configure the objects needed for your 
Workplace Services Express server, then consider granting the iSeries Create IBM 
Workplace wizard write access to the directory server. In this case the iSeries Create IBM 
Workplace wizard can optionally perform the following tasks for you:

� Create a users container.

� Create a groups container.

� Create a Workplace Services Express administrator user under the users container.

� Create a Workplace Services Express administrator group under the groups container.

� Add the Workplace Services Express administrator as a member of your Workplace 
Services Express administrator group.

� Grant your Workplace Services Express administrator write access to the LDAP directory.

Workplace Services Express uses the administrator user to permit Workplace Services 
Express users to self-register themselves via a Sign up link on the initial Workplace Services 
Express home page. Workplace Services Express also uses the administrator user to allow 
users to maintain some basic personal information via an Edit my profile link.

Task to be completed Where you can find help in this chapter

Choose a directory server 3.1.4, “Choosing a directory server” on page 37

Determine read or write access to the 
directory server

3.2, “Read/write or read-only access to the directory 
server” on page 38

Modify the LDAP server configuration 
(three choices):

IBM Directory Server 3.3, “Preparing the IBM Directory Server” on page 39

IBM Domino Enterprise server 3.4, “Preparing the Domino server for LDAP” on page 51

Other directory servers Refer to the IBM Redbook IBM Workplace Services 
Express, SG24-6758.
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Permitting users to self-register via the Sign up link and maintain some of their attributes via 
the Edit my profile link might not be desired. These features can be disabled by customizing 
the Workplace Services Express configuration, thereby creating no harm by granting write 
access to the LDAP directory at this time. With this customization in place, all user registration 
and maintenance are performed by the LDAP administrator. For information about removing 
the Sign up and Edit my profile links, refer to 5.10, “Removing the Sign up and Edit my profile 
links” on page 156.

3.2.2  Read-only access
Read-only access is better suited for experienced LDAP administrators who require a tightly 
managed directory. If this is the case, then it is the LDAP administrator’s responsibility to 
mimic the LDAP-related tasks performed by the iSeries Create IBM Workplace wizard. The 
iSeries Create IBM Workplace wizard also runs a script to remove the Sign up and Edit my 
profile links. The following entries must exist in the directory in order to use read-only access:

� A users container
� A groups container
� A Workplace Services Express administrator user located in your users container
� A Workplace Services Express administrator group located in your groups container

You also must add your Workplace Services Express administrator as a member of your 
Workplace Services Express administrator group.

3.3  Preparing the IBM Directory Server
This section explains how to prepare the IBM Directory Server for use by a Workplace 
Services Express server.

The process to prepare the IBM Directory Server depends on whether you are already using 
the IBM Directory Server and whether you will allow write access to the directory. We 
presume that most people have already configured the IBM Directory Server on their system. 
However, to make sure that nothing is overlooked, the following steps, which you can use as a 
checklist, are required to prepare the IBM Directory Server for Workplace Services Express:

1. Configure the default LDAP server.
2. Configure the HTTP Administration server.
3. Configure the IBM Tivoli® Directory Server Web Administration Tool.
4. Add the appropriate users to the LDAP server. Optionally import them from an .ldif file.
5. Test the IBM Directory Server.

If you are already using the IBM Directory Server and are going to give the iSeries Create 
Workplace wizard write authority to the directory, you can skip this section and go to 3.3.6, 
“Testing the IBM Directory Server” on page 50.

Tip: For simplicity, we recommend that you allow the iSeries Create Workplace wizard 
read/write access to the LDAP directory and then customize the Workplace Services 
Express server to remove the Sign up and Edit my profile links. 

Note: If you already have i5/OS user profiles that you want Workplace Services Express to 
use, you must import the user profiles into the LDAP server.
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3.3.1  Configuring the default LDAP server
The focus of this redbook is to set up IBM Workplace Services Express. To ensure that your 
IBM Directory Server is configured correctly, we provide the information that you need in 
Appendix B, “Setting up IBM Directory Server for i5/OS” on page 343.

3.3.2  Configuring the HTTP Administration server
For you to add users to the IBM Directory Server, you can use the HTTP Administration 
server interface. To access the HTTP Administration server interface, iSeries Tasks menu, 
point your Web browser to:

http://iSeriesHostName.domain:2001

If you cannot access the iSeries Tasks menu, refer to “Configuring the HTTP Administration 
server” on page 349 for additional information.

3.3.3  Configuring the Tivoli Directory Server Web Administration Tool
To administrator the IBM Directory Server on iSeries, you can access the Tivoli Directory 
Server Web Administration Tool. If you have not configured this tool, refer to “Enabling the 
Tivoli Directory Server Web Administration Tool” on page 349.

3.3.4  Adding a Workplace Services Express administrator to the LDAP server
The iSeries Create Workplace wizard can do all the work for you, if you allow it. If you plan to 
allow read/write access to the LDAP directory, then you are not required to add the required 
Workplace Services Express administrator user and group manually. The wizard does it for 
you. In this case, you can skip to 3.3.6, “Testing the IBM Directory Server” on page 50.

If you do not want the exposure of Workplace Services Express having write access to your 
LDAP directory, you must manually add the required Workplace Services Express 
administrator user and group. You have two options to add the Workplace Services Express 
administrator user and group, import an .ldif file or use the Tivoli Directory Server Web 
Administration Tool.

The following steps walk you through the process of manually adding the Workplace Services 
Express administrator user and group via the Tivoli Directory Server Web Administration Tool. 
If you are using an .ldif file to add a user and group to an LDAP directory, refer to 3.3.5, 
“Importing an .ldif file to add users and groups to IBM Directory Server” on page 46.

Important: If you implemented IBM Directory Server for i5/OS prior to V5R3, then your 
entries are missing the ibm-entryUuid attribute that is required for Workplace Services 
Express. If you intend for those users to have access to Workplace Services Express, then 
you must add the ibm-entryUuid attribute to those entries manually. See the Workplace 
Collaboration Services release notes for step-by-step instructions, which are the same for 
Workplace Collaboration Services and Workplace Services Express. You can find the 
release notes on the Web at:

http://www-12.lotus.com/ldd/doc/uafiles.nsf/docs/lwp25/$File/releasenotes.pdf
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Using the Tivoli Directory Server Web Administration Tool
Perform the following steps to add a user and group to the IBM Directory Server using the 
Tivoli Directory Server Web Administration Tool:

1. Access the Tivoli Directory Server Web Administration Tool:

a. Point your Web browser to your fully qualified iSeries host name on port 2001:

http://iSeriesHostName.domain:2001

In our example, we enter:

http://rchas55.rchland.ibm.com:2001

b. After the iSeries Tasks menu opens, click IBM Directory Server for iSeries.

c. Select the host name of the LDAP server that you are going to administer. In most 
cases, this is the same as the host name of your iSeries server.

d. Enter the distinguished name (DN) for the administrator (cn=administrator by default) 
and password that is configured in the IBM Directory Server properties. If you do not 
know which user and password to provide here, see Appendix B, “Setting up IBM 
Directory Server for i5/OS” on page 343, for assistance in modifying the administrator 
user name and password.

Tip: By default, the iSeries Create IBM Workplace wizard adds a user named wpsadmin 
and a group named wpsadmins to the LDAP directory. In the following steps, we manually 
add a user named wpsadmin and a group named wpsadmins. You can change these 
names and use any user or group name that you desire.

Note: If the Tivoli Directory Server Web Administration Tool does not load for you, 
configure the HTTP Administration server. Refer to “Enabling the Tivoli Directory 
Server Web Administration Tool” on page 349.
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2. Manage entries in the Tivoli Directory Server Web Administration Tool:

a. In the left pane, expand Directory management.
b. Click Manage entries.
c. Select the appropriate domain suffix for your system as shown in Figure 3-1.

Figure 3-1   Tivoli Directory Server Web Administration Tool

3. Create cn=users and cn=groups containers. We start with the users container. To create 
the users container, select the suffix where you want to create the container and click Add.

Note: If you already have a cn=users and cn=groups container for this suffix, you can 
skip to step 5 on page 44. If you do not see a + sign in the second column for your 
suffix, you must complete this step.

Tip: The Add button is located on the far right side of the panel. You might need to scroll 
to the right to find this button.
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a. In the Select object class pane (Figure 3-2), for Structural object class, select 
container and click Next.

Figure 3-2   Selecting the object class container

b. In the Select Auxiliary Object Class pane, you are not required to specify an auxiliary 
object class for the new container. Click Next.

c. In the Enter the attributes pane (Figure 3-3), set the following values: 

i. For Object class, keep the setting of container.
ii. For the Relative DN field, type cn=users.
iii. Verify that the Parent DN field contains the correct suffix for your host.
iv. In the cn field, type users.

d. Click Finish.

Figure 3-3   Modifying the attributes for the cn=users entry
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4. In the Manage Entries pane, click Add to create the groups container.

a. In the Select object class pane (Figure 3-2), for Structural object class, select 
container and click Next.

b. In the Select Auxiliary Object Class pane, you are not required to specify an auxiliary 
object class for the new container. Click Next.

c. In the Enter the attributes pane (Figure 3-4), set the following values: 

i. For Object class, keep the setting of container.
ii. In the Relative DN field, type cn=groups.
iii. Verify that the Parent DN field contains the correct suffix for your host.
iv. In the cn field, type groups.

d. Click Finish.

Figure 3-4   Modifying the attributes for the cn=groups entry

5. Create the Workplace Services Express administrator user and the Workplace Services 
Express administrator group. To create the Workplace Services Express administrator 
user, in the Manage Entries pane, click Add.

a. In the Select object class pane, select the Structural object class of inetOrgPerson 
and click Next.

b. In the Select Auxiliary Object Class pane, you are not required to specify an auxiliary 
object class for the new container. Click Next.

c. In the Enter the attributes pane (Figure 3-5), set the following values where wpsadmin 
represents your Workplace Services Express administrator:

i. For Object class, keep the setting of inetOrgPerson.
ii. In the Relative DN field, type uid=wpsadmin.
iii. Verify that the Parent DN field contains the correct suffix for your users container.
iv. In the cn field, type wpsadmin.
v. In the sn field, type wpsadmin.
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Figure 3-5   Adding the wpsadmin user to the IBM Directory server

d. Click Other attributes. You must scroll down and specify the following values as shown 
in Figure 3-6:

i. In the uid field, type the UID of your Workplace Services Express administrator. In 
this example, we type wpsadmin.

ii. In the userPassword field, type a password.

e. Click Finish to create the Workplace Services Express administrator user.

Figure 3-6   Setting a password for the wpsadmin user
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6. To create the Workplace Services Express administrator group, in the Manage Entries 
pane, click Add.

a. In the Select object class pane, select the Structural object class of 
groupOfUniqueNames and click Next.

b. In the Select Auxiliary Object Class pane, you are not required to specify an auxiliary 
object class for the new container. Click Next.

c. In the Enter the attributes pane (Figure 3-7), set the following values where wpsadmins 
represents the name of your Workplace Services Express administrator group:

i. For Object class, keep the setting of groupOfUniqueNames.
ii. For Relative DN field, type cn=wpsadmins.
iii. Verify the Parent DN field contains the correct suffix for your groups container.
iv. In the cn field, type wpsadmins.
v. The uniqueMember field must contain the DN of the Workplace Services Express 

administrator. In this example, we type: 
cn=wpsadmin,cn=users,dc=rchas55,dc=rchland,dc=ibm,dc=com

d. Click Finish to create the Workplace Services Express administrators group.

Figure 3-7   Adding the wpsadmins group to the IBM Directory server

7. Go to 3.3.6, “Testing the IBM Directory Server” on page 50.

3.3.5  Importing an .ldif file to add users and groups to IBM Directory Server
This section shows you how to modify the IBM Directory server using an .ldif file. The file 
used in this example does the following actions:

� Adds a users container
� Adds a groups container
� Adds a user called wpsadmin to the users container
� Adds a group called wpsadmins to the groups container
� Adds wpsadmin as a member to the wpsadmins group
� Gives read, write, search and compare authorities to the wpsadmins group for the users 

and groups containers
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To import the .ldif file into your directory, perform the following steps:

1. Download the example rchas55.ldif file. Refer to Appendix C, “Additional material” on 
page 359, for information about obtaining this file.

2. Modify the rchas55.ldif file on your PC workstation using Notepad or another PC text 
editor of your choice. Change the domain suffix to match the domain suffix in your 
environment.

3. In Example 3-1 you can see the file that we imported to create the users. To use this file 
for your directory server, change the domain suffix to match your environment. When you 
are finished editing the file, you should have no remaining references to rchas55. You must 
also edit the mail attribute for the wpsadmin user. If you do not want wpsadmin to have a 
reference to a mail account, remove that line from the .ldif file.

Example 3-1   Imported rchas55.ldif file

version: 1
dn: cn=users,DC=RCHAS55,DC=RCHLAND,DC=IBM,DC=COM
objectClass: top
objectClass: container
cn: users
IBM-ENTRYUUID: 298e6001-4edb-18a5-81e6-0004ac086256
aclpropagate: TRUE
ownerpropagate: TRUE
entryowner: access-id:CN=ADMINISTRATOR
entryowner: group:CN=WPSADMINS,CN=GROUPS,DC=RCHAS55,DC=RCHLAND,DC=IBM,DC=COM
aclentry: group:CN=WPSADMINS,CN=GROUPS,DC=RCHAS55,DC=RCHLAND,DC=IBM,DC=COM:obj
 ect:ad:normal:rwsc:sensitive:rwsc:critical:rwsc
aclentry: group:CN=ANYBODY:normal:rsc
aclentry: access-id:CN=THIS:object:d:normal:rwsc:sensitive:rwsc:critical:rwsc

dn: cn=groups,DC=RCHAS55,DC=RCHLAND,DC=IBM,DC=COM
objectClass: top
objectClass: container
cn: groups
IBM-ENTRYUUID: 29d09801-4edb-18a5-81e6-0004ac086256
aclpropagate: TRUE
ownerpropagate: TRUE
entryowner: access-id:CN=ADMINISTRATOR
entryowner: group:CN=WPSADMINS,CN=GROUPS,DC=RCHAS55,DC=RCHLAND,DC=IBM,DC=COM
aclentry: group:CN=WPSADMINS,CN=GROUPS,DC=RCHAS55,DC=RCHLAND,DC=IBM,DC=COM:obj
 ect:ad:normal:rwsc:sensitive:rwsc:critical:rwsc
aclentry: group:CN=ANYBODY:normal:rsc
aclentry: access-id:CN=THIS:object:d:normal:rwsc:sensitive:rwsc:critical:rwsc

dn: uid=wpsadmin,cn=users,dc=RCHAS55,dc=RCHLAND,dc=IBM,dc=COM
objectClass: top
objectClass: person
objectClass: organizationalPerson
objectClass: inetOrgPerson
mail: wpsadmin@ITSOWSE4.RCHLAND.IBM.COM
uid: wpsadmin
userPassword:: e1NIQX1bqmHkybk/PwaCJQts+DMbfuaP2A==
sn: wpsadmin
cn: wpsadmin
IBM-ENTRYUUID: 296fb801-4ee5-18a5-81e6-0004ac086256
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dn: cn=wpsadmins,cn=groups,dc=RCHAS55,dc=RCHLAND,dc=IBM,dc=COM
objectClass: top
objectClass: groupOfUniqueNames
cn: wpsadmins
IBM-ENTRYUUID: 2a973001-4ee5-18a5-81e6-0004ac086256
uniqueMember: uid=wpsadmin,cn=users,dc=RCHAS55,dc=RCHLAND,dc=IBM,dc=COM

4. Copy the modified .ldif file from your PC to the iSeries server. You can do this by using 
mapped network drive or File Transfer Protocol (FTP).

5. Open iSeries Navigator.

6. In the left pane, select Network → Servers → TCP/IP.

7. The directory server must have a status of Stopped in order for you to import the .ldif file. 
Right-click IBM Directory Server and click Stop as shown in Figure 3-8.

Figure 3-8   Stopping the IBM Directory Server via iSeries Navigator
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8. Right-click IBM Directory Server and select Tools → Import File as shown in Figure 3-9.

Figure 3-9   Selecting the Import File option for IBM Directory Server

9. In the Import LDIF File window (Figure 3-10), select the file that you copied to the iSeries 
server in the previous step. On our test system, we named the file rchas55.ldif and 
placed the file in the root directory. Click OK.

Figure 3-10   Selecting the .ldif file to import

10.When the import is completed, you receive a status message indicating that the entries 
were added successfully. If you did not have a cn=users or a cn=groups container, then 
four entries are added. If you already had a cn=users or a cn=groups container, then only 
two entries are successfully added as shown in Figure 3-11. Click OK.

Figure 3-11   Displayed messages after importing the .ldif file
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11.You return to main iSeries Navigator window. Right-click IBM Directory Server and select 
Start to start the IBM Directory Server.

3.3.6  Testing the IBM Directory Server
Running an ldapsearch command against the LDAP directory indicates whether you 
configured your LDAP server correctly. If you prefer a graphical user interface, third-party 
products are available on the Internet for download. In Example 3-2, we run the following 
ldapsearch command from a Windows command prompt to verify that the Workplace 
Services Express administrator user and Workplace Services Express administrator group 
exists in the IBM Directory server:

ldapsearch -h rchas55.rchland.ibm.com -p 389 -D cn=administrator -w password -b 
dc=rchas55,dc=rchland,dc=ibm,dc=com cn=wps*

If you manually created the wpsadmin user and wpsadmins group, you should see a minimum 
of two entries returned to you as shown in Example 3-2. If you have chosen to use an 
alternative administrator user and group, modify the command to search for the appropriate 
entries in your directory.

Example 3-2   LDAP search to verify that wpsadmin and wpsadmins are in the LDAP directory

C:\>ldapsearch -h rchas55.rchland.ibm.com -p 389 -D cn=administrator -w password -b 
dc=rchas55,dc=rchland,dc=ibm,dc=com cn=wps*

uid=wpsadmin,cn=users,dc=rchas55,dc=rchland,dc=ibm,dc=com
userpassword=NOT ASCII
uid=wpsadmin
objectclass=inetOrgPerson
objectclass=organizationalPerson
objectclass=person
objectclass=top
sn=wpsadmin
cn=wpsadmin
mail=wpsadmin@ITSOWSE1.RCHLAND.IBM.COM

cn=wpsadmins,cn=groups,dc=rchas55,dc=rchland,dc=ibm,dc=com
objectclass=groupOfUniqueNames
objectclass=top
cn=wpsadmins
uniquemember=cn=wpsadmin,cn=users,dc=rchas55,dc=rchland,dc=ibm,dc=com
uniquemember=uid=wpsadmin,cn=users,dc=RCHAS55,dc=RCHLAND,dc=IBM,dc=COM

The IBM Directory Server is now setup, and you are ready to configure your Workplace 
Services Express server. For information about configuring a Workplace Services Express 
server, refer to Chapter 4, “Installing and configuring Workplace Services Express” on 
page 71.

Note: If you did not manually add the wpsadmin user as your Workplace Services Express 
administrator and the wpsadmins group as the Workplace Services Express administrator 
group, the command returns with no output.
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3.4  Preparing the Domino server for LDAP
This section explains how to prepare a Domino Enterprise server for LDAP for use by a 
Workplace Services Express server.

The Domino Directory (names.nsf) is a familiar and easy to manage LDAP directory for most. 
If you are currently using Domino in your environment, you might want to leverage it for your 
Workplace Services Express implementation.

Unlike the schemas of other LDAP directories supported by Workplace Services Express, the 
default schema for the Domino Directory does not provide a unique ID attribute required by 
Workplace Services Express. If you are running Domino Version 6.5.3 or earlier, some 
modifications to the Domino Directory database design and data are required before it can be 
used with Workplace Services Express.

Table 3-2 summarizes the tasks that you must perform on your Domino server prior to 
configuring your first Workplace Services Express server.

Table 3-2   Checklist of tasks for preparing a Domino Directory for use as an LDAP server

Hotfix for Domino 6.5.3: There is a hotfix for Domino 6.5.3 related to the full text indexer 
that impacts LDAP searches. This hotfix is required if using this version of Domino. The 
number for this hotfix is SE19246 and the SPR is CSMH65WPRX. You can obtain the 
hotfix only through Lotus support or a Web submitted Problem Management Record 
(PMR).

Task Required or optional

Modifying the Domino Directory Only required for Domino 6.5.3 or earlier versions

Setting up the LDAP and Domino Internet 
Inter-ORB Protocol (DIIOP) tasks

Required for all Domino versions

Modifying the LDAP configuration Required for all Domino versions

Adding Workplace Services Express 
Administrative accounts to Domino

Optional; required only if read-only access is given 
to the iSeries Create Workplace Server wizard

Testing the Domino LDAP server configuration Required for all Domino versions

Domino Directory changes after upgrade to 
version 6.5.4 or higher

Required only after upgrading Domino from 6.5.3 
or earlier to Domino 6.5.4 or later

Important: At the time this redbook was written, Workplace Services Express supports 
only IBM Domino Enterprise Server V6.0.x or V6.5.x. However, because of the similarities 
between Domino Versions 6.5.4 and 7.0, we anticipate that Domino Version 7.0 will be 
supported in the future. Therefore, we indicate any differences between Domino V6.5.x 
and V7.x as applicable throughout this redbook. For a list of the supported Domino 
versions, see the Technical specification at a glance Web site at:

http://www.lotus.com/products/product5.nsf/wdocs/wsetechspecs
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3.4.1  Modifying the Domino Directory
To use a Domino server as the user repository for Workplace Services Express, you must 
have a unique identifier for each user. In Domino Version 6.5.3 and earlier, the LDAP schema 
does not have a unique identifier that can be used for Workplace Services Express. The 
modifications that we make in this section add a new field to the Person, Group, and 
Server/Certifier forms to fulfill the requirements for Workplace Services Express.

Modifications to the Domino Directory design should take place in the template 
(pubnames.ntf). However, since the changes that we are making are temporary and should 
be removed when you upgrade to Domino 6.5.4 and later, we make our changes directly into 
the names.nsf database. If you have questions when working with the Domino Designer®, 
you can find help in the Domino Designer Help and Domino Administrator Help databases.

Perform the following steps:

1. Using a Domino administrator account, start the Domino Designer client and open the 
Domino Directory database (names.nsf). 

a. Select File → Database → Open. 
b. Select your Domino server and the Domino Directory database (names.nsf).

2. Make a copy of the names.nsf for backup purposes. 

a. Select File → Database → New Copy. 

b. In the Copy Database window, specify the values to choose a destination server and 
new files name as shown in Figure 3-12.

c. Click OK.

Figure 3-12   Creating a backup copy of names.nsf

Important: Perform the following steps only if you are running Domino 6.5.3 or earlier. 
Also, if your Domino 6.5 LDAP service searches additional Domino directories, you must 
make these changes in each additional directory.
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3. As shown in Figure 3-13, open the Person form. In the left pane, select Forms, and then in 
the right pane, double-click the Person form.

Figure 3-13   Opening the Person form

4. If you see a warning message like the example in Figure 3-14, click OK to ignore it.

Figure 3-14   Domino Designer warning message

5. Add the DominoUNID field to the Person form:

a. Place your cursor at the bottom of the form. Click the Create menu and select Field as 
shown in Figure 3-15.

Figure 3-15   Creating a new field in the Person form
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b. In the Field properties window (Figure 3-16), specify the following values:

i. In the Name field, type DominoUNID.
ii. From the Type drop-down list on the left, select Text. 
iii. From the Type drop-down list on the right, select Computed when composed.

Figure 3-16   DominoUNID field properties

c. Click the Hide Paragraph When tab (the sixth tab from the left in the window) and 
select all of the Hide paragraph from options as shown in Figure 3-17.

Figure 3-17   Hide paragraph from properties of the DominoUNID field

d. Close the DominoUNID Field properties window.
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e. In the DominoUNID (Field) Value pane, in the lower right corner of the window 
(Figure 3-18), type the following field value formula:

@If(dominoUNID != ""; dominoUNID; @Text(@DocumentUniqueID))

Figure 3-18   Entering a value for the DominoUNID field

f. Select Edit → Copy to copy the field.

g. Save and close the Person form.
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6. Double-click the Group form and follow these steps:

a. Place the cursor at the bottom of the Group form. 

b. Select Edit → Paste to paste the DominoUNID field into the form. The DominoUNID 
field is now copied into the form as shown in Figure 3-20. 

c. Save and close the form.

Figure 3-19   Copying the DominoUNID into the Group form

7. Double-click the Server\Certifier form and complete the following steps.

a. In the Server\Certifier form, place the cursor at the bottom of the form. 

b. Select Edit → Paste to paste the DominoUNID field into the form. The DominoUNID 
field is now copied into the form. 

c. Save and close the form.

8. We must prevent the design task from removing our design changes. Right-click the 
Person form and select Design Properties.
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9. Click the Design tab (the third tab from the left in the window), and select Prohibit design 
refresh or replace to modify as shown in Figure 3-20. Close the Design Document 
window when finished.

Figure 3-20   Prohibiting design refresh or replace to modify

10.Right-click the Group form and select Design Properties.

11.Click the Design tab (the third tab from the left in the window) and select Prohibit design 
refresh or replace to modify.

12.Right-click the Server/Certifier form and select Design Properties.

13.Click the Design tab (the third tab from the left in the window) and select Prohibit design 
refresh or replace to modify.

By following these steps, you ensure that any new person, group, or certifier is created with a 
DominoUNID field. However, this does not modify any existing person, group, or certifier 
documents. In the next steps, we create an agent to modify existing documents.

1. From the Domino Designer client, expand Shared Code in the tree in the left pane and 
select Agents.

2. Click the New Agent button.

Note: The following steps show how to create a simple formula language agent to populate 
the DominoUNID field. However, this agent requires manual intervention to update the 
documents. If you are an experienced Domino administrator or designer, you might 
optionally use a provided Java agent (ExtIdUpdate.java) as shown in “Sample Java agent 
to populate DominoUNID field” on page 59 to update the documents.
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3. In the Agent properties window (Figure 3-21), set the Name field to PopulateDominoUNID 
and leave the rest of the fields as the default. Close the Agent window when you are 
finished.

Figure 3-21   PopulateDominoUNID agent properties

4. In the center frame, select Action to enter the code. From the right drop-down list in the 
PopulateDominoUNID(Agent): Action frame, select Formula, and type the following 
formula as shown in Figure 3-22:

FIELD dominoUNID := @If(dominoUNID != ""; dominoUNID; @Text(@DocumentUniqueID));

Figure 3-22   PopulateDominoUNID action formula

5. Save and close the agent.

6. Prevent the design task from modifying or removing the agent from the database. 

a. Right-click the PopulateDominoUNID agent and click Properties. 
b. In the Properties window, select Prohibit design refresh or replace to modify.
c. Close the Domino Designer client.
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7. Run the agent that you created. 

a. From the Lotus Notes client, open the names.nsf (Domino Directory) file.

b. In the Domino Directory, click the People view and select all the people as shown in 
Figure 3-23. 

c. From the menu, select Actions → PopulateDominoUNID.

Figure 3-23   Updating all existing person documents with the DominoUNID field

8. Verify that the agent worked successfully by viewing the document properties for a Person 
document. Right-click any Person document and select Document Properties.

9. In the Document window, select the Fields tab (second from the left). Verify that the 
DominoUNID field appears in the list with a value as shown in Figure 3-24. Do this for 
multiple documents to ensure that the change is made to all the Person documents.

Figure 3-24   Person document properties after running the PopulateDominoUNID agent

10.Use the same process to select all groups and certificates and run the agent against those 
documents as well. Note that you can find certificates under the Configuration folder.

Sample Java agent to populate DominoUNID field
Example 3-3 shows a sample Java agent (ExtIdUpdate.java) to populate the DominoUNID 
field. You can use this agent as an alternative to the agent demonstrated in the previous 
steps. Refer to Appendix C, “Additional material” on page 359, for information about obtaining 
this Java agent.

Example 3-3   Sample Java agent (ExtIdUpdate.java) to populate the DominoUNID field

/*
 * Created on November 15, 2004 This agent needs to be placed in the Domino
 * Directory. Running it will populate existing People, Group, and Cert
 * documents with a DominoUNID field. This field does not exist in the default
 * Domino 6.5.3 or earlier LDAP schema.
 *  
 */
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package workplace;
import lotus.domino.*;
public class ExtIdUpdate extends AgentBase {

public void NotesMain() {
try {

Session session = getSession();
AgentContext agentContext = session.getAgentContext();
Database dbContext = agentContext.getCurrentDatabase();

//-- Update the documents in the People, Groups, and Certificates views.
View vwPeople = dbContext.getView("People");
updateDocs(vwPeople);
vwPeople.recycle();

View vwGroups = dbContext.getView("Groups");
updateDocs(vwGroups);
vwGroups.recycle();

View vwCerts = dbContext.getView("Certificates");
updateDocs(vwCerts);
vwCerts.recycle();

} //- end try
catch (NotesException ne) {

System.out.println("NotesException: " + ne.id + " - " + ne.text);
ne.printStackTrace();

} //- end catch, NotesException.
catch (Exception e) {

System.out.println("Exception: " + e.getMessage());
e.printStackTrace();

} //- end catch, Exception.
} //- end mehod, NotesMain.

public void updateDocs(View vwUpdate) {
try {

//-- For the given view, loop through its docs and write the DominoUNID field.
Document docUpdate = vwUpdate.getFirstDocument();
Document docNextUpdate = null;
while (docUpdate != null) {

docNextUpdate = vwUpdate.getNextDocument(docUpdate);
docUpdate.replaceItemValue("DominoUNID", docUpdate.getUniversalID());
docUpdate.save(true, false);
docUpdate.recycle();
docUpdate = docNextUpdate;

} //- end while, docUpdate.
} //- end try
catch (NotesException ne) {

System.out.println("NotesException: " + ne.id + " - " + ne.text);
ne.printStackTrace();

} //- end catch, NotesException.
catch (Exception e) {

System.out.println("Exception: " + e.getMessage());
e.printStackTrace();

} //- end catch, Exception.
} //- end method, UpdateDocs

} //- end class,ExtIdUpdate 
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3.4.2  Modifying the LDAP configuration
You must also add or edit the Global Configuration document to include the necessary LDAP 
attribute types. To add the attribute types, perform the following steps:

1. Open the Domino Administrator client.

2. Click the Configuration tab.

3. In the left frame, click Server → Configurations.

4. Open the Global Configuration document, or create one if it does not already exist. The 
Global Configuration document has a server name of * - [All Servers]. To create a new 
Global Configuration document, click Add Configuration and select Use these settings 
as the default settings for all servers as shown in Figure 3-25.

Figure 3-25   Creating or modifying the Global Configuration document

5. Click the LDAP tab, and click Select Attribute Types.

Note: You do not see the LDAP tab until you select the Use these settings as the 
default settings for all servers option.
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6. In the LDAP Attribute Type Selection window (Figure 3-26), in the Object Classes field, 
type an asterisk (*) and click Display Attributes.

Figure 3-26   Attribute Type Selection for Anonymous LDAP Queries window

7. In the LDAP Type Selection window, select the following attributes and then click Add:

– DominoUNID
– HTTP-HostName
– MailFile
– MailServer
– NetAddresses
– Manager
– supportedExtension
– vendorName
– vendorVersion

8. In the LDAP Type Selection window, click OK to finish adding the attributes.

9. You return to the Configuration Settings document. Select Yes or No based on your 
business requirements for the Allow LDAP users write access field. For help on 
determining which value to select, refer to 3.2, “Read/write or read-only access to the 
directory server” on page 38. Select Yes for Automatically Full Text index Domino 
Directory field as shown in Figure 3-27.

Important: The HTTP-HostName, MailFile, MailServer, NetAddresses, and Manager 
fields are only required for Workplace Services Express integration with Domino. If you 
do not plan to use the Domino Web Access or People Finder portlets, add only the 
DominoUNID field. The supportedExtension, vendorName, and vendorVersion 
attributes should be listed by default. If they are not listed, you cannot use the iSeries 
Create IBM Workplace wizard to configure to the Workplace Services Express server.

Note: An LDAP search without a full text index is a linear search. Create a full text index 
to improve LDAP search performance.
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Figure 3-27   Additional LDAP settings

10.Save and close the document.

11.From the Domino server console, type the following command to reload the LDAP 
schema:

tell ldap reloadschema

3.4.3  Setting up the LDAP and DIIOP tasks
Both the LDAP and DIIOP tasks must be running under the Domino server for proper 
integration with Workplace Services Express. Perform the following steps to make sure these 
tasks are configured properly:

1. Open the Domino Directory (names.nsf). Navigate to Configuration → Servers → All 
Server Documents, and double-click the server document for your Domino server.

2. Navigate to the Ports → Internet Ports → Directory tab. Then verify that the LDAP port 
is enabled as shown in Figure 3-28.

Figure 3-28   Directory (LDAP) settings

Tip: Our testing has shown that reloading the schema is not always sufficient. To be 
safe, consider restarting the Domino server prior to configuring your Workplace 
Services Express server.
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3. Navigate to the Ports → Internet Ports → DIIOP tab and verify that the DIIOP port is 
enabled as shown in Figure 3-29.

Figure 3-29   DIIOP port settings

4. Click Save and Close to exit the Domino server document.

5. The LDAP and DIIOP tasks should start when the Domino server starts. If you know this is 
already happening, you can skip to 3.4.4, “Adding Workplace Services Express 
Administrative accounts to Domino” on page 65. Otherwise use the Change Domino 
Server (CHGDOMSVR) CL command to modify the server configuration as explained in the 
following steps:

a. End the Domino server by entering the following End Domino Server (ENDDOMSVR) CL 
command:

ENDDOMSVR DominoServerName

Here DominoServerName represents your Domino server name.

b. Change the Domino server configuration by entering the following Change Domino 
Server (CHGDOMSVR) CL command:

CHGDOMSVR DominoServerName

Here DominoServerName represents your Domino server name.

c. In the Change Domino Server (CHGDOMSVR) panel (Figure 3-30), modify the Web 
browsers and Directory services parameters to include *IIOP and *LDAP respectively 
and press Enter.
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Figure 3-30   Change Domino Server (CHGDOMSVR) command to add LDAP and DIIOP tasks

d. Start the Domino server by entering the following Start Domino Server (STRDOMSVR) CL 
command:

STRDOMSVR DominoServerName

Here DominoServerName represents your Domino server name.

3.4.4  Adding Workplace Services Express Administrative accounts to Domino
If you plan to give read/write access to Workplace Service Express, be aware that for users to 
sign-up or edit their profile, the LDAP administrative account given to the iSeries Create IBM 
Workplace wizard must have manager access to the Domino Directory (names.nsf). This user 
must also have Create documents and Delete documents authorities selected. And this user 
must have the following roles:

� GroupCreator
� GroupModifier
� UserCreator
� UserModifier

To view the authority for a user to your Domino Directory, perform the following steps:

1. Start the Lotus Notes client.

2. Open the Domino Directory (names.nsf) for your Domino server.

3. Select File → Database → Access Control to view the Access Control List.

                        Change Domino Server (CHGDOMSVR)                        
                                                                                
 Type choices, press Enter.                                                     
                                                                                
 Server name  . . . . . . . . . . > 'ITSODOM6'                                  
                                                                                
                                                                                
                                                                                
 Additional server ID:                                                          
   ID file's password . . . . . .   *NONE                                       
 Time zone  . . . . . . . . . . .   CST           *SAME, GMT,EST,CST,MST ...    
 Daylight savings time  . . . . .   *YES          *SAME, *YES, *NO              
 Web browsers . . . . . . . . . .   *HTTP         *SAME, *NONE, *ALL, *IIOP...  
                                    *IIOP                                       
 Internet mail packages . . . . .   *SMTP         *SAME,*NONE,*ALL,*IMAP ...    
                + for more values                                               
 Directory services . . . . . . .   *LDAP         Character value, *SAME...     
                                                                                
 Connection services  . . . . . .   *NONE         *SAME, *DECS, *NONE           
                                                                                
                                                                        More... 
 F3=Exit   F4=Prompt   F5=Refresh   F10=Additional parameters   F12=Cancel      
 F13=How to use this display        F24=More keys 

Note: If the LDAP task does not start after you make these changes, make sure that the 
line DisableLDAPOnAdmin=1 does not exist in the Domino server’s notes.ini file. If you 
see this entry, remove it. To view the notes.ini file, use the Work with Domino Servers 
(WRKDOMSVR) CL command and type option 13 (Edit Notes.ini) next to your Domino 
server.
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4. Select the entry for the user that you want to use as the LDAP Administrator in the iSeries 
Create IBM Workplace wizard. Figure 3-31 shows the authority that this user must have. 

Figure 3-31   Security required by the iSeries Create IBM Workplace wizard

5. Review the authority and then close the Access Control List window when you are 
finished. If the authority matches the example in Figure 3-31, and you are going to give 
write access to the iSeries Create IBM Workplace wizard, you can skip the following steps.

If you only give read access to the iSeries Create Workplace wizard, you must create a 
Workplace Services Express administrator group and account such as wpsadmin user and a 
wpsadmins group. Perform the following steps to create a Workplace Services Express 
administrator user and administration group:

1. Open the Domino Administrator client and click the People and Groups tab.

2. Select People and click Add Person. 
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3. On the Basics tab (Figure 3-32), specify the values from Table 3-3 in the fields, where 
wpsadmin represents your Workplace Services Express administrator.

Table 3-3   Values used to create the wpsadmin Person document

Figure 3-32   Creating the wpsadmin Person document

4. Click the Save and Close button to exit the Person document.

5. Select Groups and click Add Group. 

6. On the Basics tab (Figure 3-33), specify the values from Table 3-4, where wpsadmin 
represents your Workplace Services Express administrator and wpsadmins represents 
your administration group.

Parameter Value

Last Name wpsadmin

User Name wpsadmin/YourOrganization
wpsadmin

Shortname/UserID wpsadmin

Internet Address wpsadmin@yourdomain.com

Internet Password password of your choice
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Table 3-4   Values used to create the wpsadmins Group document

Figure 3-33   Creating the wpsadmins Group document

7. Click the Save and Close button to exit the Group document.

3.4.5  Testing the Domino LDAP server configuration
Running an ldapsearch command against the LDAP directory indicates whether you have 
configured your LDAP server correctly. If you prefer a graphical user interface, third-party 
products are available on the Internet for download.

In the following examples, we run an ldapsearch command from a Windows command 
prompt. In Example 3-4, we verify that the DominoUNID can be returned for a Domino user. 
In our example, we created a Domino user named LDAP Administrator. We use the following 
ldapsearch command, where itsodom6 is the host name of our Domino server:

ldapsearch -h itsodom6 -p 389 "cn=LDAP Administrator"

Example 3-4   Running ldapsearch to return the entry for the LDAP Administrator

C:\Documents and Settings\Administrator>ldapsearch -h itsodom6 -p 389 "cn=Ldap 
Administrator" 

CN=Ldap Administrator,O=itso6
objectclass=dominoPerson
objectclass=inetOrgPerson
objectclass=organizationalPerson
objectclass=person
objectclass=top
dominounid=789FFCB95562ACA18625709E005B98AA
givenname=Ldap
sn=Administrator
cn=Ldap Administrator
uid=LAdministrator

Parameter Value

Group Name wpsadmins

Group Type Multi-purpose

Members wpsadmin/YourOrganization
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If you do not see the DominoUNID attribute returned, your LDAP server is not ready for use 
with Workplace Services Express. Return to 3.4, “Preparing the Domino server for LDAP” on 
page 51, for help on configuring your Domino LDAP server.

If you do not allow write access to the Domino LDAP directory, make sure that the wpsadmin 
person and wpsadmins group are setup properly as shown in Example 3-5. In our example, 
we use the following ldapsearch command, where itsodom6 is the name of our Domino 
server:

ldapsearch -h itsodom6 -p 389 cn=wps* CN=wpsadmin,O=itso6

Example 3-5   Running ldapsearch to return the entries for wpsadmin and wpsadmins

C:\Documents and Settings\Administrator>ldapsearch -h itsodom6 -p 389 cn=wps*
CN=wpsadmin,O=itso6
mail=wpsadmin@itsowse1.rchland.ibm.com
objectclass=dominoPerson
objectclass=inetOrgPerson
objectclass=organizationalPerson
objectclass=person
objectclass=top
dominounid=CB41205ACE9994E0862570970050FFAB
sn=wpsadmin
cn=wpsadmin
uid=wpsadmin
CN=wpsadmins
cn=wpsadmins
mail=wpsadmins@rchland.ibm.com
objectclass=dominoGroup
objectclass=groupOfNames
objectclass=top
member=CN=wpsadmin,O=itso6
dominounid=414035F3AFEA72F786257097005214F0

3.4.6  Domino Directory changes after upgrading to Domino v6.5.4 or higher
The previous sections explain how to modify the Domino Directory to integrate with 
Workplace Services Express when running Domino Versions 6.5.3 or earlier. This section 
explains the necessary steps to take advantage of the new changes with the LDAP server 
that is part of Domino Versions 6.5.4 or later. Perform the following steps:

1. Open the Domino Directory (names.nsf) in the Domino Designer client.

2. In the left pane, click Forms and then right-click the Person form.

3. Select Design properties.

4. Deselect the Prohibit design refresh or replace to modify option.

5. Close the Design properties box.

6. Follow the same steps on the Group and Server\Certifier forms. For both forms, deselect 
the Prohibit design refresh or replace to modify option.

Important: You must only follow these steps if you modified the design of your Domino 
Directory when you were at Domino V6.5.3 or earlier and have now upgraded your server 
to Domino V6.5.4 or later.
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7. Select Shared Code → Agents and remove the PopulateDominoUNID agent if it exists 
in your database.

8. Select File → Database → Refresh Design to refresh the design of the Domino Directory 
with the latest template.

The changes are now complete, and your Domino Directory should be updated with the latest 
design for the version of Domino you are running. All previous modifications made in the 
server configuration document are still valid and do not require changing.
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Chapter 4. Installing and configuring 
Workplace Services Express

This chapter explains how you can download, install, and configure Workplace Services 
Express on the iSeries server. First, you learn how to obtain the Workplace Services Express 
code and prepare it for installation. Then you see how to install the Workplace Services 
Express code. Finally you follow the steps to configure a Workplace Services Express server 
using the iSeries Create IBM Workplace wizard.

4
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4.1  Obtaining and preparing Workplace Services Express code
Depending on your role as an IBM Client or Business Partner, you might acquire the 
Workplace Services Express software in different ways:

� On a single DVD or on a number of CD-ROMs
� Online through the IBM PartnerWorld gateway
� Online though the IBM Passport Advantage® Web site

Regardless of the method that you use to access the Workplace Services Express code, the 
installation process is the same. The steps to prepare files for installation vary slightly 
depending on the method that you use to obtain the software.

4.1.1  Downloading the installation files
If you are an IBM Business Partner, you can download Workplace Services Express through 
the IBM PartnerWorld gateway using the following steps:

1. Open a Web browser and point to the following Web address:

http://www.ibm.com/partnerworld/

2. Log on to the IBM PartnerWorld gateway using your IBM ID and password.

3. From the Software Downloads page (Figure 4-1), search for Workplace Services Express. 
Select the All search option. Then click Search.

Figure 4-1   Searching for Workplace Services Express
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4. From the list of results, select IBM Workplace Services Express V2.5 for iSeries 
Multilingual eAssembly (Figure 4-2).

Figure 4-2   Selecting IBM Workplace Services Express V2.5 for iSeries Multilingual eAssembly

5. From the next page, download all of the individual components. Save the downloaded files 
to a directory named /opt/download on the integrated file system of your iSeries server.

If the /opt/download directory does not exist on the integrated file system of your iSeries 
server, create it by performing the following steps:

a. Sign on to your iSeries server.

b. Enter the Start Qshell (STRQSH) CL command and press Enter. You can also use the 
Qshell (QSH) command, if you prefer.

c. Create the /opt/download directory by entering the following command:

mkdir -p /opt/download

If you prefer to download the files to your local PC workstation, copy them to the 
/opt/download directory on your iSeries after the downloads are complete.

4.1.2  Preparing the installation files
If you download the Workplace Services Express installation files, you must unpack, rename, 
and move these files to a particular directory structure in order to successfully install the 
Workplace Services Express code. You can do this using one of two methods:

� Using an automatic install preparation script
� Renaming the installation files manually

Using an automatic install preparation script
We created a script called prepareInstall.sh to facilitate the preparation of the downloaded 
files for installation. Refer to Appendix C, “Additional material” on page 359, for details about 
how to download this script file.

Perform the following the steps to use the install preparation script:

1. Download the install preparation script from the location specified in Appendix C, 
“Additional material” on page 359. Save it in the same directory on the integrated file 
system in which you downloaded the Workplace Services Express files, which is typically 
/opt/download.

Important: The install preparation script is for Workplace Services Express Version 2.5 
only. It does not work with later releases of Workplace Services Express.
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2. Sign on to your iSeries server.

3. Enter the Start Qshell (STRQSH) CL command and press Enter.

4. Change to the directory in which you downloaded the Workplace Services Express files by 
entering the following command:

cd /opt/download

5. Run the install preparation script by entering the following command (see Figure 4-3):

prepareInstall.sh

Figure 4-3   Launching the prepareInstall.sh script

6. The script runs and produces some output, listing the directories that it creates and the 
files that it extracts (Figure 4-4). Press the Page Up key to scroll back through the output 
and make sure that no errors occurred while preparing the Workplace Services Express 
Version 2.5 files.

Figure 4-4   Checking the output from the prepareInstall script for errors

Tip: Set your 5250 terminal size to 27 x 132 to ensure that the lines in the following 
displays are not truncated or wrapped.

                               QSH Command Entry                                
                                                                                
 > cd /opt/download                                                             
   $                                                                            
                                                                                

 ===> prepareInstall.sh                                                         

 F3=Exit   F6=Print F9=Retrieve F12=Disconnect                                  
 F13=Clear F17=Top  F18=Bottom  F21=CL command entry 

                               QSH Command Entry                                
                                                                                
   ./LWPArchives/WPS_Archive_I5OS.tar.gz                                        
   pax: 001-2298 For archive file ustar and volume 1, 4 files were processed wit
   .                                                                            
   ./WASPME                                                                     
   ./WASPME/pmeinstall.jar                                                      
   ./WASPME/media.inf                                                           
   ./WASPME/install400.bat                                                      
   ./WASPME/pmeinstall.exe                                                      
   ./WASPME/install.sh                                                          
   ./WASPME/installresponse.txt                                                 
   ./WASPME/autorun.inf                                                         
   pax: 001-2298 For archive file ustar and volume 1, 9 files were processed wit
   File extraction complete                                                     
   $                                                                            
                                                                                
 ===>                                                                           
                                                                                
F3=Exit   F6=Print F9=Retrieve F12=Disconnect                                  
F13=Clear F17=Top  F18=Bottom  F21=CL command entry 
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7. After the script has run, enter the following command to verify the files were copied 
correctly:

ls /opt/install

You should see a directory structure similar to the example in Figure 4-5.

Figure 4-5   Contents of the /opt/install directory after the prepareInstall script has run successfully

Renaming the installation files manually
You might decide to install the Workplace Services Express installation files from a directory 
other than /opt/install. Or you might have decided to place the downloaded install files in a 
directory other than /opt/download. In this case, you must manually unpack, rename, and 
copy the Workplace Services Express files from their download location to the install directory 
structure.

The downloaded files fall into a number of categories:

� WebSphere Application Server archive install files
� WebSphere Portal Server archive install files
� Workplace Services Express archive install files
� Workplace Services Express archive installer

You must copy the files that belong to the first three categories to a LWPArchives directory 
and appropriately rename them. For files that belong to the fourth category, you must extract 
them to the parent directory of the LWPArchives directory to allow the archive installer to run. 
If we use /opt/install/LWPArchives as the LWPArchives directory, then we must extract the files 
from the fourth category to /opt/install.

The following steps show how to unpack, rename, and copy the Workplace Services Express 
installation files using the Qshell environment:

1. Sign on to your iSeries server.

2. Enter the Start Qshell (STRQSH) CL command and press Enter.

3. Change to the directory which you downloaded the Workplace Services Express 
installation files to by entering the following command in Qshell:

cd /opt/download

If you downloaded the installation files to a directory other than /opt/download, substitute 
that directory path in this command.

4. Create an /opt/install directory by entering the following command:

mkdir /opt/install

If this command fails, check whether the /opt/install directory already exists. If it does, use 
a different directory to install from, for example /opt/wseinstall. 

                               QSH Command Entry                                
                                                                                
 > ls /opt/install                                                              
   LWPArchives     WASPME          WSEServer                                    
   $ 
                                                                                
 ===>                                                                           
                                                                                
F3=Exit   F6=Print F9=Retrieve F12=Disconnect                                  
F13=Clear F17=Top  F18=Bottom  F21=CL command entry                            
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5. Create the /opt/install/LWPArchives directory by entering the following command:

mkdir /opt/install/LWPArchives

6. Copy the downloaded archive install files to the LWPArchives directory and rename them 
for use by the archive installer. For each file listed in Table 4-1, run the following command:

cp original /opt/install/LWPArchives/destination

Replace original with the file to copy, and replace destination with the destination path and 
new file name. For example, for the first entry in the table, enter the following command:

cp C84B5ML.tar.gz /opt/install/LWPArchives/LWP_Archive_Common1.tar.gz

Table 4-1   Downloaded install files and their destination file names

7. Extract files that belong to the Workplace Services Express archive installer to the 
/opt/install directory:

a. Change directory to /opt/install by entering the following command:

cd /opt/install

b. Extract the archive installer. For each file in Table 4-2, run the following command:

pax -rv -C 819 -f /opt/download/filename.tar

For example, for C84B3ML.tar, enter:

pax -rv -C 819 -f /opt/download/C84B3ML.tar

Table 4-2   Downloaded Workplace Services Express Version 2.5 archive installer files

Preparing the installation files for Workplace Services Express Version 2.5.1
If you downloaded the Workplace Services Express installation files for version 2.5.1, the 
procedure for preparing the installation files is slightly different than it is for version 2.5 which 
is discussed in the previous section.

Note: In the instructions that follow, which reference /opt/install, replace /opt/install 
with the directory that you want to use for storing the Workplace Services Express 
installation files.

Original file name Destination file name

C84B5ML.tar.gz LWP_Archive_Common1.tar.gz

C84B6ML.tar.gz LWP_WAS_Archive_Common1.tar.gz

C84B7ML.tar.gz LWP_WAS_Archive_Common2.tar.gz

C84B8ML.tar.gz LWP_WPS_Archive_Common1.tar.gz

C84B9ML.tar.gz WAS_Archive_Common1.tar.gz

C84BAML.tar.gz WPS_Archive_Common1.tar.gz

C84BBML.tar.gz LWP_Upgrade_Archive_Common1.tar.gz

File name Description

C84B3ML.tar Server install and migration tools

C84BGML.tar Server archive install for iSeries

C84BHML.tar WebSphere Application Server Enterprise Enablement for iSeries
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Perform the following steps for Workplace Services Express, Version 2.5.1:

1. Sign on to your iSeries server.

2. Enter the Start Qshell (STRQSH) CL command and press Enter.

3. Change to the directory to which you downloaded the Workplace Services Express 
installation files by entering the following command in Qshell:

cd /opt/download

If you downloaded the installation files to a directory other than /opt/download, substitute 
that directory path in this command.

4. Create the /opt/install directory by entering the following command:

mkdir /opt/install

If this command fails, check whether the /opt/install directory already exists. If it does, use 
a different directory to install from, for example /opt/wseinstall. 

5. Create the /opt/install/LWPArchives directory by entering the following command:

mkdir /opt/install/LWPArchives

6. Extract the files that belong to the Workplace Services Express archive installer, to the 
/opt/install directory:

a. Change directory to /opt/install by entering the following command:

cd /opt/install

b. Extract the archive installer. For each file in Table 4-3, run the following command:

pax -rv -C 819 -f /opt/download/filename.tar

For example, for C87A0ML.tar, run the following command:

pax -rv -C 819 -f /opt/download/C87A0ML.tar

Table 4-3   Downloaded Workplace Services Express Version 2.5.1 archive installer files

Note: In Workplace Services Express Version 2.5.1, you no longer are required to rename 
the files like you had to in version 2.5. This is done automatically for you when you unpack 
or extract the installation files.

Note: In the instructions that follow, which reference /opt/install, replace /opt/install 
with the directory that you want to use for storing the Workplace Services Express 
installation files.

File name Description

C87A0ML.tar IBM Workplace Services Express 2.5.1 Server Install Multilingual

C87A1ML.tar IBM Workplace Services Express 2.5.1 Server Install Archive 1 of 3

C87A2ML.tar IBM Workplace Services Express 2.5.1 Server Install Archive 2 of 3

C87A3ML.tar IBM Workplace Services Express 2.5.1 Server Install Archive 3 of 3

C87AUML.tar IBM Workplace Services Express 2.5.1 Server Install Archive for iSeries

C87CQML.tar IBM Workplace Services Express 2.5.1 Server Install Upgrade Archive 
Multilingual

C88J1ML.tar IBM Workplace Services Express 2.5.1 WebSphere Application Server 
Enterprise Enablement for iSeries
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Two additional files are downloaded with Workplace Services Express Version 2.5.1 for i5/OS:

� C879ZIE.PDF: IBM Workplace Services Express V2.5.1 Read Me First for Windows, 
Linux and iSeries International English

� C88ECML.EXE: IBM Workplace Services Express V2.5.1 WebSphere Application Server 
for iSeries V5.0

4.1.3  Copying the installation files from physical media

If you received the Workplace Services Express install files on physical media (several 
CD-ROM discs or a single DVD), copy them to your iSeries integrated file system before you 
start the install process.

If you are copying the files from the optical drive of a local PC workstation, perform the 
following steps:

1. Insert the first CD or the DVD into the optical drive of the local PC workstation.
2. Map a network drive to the root share on your iSeries server.
3. Create a directory named /opt/install on the root share’s mapped network drive.
4. Copy the full contents of all the CD-ROMs or the full contents of the DVD to this newly 

created directory.

4.2  Installing the Workplace Services Express server code
There are several ways to install the Workplace Services Express server code. You can install 
it locally from your iSeries server or remotely from a PC workstation running Microsoft 
Windows. In this redbook, we document the local installation process. For information about 
installing Workplace Services Express remotely from a Microsoft Windows PC workstation, 
refer the IBM Workplace Services Express Version 2.5.x Information Center at:

http://publib.boulder.ibm.com/infocenter/wseic/v2r5/index.jsp

Navigate to Getting started → Installing on i5/OS → Installing the product on i5/OS.

To install Workplace Services Express from an i5/OS session, perform the following steps:

1. Sign on to your iSeries server.

2. Enter the Start Qshell (STRQSH) CL command and press Enter.

Note: It is possible to install Workplace Services Express remotely from a Microsoft 
Windows PC workstation using a graphical installer. This method takes considerably longer 
than the process described here. For more information, refer to the Workplace Services 
Express Information Center at:

http://publib.boulder.ibm.com/infocenter/wseic/v2r5/index.jsp

Note: If you don’t have a root share configured on your iSeries server, refer to the IBM 
Eserver iSeries Information Center Version 5 Release 3 (V5R3):

http://publib.boulder.ibm.com/infocenter/iseries/v5r3/index.jsp

Search for create a file share to access the relevant section.

Tip: Installing Workplace Services Express locally from your iSeries server is much faster 
than doing a remote graphical install from a PC workstation.
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3. Change to the directory to which you copied the install files by entering the following 
command:

cd /opt/install/WSEServer

If you copied the install files to a directory other than /opt/install, substitute that directory 
name for /opt/install in this command.

4. Start the installation process by running the install.sh script, as shown in Figure 4-6. 
There might be a brief pause while the installer loads. 

Figure 4-6   Launching the Workplace Services Express server installation

5. You should see the QSH Command Entry panel like the example in Figure 4-8. Depending 
on the height of your terminal, you might not be able to see all of the options presented. To 
view the missing options, press the Page Up key to scroll up. This shows a display similar 
to the example in Figure 4-7.

Figure 4-7   Language selection display (upper half; scroll down to view all options)

Important: If you downloaded the Workplace Services Express installation files from 
the Web, make sure that you have properly prepared the files for installation. Refer to 
4.1.2, “Preparing the installation files” on page 73, for details.

                               QSH Command Entry                                
                                                                                
 > cd /opt/install/WSEServer                                                    
   $                                                                            

 ===> install.sh                                                                

 F3=Exit   F6=Print F9=Retrieve F12=Disconnect                                  
 F13=Clear F17=Top  F18=Bottom  F21=CL command entry                            

                               QSH Command Entry                                
                                                                                
   IBM Workplace Services Express 2.5                                           
   (C) Copyright IBM Corp. 2001 - 2005  All Rights Reserved.                    
                                                                                
   Attaching Java program to /opt/install/WSEServer/dist/wseinstall.jar.        
                                                                                
   -----------------------------------------------------------------------------

Select a language to be used for this wizard.                                
                                                                                
   [ ] 1  - Czech                                                               
   [X] 2  - English                                                             
   [ ] 3  - French                                                              
   [ ] 4  - German                                                              
   [ ] 5  - Greek                                                               
                                                                                
 ===>                                                                           

 F3=Exit   F6=Print F9=Retrieve F12=Disconnect                                  
 F13=Clear F17=Top  F18=Bottom  F21=CL command entry                            
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Type a number that corresponds to the language to use in the wizard and press Enter. 
Note that the language selected for the wizard does not affect the range of languages 
available in the installed product. Then type 0 and press Enter to continue.

Figure 4-8   Language selection display (lower half; scroll up to view all options)

6. A welcome display (Figure 4-9) opens in the language that you selected. Type 1 and press 
Enter to continue with the wizard.

Figure 4-9   Workplace Services Express server installation welcome display

Tip: Depending on the size of your display terminal, some of the installation wizard 
displays might be too long to view all at once. If this is the case, use the Page Up key to 
scroll back to view the top of the display.

                               QSH Command Entry                                
                                                                                
   [ ] 6  - Hungarian                                                           
   [ ] 7  - Italian                                                             
   [ ] 8  - Japanese                                                            
   [ ] 9  - Korean                                                              
   [ ] 10 - Polish                                                              
   [ ] 11 - Portuguese                                                          
   [ ] 12 - Portuguese (Brazil)                                                 
   [ ] 13 - Russian                                                             
   [ ] 14 - Simplified Chinese                                                  
   [ ] 15 - Spanish                                                             
   [ ] 16 - Traditional Chinese                                                 
   [ ] 17 - Turkish                                                             
                                                                                
   To select an item enter its number, or 0 when you are finished: [0]          
                                                                                
 ===> 0 
                                                                                
F3=Exit   F6=Print F9=Retrieve F12=Disconnect                                  
F13=Clear F17=Top  F18=Bottom  F21=CL command entry                            

                               QSH Command Entry                                
                                                                                
-----------------------------------------------------------------------------
   --                                                                           
   Welcome to IBM Workplace Services Express                                    
                                                                                
   The installer will install IBM Workplace Services Express on your computer.  
   Click Next to continue.                                                      
                                                                                
   Copyright IBM Corp. 2003, 2005; All Rights Reserved. US Government Users     
   Restricted Rights - Use, duplication or disclosure restricted by GSA ADP     
   Schedule Contract with IBM Corp.                                             
                                                                                
   Press 1 for Next, 3 to Cancel or 4 to Redisplay [1]                          
                                                                                
 ===>   1 
                                                                                
F3=Exit   F6=Print F9=Retrieve F12=Disconnect                                  
F13=Clear F17=Top  F18=Bottom  F21=CL command entry                            
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7. The installer checks that your user profile has sufficient authority and that the required 
operating system level is met. If an error is displayed, refer to 2.2, “i5/OS software 
requirements” on page 11.

8. An introduction to the licensing agreement is displayed (Figure 4-10). Press Enter to view 
the full licensing agreement.

Figure 4-10   Software Licensing Agreement

9. Read the licensing agreement. Then type 1 and press Enter to continue.

10.Type 1 again and press Enter to proceed to the next step of the installation.

11.The wizard prompts you for an install location with a default value of 
/QIBM/ProdData/Workplace/WSE25 specified, as shown in Figure 4-11. On the iSeries 
server, this location cannot be changed. Type 1 and press Enter to continue.

Figure 4-11   Install location summary

                               QSH Command Entry                                
                                                                                
                                                                                
                                                                                
   Checking for required operating system and software prerequisites. Please wai
   t.                                                                           
                                                                                
   -----------------------------------------------------------------------------
   --                                                                           
   Software Licensing Agreement                                                 
   Press Enter to display the license agreement on your screen. Please          
   read the agreement carefully before installing the Program. After            
    reading the agreement, you will be given the opportunity to accept it       
    or decline it. If you choose to decline the agreement, installation         
    will not be completed and you will not be able to use the Program.          
                                                                                
                                                                                
 ===> 
                                                                                
F3=Exit   F6=Print F9=Retrieve F12=Disconnect                                  
F13=Clear F17=Top  F18=Bottom  F21=CL command entry                            

                               QSH Command Entry                                
> 1                                                                            

-----------------------------------------------------------------------------
IBM Workplace Services Express is ready to install.                          

   Summary:                                                                     

   Install location: /QIBM/ProdData/Workplace/WSE25                             

   Press 1 for Next, 2 for Previous, 3 to Cancel or 4 to Redisplay [1]          
                                                                                
 ===>   1 

F3=Exit   F6=Print F9=Retrieve F12=Disconnect                                  
F13=Clear F17=Top  F18=Bottom  F21=CL command entry                            
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12.The installation wizard installs the Workplace Services Express server files. While it 
installs the files, it displays a progress bar as shown in Figure 4-12.

Figure 4-12   Start of the installation process

13.After the server files are installed, the wizard prompts you to configure a Workplace 
Services Express server instance as shown in Figure 4-13. Type 1 and press Enter to 
continue.

Figure 4-13   Installation process completed successfully

Note: The progress bar might not accurately reflect the installation progress. The 
installation might be complete even though the progress bar still indicates less than 
40%. Check the display for messages to determine when the installation finished.

                               QSH Command Entry                                
                                                                                
   Summary:                                                                     

   Install location: /QIBM/ProdData/Workplace/WSE25                             

   Press 1 for Next, 2 for Previous, 3 to Cancel or 4 to Redisplay [1]          
 > 1                                                                            
                                                                                
   Installing IBM Workplace Services Express.  Please wait.                     
                                                                                
                                                                                
   |-----------|-----------|-----------|------------|                           
   0%         25%         50%         75%        100%                           
                                                                                
 ===>                                                                           

 F3=Exit   F6=Print F9=Retrieve F12=Disconnect                                  
 F13=Clear F17=Top  F18=Bottom  F21=CL command entry                            

                               QSH Command Entry                                

   Installing IBM Workplace Services Express.  Please wait.                     
                                                                                
                                                                                
   |-----------|-----------|-----------|------------|                           
   0%         25%         50%         75%        100%                           
   ||||||||||||||||                                                             
   -----------------------------------------------------------------------------
   --                                                                           
   IBM Workplace Services Express has been successfully installed on the system.
   Select Next to configure an instance or Cancel to exit.                      
                                                                                
                                                                                
   Press 1 for Next, 3 to Cancel or 4 to Redisplay [1]                          
                                                                                
 ===>    1 

 F3=Exit   F6=Print F9=Retrieve F12=Disconnect                                  
 F13=Clear F17=Top  F18=Bottom  F21=CL command entry                            
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14.There are two ways in which you can configure a Workplace Services Express server:

– Using the iSeries Create IBM Workplace wizard
– Manually, using the custom configuration option

The iSeries Create IBM Workplace wizard takes all user input and validates it before it 
starts the process of creating a new Workplace Services Express server. Unless you have 
a specific reason to configure an Workplace Services Express server manually, we 
recommend that you use the iSeries Create IBM Workplace wizard method. The steps 
involved in creating a new Workplace Services Express server using the iSeries Create 
IBM Workplace wizard are documented in 4.3.2, “Using the iSeries Create IBM Workplace 
wizard” on page 85.

To use the wizard to configure a Workplace Services Express server, type 0 and press 
Enter to continue as shown in Figure 4-14.

Figure 4-14   Workplace Services Express server configuration options

In this redbook, we do not document the use of the custom configuration (or manual 
configuration) option. If you want to configure a new Workplace Services Express server 
using custom configuration, refer to the IBM Workplace Services Express Version 2.5.x 
Information Center at:

http://publib.boulder.ibm.com/infocenter/wseic/v2r5/index.jsp

                                QSH Command Entry             
                                                                                       
   [X] 1 - IBM Workplace Services Express setup wizard for i5/OS (recommended):        
           The IBM Workplace Services Express wizard creates a production ready IBM    
           Workplace Services Express instance. This wizard will help you create an    
           IBM HTTP Server, create an IBM Workplace Services Express instance,         
           create and configure DB2 schemas needed by IBM Workplace Services           
           Express, and configure LDAP security.                                       
                                                                                       
   [ ] 2 - Custom configuration:                                                       
           The custom configuration option for IBM Workplace Services Express          
           provides a means of creating an IBM Workplace Services Express instance     
           that will use a Cloudscape database. After the instance is created, use     
           the database transfer tool to migrate the Cloudscape database to IBM DB2    
           for i5/OS. Additional configuration is required to set up an external       
           HTTP server and configure LDAP security for the instance. Refer to the      
           IBM Workplace Services Express Information Center for more information.     
                                                                                       
   To select an item enter its number, or 0 when you are finished: [0]                 
                                                                                       
 ===>  0 

 F3=Exit   F6=Print F9=Retrieve F12=Disconnect                                         
 F13=Clear F17=Top  F18=Bottom  F21=CL command entry 
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15.The install wizard shows some information about the iSeries Create Workplace wizard, 
including the URL from which the wizard can be accessed (see Figure 4-15). To exit the 
server install wizard, type 3 and press Enter. You return to the Qshell prompt.

Figure 4-15   Workplace Services Express setup wizard link

4.3  Configuring a Workplace Services Express server
There are two ways to configure a Workplace Services Express server on the iSeries server:

� Using the iSeries Create IBM Workplace wizard
� Manually, using the custom configuration option

The iSeries Create IBM Workplace wizard validates user input related to the configuration of 
a new Workplace Services Express server before it begins the configuration process.

Custom configuration allows slightly more control over some aspects of the configuration 
process. It is a manual process, error-prone, and is not recommended as a means of 
configuring Workplace Services Express servers. If you choose the custom configuration 
option, refer to the IBM Workplace Services Express Version 2.5.x Information Center at:

http://publib.boulder.ibm.com/infocenter/wseic/v2r5/index.jsp

4.3.1  Network preparation
You need a separate static TCP/IP address and fully qualified host name for each Workplace 
Services Express server that you want to configure on your iSeries server. Having this 
address and host name allows each Workplace Services Express server to use standard 
ports for HTTP and instant messaging communication.

Refer to 2.4, “i5/OS configuration and network requirements” on page 22, for information 
about how to configure a separate static TCP/IP address for each Workplace Services 
Express server.

Tip: Replace localhost with the fully qualified host name of your iSeries server in the 
URL to access the iSeries Create Workplace wizard.

                               QSH Command Entry                                

   Use the link below to launch the IBM Workplace Services Express setup wizard 
   http://localhost:2001/HTTPAdmin?entry=express.taskCreateWorkplace            
                                                                                
   Press 3 to Finish or 4 to Redisplay [3]                                      
                                                                                
 ===> 3                                                                          

 F3=Exit   F6=Print F9=Retrieve F12=Disconnect                                  
 F13=Clear F17=Top  F18=Bottom  F21=CL command entry                            

Important: The iSeries Create IBM Workplace wizard can only configure one Workplace 
Services Express server at a time. You must wait for the configuration of the previous 
server to complete before you start to configure a new Workplace Services Express server.
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4.3.2  Using the iSeries Create IBM Workplace wizard
A unique feature of Workplace Services Express on iSeries is the Create IBM Workplace 
wizard. This feature allows you to create and fully configure new Workplace Services Express 
servers through a graphical user interface. After you provide the initial configuration 
information, you do not need any further interaction with the wizard until the server is created. 
This is in sharp contrast to the manual process of configuring a new Workplace Services 
Express server using the custom configuration option.

Specifically, the wizard allows you to configure the following items:

� The product for which you want to create a server

Depending on which IBM Workplace products you have installed, this might include both 
Workplace Collaborative Services and Workplace Services Express.

� The name of the Workplace Services Express server that you want to create

� The optional components of Workplace Services Express that you want to configure

� The fully qualified host name to use for the Workplace Services Express server

� The port range to use of the Workplace Services Express server

� The HTTP server to use when processing Workplace Services Express requests

� The collections, libraries, or schema to use for the Workplace Services Express databases

� The Lightweight Directory Access Protocol (LDAP) server where information about users 
of Workplace Services Express is stored

� Single sign-on (SSO) configuration that you want to use with Workplace Services Express

To configure a Workplace Services Express server, perform the following steps:

1. Make sure that the iSeries HTTP administration server is running. This server provides the 
Web-based user interface to the iSeries Create IBM Workplace wizard. Start the iSeries 
HTTP administration server by using one of the following options:

– From iSeries Navigator, click Network → Servers → TCP/IP. Right-click the HTTP 
Administration in the right pane and click Start.

– From an i5/OS command line, enter the following Start TCP/IP Server (STRTCPSVR) 
CL command:

STRTCPSVR SERVER(*HTTP) HTTPSVR(*ADMIN)

2. Open a Web browser and navigate to the IBM Web Administration for iSeries page. In the 
URL, replace iSeriesHostName with the fully qualified host name of your iSeries server:

http://iSeriesHostName:2001

3. Log on to IBM Web Administration for iSeries. The user profile which you use to log on 
must have a minimum authority of *ALLOBJ, *IOSYCFG, and *JOBCTL to configure a 
Workplace Services Express server.

4. From the iSeries Tasks page, click IBM Web Administration for iSeries.
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5. In the IBM Web Administration for iSeries page, you can create, configure, and manage 
HTTP servers, application servers, and Workplace servers.

To start the process of creating a Workplace Services Express server, under the Setup 
tab, click Create IBM Workplace in the left panel or click Create a New IBM Workplace 
environment in the main pane. See Figure 4-16.

Figure 4-16   IBM Web Administration for iSeries Setup tab

Important: Do not resize your Web browser window while completing the iSeries 
Create IBM Workplace wizard. Doing so restarts the wizard.
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6. In the Create IBM Workplace information pane (Figure 4-17), which describes the 
technologies used by IBM Workplace, you do not need to interact directly with these while 
completing the wizard. However, it is useful to read through this page so that you are 
aware of the different layers involved in IBM Workplace. When you are ready, click Next to 
continue with the wizard.

Figure 4-17   Create IBM Workplace pane

7. The wizard prompts you to select which product you want to create a server of 
(Figure 4-18). Select IBM Workplace Services Express V2.5 and click Next.

Figure 4-18   Selecting the IBM Workplace product and version to configure
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8. A dependency checker runs at this point. If you are missing any of the required licensed 
products or PTFs listed in Chapter 2, “Hardware and software prerequisites” on page 9, an 
error message is displayed in the lower right pane, and you are not allowed to continue 
with the wizard. If this happens, refer to Chapter 2, “Hardware and software prerequisites” 
on page 9, and make sure that all prerequisites are installed.

9. In the next pane (Figure 4-19), you can enter a name and description for your Workplace 
Services Express server. You can use the default name provided or specify a more 
descriptive name. We recommend that you use the short form of the host name that you 
have assigned to this Workplace Services Express server. If you have not assigned a host 
name to this Workplace Services Express server, refer to 2.4.4, “Network requirements” 
on page 25, before continuing.

The name must be unique within all WebSphere Application Server installations on the 
system. If you specify a name that is already in use, the wizard shows an error message 
and does not allow you to continue until you specify a unique name. After you enter a 
unique name, click Next.

Figure 4-19   Specifying a name and description for the Workplace Services Express server

Tip: To find useful information about each pane in the iSeries Create Workplace wizard, 
click the question mark (?) icon.
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10.In the next pane (Figure 4-20), you can specify the collaboration components to enable. 
An option is available to configure the iSeries Access for Web portlet collection. This 
collection is a series of portlets that allow you to access information on your iSeries server 
through the Workplace Services Express interface. If you want to administer your iSeries 
server through a portlet interface, or run 5250 character-based applications in Workplace 
Services Express, select the iSeries Access for Web portlets option. Click Next.

Figure 4-20   Enabling iSeries Access for Web portlets
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11.In the next pane (Figure 4-21), specify the host name to use with this Workplace Services 
Express server. You should have allocated a unique host name and TCP/IP address to 
this Workplace Services Express server before you started the wizard. For details, see 
2.4.4, “Network requirements” on page 25.

The Host name drop-down list indicates all host names configured on your iSeries server. 
From the Host name drop-down list, select the host name that you allocated to this server. 
If the host name is not listed in the list, refer to 2.4.4, “Network requirements” on page 25, 
to make sure you configured the TCP/IP settings for this Workplace Services Express 
server correctly.

Figure 4-21   Specifying the host name for the Workplace Services Express server

Tip: If you modify the iSeries server host table after starting the wizard, the new entries 
will not be available in the wizard. To update the available options, restart the wizard.
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12.After you select the host name, the ports which are required for use by Workplace 
Services Express are displayed (see Figure 4-22). If any of these ports are already bound 
to another service on the host name that you selected, a warning message is displayed. If 
this happens, verify that any services running on these ports on your iSeries server are 
bound to a specific host name rather than all host names. Also ensure that no services are 
bound to the required ports on the host name that you selected.

To see which ports are currently in use on your iSeries server, use the Work with TCP/IP 
Network Status (NETSTAT) command:

a. On an i5/OS command line, type:

NETSTAT

b. In the panel that is displayed, type option 3 (Work with TCP/IP connection status) to 
view the ports in use and press Enter.

Verify that no errors are displayed in the lower pane and click Next.

Figure 4-22   Ports required by Workplace Services Express

Note: The NETSTAT command only displays ports that are bound at the time the 
command is issued. If servers are stopped, the ports that they use are not 
displayed.
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13.Workplace Services Express requires a block of 100 consecutive ports to be assigned to 
each server. These ports are used by the internal Workplace Services Express servers to 
provide various services. The ports in this block are bound across all IP addresses 
configured on your iSeries server. Therefore, they must be unique across all configured IP 
addresses, not only on the TCP/IP address assigned to your Workplace Services Express 
server.

The iSeries Create IBM Workplace wizard suggests a default value (Figure 4-23). Unless 
you have a specific reason to do otherwise, use this default. If you enter a value other than 
the default, the wizard checks that all ports in the range are free. If any are not, an error 
message is displayed and you will be unable to continue until you specify an available 
range. Click Next to continue.

Figure 4-23   Specifying the port range used by the Workplace Services Express server
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14.Workplace Services Express uses an HTTP server to receive user requests. The HTTP 
server forwards relevant requests to the application server for processing. By default, the 
name of the HTTP server is the same as the name of your new Workplace Services 
Express server (Figure 4-24). You can specify a different value, but it must be unique. You 
cannot use an existing HTTP server with Workplace Services Express.

You must also specify the TCP/IP address and port to which the HTTP server will be 
bound. Port 80 is used by default. You might specify an alternative port. If you do so, users 
must include the port number in the URL that they use to access the Workplace Services 
Express server.

After you enter the required information, click Next to continue.

Figure 4-24   Creating a new HTTP server

15.Workplace Services Express uses a number of databases to store information. To create 
the databases associated with a Workplace Services Express server, a user ID must be 
associated with the databases as the owner. This must be an i5/OS user profile. As 
explained in greater detail in this step, you can:

– Use an existing user ID.

If you decide to use an existing user ID, make sure the user profile has a minimum 
class of *USER and maximum allowed storage of *NOMAX. These values ensure that 
the size to which the databases can grow is not limited by restrictions on the database 
owner’s storage space.

You can modify an existing user profile from an i5/OS command line. 

i. Enter the Work with User Profiles (WRKUSRPRF) command; replace 
USERPROFILE in the following example with the user profile to work with:

WRKUSRPRF USERPROFILE

ii. From the Work with User Profiles display, type option 2 next to the user profile and 
press Enter. 

iii. In the Change User Profile (CHGUSRPRF) display, press F10 to display additional 
parameters. 

Scroll down using the Page Down key to edit the user’s maximum allowed storage 
property field.
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– Create a new user ID.

To create a new user profile to own the Workplace Services Express databases, the 
user profile with which you authenticated to IBM Web Administration for iSeries must 
have *SECADM authority. If it does not have this authority, the option is not displayed.

We recommend that you create a new user ID to own the databases associated with 
Workplace Services Express. Creating this user ID avoids situations where the 
database owner’s authorities or password is changed inadvertently. To easily associate 
a user profile with a Workplace Services Express server, it is best to use the Workplace 
Services Express server name as part of the user ID.

– Create the databases on a remote i5/OS server.

The databases can be named based on purpose, which makes them easily recognizable, 
or based on server name, which can be useful to allow you to identify all databases 
associated with a particular Workplace Services Express server. If you plan to configure 
multiple Workplace Services Express servers on the iSeries server, we recommend that 
you name the databases based on the Workplace Services Express server name.

A list of all databases created for this Workplace Services Express server is available on 
the summary page after the iSeries Create Workplace wizard gathers all required 
information.

Select the naming option that you want to use (Figure 4-25) and click Next to continue.

Figure 4-25   Creating a new user ID to own the Workplace Services Express databases
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16.The wizard can configure Workplace Services Express to use an LDAP server to manage 
user information. If you have not yet configured your LDAP server, refer to Chapter 3, 
“Preparing the directory server for Workplace Services Express” on page 35, before you 
continue. If you choose not to configure LDAP at this time, WebSphere Member Manger is 
used to manage user account information. To switch to LDAP at a later stage, you must 
use the manual configuration option to enable LDAP security. For details about this 
process, refer to the IBM Workplace Services Express Version 2.5.x Information Center at:

http://publib.boulder.ibm.com/infocenter/wseic/v2r5/index.jsp

To configure LDAP security (Figure 4-26):

a. Select Configure security using LDAP now. (Recommended).

b. In the LDAP server host name field, enter the fully qualified host name of your LDAP 
server.

c. Enter the port which your LDAP server is bound to in the LDAP port field. Unless you 
specified a nonstandard port when setting up your LDAP server, this should be the 
default value of 389.

d. Click Next to continue.

Figure 4-26   Configuring security using LDAP

17.Depending on the way in which you manage your LDAP directory, you might choose to 
give Workplace Services Express write access to the LDAP directory or restrict it to 
read-only access. Write access allows Workplace Services Express to create and update 
directory entries. It allows users to create new Workplace Services Express accounts for 
themselves and to update their account details. This is the best method to use if you do 
not plan on using the LDAP directory for other than for Workplace Services Express and if 
you are the administrator of the LDAP server.

Note: It is considerably easier to configure a Workplace Services Express server to 
work with your LDAP directory if you give the server write access to the LDAP directory.
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Read-only access is the best method to use if you:

– Manage the LDAP directory independently of Workplace Services Express
– Do not want to allow users to update their profiles or to create profiles for themselves
– Do not manage the LDAP server which you are using for Workplace Services Express 

user information.

If you want to give Workplace Services Express write access to your LDAP directory:

a. Select Allow write access to the LDAP directory (Figure 4-27).

b. In the LDAP user DN field, enter the distinguished name (DN) of an LDAP user who 
has write permissions on the containers that you will use to store user and group 
information.

c. In the LDAP user password field, enter the password for this LDAP user.

If you decide to provide read-only access:

a. Select Allow read-only access to the LDAP directory (Figure 4-27).

b. In the LDAP user DN field, enter the DN of an LDAP user who does not have write 
permissions on the LDAP directory.

c. In the LDAP user password field, enter the password for this LDAP user.

For further information about configuring your LDAP server, refer to Chapter 3, “Preparing 
the directory server for Workplace Services Express” on page 35.

Click Next.

Figure 4-27   LDAP configuration parameters

Note: It is possible to give your Workplace Services Express server write access to the 
LDAP directory and still prevent users from creating their own user profiles. See 3.2, 
“Read/write or read-only access to the directory server” on page 38, for details.

Tip: It is best practice to create a new LDAP user entry to be used only with this 
Workplace Services Express server. This user entry avoids any potential problems if 
the user’s permissions are modified, or if their password is changed at a later stage.
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18.Workplace Services Express requires containers in your LDAP directory to store user and 
group information. Specify the DN of the containers in your LDAP directory under which 
Workplace Services Express users and groups will be stored (Figure 4-28). If they already 
exist, click the Browse button to select them.

Figure 4-28   Specifying containers for user and group information

19.If you are using an existing LDAP directory in read-only mode, these containers should 
already exist. At a minimum, they should contain a user and group to be assigned the 
administrator role in Workplace Services Express.

If you are using an existing LDAP directory in read-write mode, you can use existing 
containers if the directory already contains information about the users for whom you want 
to provision Workplace Services Express. If you are using a new LDAP directory, or if your 
LDAP directory does not already contain entries for the Workplace Services Express 
users, specify the DN of new containers. The containers are created automatically by the 
wizard during the process of creating a new Workplace Services Express server provided 
that you have read-write access to the LDAP directory.

Depending on the directory server which you are using, the default values for these 
containers will vary:

– If you are using IBM Directory Server as an LDAP server for this Workplace Services 
Express server, the parent DN for user information is typically:

cn=users,DC=SERVER,DC=SUBDOMAIN,DC=DOMAIN,DC=TLD

The parent DN for group information is typically:

cn=groups,DC=SERVER,DC=SUBDOMAIN,DC=DOMAIN,DC=TLD

In both of these examples, replace SERVER, SUBDOMAIN, DOMAIN, and TLD with 
the appropriate sections of your iSeries server’s fully qualified domain name. The 
default values suggested by the iSeries Create IBM Workplace wizard should be 
appropriate in most cases.

– If you are using Domino as an LDAP server for this Workplace Services Express 
server, the parent DN for user information is typically:

o=organization

In this example, replace organization with the name of your Domino domain. 

The parent DN for group information is typically the root of the Domino LDAP tree, 
which can be represented as *ROOT in the Parent DN field. See Figure 4-29.
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See Chapter 3, “Preparing the directory server for Workplace Services Express” on 
page 35, for further details about setting up and populating your LDAP directory.

Click Next.

Figure 4-29   Specifying user and group containers when using Domino as an LDAP server

20.In the next pane (Figure 4-30), you enter details of the administrative user and group for 
your Workplace Services Express server, and click Next. Workplace Services Express 
requires an administrative user and administrative group entry in the LDAP directory. The 
administrative user has full access to Workplace Services Express and WebSphere 
Application Server configuration settings. It is best practice to have a dedicated entry in 
the LDAP directory for the administrative user and not to use this account for tasks other 
than administering the system.

The administrative user is automatically added to the administrative group. If you must 
give other users administrative access at a later stage, add them to the administrative 
group specified here. Refer to Chapter 3, “Preparing the directory server for Workplace 
Services Express” on page 35, for details about how to add users to your LDAP directory.

Figure 4-30   Specifying the administrative user and group
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21.SSO is a mechanism that allows a single user sign-on action to provide authentication to 
multiple servers without re-authenticating when connecting to other servers than the one 
to which the user originally authenticated. Workplace Services Express supports two 
forms of SSO:

– Lightweight Third Party Authentication (LTPA) for Web server access
– Enterprise Identity Mapping (EIM) for i5/OS application access

EIM is not configured at this point. It is documented in step 23.

LTPA provides SSO to multiple Web servers and Web application servers. It is useful when 
your Workplace Services Express server requires access to information from other 
servers, such as Domino, QuickPlace, Sametime, or WebSphere Application Servers. 

In the configuration page (Figure 4-31), you can configure LTPA SSO. The SSO domain 
name parameter specifies which servers can be accessed within the SSO environment. 

If your Workplace Services Express server does not require access to information from 
other Web servers, or if those servers run on the same host name as your Workplace 
Services Express server, select Limit SSO domain to this Web server’s host name. If 
your Workplace Services Express server requires access to information from Web servers 
running on other hosts, select Include other Web servers in your SSO environment. 

Then you can specify the domain name that you want to use for SSO. This should be as 
qualified as possible while including all servers which you want to give access to using 
SSO. Consider an example where you have three servers:

– Server 1: server1.subdomain.domain.com
– Server 2: server2.subdomain.domain.com
– Server 3: server3.subdomain2.domain.com

To use SSO with server 1 and Server 2, specify a domain name of 
subdomain.domain.com. This prevents server 3 from being included. To include server3, 
specify a domain of domain.com. This allows any server in domain.com and its 
subdomains to be configured for SSO.

To configure other servers for inclusion in your SSO domain, see Chapter 8, “Enabling 
SSO between Workplace Services Express and Domino” on page 237.

Enter the required information, and click Next.

Note: The domain parameter for LTPA SSO must be at least two elements long. The 
iSeries Create IBM Workplace wizard does not allow you to specify shorter domains.
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Figure 4-31   Web server SSO configuration

22.If you decide to include other Web servers in your SSO environment, you are prompted to 
enter a password to encrypt the LTPA keys (Figure 4-32). Enter a password in the LTPA 
password and Confirm password fields and click Next. 

See Chapter 8, “Enabling SSO between Workplace Services Express and Domino” on 
page 237, for more information about configuring SSO across multiple servers.

Figure 4-32   Specifying a password to encrypt the LTPA keys

23.Workplace Services Express can be configured to integrate with iSeries Access for Web 
through the iSeries Access portlets. These portlets allow you to administer your iSeries 
server through a portlet interface and to run full-screen, 5250 character applications in a 
portlet. Workplace Services Express provides several methods by which a Workplace 
Services Express user can authenticate to i5/OS while using the iSeries Access portlets.

One of these methods, EIM, maps Workplace Services Express user IDs to iSeries user 
profiles, allowing a user of the iSeries Access portlets to automatically authenticate to 
i5/OS without entering any additional credentials.

 

 

 

100 Deploying IBM Workplace Services Express on the IBM Eserver iSeries Server



 

If you do not want to use EIM with Workplace Services Express, select Do not Configure 
Identity Tokens (see Figure 4-33) and click Next.

Figure 4-33   Selecting whether to use Identity Tokens with Workplace Services Express

If you want to use EIM with Workplace Services Express, you must configure EIM before 
continuing. Refer to 7.1, “Configuring EIM for use with the iSeries Access portlets” on 
page 209, for information about configuring EIM. After EIM is configured, perform the 
following steps to use it with Workplace Services Express:

a. Select Configure Identity Tokens (Figure 4-34).

b. In the LDAP server host name field, enter the fully qualified host name of the LDAP 
server which is hosting your EIM domain.

c. In the LDAP port field, if the LDAP server hosting your EIM domain is running on a port 
other than 389, type that port number.

d. In the LDAP administrator DN field, enter the DN of the EIM administrator user.

e. In the LDAP administrator password field, enter the password of the EIM administrator 
user.

f. Click Next.

Figure 4-34   Selecting to use Identity Tokens with Workplace Services Express
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g. In the pane that opens (Figure 4-35), you are prompted for information about the EIM 
domain name and the source registry name where your Workplace Services Express 
user information is stored. From the EIM Domain Name drop-down list, select the EIM 
domain that you want to use with Workplace Services Express.

From the Source Registry Name drop-down list, select the name of the EIM registry 
where your Workplace Services Express user information is stored. Click Next.

Figure 4-35   Details of the EIM domain

24.A summary pane (Figure 4-36) is displayed and shows details of the Workplace Services 
Express server which you are configuring. To record a copy for future reference, click the 
Printable Summary button and save or print a copy of the full summary.

If you are satisfied that the settings displayed on the summary page accurately describe 
the Workplace Services Express server which you want to create, click Finish. The 
process of creating a new Workplace Services Express server begins.

Figure 4-36   Workplace Services Express server configuration summary

Tip: You can retrieve the information displayed on the summary page through the 
properties section of the IBM Web Administration for iSeries application after your 
Workplace Services Express server is configured.
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25.After the configuration process starts, a page is displayed that gives a visual indication of 
the progress of the configuration process (Figure 4-37). The process can take a long time 
and is measured in hours. During the configuration process, the Web browser can be 
closed. You can re-open the progress page to monitor the configuration at a later stage.

Figure 4-37   Workplace Services Express server configuration progress indicator

26.When the wizard completes, you can access your new Workplace Services Express 
server by opening a Web browser and navigating to the URL specified on the configuration 
summary page. The URL should be of the form:

http://server.domain/lwp/workplace

Here server.domain is the fully qualified host name that you assigned to this Workplace 
Services Express server.

Important: The configuration process to create a new Workplace Services Express 
server is extremely resource intensive. Make sure that you have sufficient available 
resources before you start the configuration process to avoid adversely affecting other 
business applications.
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Chapter 5. Administering Workplace 
Services Express

This chapter explains Workplace Services Express administration. In this chapter, you learn 
how to perform the following tasks:

� Start and stop the Workplace Services Express server
� Review the Workplace Services Express server configuration
� Verify whether the Workplace Services Express server is active
� Access the Workplace Services Express server via a Web browser
� Access the WebSphere Application Server Administrative Console
� Modify the password for administrative accounts
� Find and read log files
� Locate and apply fixes
� Customize the default Workplace Services Express server configuration
� Backup and recover the Workplace Services Express configuration, user data, or both
� Remove a Workplace Services Express server

5
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5.1  Starting and stopping a Workplace Services Express server
There are two ways you can start and stop a Workplace Services Express server. The first 
method is to use the IBM Web Administration for iSeries interface. The second method is to 
use Qshell scripts. The Qshell scripts start the Workplace Services Express portal server, 
although they do not start the HTTP server or the document rendering server. For this reason, 
we recommend that you use the IBM Web Administration for iSeries interface to start and 
stop the Workplace Services Express server.

For more information about the Qshell scripts and other advanced administration topics, visit 
the IBM Workplace Services Express Version 2.5.x Information Center at:

http://publib.boulder.ibm.com/infocenter/wseic/v2r5/index.jsp

5.1.1  Starting a Workplace Services Express server
Perform the following steps to start a Workplace Services Express server using IBM Web 
Administration for iSeries:

1. To access IBM Web Administration for iSeries, point your Web browser to your fully 
qualified iSeries host name on port 2001:

http://iSeriesHostName.domain:2001

In this example, we type:

http://rchas12.rchland.ibm.com:2001

2. When prompted, enter your i5/OS user profile and password to log on to the IBM Web 
Administration for iSeries. Click OK.

3. On the iSeries Tasks menu, click IBM Web Administration for iSeries. You return to the 
last server that you administered.

4. To manage your Workplace Services Express server, select your server by performing the 
following steps:

a. Click the Manage tab.
b. Click the Application Servers tab.
c. In the Server drop-down list, select your Workplace Services Express server name.

Note: The windows shown in this chapter were taken after i5/OS V5R3 PTF SI20496 was 
installed. If you do not have this PTF installed on your system, you might notice slight 
variations on some windows. Due to the performance improvement included with PTF 
SI20496, we recommend that you apply this PTF. For additional information, refer to 9.5.4, 
“X virtual frame buffer verses virtual network computing” on page 299.

Important: The Lightweight Directory Access Protocol (LDAP) server must be started 
before the Workplace Services Express server is started. If it is not started, the 
Workplace Services Express server will not start.
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5. In the upper left corner, click the green square with a white triangle, as shown in 
Figure 5-1, to start the Workplace Services Express server.

Figure 5-1   Starting a Workplace Services Express server

6. Select the Document Rendering server of your choice and click Start. If you have PTF 
SI20496 installed, you see these options:

– XVFB
– VNC

If the PTF is not installed, you can only select the virtual network computing (VNC) server 
as the document rendering service. In that case, make sure that the VNC server is 
selected and click Start. See Figure 5-2.

Note: We suggest that you select all options to be sure that your Workplace Services 
Express server functions properly. However, be aware that the Server1 server is only 
used to access the WebSphere Application Server Administrative Console and thus is 
not required to be started in most cases. For further information, refer to 9.5.1, “Startup 
performance tuning” on page 277.

Tip: The XVFB option was created to eliminate a known performance issue with the 
VNC server. We recommend that you start your server with the XVFB option.
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Figure 5-2   Confirming a start request of a Workplace Services Express server

7. Watch the status in the upper left corner change. You see the text automatically change 
from Starting to Running when completed as shown in Figure 5-3.

Figure 5-3   Example of running status after clicking Start

5.1.2  Stopping a Workplace Services Express server
Perform the following steps to stop a Workplace Services Express server using IBM Web 
Administration for iSeries:

1. To access IBM Web Administration for iSeries, point your Web browser to your fully 
qualified iSeries host name on port 2001:

http://iSeriesHostName.domain:2001

In our example, we use:

http://rchas12.rchland.ibm.com:2001

2. When prompted, enter your i5/OS user profile and password to log on to the IBM Web 
Administration for iSeries. Click OK.

3. On the iSeries Tasks menu, click IBM Web Administration for iSeries. You return to the 
last server that you administered.

Tip: Starting your server takes several minutes. To reduce the amount of time needed 
to start the server, refer to 9.5.1, “Startup performance tuning” on page 277.
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4. To manage your Workplace Services Express server, select your server by performing the 
following steps:

a. Click the Manage tab.
b. Click the Application Servers tab.
c. In the Server drop-down list, select your Workplace Services Express server name.

5. Click the red square with the small white square inside of it, as shown in Figure 5-4, to 
stop the Workplace Services Express server.

Figure 5-4   Stopping a Workplace Services Express server

6. In the next pane (Figure 5-5), review the selections and click Stop to stop the server. 

Figure 5-5   Confirming the stop request of a Workplace Services Express server

Tip: Stopping the Workplace Services Express server using IBM Web Administration 
for iSeries ends all servers for you at one time. Be sure that all items are selected so all 
jobs and servers are ended for you.
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7. Watch the status in the upper left corner change. You see the text automatically change to 
Stopped when completed as shown in Figure 5-6.

Figure 5-6   A stopped Workplace Services Express server

5.2  Reviewing the Workplace Services Express configuration
As you administer the Workplace Services Express server, you might encounter times when it 
can be helpful to review the options taken during the iSeries Create IBM Workplace wizard. 
One common reason to review this information is to determine the database schema names 
being used by your Workplace Services Express server. For example, it is important to know 
the database names before you begin disaster recovery planning for your server. To find the 
configuration summary, you can display the printable summary page generated by the iSeries 
Create IBM Workplace wizard.

There are two ways to access the printable summary:

� You can locate the file in the integrated file system on the iSeries server. The file name 
and path of the printable summary file is /QIBM/UserData/WebAS5/Base/
WSEServerName/logs/IBMWizPrintableSummary.html. Here WSEServerName 
represents your Workplace Services Express server name.

� You can also use IBM Web Administration for iSeries to view the printable summary.

Perform the following steps to locate the printable summary using IBM Web Administration for 
iSeries:

1. To access IBM Web Administration for iSeries, point your Web browser to your fully 
qualified iSeries host name on port 2001:

http://iSeriesHostName.domain:2001

In this example, we enter:

http://rchas12.rchland.ibm.com:2001

2. When prompted, enter your i5/OS user profile and password to log on to the IBM Web 
Administration for iSeries. Click OK.

3. On the iSeries Tasks menu, click IBM Web Administration for iSeries. You return to the 
last server that you administered.

4. To manage your Workplace Services Express server, select your server by performing the 
following steps:

a. Click the Manage tab.
b. Click the Application Servers tab.
c. Select your Workplace Services Express server name in the Server drop-down list.
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5. As shown in Figure 5-7, in the left pane, click View Create Summary.

Figure 5-7   Selecting the creation summary from IBM Web Administration for iSeries

6. Using either method mentioned earlier in this section, a printable summary page opens in 
your browser (Figure 5-8). You might want to review the following items in the summary:

– The database user profile name
– The portal database (also known as the portal schema)
– The name of the IBM HTTP for iSeries server
– DB2 Universal Database database file names
– Document rendering server host name and display number

Figure 5-8   iSeries Create IBM Workplace wizard printable summary
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5.3  Verifying a Workplace Services Express server is active
After you start the Workplace Services Express server, you can verify that all of the jobs are 
active and running normally. To be sure the Workplace Services Express server is fully 
functional, you must verify that multiple servers are running. These servers include the LDAP 
server, the external HTTP server, the document rendering server, and the Workplace 
Services Express Server.

The LDAP server should be running before you start the Workplace Services Express server; 
we do not cover that here. Refer to your LDAP server’s documentation for information about 
starting the LDAP server and the steps to verify that the LDAP server is running.

In Chapter 4, “Installing and configuring Workplace Services Express” on page 71, we show 
how to configure the IBM HTTP Server for iSeries within the iSeries Create IBM Workplace 
wizard. In the wizard, the HTTP server name defaults to the same name as the Workplace 
Services Express server name. 

After the IBM HTTP Server being used by your Workplace Services Express server starts, 
you see five jobs running under the QHTTPSVR subsystem with your Workplace Services 
Express server name. To determine the name of the IBM HTTP Server for iSeries instance 
being used, refer to 5.2, “Reviewing the Workplace Services Express configuration” on 
page 110. For information about starting and stopping an IBM HTTP Server for iSeries 
instance, see 5.4, “Managing an IBM HTTP Server for iSeries server” on page 123.

The document rendering server is started in the background when you start the Workplace 
Services Express server via IBM Web Administration for iSeries. To verify that the document 
rendering server is active, you must know the display number for your document rendering 
server. You can find this in the printable summary document created by the iSeries Create 
IBM Workplace wizard. For information about locating the display number of the document 
rendering server, refer to 5.2, “Reviewing the Workplace Services Express configuration” on 
page 110.

Perform the following steps to verify that the document rendering server is active:

1. Log onto the iSeries server with a 5250 session.

2. Enter the following CL command to access the Portable Application Solutions 
Environment (PASE):

call qp2term
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3. Enter the following PASE command to verify that the job is active:

ps gauxw | grep :DisplayNumber

Here DisplayNumber represents the display number of your document rendering server. 
See Figure 5-9.

Figure 5-9   Verifying that a document rendering server is active

A Workplace Services Express server runs in the QEJBAS5 subsystem. In this subsystem, 
you should see three active jobs for each Workplace Services Express server running. These 
jobs are QJVAEXEC, SERVER1, and WEBSPHERE_PORTAL (WEBSPHERE_).

� The QJVAEXEC job is started by the WEBSPHERE_PORTAL job and is required for 
instant messaging functionality.

� The SERVER1 job is used during the initial configuration process to configure the 
Workplace Services Express server. It is also used to administer the server via the 
WebSphere Application Server Administrative Console.

� The WEBSPHERE_PORTAL job is responsible for responding to all Workplace Services 
Express user requests.

There are multiple ways to determine which jobs comprise the Workplace Service Express 
server. The following sections explain three different methods to determine which jobs belong 
to your Workplace Services Express server.

� Method 1 uses iSeries Navigator to view job logs and open integrated file system files. It 
uses the job log and open integrated file system files to determine which jobs belong to 
your Workplace Services Express server. For information about this method, refer to 5.3.1, 
“Using iSeries Navigator to view active jobs (method 1)” on page 114.

� Method 2 uses iSeries Navigator to view job logs and the time a job entered the system. It 
uses the job log and the time stamp to determine which jobs belong to your Workplace 
Services Express server. For information about this method, refer to 5.3.2, “Using iSeries 
Navigator to view active jobs (method 2)” on page 117.

� Method 3 uses i5/OS CL commands to view job logs and job numbers. It uses the job log 
and job number to determine which jobs belong to the Workplace Services Express 
server. For information about this method, refer to 5.3.3, “Using i5/OS commands to view 
active jobs (method 3)” on page 120.

$
> ps gauxw | grep :1                                                                                                               
qejbsvr 1787 0.0 0.0 3024 0 - A 13:26:23  0:17 /QOpenSys/QIBM/ProdData/DeveloperTools/icewm/bin/icewm
qejbsvr 1772 0.0 0.0 4976 0 - A 13:26:20  0:06 /QOpenSys/QIBM/ProdData/DeveloperTools/vnc/Xvnc :1 
-desktop X -httpd
 / 
dalandon 5658 0.0  0.0 7028  0 - A 12:08:17  0:00 /QOpenSys/usr/bin/-sh -i                                            
   $                                                                                                                                

===> 
F3=Exit     F6=Print   F9=Retrieve   F11=Truncate/Wrap                                                                             
F13=Clear   F17=Top    F18=Bottom    F21=CL command entry                                                                          
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5.3.1  Using iSeries Navigator to view active jobs (method 1)
Perform the following steps to find the jobs that make up the Workplace Services Express 
server using iSeries Navigator:

1. From iSeries Navigator, in the left pane, click My Connections → iSeries system 
name → Work Management → Subsystems → Active Subsystems → Qejbas5 as 
shown in Figure 5-10. Here you see a Qjvaexec, Server1, and Wepsphere_Portal 
(WebSphere_) job for each running Workplace Services Express server.

Figure 5-10   Viewing active jobs in the Qejbas5 subsystem with Series Navigator

2. If you are running multiple Workplace Services Express servers, you must know which 
jobs are associated with each Workplace Services Express server. Right-click a 
WebSphere_ job and click Job Log. The job log contains the Workplace Services 
Express server name as shown in Figure 5-11.

Note: You might not see an even number of Server1, WebSphere_, and Qjvaexec jobs 
if you are running other WebSphere Application Servers in the QEJBAS5 subsystem.
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Figure 5-11   Viewing the WebSphere_ job log with iSeries Navigator

3. To find the correct Server1 job, you can also review the job log as you did with the 
WebSphere_Portal (WebSphere_) job.

4. Unfortunately, you cannot use this method to find the Qjvaexec job because the job log for 
the Qjvaexec job does not contain the Workplace Services Express server name. To 
determine which Qjvaexec job belongs to your Workplace Services Express server, you 
can view the open integrated file system objects for the job. You should see files for your 
Workplace Services Express server in the Qjvaexec job’s file system objects list. 
Right-click Qjvaexec and then click Details → Open Files → File System Objects as 
shown in Figure 5-12.

Figure 5-12   Opening file system objects for the Qjvaexec job with iSeries Navigator
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5. In the Qjavexec File System Objects window, review the list of open files. The list is long 
and you must scroll down to find the group of files containing the Workplace Services 
Express server name. You should now be able to determine whether this is the correct job 
for your Workplace Services Express server as shown in Figure 5-13.

Figure 5-13   Viewing the open file system objects for the Qjvaexec job with iSeries Navigator

6. To view the IBM HTTP Server jobs, in the left pane of iSeries Navigator, click My 
Connections → iSeries system name → Work Management → Subsystems → Active 
Subsystems → Qhttpsvr. You see five jobs with the name of your IBM HTTP Server as 
shown in Figure 5-14. These jobs compose the IBM HTTP Server for iSeries.

Figure 5-14   Viewing the active jobs in the Qhttpsvr subsystem with iSeries Navigator
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5.3.2  Using iSeries Navigator to view active jobs (method 2)
Perform the following steps to find the jobs that make up the Workplace Services Express 
server using iSeries Navigator:

1. From iSeries Navigator, in the left pane, click My Connections → iSeries system 
name → Work Management → Subsystems → Active Subsystems → Qejbas5 as 
shown in Figure 5-15. Here you see a Qjvaexec, Server1, and WebSphere_Portal 
(WebSphere_) job for each running Workplace Services Express server.

Figure 5-15   Viewing active jobs in the Qejbas5 subsystem with iSeries Navigator

Note: You might not see an even number of Server1, WebSphere_, and Qjvaexec jobs 
if you are running other WebSphere Application Servers in the QEJBAS5 subsystem.

 

 

 

Chapter 5. Administering Workplace Services Express 117



 

2. If you are running multiple Workplace Services Express servers, you must know which 
jobs are associated with each Workplace Services Express server. Right-click a 
WebSphere_ job and click Job Log. The job log contains the Workplace Services 
Express server name as shown in Figure 5-16.

Figure 5-16   Viewing the WebSphere_ Job Log with iSeries Navigator

3. To find the correct Server1 job, you can also review the job log as you did with the 
WebSphere_Portal (WebSphere_) job.

4. Unfortunately, you cannot use this method to find the Qjvaexec job because the job log for 
the Qjvaexec job does not contain the Workplace Services Express server name. To 
determine which Qjvaexec job belongs to your Workplace Services Express server, you 
can find the Qjvaexec job that was started at approximately the same time as the Server1 
and WebSphere_ jobs. To do this, add a column to the default active jobs view so you can 
see the date and time each job entered the system. Perform the following steps to add a 
column:

a. From iSeries Navigator, select View → Customize this view → Columns or press 
F12 as shown in Figure 5-17.

Figure 5-17   Customizing the iSeries Navigator view
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b. In the Active Jobs - Columns window (Figure 5-18), make the following changes:

i. Under Columns available to display, select Entered System.
ii. Under Columns to be displayed, select Thread Count.
iii. Click Add After.
iv. Click OK to finish adding the column.

Figure 5-18   Active Jobs - Columns window

5. In iSeries Navigator, scroll to the right and click the Entered System heading to sort the 
jobs by the time they entered the system. You might have to resize some of the columns in 
order for all columns to fit in the window. After you do this, you can see the Workplace 
Services Express server jobs grouped together as shown in Figure 5-19.

Figure 5-19   Qejbas5 subsystem jobs sorted by the time they entered the system
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6. To view the IBM HTTP Server jobs, in the left pane of iSeries Navigator, click My 
Connections → iSeries system name → Work Management → Subsystems → Active 
Subsystems → Qhttpsvr. You see five jobs with the name of your IBM HTTP Server as 
shown in Figure 5-20. These jobs compose the IBM HTTP Server for iSeries.

Figure 5-20   Viewing the active jobs in the Qhttpsvr subsystem with Series Navigator

5.3.3  Using i5/OS commands to view active jobs (method 3)
Perform the following steps to find the jobs that make up the Workplace Services Express 
server using i5/OS CL commands:

1. To view all active jobs on the iSeries server, from an i5/OS command line, enter the Work 
with Active Jobs (WRKACTJOB) command. All active jobs are visible here and are organized 
by subsystem. You can find the QJAVEXEC, WEBSPHERE_, and SERVER1 jobs under 
the QEJBAS5 subsystem. The IBM HTTP Server jobs run in the QHTTPSVR subsystem. 
See Figure 5-21.
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Figure 5-21   Using WRKACTJOB to find active Workplace Services Express jobs

2. If you are running multiple Workplace Services Express servers, you must know which 
jobs are associated with each Workplace Services Express server. Enter option 5 (Work 
with) next to the WEBSPHERE_ job and press Enter.

3. On the Work with Job display, enter option 10 (Display job log, if active or on job queue) to 
view the job log. The first line in the job log contains the Workplace Services Express 
server name as shown in Figure 5-22. In our example, the name of the Workplace 
Services Express server is itsowse3.

Figure 5-22   Viewing the job log for the WebSphere_Portal (WEBSPHERE_) job

4. Press F3 (Exit) to exit the job log. You should now see the Work with Active Jobs display.

5. To find the correct Server1 job, you can also review the job log as you did with the 
WebSphere_Portal (WEBSPHERE_) job.

                             Work with Active Jobs                     RCHAS12  
                                                             10/19/05  09:18:08 
 CPU %:      .0     Elapsed time:   00:00:00     Active jobs:   330             
                                                                                
 Type options, press Enter.                                                     
   2=Change   3=Hold   4=End   5=Work with   6=Release   7=Display message      
   8=Work with spooled files   13=Disconnect ...                                
                                                                                
 Opt  Subsystem/Job  User        Type  CPU %  Function        Status            
        SERVER1      QEJBSVR     BCH      .0  PGM-QEJBSTRSVR   JVAW             
        SERVER1      QEJBSVR     BCH      .0  PGM-QEJBSTRSVR   JVAW             
        WEBSPHERE_   QEJBSVR     BCH      .0  *  -COMMIT       JVAW             
        WEBSPHERE_   QEJBSVR     BCH      .0  *  -COMMIT       JVAW             
        WEBSPHERE_   QEJBSVR     BCH      .0  *  -COMMIT       JVAW             
        WEBSPHERE_   QEJBSVR     BCH      .0  *  -COMMIT       JVAW             
        WEBSPHERE_   QEJBSVR     BCH      .0  *  -COMMIT       JVAW             
      QHTTPSVR       QSYS        SBS      .0                   DEQW             
        ADMIN        QTMHHTTP    BCH      .0  PGM-QZHBMAIN     SIGW             
                                                                        More... 
 Parameters or command                                                          
 ===>                                                                           
 F3=Exit   F5=Refresh       F7=Find      F10=Restart statistics                 
 F11=Display elapsed data   F12=Cancel   F23=More options   F24=More keys 

                               Display Job Log                                  
                                                             System:   RCHAS12  
 Job . . :   WEBSPHERE_    User . . :   QEJBSVR       Number . . . :   225876   
                                                                                
  >> CALL PGM(QEJBAS5/QEJBSTRSVR) PARM('-instance' '/QIBM/UserData/WebAS5/Base/ 
     itsowse3' '-server' 'WebSphere_Portal') 

                                                                         Bottom 
 Press Enter to continue.                                                       
                                                                                
 F3=Exit   F5=Refresh   F10=Display detailed messages   F12=Cancel              
 F16=Job menu           F24=More keys 
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6. Unfortunately you cannot use this method to find the QJVAEXEC job because the job log 
for the QJVAEXEC job does not contain the Workplace Services Express server name. To 
determine which QJVAEXEC job belongs to your Workplace Services Express server, you 
can find the QJVAEXEC job that was started at the same time as the SERVER1 and 
WEBSPHERE_ jobs.

Review the job log of the SERVER1 job of your Workplace Services Express server and 
make a note of the job number. Within i5/OS, jobs are started with a unique and sequential 
job number.

7. To find the jobs that were started at approximately the same time as the WEBSPHERE_ 
and SERVER1 jobs of your Workplace Services Express server, you can sort the jobs on 
the WRKACTJOB display by job number. To view the job numbers in the Work with Active 
Jobs display, press F11 twice. Figure 5-23 shows how your display should look now. 

Figure 5-23   Work with Active Jobs display showing job numbers

                             Work with Active Jobs                     RCHAS12  
                                                             10/19/05  09:46:48 
 CPU %:     5.3     Elapsed time:   00:28:39     Active jobs:   333             
                                                                                
 Type options, press Enter.                                                     
   2=Change   3=Hold   4=End   5=Work with   6=Release   7=Display message      
   8=Work with spooled files   13=Disconnect ...                                
                                                                                
 Opt  Subsystem/Job  User        Number  Type  CPU %  Threads                   
        SERVER1      QEJBSVR     231202  BCH      .0       33                   
        SERVER1      QEJBSVR     234830  BCH      .0       34                   
        WEBSPHERE_   QEJBSVR     225876  BCH      .5      268                   
        WEBSPHERE_   QEJBSVR     228776  BCH      .2      123                   
        WEBSPHERE_   QEJBSVR     229196  BCH      .5      153                   
        WEBSPHERE_   QEJBSVR     231279  BCH      .5      154                   
        WEBSPHERE_   QEJBSVR     234795  BCH     1.0      149                   
      QHTTPSVR       QSYS        199725  SBS      .0        1                   
        ADMIN        QTMHHTTP    232284  BCH      .0        1                   
                                                                        More... 
 Parameters or command                                                          
 ===>                                                                           
 F3=Exit   F5=Refresh   F7=Find   F10=Restart statistics   F11=Display status   
 F12=Cancel   F17=Top   F18=Bottom   F23=More options      F24=More keys 
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8. To sort all of the jobs by job number, place your cursor on the Number column and press 
F16. You should now find a QJVAEXEC job that started at approximately at the same time 
as the SERVER1 or WEBSPHERE_ job as shown in Figure 5-24.

Figure 5-24   Viewing all active jobs sorted by job number in the Work with Active Jobs display

5.4  Managing an IBM HTTP Server for iSeries server
You can use IBM Web Administration for iSeries to access the IBM HTTP Server for iSeries 
configuration. You might have to update the configuration for performance reasons, and you 
must understand where to manage the server configuration. To manage your IBM HTTP 
Server for iSeries, perform the following steps:

1. To access IBM Web Administration for iSeries, point your Web browser to your fully 
qualified iSeries host name on port 2001:

http://iSeriesHostName.domain:2001

In our example, we enter:

http://rchas12.rchland.ibm.com:2001

2. When prompted, enter your i5/OS user profile and password to log on to the IBM Web 
Administration for iSeries. Click OK.

3. On the iSeries Tasks menu, click IBM Web Administration for iSeries. You return to the 
last server that you administered.

4. To manage your HTTP server, select your server by performing the following steps:

a. Click the Manage tab.

b. Click the HTTP Servers tab.

c. In the Server field, select your HTTP server name. If you do not know the name of your 
IBM HTTP Server for iSeries server name, refer to 5.2, “Reviewing the Workplace 
Services Express configuration” on page 110.

                             Work with Active Jobs                     RCHAS12  
                                                             10/19/05  09:53:13 
 CPU %:     7.3     Elapsed time:   00:35:04     Active jobs:   333             
                                                                                
 Type options, press Enter.                                                     
   2=Change   3=Hold   4=End   5=Work with   6=Release   7=Display message      
   8=Work with spooled files   13=Disconnect ...                                
                                                                                
 Opt  Subsystem/Job  User        Number  Type  CPU %  Threads                   
        QJVAEXEC     QEJBSVR     226818  BCI      .0       42                   
        QSQSRVR      QUSER       226802  PJ       .0        1                   
        QSQSRVR      QUSER       226791  PJ       .0        1                   
        QSQSRVR      QUSER       226790  PJ       .0        1                   
        QSQSRVR      QUSER       226787  PJ       .0        1                   
        QSQSRVR      QUSER       226775  PJ       .0        1                   
        SERVER1      QEJBSVR     226233  BCH      .0      161                   
        QJVAEXEC     QEJBSVR     226037  BCI      .0       42                   
        QSQSRVR      QUSER       226035  PJ       .0        1                   
                                                                        More... 
 Parameters or command                                                          
 ===>                                                                           
 F3=Exit   F5=Refresh   F7=Find   F10=Restart statistics   F11=Display status   
 F12=Cancel   F17=Top   F18=Bottom   F23=More options      F24=More keys 
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d. You can now manage your IBM HTTP Server for iSeries server by selecting any of the 
options in the left pane. You can also determine if the server is running or stopped by 
reviewing the status in the upper left corner of the pane as shown in Figure 5-25.

Figure 5-25   Managing the IBM HTTP Server for iSeries server

5.5  Accessing a Workplace Services Express server
The only client available for use with a Workplace Services Express server is a Web browser. 
For information regarding supported Web browsers, refer to 2.7, “Client requirements” on 
page 31. The URL that you should use to access the Workplace Services Express server is 
provided for your reference in IBM Web Administration for iSeries. Perform the following 
steps:

1. To access IBM Web Administration for iSeries, point your Web browser to your fully 
qualified iSeries host name on port 2001:

http://iSeriesHostName.domain:2001

In our example, we use:

http://rchas12.rchland.ibm.com:2001

2. When prompted, enter your i5/OS user profile and password to log on to the IBM Web 
Administration for iSeries. Click OK.

3. On the iSeries Tasks menu, click IBM Web Administration for iSeries. You return to the 
last server that you administered.
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4. If you must select your Workplace Services Express server, in IBM Web Administration for 
iSeries, follow these steps:

a. Click the Manage tab.
b. Click the Application Servers tab.
c. In the Server drop-down list, select your Workplace Services Express server name.

5. In the middle of the right pane, you see a box that gives you the URL to access the 
Workplace Services Express server as shown in Figure 5-26. Click the URL link or type 
the URL manually into a Web browser. In the following example, you substitute your own 
details for the items in italics:

http://host.domain:port/lwp/workplace

Figure 5-26   Managing the Workplace Services Express server in the IBM Web Administration for iSeries tool
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6. The window that opens first when you access the Workplace Services Express server is 
blank, except for the banner at the top of the page. In the upper right corner of the pane, 
you have the option to Log In or Sign up. See Figure 5-27.

Figure 5-27   Logging into Workplace Services Express

7. In the next pane, click Log in to log in to the Workplace Services Express server. Any user 
in the LDAP directory with a proper user ID and password can now log into the server. You 
can optionally log in as the Workplace Services Express administrator to administer the 
Workplace Services Express server as shown in Figure 5-28.

Figure 5-28   Logging into Workplace Services Express as the administrator, wpsadmin

Note: The Sign up link is displayed only if you allowed write access to the LDAP 
directory. If you do not want your users to Sign up, refer to 5.10, “Removing the Sign up 
and Edit my profile links” on page 156.
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After you log into Workplace Services Express, you see a window similar to the example in 
Figure 5-29.

Figure 5-29   Initial default window after logging into Workplace Services Express

5.6  Accessing the WebSphere Application Server 
Administrative Console

The administrative console for the WebSphere Application Server is where you make 
modifications to the Workplace Services Express configuration. You can make changes in 
regard to:

� User policies
� Security (such as configuring single sign-on (SSO))
� Performance

If you know the URL to access the WebSphere Application Server Administrative Console, 
you can enter it into your Web browser manually. Alternatively, you can use a link that is 
provided for you in IBM Web Administration for iSeries. To access the WebSphere Application 
Server Administrative Console from IBM Web Administration for iSeries, perform the following 
steps:
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1. To access IBM Web Administration for iSeries, point your Web browser to your fully 
qualified iSeries host name on port 2001:

http://iSeriesHostName.domain:2001

In our example, we enter:

http://rchas12.rchland.ibm.com:2001

2. When prompted, enter your i5/OS user profile and password to log on to the IBM Web 
Administration for iSeries. Click OK.

3. On the iSeries Tasks menu, click IBM Web Administration for iSeries. You return to the 
last server that you administered.

4. To manage your Workplace Services Express server, select your server by performing the 
following steps:

a. Click the Manage tab.
b. Click the Application Servers tab.
c. In the Server drop-down list, select your Workplace Services Express server name.

5. In the left pane, click Launch Administrative Console to launch the WebSphere 
Application Server Administrative Console. See Figure 5-30.

Figure 5-30   Launching the WebSphere Application Server Administrative Console for Workplace Services Express

Note: Be aware that selecting Launch Administrative Console from either one of the 
Workplace Services Express servers, Server1 or WebSphere_Portal, brings you to the 
same place.
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6. A new Web browser window opens with a logon page for the WebSphere Application 
Server Administrative Console (Figure 5-31). You must log into the console using the 
administrator user ID and password that you chose as part of the configuration process of 
the Workplace Services Express server. For our example, this is wpsadmin.

Figure 5-31   Login page for the WebSphere Application Server Administrative Console

At this point in this redbook, we do not explain how to modify the server configuration. 
However, the remainder of this redbook assumes that you know how to access the 
WebSphere Application Server Administrative Console as demonstrated in this section.

For more information about administering Workplace Services Express, refer to the IBM 
Workplace Services Express Version 2.5.x Information Center at:

http://publib.boulder.ibm.com/infocenter/wseic/v2r5/index.jsp

5.7  Changing administrator account passwords
You must make necessary Workplace Services Express server configuration modifications to 
change the password for the following users:

� Database administrator (DB2 Universal Database database owner user profile)
� Workplace Services Express administrator
� LDAP administrator password
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5.7.1  Changing the database administrator password
Use the following steps to change the database administrator password.

1. End the HTTP server being used by your Workplace Services Express server to prevent 
user interaction with Workplace Services Express while you perform the password 
changes.

2. Change the password for the database owner’s user profile. You can use the Change User 
Profile (CHGUSRPRF) CL command to update the password, for example:

CHGUSRPRF USRPRF(WSEDBUSER) PASSWORD(new1pass) STATUS(*ENABLED)

Here WSEDBUSER represents the name of the database user ID, and new1pass 
represents the new password for the database user.

3. Open the WebSphere Application Server Administrative Console and log in as the 
Workplace Services Express administrator. For help on how to access the administrative 
console, refer to 5.6, “Accessing the WebSphere Application Server Administrative 
Console” on page 127.

4. From the WebSphere Application Server Administrative Console, in the left pane, click 
Security → JAAS Configuration → J2C Authentication Data. See Figure 5-32.

Figure 5-32   J2C Authentication Data Entries

Tip: If your company’s security policy requires that you change all passwords periodically, 
but you do not know which user profile is being used by your Workplace Services Express 
server, refer to 5.2, “Reviewing the Workplace Services Express configuration” on 
page 110.

Important: We recommend that you perform this procedure after normal business hours.
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5. In the J2C Authentication Data Entries pane, click each of the aliases in the following list, 
highlight the old password, and then enter the new password. Click Apply and then click 
OK to update the entry. 

– WSEServerName/LWPComm
– fbkDBAuth
– wmmDBAuth
– wpsDBAuth

Figure 5-33 shows an example of modifying the WSEServerName/LWPComm entry, 
where WSEServerName represents your Workplace Services Express server name.

Figure 5-33   Modifying the password in the WSEServerName/LWPComm data entry

6. Click Save to apply the changes to the master configuration.
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7. When you see the Save to Master Configuration box (Figure 5-34), click the Save button 
to complete the save.

Figure 5-34   Saving changes to the master configuration

8. In the left pane, click Resources → JDBC™ Providers. In the JDBC Providers pane, 
scroll down and you see details like the example in Figure 5-35. At the bottom of the JDBC 
Providers pane, click wpcp50JDBC.

Figure 5-35   JDBC Providers pane

9. In the wpcp50JDBC pane, scroll to the bottom of the pane and click Data Sources 
(Version 4). 
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10.You now see the Data Sources (Version 4) pane (Figure 5-36). Click each of the following 
names, highlight the old password, and enter the new password. Click Apply and then 
click OK to update the password. 

– feedbackDS
– perDS
– wcmDS

Figure 5-36   wpcp50JDBC Data Sources (Version 4) page

Figure 5-37 shows changes that are made to the feedbackDS entry.

Figure 5-37   Modifying the password for the feedbackDS data source

11.Click Save to apply changes to the master configuration.
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12.When you see the Save to Master configuration box, click the Save button to complete the 
save.

13.Log out of the WebSphere Application Server Administrative Console.

14.Modify the WCM.properties file to include the new password:

a. Map a drive to the root directory of the iSeries server integrated file system.

b. Open the WCM.properties file in WordPad or the text editor of your choice. The file is 
located in the directory /QIBM/UserData/WebAS5/Base/WSEServerName/wpcp
/config/WebSphere_Portal/author, where WSEServerName represents your 
Workplace Services Express server name.

c. Modify the wcm.database.password entry to contain the new password as shown in 
Figure 5-38.

d. Save and close the WCM.properties file.

Figure 5-38   Modifying the password in the WCM.properites file

15.Stop your Workplace Services Express server. For assistance with stopping your server, 
see 5.1.2, “Stopping a Workplace Services Express server” on page 108.

16.Start your Workplace Services Express server. For assistance with starting your server, 
refer to 5.1.1, “Starting a Workplace Services Express server” on page 106.

17.Test your Workplace Services Express environment to verify that the changes were 
successfully applied.
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5.7.2  Changing the Workplace Services Express administrator password
To modify the Workplace Services Express administrator password, follow these steps.

1. End the HTTP server being used by your Workplace Services Express server to prevent 
user interaction with Workplace Services Express while you perform the password 
changes.

2. Open the WebSphere Application Server Administrative Console and log in as the 
Workplace Services Express administrator. For help on how to access the WebSphere 
Application Server Administrative Console, refer to 5.6, “Accessing the WebSphere 
Application Server Administrative Console” on page 127.

3. Modify the password for the Workplace Services Express administrator in the LDAP 
directory. For assistance with changing the password, refer to you LDAP server’s product 
documentation.

4. From the left pane of the WebSphere Application Server Administrative Console, click 
Security → User Registries → LDAP. 

5. In the LDAP User Registry pane (Figure 5-39), scroll down and click Advanced LDAP 
Settings.

Figure 5-39   Accessing the Advanced LDAP Settings via the WebSphere Application Server Administrative Console

Important: We recommend that you perform this procedure after normal business hours.

Note: Keep this Web browser session open and active until you are told to exit the 
WebSphere Application Server Administrative Console.
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6. In the Advanced LDAP Settings pane (Figure 5-40), note all the values. We recommend 
that you print a copy of this page for your reference. We also recommend that you copy 
and paste the values from the User Filter and Group Filter fields into a text document to 
simplify the process of restoring the values in a future step.

Figure 5-40   Advanced LDAP Settings in the WebSphere Application Server Administrative Console

7. Scroll to the bottom of the Advanced LDAP Settings pane and click Cancel.

8. From the left pane of the WebSphere Application Server Administrative Console, click 
Security → User Registries → LDAP. Refer to Figure 5-39 on page 135.

9. Under the General Properties section, change the password in the following fields 
(Figure 5-41):

– Server User Password
– Bind Password

Click OK to save the new values.

Figure 5-41   Changing the Server User Password and Bind Password in the LDAP User Registry page

10.From the left pane of the WebSphere Application Server Administrative Console, click 
Security → User Registries → LDAP. Refer to Figure 5-39 on page 135.

11.Scroll down and click Advanced LDAP Settings. You see a page similar to the one shown 
in Figure 5-40.

 

 

 

136 Deploying IBM Workplace Services Express on the IBM Eserver iSeries Server



 

12.Restore the values of the fields from the recorded values noted in step 6 and click OK.

13.Click Save to apply changes to the master configuration.

14.When you see the Save to Master configuration box, click the Save button to complete the 
save.

15.From the left pane of the WebSphere Application Server Administrative Console, click 
Security → User Registries → Custom.

16.In the Custom User Registry pane, change the Server User Password (Figure 5-42).

Figure 5-42   Changing the Server User Password field in the Custom User Registry settings

17.Click Save to apply changes to the master configuration.

18.When you see the Save to Master configuration box, click the Save button to complete the 
save.

19.From the left pane of the WebSphere Application Server Administrative Console, click 
Applications → Enterprise Applications.
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20.For each of the following Enterprise Applications, complete the steps that follow:

– LWP_CAI
– LWP_Discussion_Service
– LWP_Security
– LWP_Team_Task_List
– LWP_Template_Infrastructure

a. Select one of the applications from the previous list (Figure 5-43).

Figure 5-43   Selecting an Enterprise Application

b. Scroll down to the Additional Properties section and click Map security roles to 
users/groups (Figure 5-44).

Figure 5-44   Selecting Map security roles to users/groups
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c. Select the wpsRunAsAdmin role and click Lookup groups (Figure 5-45).

Figure 5-45   Lookup groups for the wpsRunAsAdmin role

d. In the Search String field, type your Workplace Services Express administrator group 
and click Search. For our example, we search for a group called wpsadmins.

e. Select your administrator group and click >> to select the group as shown in 
Figure 5-46. Click OK.

Figure 5-46   Selecting the wpsadmins group

f. In the Mapping Users to Roles pane, click OK.

g. Scroll down to Additional Properties. Click Map RunAs roles to users. See 
Figure 5-44.
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h. In the Mapping RunAs Roles to Users pane (Figure 5-47), complete these steps:

i. Select the wpsRunAsAdmin role. 
ii. In the username field, enter your Workplace Services Express administrator ID. 
iii. In the password field, enter the new administrator password. 
iv. Click Apply.
v. Click OK.

Figure 5-47   Modifying the wpsadmin password for an enterprise application

i. Click OK.

j. Return to step a to modify all of the enterprise applications listed. Do not save your 
changes at this time.

21.After you change all of the enterprise applications, click Save to apply changes to the 
master configuration.

22.When you see the Save to Master configuration box, click the Save button to complete the 
save.

23.Click Logout to exit the WebSphere Application Server Administrative Console.

24.End the Workplace Services Express server. For assistance, refer to 5.1.2, “Stopping a 
Workplace Services Express server” on page 108.

25.Map a network drive to the root directory of your iSeries server.

26.Navigate to the integrated file system directory, \QIBM\UserData\WebAS5\Base\
WSEServerName\config\cells\WSEServerName_WSEServerName, where 
WSEServerName represents your Workplace Services Express server name.

27.Open the security.xml file with WordPad or the editor of your choice.
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28.Find the security:CustomUserRegistry section and copy the value of “serverPassword” as 
shown in Figure 5-48. This is the encrypted form of the new password for your Workplace 
Services Express administrator.

Figure 5-48   Copying the serverPassword from the security.xml file

29.Exit the security.xml file without saving any changes.

30.Using your mapped drive to the iSeries server, navigate to the directory, 
\QIBM\UserData\WebAS5\Base\WSEServerName\properties\, where WSEServerName 
represents your Workplace Services Express server name.

31.Open the soap.client.props file in WordPad or the editor of your choice.

32.Modify the following entries as demonstrated in Figure 5-49:

– com.ibm.SOAP.loginUserid=wpsadmin

Here wpsadmin represents your Workplace Services Express administrator.

– com.ibm.SOAP.loginPassword=newpassword

Here newpassword represents the encrypted form of the new Workplace Services 
Express administrator password that you copied from the security.xml file.

Figure 5-49   Modifying the soap.client.props file
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33.Save and close the soap.client.props file.

34.Start your Workplace Services Express server. For help, refer to 5.1.1, “Starting a 
Workplace Services Express server” on page 106.

35.Log into Workplace Services Express as the administrator with the new password.

36.At the top of the Workplace Services Express pane, click Administration.

37.In the Administration pane, click the Access tab.

38.In the left pane, click Credential Vault (Figure 5-50).

Figure 5-50   Accessing the credential vault for the Workplace Services Express server

39.In the Credential Vault pane, click Manage system vault slots (Figure 5-51).

Figure 5-51   Selecting Manage system vault slots

40.Select Modify Shared Slot for the deployment.user Vault Slot Name as shown in 
Figure 5-52.

Figure 5-52   Selecting Modify Shared Slot for the deployment.user Vault Slot Name
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41.In the Shared password and Confirm password fields, enter the new password for the 
administrator (Figure 5-53). Click OK.

Figure 5-53   Modifying the password for the shared user ID

42.Back in the Credential Vault pane, click Done.

43.Log out of the Workplace Services Express server.

44.Stop your Workplace Services Express server. For help, refer to 5.1.2, “Stopping a 
Workplace Services Express server” on page 108.

45.Start your Workplace Services Express server. For help, refer to 5.1.1, “Starting a 
Workplace Services Express server” on page 106.

5.7.3  Changing the LDAP administrator password
To modify the LDAP administrator password:

1. Stop your Workplace Services Express server. For help, refer to 5.1.2, “Stopping a 
Workplace Services Express server” on page 108.

2. Change the LDAP administrator password in the LDAP directory.

3. Log on to your iSeries server with a 5250 emulation session.

4. Enter the following Add Link (ADDLNK) CL command to create a symbolic link needed to 
run the wmm_encrypt.sh script in a future step:

ADDLNK OBJ('/qibm/proddata/webas5/pme/bin/setupCmdLine')
NEWLNK('/qibm/proddata/webas5/pme/bin/setupCmdLine.sh')

5. Start the Qshell environment using the STRQSH CL command.

6. Enter the following Qshell command:

cd /QIBM/ProdData/WebAS5/PME/wmm/bin
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7. Enter the following Qshell command as demonstrated in Example 5-1.

wmm_encrypt.sh Newpassword

Here Newpassword represents the new password for your LDAP administrator.

Example 5-1   Running the wmm_encrypt.sh script

cd /QIBM/ProdData/WebAS5/PME/wmm/bin 
$                                                                               
 wmm_encrypt.sh Newpassword 
 IBM* 
 Licensed Materials - Property of IBM 
 5697-A16 
 (C) Copyrights by IBM and by other(s) 1978, 2003.  All Rights Reserved. 
 * Trademark of International Business Machines Corp. 
 ASCII encrypted string : 8XL0qpqSJeTwNYcRSpVpKg== 
 HEX encrypted string : 38584C30717071534A6554774E596352537056704B673D3D0A       
 $                                                                               

8. Copy the ASCII encrypted string returned from the wmm_encrypt.sh script.

9. From a mapped drive to the iSeries root directory, open the wmm.xml file located in the 
integrated file system directory, \QIBM\UserData\WebAS5\Base\ITSOWSE4\PortalServer
\shared\app\wmm\wmm.xml, with WordPad or the editor of your choice.

10.Paste the password into the adminPassword field (Figure 5-54).

Figure 5-54   Modifying the wmm.xml file

11.Save and close the wmm.xml file.

12.Start your Workplace Services Express server. For help, refer to 5.1.1, “Starting a 
Workplace Services Express server” on page 106.

5.8  Accessing the Workplace Services Express logs
If you have never administered a WebSphere Portal server in the past, troubleshooting 
Workplace Services Express might seem overwhelming. In this section, we explain where 
data is logged. The log files that you want to review most often include:

� iSeries Create IBM Workplace wizard log files as discussed in 5.8.1, “iSeries Create IBM 
Workplace wizard log files” on page 145

� WebSphere Portal Server standard output and standard error log files as discussed in 
5.8.2, “WebSphere Portal Server standard output and standard error logs” on page 147

� WebSphere Application Server standard output and standard error log files as discussed 
in 5.8.3, “WebSphere Application Server standard output and standard error logs” on 
page 149

Tip: Scroll to the right to find the adminPassword field.
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The standard output and standard error log files are:

SystemOut.log Log where you find general output from the Workplace application or 
other portlets running on your Workplace Services Express server

SystemErr.log Log where you find errors from the Workplace application or other 
portlets running on your Workplace Services Express server

native_stdout.log Log where you find information regarding the internal startup and 
shutdown of the WebSphere Portal server

native_stderr.log Log where you find errors regarding the internal startup and shutdown 
of the WebSphere Portal server; this file is typically blank

5.8.1  iSeries Create IBM Workplace wizard log files
The iSeries Create IBM Workplace wizard provides logs to confirm the completion of each 
step it performs for you. If there is a problem during the configuration of a Workplace Services 
Express server, you can review the iSeries Create IBM Workplace wizard log files to find the 
problem. Finding the iSeries Create IBM Workplace wizard log files is easy from the IBM Web 
Administration for iSeries, as explained in the following steps. 

1. To access the IBM Web Administration for iSeries, point your Web browser to your fully 
qualified iSeries host name on port 2001:

http://iSeriesHostName.domain:2001

In our example, we enter:

http://rchas12.rchland.ibm.com:2001

2. When prompted, enter your i5/OS user profile and password to log on to the IBM Web 
Administration for iSeries. Click OK.

3. From the iSeries Tasks menu, click IBM Web Administration for iSeries. You return to 
the last server that you administered.

4. To manage your Workplace Services Express server, select your server by performing the 
following steps:

a. Click the Manage tab.
b. Click the Application Servers tab.
c. In the Server drop-down list, select your Workplace Services Express server name.
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5. You can view the creation log files in two ways. The first way is to click View Creation 
Logs in the left pane as shown in Figure 5-55.

Figure 5-55   Selecting to view the creation log files for a Workplace Services Express server

Alternately, you can view the logs for a specific configuration step. For example, if the 
database configuration step fails, you want to review the logs for that task:

a. Click Database Configuration in the right pane and then click View the detailed list 
of tasks for the Database Configuration. 

b. In the new window that opens (Figure 5-56), click the file that you want to display. 

Figure 5-56   Detailed step information for the Database Configuration
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Figure 5-57 shows the first file, the WSEWIZARD_trace.log file.

Figure 5-57   View of the WSEWIZARD_trace.log file

5.8.2  WebSphere Portal Server standard output and standard error logs
The standard output and standard error logs are where the applications running in the 
WebSphere Portal Server place their output. These logs are where you find output from the 
Workplace Services Express application that you might want to review for errors.

Another reason to review the log files is to determine the cause of a failure if the Workplace 
Services Express server does not start. For example, if you try to start the Workplace 
Services Express server and the LDAP server is not running, the Workplace Services 
Express server seems to start and then stop. In this case, the SystemOut.log shows an error 
stating that the Workplace Services Express server could not connect to the LDAP server.

You can access the WebSphere Portal Server standard output and standard error logs in two 
ways:

� Open the files in the integrated file system of the iSeries server. The log files are written to 
the directory /QIBM/UserData/WebAS5/Base/WSEServerName/PortalServer/log, where 
WSEServerName represents your Workplace Services Express server name.

� Select the log files from the IBM Web Administration for iSeries.
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To select the log files from the IBM Web Administration for iSeries, perform the following 
steps:

1. Access IBM Web Administration for iSeries. Point your Web browser to your fully qualified 
iSeries host name on port 2001:

http://iSeriesHostName.domain:2001

In our example, we enter:

http://rchas12.rchland.ibm.com:2001

2. When prompted, enter your i5/OS user profile and password to log on to the IBM Web 
Administration for iSeries. Click OK.

3. On the iSeries Tasks menu, click IBM Web Administration for iSeries. You return to the 
last server that you administered.

4. To manage your Workplace Services Express server, select your server by performing the 
following steps:

a. Click the Manage tab.
b. Click the Application Servers tab.
c. In the Server drop-down list, select your Workplace Services Express server name.

5. In the left pane, click View Logs and then click the Portal Logs tab.

6. You see a number of logs appear as shown in Figure 5-58. From this pane, you can click 
the log that you would like to view. In our example, we selected 
/QIBM/UserData/WebAS5/Base/WSEServerName/PortalServer5/SystemOut.log to 
view the standard output log file. 

Figure 5-58   Viewing the WebSphere Portal Server logs
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Example 5-2 shows the SystemOut.log for our scenario with the relevant errors received 
when the LDAP server was not running during startup. In our example, we use a Domino 
LDAP server called itsodom6.

Example 5-2   Example SystemOut.log

10/26/05 15:37:43:803 CDT]  75ea547 LdapRegistryI E SECJ0352E: Could not get the users matching the pattern 
cn=wpsadmin,o=itso6 because of the following exception javax.naming.CommunicationException: 
itsodom6.RCHLAND.IBM.COM:389.  Root exception is java.net.ConnectException: A remote host refused an 
attempted connect operation.

[10/26/05 15:37:43:807 CDT]  75ea547 LdapRegistryI E SECJ0336E: Authentication failed for user 
cn=wpsadmin,o=itso6 because of the following exception 
[10/26/05 15:37:43:810 CDT]  75ea547 LTPAServerObj E SECJ0369E: Authentication failed when using LTPA. The 
exception is itsodom6.RCHLAND.IBM.COM:389.
[10/26/05 15:37:43:819 CDT]  75ea547 JaasLoginHelp E SECJ4001E: Login failed for 
cn=wpsadmin,o=itso6/itsodom6.RCHLAND.IBM.COM:389 
[10/26/05 15:37:43:870 CDT]  75ea547 ContextManage E SECJ0270E: Failed to get actual credentials. The 
exception is .
[10/26/05 15:37:43:971 CDT]  75ea547 SecurityCompo E SECJ0007E: Error during security initialization. The 
exception is .
[10/26/05 15:37:44:133 CDT] 2c294d10 mta           A     CLHBN0002I: MailService stopped::SITUATION: 
OtherSituation::CLHBN::E95BB299704B2B2A5C5E0040466011DA::9.5.92.90::IPV4::thread=Thread-0
[10/26/05 15:37:49:276 CDT]  75ea547 ObjectPoolSer I OBPL0011I: The Object Pool service is stopping.
[10/26/05 15:37:49:277 CDT]  75ea547 ExtendedMessa I EMSG0203I: The Extended Messaging service is stopping.
[10/26/05 15:37:49:300 CDT]  75ea547 SchedulerServ I SCHD0040I: The Scheduler Service is stopping.
[10/26/05 15:37:49:300 CDT]  75ea547 SchedulerServ I SCHD0002I: The Scheduler Service has stopped.
[10/26/05 15:37:49:310 CDT]  75ea547 AppProfileCom I ACIN0009I: The application profiling service is 
stopping.
[10/26/05 15:37:49:311 CDT]  75ea547 ActivitySessi I WACS0049I: The ActivitySession service is stopping.
[10/26/05 15:37:49:356 CDT]  75ea547 TraceNLS      u Unable to load ResourceBundle 
com.ibm.ws.handlerfw.resources.handlerframework
[10/26/05 15:37:49:356 CDT]  75ea547 HandlerFramew I HANDFW: stopped
[10/26/05 15:37:49:457 CDT]  75ea547 StaffServiceI I STFF0002I: Staff Service stopping.
[10/26/05 15:37:49:724 CDT]  75ea547 WsServer      E WSVR0003E: Server WebSphere_Portal failed to start

5.8.3  WebSphere Application Server standard output and standard error logs
The WebSphere Application Server standard output and standard error logs are used to log 
information about the initial startup and shutdown of the WebSphere_Portal server. The 
output and error logs for the WebSphere Portal Server discussed in 5.8.2, “WebSphere Portal 
Server standard output and standard error logs” on page 147, should contain the information 
for the Workplace Services Express server.

There are cases when there might be errors in the log files for the WebSphere Application 
Server that you should review. These cases include a Workplace Services Express server 
failure where no data can be found in the WebSphere Portal logs or a failure during the initial 
startup. You can access the standard output and standard error logs in two ways:

� Open the files in the integrated file system of the iSeries server. The log files are written to 
the directory /QIBM/UserData/WebAS5/Base/WSEServerName/logs/WebSphere_Portal, 
where WSEServerName represents your Workplace Services Express server.

� Select the log files from the IBM Web Administration for iSeries.
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To select the log files from the IBM Web Administration for iSeries, follow these steps:

1. Access IBM Web Administration for iSeries. Point your Web browser to your fully qualified 
iSeries host name on port 2001:

http://iSeriesHostName.domain:2001

In our example, we enter:

http://rchas12.rchland.ibm.com:2001

2. When prompted, enter your i5/OS user profile and password to log on to the IBM Web 
Administration for iSeries. Click OK.

3. From the iSeries Tasks menu, click IBM Web Administration for iSeries. You return to 
the last server that you administered.

4. To manage your Workplace Services Express server, select your server by performing the 
following steps:

a. Click the Manage tab.
b. Click the Application Servers tab.
c. In the Server drop-down list, select your Workplace Services Express server name.

5. In the left pane, click View Logs and then click the WAS Logs tab to view the WebSphere 
Application Server logs as shown in Figure 5-59.

Figure 5-59   Viewing the WebSphere Application Server logs

5.8.4  Collecting logs for technical support or development
A collector script is available for your use in the integrated file system directory 
/QIBM/UserData/WebAS5/Base/WSEServerName/WorkplaceServer/tools/collector, where 
WSEServerName represents the name of your Workplace Services Express server. Use this 
script when collecting data for review by Lotus technical support or development. Perform the 
following steps to run the collector script:

Note: In these steps WSEServerName represents your Workplace Services Express 
server name.
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1. Log on to the iSeries server and navigate to the QSHELL environment by entering the 
STRQSH CL command.

2. Navigate to the directory containing the collector script by entering the following QSHELL 
command:

cd /QIBM/UserData/WebAS5/Base/WSEServerName/
WorkplaceServer/tools/collector/scripts/os400

3. Enter the following QSHELL command to run the collector script:

runCollector.sh

4. Review the output. You should see entries similar to those shown in Example 5-3.

Example 5-3   Example Qshell output from the runCollecter.sh script

> runCollector.sh 
   Lotus Workplace Data Collection    
      Creating property file ...      
... 
/QIBM/UserData/WebAS5/Base/itsowse3/WorkplaceServer/tools/collector/scripts/os400/collec
tor.property ...            
    ... Created property file                                                                                               
 QSH0005:  Command ended normally with exit status 0.                                                                       
 CPD4090:  Printer device PRT01 not found. Output queue changed to QPRINT in library 
QGPL.                                  
 CPC7301:  File SNPSHTPF created in library QTEMP.                                                                          
 CPC7301:  File SNPSHTSRC created in library QTEMP.                                                                         
 CPF5815:  Member QPDSPSTS for file SNPSHTPF in library QTEMP not found.                                                    
 CPF3484:  Member QPDSPSTS added to file SNPSHTPF in QTEMP.                                                                 
 CPF3485:  15 records copied to file SNPSHTPF in QTEMP.                                                                     
 CPF5815:  Member QPDSPSTS for file SNPSHTSRC in library QTEMP not found.                                                   
 CPF2889:  Member QPDSPSTS added to file SNPSHTSRC in QTEMP.                                                                
 CPC2955:  15 records copied from member QPDSPSTS.                                                                          
 CPC7309:  Member QPDSPSTS removed from file SNPSHTPF in QTEMP.                                                             
 CPC7309:  Member QSYSPRT removed from file SNPSHTPF in QTEMP.                                                  
 CPC7309:  Member QSYSPRT removed from file SNPSHTSRC in QTEMP.                                                 
 Collecting log data for instance itsowse3                                                                      
 Attaching Java program to 
/QIBM/UserData/WebAS5/Base/itsowse3/WorkplaceServer/tools/collector/collector.jar. 

5. You can now use a mapped drive to locate the .jar file created by the collector. You can 
find this file in the integrated file system directory /QIBM/UserData/WebAS5/Base/
WSEServerName/WorkplaceServer/tools/collector/out.

The name of the file is collector_yyyymmdd_hhmmss.jar, for example 
collector_20051024_102226.jar. You can now send this .jar file to Lotus technical support 
for review.

Tip: If you receive an error message when running the runCollector.sh script, use the 
-instance parameter to see if the problem goes away, for example:

runCollector.sh -instance WSEServerName
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5.9  Obtaining and applying fixes
In this section, we explain how to obtain and apply fixes in the Workplace Services Express 
environment. We also demonstrate how to locate and use the WebSphere Portal Update 
Installer.

5.9.1  Obtaining iSeries specific fixes
You should stay current on i5/OS program temporary fixes (PTFS) for Java, DB2 Universal 
Database, and WebSphere. There are a number of PTF groups that are available to make this 
easier for you. For general iSeries fixes help and ordering information, refer to:

http://www.ibm.com/servers/eserver/support/iseries/fixes/index.html

For more information about iSeries PTFS, see 2.3, “Program temporary fixes” on page 16.

5.9.2  Obtaining WebSphere Portal and Workplace Services Express fixes
You can search on known problems, technical documents, and individual fixes for Workplace 
Services Express, as well as download necessary information from the following Workplace 
Services Express Web site:

http://www.ibm.com/support/search.wss?rs=2175&tc=SSMHXX&q=2.5&dc=
D400%2BD410%2BD420%2BD430&dtm

To obtain individual fixes known as interim fixes (ifixes) for Workplace Services Express, you 
must download the WebSphere Portal Update installer, which is located on the Web at:

http://www.ibm.com/support/docview.wss?rs=899&uid=swg24006942

For detailed information about downloading and installing the WebSphere Portal Update 
Installer, refer to 5.9.3, “Obtaining and installing the WebSphere Portal Update Installer” on 
page 152. For information about installing an individual ifix, refer to 5.9.4, “Installing a 
Workplace Services Express interim fix” on page 154.

5.9.3  Obtaining and installing the WebSphere Portal Update Installer
The WebSphere Portal Update Installer is used to provide individual fixes and fixpacks related 
to WebSphere Portal, Workplace Services Express, or both. Perform the following steps to 
obtain and install the WebSphere Portal Update Installer:

1. Open a Web browser and go to the following Web site:

http://www.ibm.com/support/docview.wss?rs=899&uid=swg24006942

Important: Be aware that when you apply a WebSphere group PTF, the version of 
WebSphere Application Server is updated. While in most cases this is a good thing, it can 
have undesired consequences in your environment. Be sure to read the cover letters and 
other preventative service planning documentation that is available to understand the 
changes that will be made when you apply i5/OS PTFs.
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2. Click the PortalUpdateInstaller50X download option as shown in Figure 5-60.

Figure 5-60   Downloading the WebSphere Portal Update Installer

3. In the Terms and conditions window, click I agree.

4. Sign in with your IBM user ID and password.

5. Because of the number of files available for download from this page, we recommend that 
you use the Find option to look for the string WebSphere Portal for Multiplatforms 
Update Installer. Then click the Download now link as shown in Figure 5-61.

Figure 5-61   Selecting to download the WebSphere Portal for MultiPlatforms Update Installer

6. Save the PortalUpdateInstaller.zip file to your workstation.

7. Map a network drive to the root directory of the iSeries server integrated file system.
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8. Create a new folder or directory in the iSeries integrated file system to place the 
WebSphere Portal Update Installer files. For our example, we named the folder 
PortalUpdateInstaller.

9. Extract all of the files from PortalUpdateInstaller.zip to the new directory on your iSeries 
(/PortalUpdateInstaller).

10.Change the authority of the directory and all subdirectories and files to allow *PUBLIC 
*RWX authority. Perform the following steps to update the authority:

a. From an i5/OS command line, enter: 

STRQSH

b. From the QSHELL command line, enter:

cd /

c. From the QSHELL command line, enter:

chmod -R o+rwx PortalUpdateInstaller 

5.9.4  Installing a Workplace Services Express interim fix
After you install the WebSphere Portal Update Installer, you can download and apply interim 
fixes. To help you understand the process, we demonstrate how to download and apply the 
ifix LOCJAC8 for SPR LLGO6CJAC8. For information about this problem, see:

http://www.ibm.com/support/docview.wss?uid=swg24009928

Perform the following steps to install an ifix:

1. Back up your Workplace Services Express configuration data. For assistance, refer to 
5.11.1, “Saving a Workplace Services Express server: sample CL program” on page 161.

2. Download the ifix to your workstation.

3. Map a drive to the iSeries server integrated file system root directory.

4. Create a directory on your iSeries server to temporarily place the fix. For our example, we 
created a directory called fixes in our PortalUpdateInstaller directory.

5. Extract the files in the zip file that you download (LOCJAC8.zip in this example) to your 
fixes directory.

6. Sign onto the iSeries server and open a QSHELL window using the STRQSH CL command.

7. Modify the authorities on the .jar file so that the file is executable:

a. Change to the directory that contains your fix .jar file, for example:

cd /PortalUpdateInstaller/fixes

b. Modify the permissions of the .jar file with the chmod command, for example:

chmod 755 LOCJAC8.jar

8. Shut down the Workplace Services Express server where you want to install the fix.

9. To avoid a possible timeout error when installing the fix, increase the timeout value in the 
soap.client.properties file:

a. Use your mapped network drive to navigate to the integrated file system directory, 
\QIBM\UserData\WebAS5\Base\WSEServerName\properties directory, for your 
Workplace Services Express server. In the directory name, WSEServerName 
represents your actual Workplace Services Express server name.

b. Open the soap.client.props file in any text editor.
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c. Change the value in the com.ibm.SOAP.requestTimeout to 6000 as shown in 
Figure 5-62.

Figure 5-62   Modifying the soap.client.props file

10.In order for the fix to install, the wpconfig.properties file must contain the Workplace 
Services Express administrator user ID and password. The wpconfig.properties file is 
located in the integrated file system directory, \QIBM\UserData\WebAS5\Base\
WSEServerName\PortalServer\config. In this directory name, WSEServerName 
represents your actual Workplace Services Express server name. Use your mapped drive 
and any text editor to modify the wpconfig.properties file.

11.The WAS_PROD_HOME environment variable must be set before you can run the 
installer. Enter the following command at the QSHELL command prompt:

export WAS_PROD_HOME=/QIBM/ProdData/WebAS5/Base

12.Install the fix by entering the following QSHELL command, where the fixes parameter 
value is the name of the ifix .jar file that you downloaded:

/PortalUpdateInstaller/updatePortal.sh
-installDir "/qibm/userdata/webas5/base/WSEServerName/PortalServer"
-fix -install
-fixDir /PortalUpdateInstaller/fixes  
-fixes LOCJAC8 

Example 5-4 shows the output received when installing an ifix.

Example 5-4   Example output received when installing an ifix

/PortalUpdateInstaller/updatePortal.sh     
-installDir "/qibm/userdata/webas5/base/itsowse7/PortalServer"   
-fix -install   
-fixDir /PortalUpdateInstaller/fixes  -fixes LOCJAC8 

Start of [ /PortalUpdateInstaller/updatePortal.sh ]                                                                          
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 Build 20050906_0958                                                                                                              
                                                                                                                                  
 Verifying installer jar:                                                                                                         
 [ PortalUpdateInstaller.jar ]                                                                                                    
                                                                                                                                  
 /qibm/userdata/webas5/base/itsowse7/PortalServer                                                                                 
 rm: 001-2103 Error found getting information for file or directory 
/qibm/userdata/webas5/base/itsowse7/PortalServer/version/EXPRESS.product. No such path 
or directory.                                                                                           
 /qibm/userdata/webas5/base/itsowse7/PortalServer                                                                                 
 Fix update specified                                                                                                             
 Installation specified                                                                                                           
 Fix directory: /PortalUpdateInstaller/fixes                                                                                      
 Fix JAR file: LOCJAC8.jar                                                                                                        
 Target product directory: /qibm/userdata/webas5/base/itsowse7/PortalServer                                                       
 Copyright (c) IBM Corporation 2002; All rights reserved.                                                                         
 WebSphere Portal Version 5                                                                                                       
 Update Installer Version 1.5, Dated 9/24/03                                                                                      
                                                                                                                                  
 Configuration Properties:                                                                                                        
         WAS Home:/QIBM/UserData/WebAS5/Base/ITSOWSE7                                                                             
         UserInstallRoot:/QIBM/UserData/WebAS5/Base/ITSOWSE7                                                                      
         CellName:ITSOWSE7_ITSOWSE7                                                                                               
         NodeName:ITSOWSE7_ITSOWSE7                                                                                               
         ServerName:WebSphere_Portal                                                                                              
         WAS DMgr processing:false                                                                                                
 Checking the status of all Application Servers                                                                                   
 Checking status of server server1                                                                                                
 Checking status of server WebSphere_Portal                                                                                       
 Fix: LOCJAC8                                                                                                                     
 Task 1 out of 3; Begin (1 of 1) Installing fix LOCJAC8; preparing for installation                                               
 Task 1 out of 3; End (1 of 1) Installing fix LOCJAC8; preparing for installation                                                 
 Task 2 out of 3; Begin (1 of 1) Installing fix LOCJAC8; installing component 1 of 1                                              
 Quiet Mode: Logging to 
/qibm/userdata/webas5/base/itsowse7/PortalServer/version/log/20051021_200652_LOCJAC8_Lot
us Collaborative Components_install.log                                                                                                            
                                                                                                                                  
 Task 2 out of 3; End (1 of 1) Installing fix LOCJAC8; installing component 1 of 1      
 Task 3 out of 3; Begin (1 of 1) Installing fix LOCJAC8; completing installation        
 Task 3 out of 3; End (1 of 1) Installing fix LOCJAC8; completing installation          
 Fix installation completed successfully.                                               
 End of [ /PortalUpdateInstaller/updatePortal.sh ] 

13.In step 10 you modified the wpconfig.properties file to include the Workplace Services 
Express administrator and password. Now remove the password from this file to protect 
the integrity of the password.

5.10  Removing the Sign up and Edit my profile links
By default, Workplace Services Express allows a user to sign up (or self register) and edit 
their profile. The Sign up option creates a new user in the back-end LDAP server. The Edit my 
profile option modifies the entry for the user in the back-end LDAP server. Some companies 
find this undesirable.
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The following steps explain you how to remove the Sign up and Edit profile links from your 
Workplace Services Express server:

1. Stop your Workplace Services Express server. For assistance with stopping your server, 
refer to 5.1.2, “Stopping a Workplace Services Express server” on page 108.

2. Log on to the iSeries server via a 5250 emulation session and enter the STRQSH CL 
command.

3. Change to the configuration directory for the Workplace Services Express server:

cd /QIBM/UserData/WebAS5/Base/WSEServerName/PortalServer/config

Here WSEServerName represents your Workplace Services Express server name.

4. You can now run the WPSconfig script to update the Workplace Services Express server:

WPSconfig.sh action-fixup-signup-link

You see output similar to what is shown in Example 5-5.

Example 5-5   Updating the Workplace Services Express server to remove the sign up link

WPSconfig.sh action-fixup-signup-link                                                                         
Licensed Materials - Property of IBM                                                                          
5724-E76, 5724-E77                                                                                            
(C) Copyright IBM Corp. 2001, 2004  All Rights Reserved.                                                      
                                                                                                              
Running WebSphere Portal 5.0.2.2 configuration                                                                
Executing native2ascii with native encoding 'ISO8859_1': wpconfig.properties -> 
wpconfig_ascii.properties     
Native2ascii execution was successful!                                                                        
Setting cfg.file.name.original to wpconfig.properties                                                         
Setting cfg.file.name to wpconfig_ascii.properties                                                            
Adding ENTITY for property_file_updates                                                                       
Adding ENTITY for d57415                                                                                      
Adding ENTITY for CM_502                                                                                      
Adding ENTITY for d63026         
Adding ENTITY for d70013         
Adding ENTITY for PQ78657        
Adding ENTITY for WP_PTF_5021    
Adding ENTITY for d66191         
Adding ENTITY for Likeminds_502  
Adding ENTITY for d61137         

Note: If you only allowed read access to the LDAP directory during configuration, the Sign 
up and Edit my profile links should have been removed for you by the iSeries Create IBM 
Workplace wizard. Therefore, you do not have to perform the following steps.

Important: Be aware that performing these steps only removes the link from the 
Workplace Services Express environment. If you set up your Workplace Services Express 
server with an LDAP user and password that has write access to the LDAP directory, 
changes to the LDAP server can still be made manually when you enter the URL to access 
the Sign up page directly. 

To modify the Workplace Services Express server’s access to the LDAP directory, modify 
the authority of the Workplace Services Express administrator account. As part of the 
configuration process performed by the iSeries Create IBM Workplace wizard, the 
Workplace Services Express administrator was granted either read or read/write authority 
to the LDAP directory. We recommend that you manually remove the Workplace Services 
Express administrator’s write authority to the LDAP server to prevent all changes to the 
LDAP server by Workplace Services Express.

 

 

 

Chapter 5. Administering Workplace Services Express 157



 

Adding ENTITY for d15446         
Adding ENTITY for d63750         
Adding ENTITY for d63852         
Adding ENTITY for d60351         
Adding ENTITY for d63291         
Adding ENTITY for d64954         
Adding ENTITY for d66322         
Adding ENTITY for d66323         
Adding ENTITY for d50062         
Adding ENTITY for d68644         
Adding ENTITY for PQ85659                        
Adding ENTITY for WP_PTF_502                     
Adding ENTITY for d74818                         
Adding ENTITY for LWP_25                         
Adding ENTITY for LO07957                        
Adding ENTITY for iseries_arcfixups              
Adding ENTITY for iseries_dg1fixups              
Adding ENTITY for lwp_arcfixup                   
Adding ENTITY for lwp_migrate_fixup              
Adding ENTITY for postfixup                      
Adding entity include for property_file_updates  
Adding entity include for d57415                 
Adding entity include for CM_502                 
Adding entity include for d63026                 
Adding entity include for d70013                 
Adding entity include for PQ78657                
Adding entity include for WP_PTF_5021            
Adding entity include for d66191         
Adding entity include for Likeminds_502  
Adding entity include for d61137         
Adding entity include for d15446         
Adding entity include for d63750         
Adding entity include for d63852         
Adding entity include for d60351         
Adding entity include for d63291         
Adding entity include for d64954         
Adding entity include for d66322         
Adding entity include for d66323         
Adding entity include for d50062         
Adding entity include for d68644         
Adding entity include for PQ85659        
Adding entity include for WP_PTF_502     
Adding entity include for d74818         
Adding entity include for LWP_25 
 Adding entity include for LO07957                                                                                                
 Adding entity include for iseries_arcfixups                                                                                      
 Adding entity include for iseries_dg1fixups                                                                                      
 Adding entity include for lwp_arcfixup                                                                                           
 Adding entity include for lwp_migrate_fixup                                                                                      
 Adding entity include for postfixup                                                                                              
 Setting build file name to 
/QIBM/UserData/WebAS5/Base/itsowse3/PortalServer/config/wpconfig_dynamic.xml                          
 Buildfile: /QIBM/UserData/WebAS5/Base/itsowse3/PortalServer/config/wpconfig_dynamic.xml                                          
                                                                                                                                  
 action-iseries-switch-user:                                                                                                      
 [switchprofile] Unable to extract user profile from WAS server.xml file                                                          
 [switchprofile] WAS server.xml file is 
/QIBM/UserData/WebAS5/Base/itsowse3/config/cells/ITSOWSE3_ITSOWSE3/nodes/ITSOWSE3_ITSOWS
E3
 /servers/ITSOWSE3/server.xml                                                                                                     
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 [switchprofile] Processing will proceed with default user profile (QEJBSVR)                                                      
    [logmsg] 2005.10.25 11:07:59.707 iseries-switch-user                                                                          
    [logmsg]   EJPC5000I Switched to user "QEJBSVR".                                                                              
 iseries-switch-back:                                                                                                             
 [switchprofile] Switching back to original user= AHOERLE                                                                         
                                                                                                                                  
 action-update-wpconfig-dynamic:                                                                                                  
                                                                                                                                  
 iseries-switch-to-was-user:                                                                                                      
 [switchprofile] Unable to extract user profile from WAS server.xml file                                                          
 [switchprofile] WAS server.xml file is 
/QIBM/UserData/WebAS5/Base/ITSOWSE3/config/cells/ITSOWSE3_ITSOWSE3/nodes/ITSOWSE3_ITSOWS
E3
 /servers/ITSOWSE3/server.xml                                                                                                     
 [switchprofile] Processing will proceed with default user profile (QEJBSVR)                                                      
                                                                                                                                  
 iseries-switch-user:                                                                                                             
                                                                                                                                  
 init-jsp-backup:                                                                                                                 
                                                                                                                                  
 action-backup-jsp:                                                                                                               
     [echo] Backing up original JSP 
/QIBM/UserData/WebAS5/Base/ITSOWSE3/installedApps/ITSOWSE3_ITSOWSE3/wps.ear/wps.war/them
es/ht
ml/workplace/ToolBarInclude.jsp                                                                                                  
     [copy] Copying 1 file to 
/QIBM/UserData/WebAS5/Base/ITSOWSE3/installedApps/ITSOWSE3_ITSOWSE3/wps.ear/wps.war/them
es/html/wor
kplace                                                                                                                           
                                                                                                                                 
action-copy-orig-backup:                                                                                                         
                                                                                                                                 
action-fixup-signup-link:                                                                                                        
     [echo] Commenting out the Sign Up Link from in 
/QIBM/UserData/WebAS5/Base/ITSOWSE3/installedApps/ITSOWSE3_ITSOWSE3/wps.ear/w
ps.war/themes/html/workplace/ToolBarInclude.jsp                                                                                  
  [replace] Replaced 1 occurrences in 1 files.                                                                                   
  [replace] Replaced 1 occurrences in 1 files.                                                                                   
  [replace] Replaced 1 occurrences in 1 files.                                                                                   
                                                                                                                                 
BUILD SUCCESSFUL                                                                                                                 
Total time: 5 seconds 

5. Start your Workplace Services Express server. For assistance with starting your server, 
see 5.1.1, “Starting a Workplace Services Express server” on page 106.

5.11  Backup and recovery
The backup and recovery of a Workplace Services Express server can be complex if you do 
not understand where the data is stored. When planning for backup and recovery of your 
Workplace Services Express server, you must plan for all of the components that complete 
the Workplace Services Express environment. Three servers, the LDAP server, HTTP server 
and the Workplace Services Express Server, make up the Workplace Services Express 
environment.

The data for the LDAP server is stored in different places depending on the LDAP server that 
you are using. Refer to the product documentation for the LDAP server that you are using for 
information about backup and recovery.
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If you are using the IBM Directory Server for iSeries as your LDAP server, you can find 
information in the iSeries Information Center:

http://publib.boulder.ibm.com/infocenter/iseries/v5r3/topic/rzahy/
rzahybup-rf.htm#rzahybup-rf

For information about saving a Domino server on iSeries, refer to the IBM Redbook Domino 6 
for iSeries Best Practices Guide, SG24-6937.

The default HTTP server used by the Workplace Services Express server is the IBM HTTP 
Server for iSeries (powered by Apache). Unless you changed the defaults when running the 
iSeries Create IBM Workplace wizard, the data is stored within the iSeries server integrated 
file system in the /www/WSEServerName directory.

The Workplace Services Express data is stored in several places. The product code, user 
data and configuration data are all stored in different places.

The Workplace Services Express product code is stored in the QWSE25 library and 
/QIBM/ProdData/Workplace/WSE25 directory. The data here is only changed after applying 
PTFs, and therefore, only must be saved periodically. This can be done as part of a weekly, 
monthly, or quarterly complete system save.

The Workplace Services Express user data is stored within DB2 Universal Database. The 
names of the libraries that contain the data depends on the naming option chosen in the 
iSeries Create IBM Workplace wizard. The default naming option is based on the server 
name of the Workplace Services Express server. Therefore, you see WSEServerName1, 
WSEServerName2, and so on type libraries on your system. If you have not chosen the 
default naming, refer to 5.2, “Reviewing the Workplace Services Express configuration” on 
page 110, to determine the library names. Save the libraries that contain the DB2 Universal 
Database data often. We recommend that you save these libraries daily.

The configuration data is stored within the integrated file system in the 
/QIBM/UserData/WebAS5/Base/WSEServerName directory, where WSEServerName 
represents your Workplace Services Express server name. To ensure easy recovery, if 
necessary, we recommend that you back up this directory daily or weekly. There is also some 
configuration data stored in the WebSphere Portal Server database. This database can be 
included in your backup procedure when backing up all user data. An example of 
configuration data that is stored in the DB2 Universal Database database is user policies.

Table 5-1 summarizes the information to be saved and the recommended frequency of the 
backup.

Tip: When you save the IBM Directory Server, do not save the QDIRSRV2 library because 
the contents cannot be restored in any usable way. Also be aware that the 
/QIBM/UserData/OS400/Dirsrv directory can only be restored on the same release of 
OS/400 or i5/OS on which it was saved.

Important: At this time, there is no way to save and restore individual documents. All 
backup and recovery must be done at the database level. The functionality to restore 
individual documents will be added to a future release of Workplace Services Express.
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Table 5-1   Summary of backup recommendations for Workplace Services Express

5.11.1  Saving a Workplace Services Express server: sample CL program
You should now understand where the Workplace Services Express data is stored. To assist 
you in backing up the Workplace Services Express server configuration data and user data 
along with the IBM HTTP Server, we provide a sample CL program, called SAVEWSE25.txt, 
for you to use. This program performs the following actions:

� Ends the HTTP server
� Ends the Workplace Services Express server
� Ends the QEJBAS5 subsystem
� Monitors the QEJBAS5 subsystem to make sure it has ended
� Saves the /www/WSEServerName directory
� Saves the /QIBM/UserData/WebAS5/Base/WSEServerName directory
� Saves the DB2 Universal Database libraries (assuming the default naming convention)
� Starts the HTTP server
� Starts the Workplace Services Express server

In the directory name, WSEServerName represents your Workplace Services Express server 
name.

Example 5-6 shows the sample CL program, SAVEWSE25.txt. You can also download a copy 
of this CL program, as explained in Appendix C, “Additional material” on page 359.

This CL program expects the following parameters:

� The Workplace Services Express server name
� The administrator user ID
� The administrator user ID password

The following command shows an example call to the CL program. Here itsowse3 represents 
the Workplace Services Express server name, wpsadmin represents the administrator user 
ID, and password represents the password for the administrator.

CALL PGM(SAVEWSE25) PARM('itsowse3' 'wpsadmin' 'password')

Component to be saved Where data is stored Frequency of 
backup

Workplace Services 
Express product data

QWSE25 library and 
/QIBM/ProdData/Workplace/WSE25

Weekly, 
monthly, or 
quarterly

IBM HTTP Server for 
iSeries

/www/WSEServerName Daily or weekly

Workplace Services 
Express configuration data

/QIBM/UserData/WebAS5/Base/WSEServerName Daily or weekly

Workplace Services 
Express user data

DB2 Universal Database libraries Daily

Tip: In a future version of Workplace Services Express, scripts will be provided that will 
back up and recover a Workplace Services Express server.
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Example 5-6   Sample CL program to save a Workplace Services Express server

/*This program is a basic example of backing up a Workplace Services Express */  
/*server.  This program assumes that you are running one Workplace Service Express */
/*server and that you are not running any stand-along WebSphere Application Servers */
/*in the QEJBAS5 subsystem.  If you are, that is not a problem, but be aware it will*/              
/*be ended when this program executes.  Also, this program assumes that you  */              
/*are using the default naming scheme for the data libraries.  If you have   */              
/*chosen the option to name the libraries based on their purpose, you will   */              
/*need to modify this program to use the correct library names.              */   
/*Please be aware that this program does not backup the LDAP directory.      */   
/*                                                                           */            
              PGM        PARM(&INSTANCE &USER &PASSWORD)                                     
              DCL        VAR(&INSTANCE) TYPE(*CHAR) LEN(10)                                  
              DCL        VAR(&CMD) TYPE(*CHAR) LEN(300)                                      
              DCL        VAR(&COUNT) TYPE(*DEC) LEN(2 0) VALUE(0)                            
              DCL        VAR(&USER) TYPE(*CHAR) LEN(12)                                     
              DCL        VAR(&PASSWORD) TYPE(*CHAR) LEN(12)                                 
              DCL        VAR(&MSG) TYPE(*CHAR) LEN(250)                                     
                                                                                
/* End the HTTP server and Workplace Services Express instance   */                          

              ENDTCPSVR  SERVER(*HTTP) HTTPSVR(&INSTANCE)                           
              MONMSG     MSGID(TCP1A77) /* HTTP server already ended */                      

              CHGVAR     VAR(&CMD)                  
                         VALUE('/qibm/userdata/WebAS5/Base/' *TCAT +                     
                           &INSTANCE *TCAT +                                               
                           '/PortalServer/rootscripts/subtasks/stopPor+                    
                           talServer.sh -user' *BCAT &USER *BCAT +                         
                           '-password' *BCAT &PASSWORD)                                      

              QSH        CMD(&CMD) /* run script to end server */             
              MONMSG     MSGID(QSH0006) EXEC(DO)                                  
              SNDPGMMSG  MSG('Error trying to end the Workplace +                  
                           services express instance.  The backup +                  
                           was aborted.')                                                
              GOTO       CMDLBL(END)                                                     
              ENDDO                                                                          

              MONMSG     MSGID(QSH0007) EXEC(DO)                           
              SNDPGMMSG  MSG('Error trying to end the Workplace +                    
                           Services Express instance.  The backup +                    
                           was aborted.')                         
              GOTO       CMDLBL(END)                            
              ENDDO                                                                          

  /*End the QEJBAS5 subsystem            */                                    

Important: The password is case sensitive. To ensure that the correct case is passed to 
the program, you must use single quotation marks around each parameter value. If you do 
not specify the single quotation marks, the text is converted to all uppercase and the 
program is unable to end the Workplace Services Express server. For example, the 
following command does not work:

CALL PGM(SAVEWSE25) PARM(ITSOWSE3 WPSADMIN PASSWORD) 

Here is the command again with the parameters passed correctly to the CL program:

CALL PGM(SAVEWSE25) PARM('itsowse3' 'wpsadmin' 'password')
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              ENDSBS     SBS(QEJBAS5) DELAY(1800) /* Allow 30 minutes +    

for the server to end before ending the +                     
                           subsystem immediately */  
              MONMSG     MSGID(CPF0000)                                                      

  /*Begin loop to verify that all jobs have ended before starting backup */                  

   LOOP:                                                                                     

             ALCOBJ     OBJ((QEJBAS5/QEJBAS5 *SBSD *EXCL)) WAIT(600) +                    
                           /* Wait 10 minutes to get subsystem */ 
              MONMSG     MSGID(CPF1002) EXEC(DO)                                        
              CHGVAR     VAR(&COUNT) VALUE(&COUNT +1)                       
              IF         COND(&COUNT = 6) THEN(GOTO CMDLBL(LOOP))                      
              SNDPGMMSG  MSG('The QEJBAS5 subsystem failed to end +                      
                           after 1 hour.  Backup is aborted.') 
              GOTO END                                                                 
              ENDDO                                                                    
                                                                                       
  /*Save the HTTP and WSE instance data followed by DB2 data to tape device tap01*/                  

              SAV        DEV('/qsys.lib/tap01.devd') OBJ((('/www/' +                    
                           *CAT &INSTANCE)) +                                           
                           (('/qibm/userdata/WebAS5/Base/' *CAT +                       
                           &INSTANCE)))                                                
              MONMSG     MSGID(CPF0000)                                                
              SAVLIB     LIB((&INSTANCE *TCAT '*')) DEV(TAP01)                         
              MONMSG     MSGID(CPF0000)                                                
              DLCOBJ     OBJ((QEJBAS5/QEJBAS5 *SBSD *EXCL))                            
                   
    /*Restart the HTTP and WSE server*/                                                      

              STRTCPSVR  SERVER(*HTTP) HTTPSVR(&INSTANCE)                      
              STRSBS     SBSD(QEJBAS5/QEJBAS5)                                 
                                      
              CHGVAR     VAR(&CMD) +                             
                           VALUE('/qibm/userdata/WebAS5/Base/' *TCAT +                     
                           &INSTANCE *TCAT +                                               
                           '/PortalServer/rootscripts/startWorkplaceSe+                    
                           rvices.sh')                                                
              QSH        CMD(&CMD) /* run script to start server */                   
   END:                     
   ENDPGM

5.11.2  Restoring a Workplace Services Express server
This section explains how to restore the IBM HTTP Server for iSeries (powered by Apache) 
server, user data, and configuration data used by a Workplace Services Express server. 
Before you can understand the restore process, you must understand private authorities.

Private authorities are the authorities to an object for any user other than the owner. For 
example in Figure 5-63, ITSOUSER is the owner, and QTMMHTTP has *X authority to the 
/www/itsowse3 directory. The authority QTMMHTTP has to the object is considered a private 
authority. If we lose the private authorities to this directory, the IBM HTTP Server for iSeries 
server itsowse3 will no longer start because the QTMMHTTP authority no longer exists. This 
becomes important because, depending on how the data is restored to the system, the 
private authorities might not be recovered.
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Figure 5-63   Work with Authority display for the /www/itsowse3 object

There are two methods to restore the private authorities. The first option takes the following 
approach:

� Restore user profiles (RSTUSRPRF *ALL)
� Restore data (IBM HTTP Server or configuration data)
� Restore authorities (RSTAUT)

The second option is to manually rebuild the private authorities. We use this approach in our 
examples because saving and restoring user profiles are beyond the scope of this redbook. 
For additional information, refer to the iSeries Information Center at:

http://publib.boulder.ibm.com/infocenter/iseries/v5r3/index.jsp?topic=/rzaiu/
rzaiuicbackup.htm

Restoring an IBM HTTP Server for iSeries (powered by Apache) server
Before you can restore the IBM HTTP Server for iSeries (powered by Apache) server, you 
must end it, although you are not required to end the Workplace Services Express server. 
However, without an HTTP server, the Workplace Services Express server is not functional. 
Therefore, in our example, we end both servers. Perform the following steps to restore the 
HTTP server. Notice that WSEServerName represents the Workplace Services Express 
server name.

1. End the IBM Workplace Services Express server. For information about ending the 
Workplace Services Express server, refer to 5.1.2, “Stopping a Workplace Services 
Express server” on page 108.

2. End the IBM HTTP Server using the following End TCP/IP Server (ENDTCPSVR) CL 
command. Do this step only if you did not end the HTTP server with the Workplace 
Services Express server in the previous step.

ENDTCPSVR SERVER(*HTTP) HTTPSVR(WSEServerName)

                              Work with Authority                               
                                                                                
 Object . . . . . . . . . . . . :   /www/itsowse3                               
 Owner  . . . . . . . . . . . . :   ITSOUSER 
 Primary group  . . . . . . . . :   *NONE                                       
 Authorization list . . . . . . :   *NONE                                       
                                                                                
                                                                                
 Type options, press Enter.                                                     
   1=Add user   2=Change user authority   4=Remove user                         
                                                                                
                    Data     --Object Authorities--                             
 Opt  User        Authority  Exist  Mgt  Alter  Ref                             
                                                                                
      *PUBLIC     *X                                                            
      ITSOUSER *RWX         X     X     X     X                              
      QTMHHTTP    *X                                                            
                                                                                
                                                                         Bottom 
 Parameters or command                                                          
 ===>                                                                           
 F3=Exit   F4=Prompt   F5=Refresh      F9=Retrieve                              
 F11=Display detail data authorities   F12=Cancel   F24=More keys               
 (C) COPYRIGHT IBM CORP. 1980, 2003. 
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3. Restore the IBM HTTP Server data directory from tape:

RST DEV('/qsys.lib/tap01.devd') OBJ(('/www/WSEServerName')) 

4. Restore the private authorities for the IBM HTTP Server files and directories:

CHGAUT OBJ('/www/WSEServerName/conf') USER(QTMHHTTP) DTAAUT(*X)
CHGAUT OBJ('/www/WSEServerName/htdocs') USER(QTMHHTTP) DTAAUT(*RX)
CHGAUT OBJ('/www/WSEServerName/logs') USER(QTMHHTTP) DTAAUT(*RWX)
CHGAUT OBJ('/www/WSEServerName/conf/httpd.conf') USER(QTMHHTTP) DTAAUT(*R)
CHGAUT OBJ('/www/WSEServerName/htdocs/index.html') USER(QTMHHTTP) DTAAUT(*R)

5. Start the IBM HTTP Server using the following CL command:

STRTCPSVR SERVER(*HTTP) HTTPSVR(WSEServerName)

Restoring Workplace Services Express server configuration data
This section explains how to restore the Workplace Services Express configuration data.

Perform the following steps:

1. End the IBM Workplace Services Express server. For information about ending the server, 
refer to 5.1.2, “Stopping a Workplace Services Express server” on page 108.

2. Restore the Workplace Services Express configuration data directory from tape:

RST DEV('/qsys.lib/tap01.devd') OBJ(('/QIBM/UserData/WebAS5/Base/WSEServerName'))

3. Restore the private authorities or you will lose the link between your HTTP server and the 
Workplace Services Express server:

CHGAUT OBJ('/QIBM/UserData/WebAS5/Base/WSEServerName/config/cells/plugin-cfg.xml')
USER(QTMHHTTP) DTAAUT(*RX)

CHGAUT OBJ('/QIBM/UserData/WebAS5/Base/WSEServerName/config/cells') USER(QTMHHTTP)
DTAAUT(*RX)

CHGAUT OBJ('/QIBM/UserData/WebAS5/Base/WSEServerName/config') USER(QTMHHTTP) DTAAUT(*RX)

4. Start your Workplace Services Express server. For assistance with starting your server, 
refer to 5.1.1, “Starting a Workplace Services Express server” on page 106.

Restoring Workplace Services Express server user data
You might want to restore Workplace Services Express server user data if a user makes a 
fatal error and deletes data that they needed. You might also have to restore the DB2 
Universal Database data if an undesired configuration change is made that is stored in the 
WebSphere Portal configuration database and you do not understand what was changed.

Important: Some configuration data is also stored within the DB2 Universal Database 
database. If you are unsure about whether the configuration data that you need is stored in 
the integrated file system directory or in DB2 Universal Database, we recommend that you 
also follow the steps outlined in “Restoring Workplace Services Express server user data” 
on page 165. An example of configuration data that is stored in the DB2 Universal 
Database database is user policies.

Note: Because of the large numbers of small files that must be created, the restore time 
is longer than that of the save time. During our testing, we have observed restore times 
between one and two hours.

Important: In Workplace Services Express, there is no functionality to restore a single 
document, team space, and so on. At this time, you must restore the entire database. This 
limitation will be addressed in a future release of Workplace Services Express.
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Use the following steps to restore the DB2 Universal Database data. Here WSEServerName 
represents your Workplace Services Express server name.

1. End the IBM Workplace Services Express server. For information about ending the 
Workplace Services Express server, refer to 5.1.2, “Stopping a Workplace Services 
Express server” on page 108.

2. Delete the existing DB2 Universal Database data libraries:

a. Enter the following Work Library CL command:

wrklib WSEServerName*

b. On the Work with Libraries display (Figure 5-64), type option 4 (Delete) next to each 
library and press Enter.

Figure 5-64   Deleting all libraries associated with the Workplace Services Express server ITSOWSE5

c. On the Confirm Delete of Libraries display, press Enter to confirm the deletion request.

Note: We presume that you are using the default naming convention based on the 
Workplace Services Express server name. If you did not select this option, see 5.2, 
“Reviewing the Workplace Services Express configuration” on page 110, for 
information about the database naming conventions.

                              Work with Libraries                               
                                                                                
 Type options, press Enter.                                                     
   1=Create   2=Change   3=Copy    4=Delete   5=Display   6=Print               
   8=Display library description   9=Save     10=Restore                        
   11=Save changed objects         12=Work with objects   14=Clear              
                                                                                
                              ASP                                               
 Opt  Library     Attribute   Device      Text                                  
                                                                                
 4    ITSOWSE5    PROD                    COLLECTION - created by SQL           
 4    ITSOWSE51   PROD                    COLLECTION - created by SQL           
 4    ITSOWSE518  PROD                    COLLECTION - created by SQL           
 4    ITSOWSE52   PROD                    COLLECTION - created by SQL           
 4    ITSOWSE53   PROD                    COLLECTION - created by SQL           
 4    ITSOWSE54   PROD                    COLLECTION - created by SQL           
 4    ITSOWSE55   PROD                    COLLECTION - created by SQL           
                                                                                
                                                                         Bottom 
 Parameters for options 1, 2, 3, 5, 8, 9, 10, 11 and 12 or command              
 ===>                                                                           
 F3=Exit      F4=Prompt   F5=Refresh   F9=Retrieve   F11=Display names only     
 F12=Cancel   F16=Repeat position to   F17=Position to 
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d. You might see a Display Program Messages display with the error message “Receiver 
QSQJRN0001 in LibraryName never fully saved. (I C)” when you delete the DB2 
Universal Database libraries. If you see this message, type I to allow the deletion to 
continue. This might occur multiple times as shown in Figure 5-65.

Figure 5-65   Error message ‘Receiver QSQJRN0001 in ITSOWSE55 never fully saved. (I C)’

3. Restore the libraries by entering the following Restore Library (RSTLIB) CL command 
(see Figure 5-66):

RSTLIB SAVLIB(WSEServerName*) DEV(TAP01)

Figure 5-66   Example output from the RSTLIB command

4. Start your Workplace Services Express server. For assistance with starting your server, 
refer to 5.1.1, “Starting a Workplace Services Express server” on page 106.

                           Display Program Messages                            
                                                                               
Job 241463/AHOERLE/QPADEV0006 started on 10/20/05 at 08:48:45 in subsystem Q  
Maximum number of records reached for file QSYSPRT. (C R NOMAX 1-999999)      
NOMAX                                                                         
Receiver QSQJRN0001 in ITSOWSE55 never fully saved. (I C)                     
I                                                                             
Receiver QSQJRN0002 in ITSOWSE55 never fully saved. (I C)                     
I                                                                             
Receiver QSQJRN0002 in ITSOWSE54 never fully saved. (I C)                     
I                                                                             
Receiver QSQJRN0001 in ITSOWSE52 never fully saved. (I C)                     
I                                                                             
Receiver QSQJRN0001 in ITSOWSE54 never fully saved. (I C) 
                                                                                                                                                              
 F3=Exit   F12=Cancel 

                                Command Entry                         RCHAS12  
                                                          Request level:   1   
Previous commands and messages:                                                
   > wrklib itsowse*                                                           
   > RSTLIB SAVLIB(ITSOWSE*) DEV(TAP01)                                        
     325 objects restored from ITSOWSE33 to ITSOWSE33.                         
     79 objects restored from ITSOWSE34 to ITSOWSE34.                          
     316 objects restored from ITSOWSE35 to ITSOWSE35.                         
     113 objects restored from ITSOWSE36 to ITSOWSE36.                         
     94 objects restored from ITSOWSE37 to ITSOWSE37.                          
     29 objects restored from ITSOWSE38 to ITSOWSE38.                          
     6 libraries restored at 10/20/05 12:45:03.                                
                                                                        Bottom 
Type command, press Enter.                                                     
===>                                                                           
                                                                                                                                                             
F3=Exit   F4=Prompt   F9=Retrieve   F10=Include detailed messages              
F11=Display full      F12=Cancel    F13=Information Assistant   F24=More keys 
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5.12  Removing a Workplace Services Express server
There might be a time when you want to remove a Workplace Services Express server. The 
steps in this section explain how to remove a Workplace Services Express server using the 
IBM Web Administration for iSeries tool.

As part of the deletion process, you are expected to know several configuration options that 
you selected in the iSeries Create IBM Workplace wizard. We recommend that you print a 
copy of the Printable Summary generated by the iSeries Create IBM Workplace wizard and 
keep it with you when performing these steps. To access the printable summary, refer to 5.2, 
“Reviewing the Workplace Services Express configuration” on page 110. Perform the 
following steps:

1. Access the IBM Web Administration for iSeries by pointing your Web browser to your fully 
qualified iSeries host name on port 2001:

http://iSeriesHostName.domain:2001

In our example, we use:

http://rchas12.rchland.ibm.com:2001

2. When prompted, enter your i5/OS user profile and password, log on to the IBM Web 
Administration for iSeries. Click OK.

3. On the iSeries Tasks menu, click IBM Web Administration for iSeries. You return to the 
last server that you administered.

4. Within the IBM Web Administration tool, manage all the application servers:

a. Click the Manage tab.
b. Click the All Servers tab.
c. Click the All Application Servers tab as shown in Figure 5-67.

Figure 5-67   Managing all application servers with the IBM Web Administrator for iSeries tool
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5. Scroll through the list of application servers to find the Workplace Services Express server 
you want to remove. Select either the Server1 or WebSphere_Portal entry for your 
Workplace Services Express server, and click Delete as shown in Figure 5-68.

Figure 5-68   Deleting a Workplace Services Express server

6. Using the Delete wizard (Figure 5-69), we recommend that you remove the HTTP server 
with the Workplace Services Express server. The Delete wizard does not remove the DB2 
Universal Database databases by default. Select each of the local database collections, 
libraries, or schemas that are associated with this Workplace Services Express server to 
allow the Delete wizard to remove them from the system. Click Next.

Figure 5-69   Confirming selections for deletions within the Delete wizard

 

 

 

Chapter 5. Administering Workplace Services Express 169



 

7. In the Delete summary pane (Figure 5-70), click Delete to finish removing the Workplace 
Services Express server. 

Figure 5-70   Deletion summary pane

8. At this point, the deletion is in process. You should return to the Manage All Servers pane. 
You should see that your Workplace Services Express server has a status of Deleting as 
shown in Figure 5-71.

Figure 5-71   Manage All Application Servers: Deleting a Workplace Services Express server

9. When the Delete wizard completes, no status message is displayed. You see the 
Workplace Services Express server disappear from the list or see a status of Deleted.
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10.If you chose to delete the DB2 Universal Database data in the Delete wizard, you can skip 
this step. However, if you did not choose to have the Delete wizard remove the DB2 
Universal Database data, you must manually delete the libraries used by your Workplace 
Services Express server. Using the default naming convention based on your Workplace 
Services Express server name, perform the following steps to remove the libraries:

a. Enter the following Work with Libraries (WRKLIB) CL command:

wrklib WSEServerName*

Here WSEServerName represents your Workplace Services Express server name.

b. On the Work with Libraries display (Figure 5-72), type option 4 (Delete) next to each 
library and press Enter.

Figure 5-72   Deleting all libraries associated with the ITSOWSE5 Workplace Services Express server

c. On the Confirm Delete of Libraries display, press Enter to confirm the deletion request.

Note: In our testing, the Workplace Services Express server always disappeared. If you 
see the server in a Deleted status, a file was in use and the Delete wizard was unable to 
remove the /QIBM/UserData/WebAS5/Base/WSEServerName directory (where 
WSEServerName represents your Workplace Services Express server name). Remove 
the directory manually from a mapped drive, and the Workplace Services Express 
server then disappears from the list.

Note: In our testing, we found that not all libraries were deleted. We suggest that you 
verify that all libraries are properly deleted.

                              Work with Libraries                               
                                                                                
 Type options, press Enter.                                                     
   1=Create   2=Change   3=Copy    4=Delete   5=Display   6=Print               
   8=Display library description   9=Save     10=Restore                        
   11=Save changed objects         12=Work with objects   14=Clear              
                                                                                
                              ASP                                               
 Opt  Library     Attribute   Device      Text                                  
                                                                                
 4    ITSOWSE5    PROD                    COLLECTION - created by SQL           
 4    ITSOWSE51   PROD                    COLLECTION - created by SQL           
 4    ITSOWSE518  PROD                    COLLECTION - created by SQL           
 4    ITSOWSE52   PROD                    COLLECTION - created by SQL           
 4    ITSOWSE53   PROD                    COLLECTION - created by SQL           
 4    ITSOWSE54   PROD                    COLLECTION - created by SQL           
 4    ITSOWSE55   PROD                    COLLECTION - created by SQL           
                                                                                
                                                                         Bottom 
 Parameters for options 1, 2, 3, 5, 8, 9, 10, 11 and 12 or command              
 ===>                                                                           
 F3=Exit      F4=Prompt   F5=Refresh   F9=Retrieve   F11=Display names only     
 F12=Cancel   F16=Repeat position to   F17=Position to 
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d. You might see a Display Program Messages display with the error message “Receiver 
QSQJRN0001 in LibraryName never fully saved. (I C)” when you delete the DB2 
Universal Database libraries. If that happens, type I to allow the deletion to continue. 
This might occur multiple times as shown in Figure 5-73.

Figure 5-73   Error message ‘Receiver QSQJRN0001 in ITSOWSE55 never fully saved. (I C)’ 

11.If you used a separate user profile to own all objects used by this Workplace Services 
Express server, you can delete it now. The Delete wizard does not delete the user profile. 
Enter the following Delete User Profile (DLTUSRPRF) CL command:

DLTUSRPRF USRPRF(DB2OwnerProfile) OWNOBJOPT(*DLT)

Here DB2OwnerProfile represents the name of the user profile that you specified during 
the configuration of the Workplace Services Express server.

You should now have no remaining references to the Workplace Services Express server.

                          Display Program Messages                            
                                                                               
Job 241463/AHOERLE/QPADEV0006 started on 10/20/05 at 08:48:45 in subsystem Q  
Maximum number of records reached for file QSYSPRT. (C R NOMAX 1-999999)      
NOMAX                                                                         
Receiver QSQJRN0001 in ITSOWSE55 never fully saved. (I C)                     
I                                                                             
Receiver QSQJRN0002 in ITSOWSE55 never fully saved. (I C)                     
I                                                                             
Receiver QSQJRN0002 in ITSOWSE54 never fully saved. (I C)                     
I                                                                             
Receiver QSQJRN0001 in ITSOWSE52 never fully saved. (I C)                     
I                                                                             
Receiver QSQJRN0001 in ITSOWSE54 never fully saved. (I C) 
                                                                               
                                                                               
 F3=Exit   F12=Cancel 

Attention: The OWNOBJOPT(*DLT) parameter in the previous DLTUSRPRF 
command removes all objects owned by that user profile. If you are using the same 
user profile to own the DB2 Universal Database data for other Workplace Services 
Express server, do not delete the profile at this time.
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Chapter 6. Integrating the Domino portlets

The purpose of this chapter is to:

� Introduce you to the portlets provided with Workplace Services Express

� Show you how to integrate Domino Web Access with Workplace Services Express

� Demonstrate how to create a Domino discussion database and integrate it with Workplace 
Services Express using the Domino Application portlet

6
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6.1  Supplied portlets with Workplace Services Express
Workplace Services Express provides many portlets that you can deploy in your Workplace 
Services Express environment. These portlets provide a vast number of functions. While 
some of the portlets are the core of Workplace Services Express, others provide functionality 
that is not provided in the base Workplace Services Express product.

For example, portlets are available to access Domino and other mail systems because the 
Workplace Services Express product does not include user mail and calendar functionality. 
Workplace Services Express is sold in conjunction with a WebSphere Portal server license. 
Because of this, you can download and install any portlet that runs on WebSphere Portal 
Server Version 5.0.2.2. For a list of all available portlets for download, visit the IBM 
WebSphere Portal solutions catalog at:

http://catalog.lotus.com/wps/portal/portal

To find portlets that are available for download specifically for Workplace Services Express, 
visit the IBM Workplace Services Express solutions catalog at:

http://catalog.lotus.com/wps/portal/wse

The following portlets are included with and available to deploy with Workplace Services 
Express:

� About IBM Workplace Services Express: This portlet provides information about the 
installed product and by default is only enabled for users with administrative access.

� Bookmarks: The IBM Bookmarks portlet displays bookmarks defined by the user in a Web 
browser. The user can add, delete, and edit bookmarks.

� Company Tracker portlet: This portlet allows you to select and manage a list of companies 
whose performance you are interested in tracking. It includes details on quotes, charts, 
news, and profile data.

� Domino Application portlet: The Domino Application portlet enables you to integrate any 
Web-enabled Domino application into WebSphere Portal. For information about deploying 
this portlet, refer to 6.4, “Using the Domino Application portlet” on page 192.

� Document Search: This portlet is installed but not placed on a page. It provides users 
access to the Portal Search Engine. Before Document Search can perform searches, the 
administrator must build the search index using Manage Search Index in Portal 
administration.

� Domino Web Access: This portlet helps users to view a Domino Web Access or iNotes™ 
mail file in Workplace Services Express. For information about deploying this portlet, refer 
to 6.2, “Configuring the Domino Web Access portlet” on page 175.

� Internet Mail Box: This portlet enables users to connect to an Internet Message Access 
Protocol (IMAP) or Post Office Protocol Version 3 (POP3) Internet-based mail server to 
receive, compose, and send Internet e-mail.

� Microsoft Exchange portlet application: This portlet application provides connectivity to 
the Microsoft Exchange server and consists of the following portlets:

– MS Exchange Mail portlet
– MS Exchange Calendar portlet
– MS Exchange Tasks portlet
– MS Exchange Contacts portlet
– MS Exchange Notes portlet

� My News: This portlet provides top headlines from a wide array of general, business, and 
industry news categories.
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� My Stock: The My Stock portlet displays financial performance and fundamental 
investment data for selected companies, investments, symbols, and indices.

� My Weather: The My Weather portlet displays weather-related data and forecasts for 
user-selected cities.

� My Vertical News: This portlet provides top headlines from a wide array of general, 
business, and industry news categories.

� Retirement Planner: The Retirement Planner is a goal-based tool that estimates your 
desired retirement income and estate and evaluates the savings plan required to fund that 
need.

6.2  Configuring the Domino Web Access portlet
This section explains how to configure the Domino Web Access portlet in the Workplace 
Services Express environment.

6.2.1  Setting up Domino for use with the Domino Web Access portlet
Before you can use the Domino Web Access portlet in Workplace Services Express, make 
sure that your Domino configuration meets the requirements for use with this portlet. Perform 
the following steps:

1. Verify that all mail files to be accessed from the portlet are using the Domino Web Access 
or iNotes template:

a. Open the Domino Administrator client and connect to your Domino server.

b. Click the Files tab.

c. Click the folder that contains your mail files. Typically this is the mail folder.

d. Scroll to the right and review the template name as shown in Figure 6-1. If you do not 
see iNotes6 or DWA7 in this column, you must convert your user’s mail file to use a 
Domino Web Access (inotes6.ntf or dwa7.ntf) template.

Figure 6-1   Viewing the mail file template name in the Files tab of the Domino Administrator

Note: The steps to configure the Domino Web Access portlet are the same for Domino 6.x 
and Domino 7.x.
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2. If necessary, update the design of the mail file to inotes6.ntf or dwa7.ntf using one of the 
following convert commands on the Domino server console. In this command, FileName 
represents the mail file name (see Example 6-1).

– For Domino 6.x, type the following command:

load convert mail/FileName.nsf * inotes6.ntf

– For Domino 7.x, type the following command:

load convert mail/FileName.nsf * dwa7.ntf

Example 6-1   Domino load convert utility

> Load convert mail/nadminis.nsf * inotes6.ntf
Load convert mail/nadminis.nsf * inotes6.ntf
10/13/2005 15:04:53   Mail Conversion Utility starting
10/13/2005 15:04:53   Mail Convert: Started replacing design template '*' with 'iNotes6' 
in 'mail/nadminis.nsf'
10/13/2005 15:04:55   Adding 'DOLS Configuration Settings' to database 'Notes 
Administrator' from template 'Domino Web Access (6)' 
'10/13/2005 15:04:55   Adding '(ToggleUpdate Tasks)' to database 'Notes Administrator' 
from template 'Domino Web Access (6)' 
10/13/2005 15:04:55   Adding '($Journal)' to database 'Notes Administrator' from 
template 'Domino Web Access (6)' 
10/13/2005 15:04:55   Adding '($Users)' to database 'Notes Administrator' from template 
'Domino Web Access (6)' 
10/13/2005 15:04:57   Mail Convert: Finished replacing design template in 
'mail/nadminis.nsf'
10/13/2005 15:04:57   Mail Conversion Utility shutdown

3. Add the appropriate fields to the Global Configuration document to allow LDAP queries for 
the HTTP host name, mail server, and mail file name fields:

a. From the Domino Administrator client, click the Configuration tab.

b. In the left frame, click Server → Configurations.

c. Double-click the Global Configuration document to open it. The global configuration 
document has a server name of * - [All Servers].

d. In the Global Configuration document, click the LDAP tab.

Tip: You can convert all files in the mail folder at one time by using one of the following 
commands:

� For Domino 6.x:

load convert mail/* * inotes6.ntf 

� For Domino 7.x:

load convert mail/* * dwa7.ntf 

Tip: You might have to scroll up to see the Global Configuration document. 
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e. The following fields should be listed under the LDAP Attribute Types column as shown 
in Figure 6-2:

• HTTP-HostName
• MailFile
• MailServer

Figure 6-2   LDAP tab of the Global Configuration document

If these fields are not listed, perform the following steps to add them:

a. Click Edit Server Configuration.
b. Click Select Attribute Types.
c. In the ObjectClasses field, type an asterisk (*).
d. Click Display Attributes.
e. Select the attributes HTTP-HostName, MailFile and MailServer.
f. Click Add.
g. Click OK to exit the LDAP Attribute Type Selection window.
h. Save and close the configuration document.
i. End the Domino server.
j. After the Domino server successfully ends, restart the Domino server.

Tip: These fields are listed only if you followed the steps in 3.4.2, “Modifying the 
LDAP configuration” on page 61.
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6.2.2  Configuring Workplace Services Express to use Domino Web Access 
portlet

To use the Domino Web Access portlet, you must make changes to the wpconfig.properties 
file as explained in the following steps:

1. Stop the Workplace Services Express WebSphere Portal server:

a. In an i5/OS command line, enter the STRQSH CL command to start the Qshell 
environment.

b. In the Qshell command line, enter the following command, replacing WSEServerName 
with the name of your Workplace Services Express server:

cd /qibm/userdata/webas5/Base/WSEServerName/PortalServer/rootscripts/subtasks

c. In the Qshell command line, enter the following command using the proper 
administrator ID and password for your Workplace Services Express server as shown 
in Example 6-2:

stopPortalServer.sh -user wpsadmin -password password

Example 6-2   Stopping the Workplace Services Express WebSphere Portal server

stopPortalServer.sh  -user wpsadmin -password password                               
ADMU0116I: Tool information is being logged in file                                  
           /QIBM/UserData/WebAS5/Base/itsowse2/logs/WebSphere_Portal/stopServer.log  
ADMU3100I: Reading configuration for server: WebSphere_Portal                        
ADMU3201I: Server stop request issued. Waiting for stop status.                      
ADMU4000I: Server WebSphere_Portal stop completed.                                   
$ 

2. After the Workplace Services Express WebSphere Portal server ends, edit the 
wpconfig.properties file to modify the Lotus Collaborative Components (LCC) properties:

a. Map a drive to your iSeries server.

b. Navigate to the /QIBM/UserData/WebAS5/Base/WSEServerName/PortalServer/config 
directory, where WSEServerName represents the name of your Workplace Services 
Express server.

c. Open the wpconfig.properties file in WordPad or another text editor program of your 
choice.

d. Modify the LCC.DominoDirectory.Enabled and LCC.DominoDirectory.Server 
properties to the following values:

i. Set LCC.DominoDirectory.Enabled to true.

ii. Set LCC.DominoDirectory.Server to match your Domino server name. In our 
environment, the Domino server is named itsodom6.rchland.ibm.com.

Tip: You can alternatively end the Workplace Services Express WebSphere Portal 
server using the IBM Web Administration for iSeries interface. See 5.1.2, “Stopping a 
Workplace Services Express server” on page 108.

Note: It might take several minutes for the WebSphere Portal server to end.
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Example 6-3 shows the settings for our example.

Example 6-3   Modified wpconfig.properties file

# LCC.DominoDirectory.Enabled: Is Lotus Domino Directory enabled in the environment?
# { true | false }
LCC.DominoDirectory.Enabled=true

# LCC.DominoDirectory.Server: The Lotus Domino Directory server name.
# { hostname | ip address }
LCC.DominoDirectory.Server=itsodom6.rchland.ibm.com

e. Save and close the wpconfig.properties file.

3. Run the configuration script to update your Workplace Services Express server with the 
new values that you entered in the wpconfig.properties file:

a. Return to the Qshell command line, or in an i5/OS command line, enter the command 
STRQSH to start Qshell.

b. In the Qshell command line, enter the following command, replacing WSEServerName 
with the name of your Workplace Services Express server:

cd /qibm/userdata/webas5/Base/WSEServerName/PortalServer/config

c. In the Qshell command line, enter the following command to update the configuration:

WPSconfig.sh lcc-configure-dominodirectory

You know that the command has completed when you see the message “BUILD 
SUCCESSFUL” as shown in Figure 6-3.

Figure 6-3   Successful completion of the WPSConfig.sh lcc-configure-dominodirectory command

Note: In our tests, we used a Domino Version 6.5.3 server and a Domino Version 
7.0 server. We saw no differences in the setup or configuration between the two 
Domino versions.

                               QSH Command Entry                                
                                                                                
   action-lcc-server-notcontacted-warning:                                      
                                                                                
   action-lcc-ssl-property-isboolean-test:                                      
                                                                                
   action-lcc-validate-ssl-property-isboolean:                                  
      [logmsg] 2005.10.14 15:09:14.820 action-lcc-update-dominodirectory-propert
   ies                                                                          
      [logmsg]   EJPC2543I Lotus Collaborative Services property file updates co
   mpleted for Lotus Domino Directory.                                          
                                                                                
                                                                                
   BUILD SUCCESSFUL                                                             
   Total time: 1 minute 8 seconds                                               
   $                                                                            
                                                                                
 ===> 
 F3=Exit   F6=Print F9=Retrieve F12=Disconnect                                  
 F13=Clear F17=Top  F18=Bottom  F21=CL command entry 
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4. Start the Workplace Services Express WebSphere Portal server:

a. If Qshell is not already started, enter the STRQSH command on an i5/OS command line 
to start Qshell.

b. In the Qshell command line, enter the following command, replacing WSEServerName 
with the name of your Workplace Services Express server:

cd /qibm/userdata/webas5/Base/WSEServerName/PortalServer/rootscripts/subtasks

c. In the Qshell command line, enter the following command to start the Workplace 
Services Express WebSphere Portal server.

startPortalServer.sh

d. You see the message “Application server started”, as shown in Figure 6-4, when 
your Workplace Services Express WebSphere Portal server successfully starts.

Figure 6-4   Workplace Services Express WebSphere Portal server successfully started

Tip: Alternatively, you can start the Workplace Services Express WebSphere Portal 
server via the IBM Web Administration for iSeries interface. See 5.1.1, “Starting a 
Workplace Services Express server” on page 106.

Note: It takes several minutes for the Workplace Services Express WebSphere 
Portal server to start.

                               QSH Command Entry                                
                                                                                
   ADMU0116I: Tool information is being logged in file                          
              /QIBM/UserData/WebAS5/Base/ITSOWSE2/logs/WebSphere_Portal/stopServ
   er.log                                                                       
   ADMU3100I: Reading configuration for server: WebSphere_Portal                
   ADMU3201I: Server stop request issued. Waiting for stop status.              
   ADMU4000I: Server WebSphere_Portal stop completed.                           
   $                                                                            
 > startportalserver.sh                                                         
   CPC1221: Job 217018/QEJBSVR/WEBSPHERE_ submitted to job queue QEJBJOBQ in    
   library QEJBAS5.                                                             
   EJB6123: Application server started.                                         
    Cause . . . . . :   Application server WebSphere_ in PME instance ITSOWSE2  
      has started and is ready to accept connections on admin port 10210.       
   $                                                                            
                                                                                
 ===>                                                                           
F3=Exit   F6=Print F9=Retrieve F12=Disconnect                                  
 F13=Clear F17=Top  F18=Bottom  F21=CL command entry 
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6.2.3  Configuring the Domino Web Access portlet
Use the following steps to help you add the Domino Web Access portlet to the Mail tab of a 
Workplace Services Express server:

1. Log into the Workplace Services Express server with the Workplace Services Express 
administrator user ID and password, for example wpsadmin.

2. Click the Mail tab and click the Add Content portlet, which is the bar on the lower right 
side of the pane as shown in Figure 6-5.

Figure 6-5   Selecting the Add Content portlet

Tip: If you log into Workplace Services Express as the Workplace Services Express 
administrator and configure the Domino Web Access portlet, the portlet is then ready 
for use by all users. If you log in as a user to perform the steps that follow, the portlet is 
configured only for that user.
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3. Scroll to the bottom of Add Content portlet pane and click Add as shown in Figure 6-6.

Figure 6-6   Clicking Add in the Add Content portlet pane

4. In the Add Content pane, in the Title contains field, type Domino and click Search as shown 
in Figure 6-7.

Figure 6-7   Searching for Domino portlets in the Add Content portlet pane
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5. Select Domino Web Access and click OK as shown in Figure 6-8.

Figure 6-8   Selecting the Domino Web Access portlet

6. You should now see Domino Web Access in the list of available portlets as shown in 
Figure 6-9. Drag the Domino Web Access portlet to the Mail tab. 

Figure 6-9   The Add Content portlet pane after Domino Web Access is added
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You see an orange bar when you are in the proper place to drop the portlet as shown in 
Figure 6-10.

Figure 6-10   Dragging and dropping the Domino Web Access portlet to the Mail tab

7. Your page changes to one of three possible choices:

– If your Workplace Services Express administrator has a mail file, it begins to load. If 
you have not configured single sign-on (SSO), you are prompted to enter a Domino 
user ID and password as shown in Figure 6-11. For information about configuring SSO, 
refer to Chapter 8, “Enabling SSO between Workplace Services Express and Domino” 
on page 237.

Figure 6-11   Domino Web Access portlet prompting for a user name and password

Note: After you drop the portlet onto the page, you might not see any activity in the 
Web browser. Be patient. The pane changes and the new portlet appears in a moment.
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– If your Workplace Services Express administrator has a mail file, it begins to load. If 
you have configured SSO, the mail file is displayed as shown in Figure 6-12.

Figure 6-12   Viewing the mail file for the Workplace Services Express administrator via the Domino Web Access portlet

– If your Workplace Services Express administrator does not have a mail file, you see a 
page like the example in Figure 6-13. If you want to test the portlet, log off Workplace 
Services Express and log in as a user with a valid mail file. You should see a page 
similar to the examples in Figure 6-11 or Figure 6-13.

Figure 6-13   Domino Web Access portlet for the Workplace Services Express administrator with no Domino mail file

 

 

 

Chapter 6. Integrating the Domino portlets 185



 

8. By default, the Domino Web Access portlet tries to automatically locate the mail file. This 
is why we had add the HTTP-HostName, MailServer and MailFile fields to the LDAP 
schema in Domino. If you do not want Workplace Services Express to automatically locate 
the mail file, you can edit the portlet to manually select the mail file. Be aware that if you 
choose this option, you must manually configure the portlet for every user in the 
Workplace Express environment.

If you choose to let the server automatically find the mail file, you can configure one and 
have it work for everyone with a valid mail file name in the Person document on the 
Domino server. If you plan to let the portlet automatically detect the mail file, you can skip 
to step 9 on page 187. To manually configure the portlet, perform the following steps:

a. Click the edit icon (the pencil) located in the top right corner of the portlet page. This 
loads a page that allows you to modify the configuration of the Domino Web Access 
portlet.

b. In the Domino Web Access pane, click Let me manually select my mail database.

c. Click your Domino server name if it appears in the Server list, or enter the fully qualified 
Internet host name of the Domino server. In our example, the Domino server’s fully 
qualified host name is itsodom70.rchland.ibm.com. After you select or enter the 
Domino server’s host name, click the check mark to select the server as shown in 
Figure 6-14.

Figure 6-14   Selecting the Domino server’s host name when editing the Domino Web Access portlet
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d. In the Database field, you now see an error message that indicates that the database 
was not found or could not be retrieved. Ignore this message. 

In the Database filename field, enter the path to the mail database. For example, our 
mail file is named wpsadmin.nsf and is located in the mail directory of the Domino 
server. The value that we enter in the Database filename field is mail/wpsadmin.nsf as 
shown in Figure 6-15.

Figure 6-15   Entering the mail database filename for the Domino Web Access portlet

e. Click Save to save your changes.

f. You are either prompted to log into the Domino server, or if you have configured SSO, 
the mail file is displayed. Refer to Figure 6-11 on page 184 or Figure 6-13 on page 185. 
For assistance in configuring SSO, refer to Chapter 8, “Enabling SSO between 
Workplace Services Express and Domino” on page 237.

9. At this time, a user can now use the Domino Web Access portlet to send and receive mail. 
However, the user does not have access to calendar or address book functionality. The 
remaining steps explain how to configure the Domino Web Access portlet to access the 
calendar and address book (contacts). We start with the calendar function. Under the 
Workplace Services Express Mail tab, click Calendar as shown in Figure 6-16.

Figure 6-16   Workplace Services Express Calendar page
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10.Click the Add Content portlet window. Drag the Domino Web Access portlet to the 
Calendar Information page. You see an orange bar when you are in a place where you 
can drop the portlet. For assistance with this step, refer to step 6 on page 183.

11.Edit the Domino Web Access portlet to view the calendar information. Click the edit icon 
(the pencil) located in the upper right corner of the portlet window.

12.In the Domino Web Access pane (Figure 6-17), for Functional Area field, select Calendar 
and optionally change the Start with field. In our example, we set the Start with field to 
One Week. If you are not allowing the server to automatically select the mail file, you must 
manually select the mail file. For assistance with manually selecting the mail file, refer to 
step 8 on page 186. Click Save to save your changes.

Figure 6-17   Editing the Domino Web Access portlet for calendar use

You should now be able to access your personal calendar as shown in Figure 6-18.

Figure 6-18   Viewing the calendar via the Domino Web Access portlet

13.Configure the address book. Under the Workplace Services Express Mail tab, click 
Address Book.
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14.Click the Add Content portlet window. Drag the Domino Web Access portlet to the 
Address Book page. You see an orange bar appear when you are in a place where you 
can drop the portlet. For assistance with this step, refer to step 6 on page 183.

15.Edit the Domino Web Access portlet to view the address book information. Click the edit 
icon (the pencil) located in the upper right corner of the portlet window.

16.In the Domino Web Access pane (Figure 6-19), for Functional Area, select Contacts. If 
you are not allowing the server to automatically select the mail file, you must manually 
select the mail file. For assistance on manually selecting the mail file, refer to step 8 on 
page 186. Click Save to save your changes

Figure 6-19   Configuring the Domino Web Access portlet to view contacts

You should now be able to access your personal contacts as shown in Figure 6-20.

Figure 6-20   Viewing the address book via the Domino Web Access portlet
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17.Now that you have configured the Domino Web Access portlet on the Mail, Calendar and 
Address Book pages, you might want to have the informational message displayed in the 
Information portlet that appears on each of those pages to be removed. Since you are 
currently on the Address Book page, we show you how to edit the Address Book page to 
remove the Address Book Information portlet. You can then use the same steps to edit the 
Mail and Calendar pages to remove their Information portlets.

To edit the Address Book page, click Actions → Edit Page as shown in Figure 6-21.

Figure 6-21   Selecting the Edit Page option for the Address Book page

18.Click the trash can icon, next to the Address Book Information portlet, to remove the 
Address Book Information portlet from the Address Book page. See Figure 6-22.

Figure 6-22   Removing the Address Book Information portlet

Tip: An alternate method to remove the Address Book Information portlet is to use the 
trash can in the portlet title bar. If you use this option, you can skip to step 22 on 
page 191.
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19.You are prompted to confirm that you want to remove the Address Book Information portlet 
as shown in Figure 6-23. Click OK to remove the portlet.

Figure 6-23   Confirming deletion of the Address Book Information portlet

20.On the Edit Layout page, click Done to complete your changes.

21.You return to the Address Book page where you can confirm that you no longer see the 
Address Book Informational portlet on the Address Book page.

22.Edit the following pages to remove the Information portlets as explained in the previous 
steps:

– Mail
– Calendar

6.3  Portalizing Domino applications
Customers with previous investments in a Domino infrastructure might have existing Domino 
applications. There are several techniques that allow those applications to be displayed and 
used inside Workplace Services Express, therefore leveraging the investment made on the 
Domino infrastructure. These techniques insert the application into a portlet, which is then 
displayed according to the user’s role and context inside the portal.

This section discusses the different options to portalize an existing Domino application. It 
shows an example of portalizing a Domino application using the Domino Application portlet. 
This portlet provides a way to display an existing Domino application and does not require a 
programming effort. 

For more information about the Domino Application portlet, refer to the IBM Redpaper IBM 
Lotus Domino Application Portlet: Configuration and Tips, REDP-3917.

6.3.1  Options for portalizing Domino applications
To portalize an existing Domino application, consider the options in the following list. 
Choosing one depends on the application, the user’s expertise, and whether changes to the 
application code are necessary. 

� Existing Domino portlets

Several existing Domino specific-portlets are available to access typical Domino 
databases, such as a mail file database. If a portlet already exists, this is a good choice for 
portalizing the application. An example of this technique is the Domino Web Access 
portlet, which is used to access the user’s mail file.
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� Domino Application portlet

You can configure this portlet to access a Domino application on a Domino server. This 
portlet has some advantages, including SSO authentication and caching options. This 
option does not require a programming effort and can be easily deployed.

When this portlet is called, the portal makes a request to the Domino server. The retrieved 
information is transformed to redirect any references to the Domino server to the portal 
server. The modified content is then displayed in the Web browser. For details about this 
option, see 6.4, “Using the Domino Application portlet” on page 192.

� Exposing Domino applications as a Web service

To expose Domino applications as a Web service, a Web service must be created that 
accesses the Domino information. Then a new portlet is programmed that consumes that 
Web service. This has the advantage that if the Domino application is already exposed as 
a Web service, the portlet programmer does not need Domino experience since the 
objective is only to consume a Web service.

� Using the Lotus Collaborative Services application programming interface (API)

Another option is to program a new portlet that uses the Lotus Collaborative Services API. 
By using this option, programmers can include typical collaborative functions present in 
the Domino environment on their applications.

6.4  Using the Domino Application portlet
The Domino Application portlet is one of the options for portalizing Domino applications. This 
portlet is installed by default on the Workplace Services Express server, and to be used, it 
must only be deployed and configured.

Perform the following steps to configure a new discussion database in Domino and to access 
that database using the Domino Application portlet:

1. In our example, we create a new discussion database. From the Lotus Notes client, press 
Ctrl+N or select File → Database → New.

2. In the New Database window, complete the values as shown in Figure 6-24. Make sure 
you are saving the database on the Domino server. For our example, we use a Domino 
server called dom654, which is in the organization called itso654. After you complete the 
information, click OK. The discussion database is now created on the Domino server.
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Figure 6-24   Creating a new discussion database on the Domino server

3. To test the new discussion database, open it and write a new message. 

To open the database from the Lotus Notes client:

a. Select File → Database → Open. 
b. Select the correct Domino server and file name. 
c. Click Open. 

4. After the Discussion database opens, click New Main Topic and write a new topic. 
Figure 6-25 shows an example. 

Figure 6-25   Creating a new topic in the discussion database
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5. After you create and test the database, open a Web browser and log into the Workplace 
Services Express server with an administrative account. In our example, we use wpsadmin 
as shown in Figure 6-26.

Figure 6-26   Logging in to the Workplace Services Express server as the administrator

6. It is considered a best practice to clone the Domino Application portlet before you deploy 
it, since details of the Domino server and database which the portlet should access are 
stored in the portlet’s global configuration. Cloning the portlet allows you to have several 
instances of the Domino Application portlet, each with its own configuration pointing to a 
different Domino application.

To make a clone of the portlet:

a. Navigate to Administration → Portlets → Manage Portlets. 
b. Find the Domino Application portlet in the list (or search for it) and select it. 
c. Click Copy. 

A new clone of the portlet is generated. See Figure 6-27 for an example.

Figure 6-27   Copying a portlet

Important: If you do not clone the portlet and the same portlet is later deployed, there 
can be a conflict to which database the portlet is pointing to. Therefore, we recommend 
that you always clone the portlet before you deploy it. 
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7. You see a message (Figure 6-28) stating that the portlet cloned successfully on top of the 
page. 

Figure 6-28   Portlet cloned successfully message

8. Modify the parameters. Make sure you have selected the new portlet from the list, and 
click Modify parameters, as shown in Figure 6-29.

Figure 6-29   Modifying a portlet’s parameters

9. The parameter to change is the title of the portlet. Although it is not necessary to make this 
change, it is considered a best practice to do so. Using a different name makes the portlet 
easier to search for and provides a name relative to its use. In the Modify parameters 
page, scroll down to the Edit Locale Specific Titles section and make sure English is 
selected. Then click Set title for selected locale. See Figure 6-30.

Figure 6-30   Modifying a portlet’s title

Note: To make sure you are selecting the new clone, check the portlet’s unique number 
after its name. The new clone has a different end letter, lower than the original. In our 
case, the original portlet had 3_0_B8, and the new one has 3_0_CI. 
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10.Type a new name for the portlet and click OK as shown in Figure 6-31.

Figure 6-31   Typing a new name for the cloned portlet

11.On the Parameters page, click Save.

12.Add the portlet to a page. A new label and page are created for this purpose. From the 
Administrative pages of Workplace Services Express server, navigate to Portal User 
Interface → Manage Pages and select the My portal link. This places you inside the 
portal hierarchy of pages.

13.Click New label. See Figure 6-32.

Figure 6-32   Creating a new label

Important: This step only changes the title for the English language. If users will 
access the portal in other languages, we recommend that you also change those titles.

Note: Your portal hierarchy of pages can be different than the example shown in 
Figure 6-32 if changes were made to the default configuration of pages.

 

 

 

196 Deploying IBM Workplace Services Express on the IBM Eserver iSeries Server



 

14.On the Page Properties pane (Figure 6-33), type a new name for the label and click OK. 

Figure 6-33   Naming the new label

15.A message confirms the creation of the label as shown in Figure 6-34.

Figure 6-34   Confirming the creation of the new label
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16.Create a new page within the new label. Click the newly created label as shown in 
Figure 6-35.

Figure 6-35   Accessing the new label

17.In the Manage Pages pane (Figure 6-36), click New Page.

Figure 6-36   Creating a new page
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18.In the Page Properties pane (Figure 6-37), for Title, type Discussion for the new page and 
click OK. 

Figure 6-37   Naming the new page

19.A message confirms that the page is successfully created as shown in Figure 6-38.

Figure 6-38   Message confirming creation of the new page

20.Navigate to the new page. Click the My Work link and select the Domino Application 
Portlet → Discussion page. 
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21.The portlet that we just created is not in the portlet list, so we must add it to the page as 
shown in Figure 6-39. 

a. Open the portlet list on the right side of the page.
b. Click Search at the bottom of the panel.
c. Type domino.
d. Select Discussion - Domino Application Portlet. 
e. Click OK.

Figure 6-39   Selecting the new portlet
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22.The new portlet is now displayed in the list, as shown on Figure 6-40. 

Figure 6-40   Selecting the new portlet

Drag it to the top of the page to deploy it. See Figure 6-41. 

Figure 6-41   Dropping the new portlet into the page to deploy it

23.With the new portlet now deployed onto the page, configure it. 

a. Click the wrench icon located in the upper right side of the portlet as shown on 
Figure 6-42.

Figure 6-42   Accessing the portlet configuration mode

 

 

 

Chapter 6. Integrating the Domino portlets 201



 

b. On the Source and Display tab, set the source and display properties. This is the host 
name of the Domino server and the name and path of the Domino database that we 
are accessing. We use the values shown in Figure 6-43.

Figure 6-43   Configuring source and display options
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c. Click the Authentication tab. In our environment, SSO is already configured. 
Therefore we choose Single Sign-On (SSO) as the authentication mechanism. Click 
Save. See Figure 6-44.

Figure 6-44   Configuring authentication 

Note: For more information about configuring SSO, refer to Chapter 8, “Enabling 
SSO between Workplace Services Express and Domino” on page 237.
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d. If you see a warning security message (Figure 6-45), click Yes.

Figure 6-45   Security warning

e. The new portlet is configured and displayed on the page (Figure 6-46). You can see 
that the topic posted in the Discussion database, as done in step 3 on page 193, is 
displayed.

Figure 6-46   Domino Application portlet displaying Discussion database
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24.To test the portlet using a non-administrator user:

a. Log out of Workplace Services Express server and login again with another user. 
b. Navigate to the Domino Application Portlet tab and click New Main topic. 
c. Write a subject and some content. 
d. Click Save & Close, as shown in Figure 6-47. 

Figure 6-47   Creating a new topic in the Domino Discussion database

25.Both topics should now appear in the view (Figure 6-48). The same view is shown from 
the Lotus Notes client in Figure 6-49. Note that both views are the same; the difference is 
the client.

Figure 6-48   Discussion database view from Workplace Services Express
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Figure 6-49   Discussion database view from the Lotus Notes client

6.5  Portalizing non-Domino applications
Although this chapter explains how to portalize an existing Domino application, the concepts 
covered here can be applied to non-Domino applications, such as RPG or COBOL 
applications. There are several techniques to portalize other applications:

� To create portlets to run RPG and COBOL applications on your iSeries server, you can 
create a new portlet using the WebSphere Development Studio Client for iSeries. For 
more information, see the following Web site:

http://www.ibm.com/software/awdtools/wdt400/

� Expose the application as a set of Web services and build a portlet that consumes those 
Web services.

� Build a new portlet based either on the IBM Portlet API or the JSR 168 standard. For more 
information about building new portlets, refer to the IBM Redbook IBM Rational 
Application Developer V6 Portlet Application Development and Portal Tools, SG24-6681.

� Use an existing portlet. Many portlets are available in the IBM Workplace Solution Catalog 
on the Web at:

http://catalog.lotus.com/wps/portal/portal

� Use a portlet builder. Several companies provide portlet builders. These are applications 
that generate a customized portlet based on specified input, such as data sources and 
types. Some of these applications are also portlets, so the new portlets can be built inside 
Workplace Services Express.

Choosing which technique to use depends on the existing application, whether there are 
available portlets to access that application, and your knowledge and experience of J2EE 
development.
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Chapter 7. Integrating iSeries Access for 
Web portlets

The V5R3 release of iSeries Access for Web provides a number of portlets that you can use 
in a Workplace Services Express on iSeries environment. These portlets can help to quickly 
integrate your existing 5250 character-based applications into your Workplace Services 
Express environment and provide a portlet-based interface to administer your iSeries server.

iSeries Access for Web V5R3 provides the following portlets:

� 5250 portlet
� Commands portlet
� Database tables and SQL portlets
� iFrame portlet
� Integrated file system browsing portlets
� Printer portlets

The process of integrating the iSeries Access for Web portlets into a Workplace Services 
Express environment varies depending on the following criteria:

� The authentication method that you plan to use with the portlets

� Whether you already have iSeries Access for Web configured on a separate WebSphere 
Application Server instance

� Whether you selected the iSeries Access for Web portlets component when configuring 
your Workplace Services Express server

7
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Figure 7-1 shows the choices that you must make when configuring the iSeries Access for 
Web portlets.

Figure 7-1   Integrating iSeries Access for Web portlets into a Workplace Services Express environment

Since the Workplace Services Express user directory is managed separately from the i5/OS 
user profile registry, the iSeries Access for Web portlets must authenticate users to your 
i5/OS server before they can access the iSeries Access for Web portlets.
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The iSeries Access for Web portlets can authenticate users with any of the following 
methods:

� Using a credential specific to a particular portlet window
� Using a credential set with the iSeries credentials portlet
� Using a shared credential set by the Workplace Services Express administrator
� Using the current user’s Workplace Services Express credential mapped to an i5/OS user 

profile by Enterprise Identity Mapping (EIM)

The first three methods involve using a user name and password, which are either entered 
directly by the user or set by the Workplace Services Express administrator. The fourth 
method associates i5/OS user profiles with Workplace Services Express users by using EIM. 
If you use this method of authentication, after a user has authenticated to Workplace Services 
Express, they do not have to provide any further credentials to allow the iSeries Access for 
Web portlets to access information about your iSeries server.

If you plan on using Workplace Services Express user credentials mapped to i5/OS user 
profiles by EIM for authentication, refer to 7.1, “Configuring EIM for use with the iSeries 
Access portlets” on page 209, before you configure iSeries Access for Web. If you plan to use 
any of the other methods, refer to 7.2, “Configuring iSeries Access for Web” on page 223, for 
information about how to configure authentication.

7.1  Configuring EIM for use with the iSeries Access portlets
By using EIM with Workplace Services Express and the iSeries Access for Web portlets, a 
user can log in to Workplace Services Express and is automatically authenticated to i5/OS 
with an i5/OS user profile specific to this Workplace Services Express user. EIM achieves this 
by mapping entries in the Lightweight Directory Access Protocol (LDAP) directory to entries in 
the i5/OS user profile registry.

Configuring EIM to work with the iSeries Access for Web portlets in Workplace Services 
Express involves:

� Configuring EIM on your iSeries server
� Creating a new EIM domain
� Adding the Workplace Services Express user registry to the EIM domain
� Creating EIM identifiers for the Workplace Services Express users
� Associating users from the Workplace Services Express user registry with entries in the 

i5/OS user profile registry

Perform the following steps to configure EIM for use with Workplace Services Express:

1. Make sure that the IBM Directory Server is configured on your iSeries server. IBM 
Directory Server is used to store EIM domain configuration data and to access information 
about i5/OS user profiles. See Appendix B, “Setting up IBM Directory Server for i5/OS” on 
page 343, for information about configuring IBM Directory Server.

2. Create an EIM domain. An EIM domain stores information about user registries, user 
identifiers, and the mappings between entries in the user registries. In a Workplace 
Services Express environment, the registries used are the Workplace Services Express 
user registry, stored on an LDAP server, and the i5/OS user profile registry. Perform the 
following steps to create a new EIM domain:
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a. Open iSeries Navigator and expand My Connections → iSeries server name → 
Network → Enterprise Identity Mapping.

b. Right-click Configuration and select Configure. The EIM configuration wizard starts.

If the Configure option is not available, you can select Reconfigure. Be aware that 
reconfiguring EIM overwrites the previous EIM configuration.

c. A Welcome window opens that describes the configuration options that are available 
(Figure 7-2). Select Create and join a new domain and click Next.

Figure 7-2   Selecting to create and join a new EIM domain

d. EIM can use either a local or remote directory server to store domain configuration 
information. In our example, we use the local IBM Directory Server and select On the 
local directory server (Figure 7-3). Click Next.

Figure 7-3   Selecting where to configure an EIM domain
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e. The wizard prompts you to choose whether to configure the Network Authentication 
Service (Figure 7-4). EIM can be integrated with the Kerberos Network Authentication 
System to allow single sign-on (SSO) from local workstations. You are not required to 
set up EIM to work with Workplace Services Express. If you need information about 
integrating EIM into a Kerberos environment, see the iSeries Information Center at 

http://publib.boulder.ibm.com/infocenter/iseries/v5r3/index.jsp

Select No and click Next.

Figure 7-4   Selecting whether to configure the Network Authentication Service
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f. In the next window, the wizard prompts for the distinguished name and password of a 
user to authenticate to the directory server with while configuring EIM (Figure 7-5). 

Enter the LDAP administrative user ID and password. If you do not know the LDAP 
administrative user’s password, see  “Managing the IBM Directory Server on i5/OS” on 
page 344 for information about how to reset the password. 

After you complete the values, click Next.

Figure 7-5   Specifying the LDAP administrator ID
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g. In the next window, enter a name for the EIM domain which you are about to create 
(Figure 7-6). Click Next.

Figure 7-6   Specifying a name for the new EIM domain

h. The EIM Configuration Wizard prompts you to enter a parent distinguished name (DN) 
for the EIM domain information in your LDAP directory (Figure 7-7). If you select Yes, 
you can specify where to store the EIM domain configuration information in your LDAP 
directory. Unless you have a specific reason to store the domain information in a 
location other than in a container in the root of your LDAP directory, select No and click 
Next.

Figure 7-7   Option to specify the parent DN for the EIM domain
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i. If the directory server is started, a warning message is displayed, indicating that the 
wizard will restart the directory server when configuring the EIM domain. If this 
message appears, click Yes.

j. In the window that opens, the wizard prompts you to select the user registries to add to 
the new EIM domain (Figure 7-8). At this point, we add the i5/OS user profile registry to 
the EIM domain. 

Select Local OS/400, and enter the fully qualified host name associated with the IP 
address to which the IBM Directory Server is bound on your iSeries server. If you do 
not know which IP address the directory server is bound to, see Appendix B, “Setting 
up IBM Directory Server for i5/OS” on page 343. Click Next to continue.

Figure 7-8   Entering the host name to which the IBM Directory Server is bound 
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k. EIM is used by several i5/OS functions. To access the EIM domain controller, i5/OS 
must authenticate to it as an LDAP user. The wizard prompts for the distinguished 
name and password of the user to use (Figure 7-9). 

In the Distinguished name field, enter the distinguished name of the LDAP 
administrative user. In the Password and Confirm password fields, enter the password 
for the LDAP administrative user. Then click Next.

Figure 7-9   Specifying an LDAP user for i5/OS to use when accessing the EIM domain

l. In the summary page that opens, review the information and click Finish to start the 
configuration of a new EIM domain.

m. While the EIM domain is being configured, a progress window opens. This window 
closes, and you return to iSeries Navigator after the new EIM domain is configured.

3. The newly created EIM domain might not be listed in Domain Management in iSeries 
Navigator. If it is not, you can add the new EIM domain to Domain Management by 
performing the following steps:

a. Open iSeries Navigator and expand My Connections → iSeries server name → 
Network → Enterprise Identity Mapping.

If possible, expand the Domain Management item and check whether your new EIM 
domain is already added.

b. Right-click Domain Management and select Add Domain.
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c. In the Add Domain window (Figure 7-10), make sure that the Domain Controller field is 
filled in with the fully qualified host name of your iSeries server. Click Browse to view a 
list of available domains.

Figure 7-10   Add Domain window

d. The window that opens prompts you for credentials with which to connect to the LDAP 
directory on the domain controller (Figure 7-11). Enter the LDAP administrative user’s 
distinguished name and password. Then click OK.

Figure 7-11   Entering credentials to connect to the EIM domain controller
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e. In the Browse EIM Domains window, a list of available EIM domains is displayed 
(Figure 7-12). Select the newly created EIM domain and click OK.

Figure 7-12   Browsing the list of EIM domains

f. You return to the Add domain window (Figure 7-10). Click OK to add the EIM domain to 
Domain Management.

4. Add the Workplace Services Express user registry to the newly created EIM domain. User 
entries in the Workplace Services Express registry are mapped to entries in the i5/OS 
user registry to authenticate Workplace Services Express users to i5/OS.

Perform the following steps to add the user registry:

a. Open iSeries Navigator.

b. Expand My Connections → iSeries server name → Network → Enterprise Identity 
Mapping → Domain Management → Domain (where Domain is the name of the EIM 
domain that you just created). Right-click User Registries and select Add Registry → 
System (Figure 7-13).

Figure 7-13   Adding a new system registry
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c. In the add registry window (Figure 7-14), complete the fields as follows: 

i. In the Registry field, enter a name for the registry. For example, we enter Workplace 
Services Express Users.

ii. From the Type list, select 1.3.18.0.2.33.14-caseIgnore.

iii. In the Description field, enter a description of the registry.

iv. Enter the Uniform Resource Locator (URL) of the location in your LDAP directory 
where Workplace Services Express user account information is stored. If you are 
using the IBM Directory server to store Workplace Services Express user 
information and chose the default containers, this should be in the form:

ldap://servername:port/cn=users,dc=server,dc=domain,dc=tld

Here servername is the fully qualified host name to which IBM Directory Server is 
bound. Port is the port to which IBM Directory Server is bound. This is 389 by 
default. And server, domain, and tld are the subcomponents of your IBM Directory 
Server’s fully qualified host name.

If you are using Domino to store Workplace Services Express user information, the 
LDAP URL is in the form:

ldap://servername:port/o=organization

Here servername is the fully qualified host name of your Domino server. Port is the 
port to which your Domino LDAP server is bound. This is 389 by default. And 
organization is the Domino organization where your Workplace Services Express 
users are stored.

v. Click OK.

Figure 7-14   Entering details of the new system registry

 

 

 

218 Deploying IBM Workplace Services Express on the IBM Eserver iSeries Server



 

5. Create an EIM identifier for each Workplace Services Express user that will use the 
iSeries Access for Web portlets. An EIM identifier links an entry in the Workplace 
Services Express user registry to an entry in the i5/OS user registry, allowing users 
authenticated to Workplace Services Express to be authenticated to i5/OS with an i5/OS 
user profile.

Perform the following steps to create a new EIM identifier and add an association from a 
Workplace Services Express user to an i5/OS user profile to it:

a. Open iSeries Navigator.

b. Expand My Connections → iSeries server name → Network → Enterprise Identity 
Mapping → Domain Management → Domain (where Domain is the name of the EIM 
domain which you created in step 2). Right-click Identifiers and select New Identifier 
(Figure 7-15).

Figure 7-15   Creating a new EIM Identifier
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c. In the New Identifier window (Figure 7-16), in the Identifier field, enter a name for the 
new identifier. This is purely for recognition purposes and is not required to match a 
user’s Workplace Services Express user name or their i5/OS user profile. Click OK.

Figure 7-16   Specifying details of the new Identifier

d. A list of identifiers is displayed in the right pane. Double-click the identifier that you just 
created.

e. In the identifier Properties window (Figure 7-17), click the Associations tab.

i. Click Add to add the source association.

Figure 7-17   Identifier Properties window
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ii. In the Add Association window (Figure 7-18), you can specify the registry from 
which to retrieve the user entry, details of the user entry in the registry, and the type 
of association that you want to create.

Click the Browse button next to the Registry field to see a list of configured 
registries.

Figure 7-18   Add Association window

iii. From the registry list (Figure 7-19), select the Workplace Services Express user 
registry that you created in step 4 on page 217 and click OK.

Figure 7-19   Selecting the Workplace Services Express user registry

iv. You return to the Add Association window (Figure 7-18). In the User field, enter the 
Workplace Services Express user name of the user for which you are creating the 
association.

From the Association Type drop-down list, select Source and click OK.

Note: Clicking the Browse button does not allow you to select the user from a 
list.
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f. You return to the Identifier Properties window, in which you can now see that the 
Workplace Services Express source user association is now listed (Figure 7-20). Click 
Add to add a target association which associates the Workplace Services Express 
user with an i5/OS user profile.

Figure 7-20   Identifier Properties window with the source association added

i. In the Add Association window, click Browse next to the Registry field to see a list 
of configured registries.

ii. From the registry list, select the i5/OS user registry (Figure 7-21). This typically has 
the same name as the fully qualified domain name of your iSeries server. Click OK.

Figure 7-21   Selecting the target association registry

iii. You return to the Add Association window. In the User field, enter the i5/OS user 
profile name that you want to associate with the Workplace Services Express user. 
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From the Association Type dropdown list, select Target and click OK.

g. You return to the Identifier Properties window. Click OK to save the identifier.

7.2  Configuring iSeries Access for Web
Some of the iSeries Access for Web portlets rely on the iSeries Access for Web servlets to 
provide functionality. These portlets require iSeries Access for Web to be configured on your 
iSeries server.

If you already have iSeries Access for Web configured with a separate WebSphere 
Application Server instance, your Workplace Services Express instance uses the existing 
configuration. If you have not yet configured iSeries Access for Web, complete these steps:

1. Access the IBM Web Administration for iSeries by pointing your Web browser to your fully 
qualified iSeries host name on port 2001:

http://iSeriesHostName.domain:2001

In our example, we enter:

http://rchas12.rchland.ibm.com:2001

2. When prompted, enter your i5/OS user profile and password to log on to the IBM Web 
Administration for iSeries. Click OK.

3. In the iSeries Tasks menu, click IBM Web Administration for iSeries. You return to the 
last server that you administered.

4. Click the Setup tab. Then in the Common Tasks and Wizards menu, in the left pane, 
select Create Application Server. See Figure 7-22.

Figure 7-22   Creating a new application server

Note: Clicking the Browse button does not allow you to select the user profile 
from a list.
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5. The next pane summarizes the process of creating a new application server (Figure 7-23). 
Click Next.

Figure 7-23   Create Application Server wizard

6. The next pane displays a list of application server versions that are available on your 
iSeries server (Figure 7-24). Select V5.0 Base from the list and click Next.

Figure 7-24   Selecting WebSphere Application Server V5.0 Base
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7. In the Application Server Name field, enter a name for the new application server 
(Figure 7-25). For our example, we use iSeriesWebAccess. Take note of this value 
because it is required later. Click Next.

Figure 7-25   Entering a name for the new Application Server

8. In the Select HTTP Server Type pane (Figure 7-26), select Create a new HTTP Server 
(powered by Apache) and click Next.

Figure 7-26   Selecting to create a new HTTP server
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9. In the HTTP server Name field, enter a name for the new HTTP Server (Figure 7-27). For 
our example, we use IWAHTTP. Take note of this value because it is required later. Leave 
the default values in the other fields in this pane. Click Next.

Figure 7-27   Entering a name for the new HTTP server

10.In the next pane, the wizard prompts for a port range to use with the new Application 
server. Retain the default value and click Next.

11.The wizard then prompts for sample applications to install (Figure 7-28). Deselect all the 
check boxes that are enabled and click Next.

Figure 7-28   Selecting sample applications to deploy to the new Application Server

12.In the next pane, the wizard prompts you to configure Identity Tokens. Select Do not 
Configure Identity Tokens. EIM cannot be used with the iSeries Access for Web servlets 
when they are used inside the iFrame portlets. Click Next to continue.
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13.A summary page (Figure 7-29) is displayed. Click Finish to create the new Application 
Server.

Figure 7-29   Summary page

14.The wizard creates the new Application server. After the server is created, click the start 
button to start the server (Figure 7-30).

Figure 7-30   Starting the new application server

15.Open a 5250 emulation session and log on to your iSeries server.
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16.Enter the following CL command to configure the iSeries Access for Web servlets on the 
newly created Application server:

QIWA2/CFGACCWEB2 APPSVRTYPE(*WAS50) WASINST(iSeriesWebAccess) APPSVR(iSeriesWebAccess) 
NODENAME(iSeriesServer_iSeriesWebAccess) 

Here iSeriesWebAccess is the name of your new application server, and iSeriesServer is 
the short name of your iSeries server host name. For our example, we use this command:

QIWA2/CFGACCWEB2 APPSVRTYPE(*WAS50) WASINST(iSeriesWebAccess) APPSVR(iSeriesWebAccess) 
NODENAME(RCHAS55_iSeriesWebAccess)

17.The CFGACCWEB2 command runs and displays some output. After it finishes, return to 
the IBM Web Administration for iSeries page in your Web browser.

18.Click the stop button to shut down the newly created application server.

19.Click the start button to restart the newly created application server.

7.3  Installing the iSeries Access for Web portlets

If you did not select the iSeries Access for Web portlets when configuring your Workplace 
Services Express server, you can install the portlets on an existing Workplace Services 
Express server by performing the following steps:

1. Make sure that your Workplace Services Express server is running. You can do this 
through the IBM Web Administration for iSeries interface. See 5.3 “Verifying a Workplace 
Services Express server is active” on page 112, for details.

2. Open a 5250 emulation session and log on to your iSeries server.

3. Enter the STRQSH CL command to start the Qshell environment.

4. Change directory to the iSeries Access for Web install directory by entering the following 
command:

cd /QIBM/ProdData/Access/Web2/install

5. Run the cfgaccweb2 command as follows to configure iSeries Access for Web to work with 
your Workplace Services Express server:

cfgaccweb2 -appsvrtype *WSE -wasinst INSTANCE -wpusrid WPSADMIN -wppwd WPPASSWORD -wpurl 
server:port/lwp/config -wppag *YES

You must substitute the following parameters in the cfgaccweb2 command with your 
environment’s respective information:

– INSTANCE: The name of the Workplace Services Express server for which you are 
configuring iSeries Access for Web

– WPSADMIN: The Workplace Services Express administrative user ID which you 
specified when configuring your Workplace Services Express server

– WPPASSWORD: The password which you assigned to the Workplace Services 
Express administrative user

– server: The fully qualified host name of the HTTP server which you assigned to your 
Workplace Services Express server

Important: If you selected the iSeries Access for Web portlets option when configuring 
your Workplace Services Express server (see Figure 4-20 on page 89), the portlets are 
already installed in your Workplace Services Express server and you can skip this section.
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– port: The port on which the HTTP server assigned to this Workplace Services Express 
instance is running

This is typically port 80, unless you specified a nonstandard port when configuring your 
Workplace Services Express server.

For our example, we entered the following command:

cfgaccweb2 -appsvrtype *WSE -wasinst ITSOWSE1 -wpusrid wpsadmin -wppwd password -wpurl 
itsowse1.rchland.ibm.com/lwp/config -wppag *YES

6. The cfgaccweb2 command runs and several messages are displayed (Figure 7-31). After 
the cfgaccweb2 command completes, iSeries Access for Web is configured on your 
Workplace Services Express server.

Figure 7-31   Output of the cfgaccweb2 command

7.4  Configuring the iSeries Access for Web portlets
After the iSeries Access portlets are installed, you see a new My iSeries tab in your 
Workplace Services Express server. See Figure 7-32. 

Depending on the method of authentication which you choose to use with the iSeries Access 
for Web portlets, you might have to perform some configuration before using the portlets. If 
you configured EIM, as explained in 7.1, “Configuring EIM for use with the iSeries Access 
portlets” on page 209, no further configuration is needed. You can start using the portlets to 
access information on your iSeries server. If you did not configure EIM, you must set some 
authentication information in the portlet’s configuration mode.

                               QSH Command Entry                                
                                                                                
   Configuring iSeries Access for Web                                           
                                                                                
   Preparing to perform the configuration changes.                              
                                                                                
   Calling Portal Server to perform the configuration changes.                  
                                                                                
   Refer to the following log file for additional success/failure information:  
   /QIBM/UserData/Access/Web2/wse/itsowse1/logs/cfgwseiwa.log                   
                                                                                
   Refer to the following log file for additional success/failure information:  
   /QIBM/UserData/Access/Web2/wse/itsowse1/logs/cfgwseiwapage.log               
                                                                                
   iSeries Access for Web command has completed.                                
                                                                                
                                                                                
 ===>                                                                           
                                                                                                                                                               
F3=Exit   F6=Print F9=Retrieve F12=Disconnect                                  
 F13=Clear F17=Top  F18=Bottom  F21=CL command entry                            
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There are three methods of providing authentication information to the iSeries Access for 
Web portlets if you are not using EIM:

� Using a credential specific to a particular portlet window

See 7.4.1, “Authenticating using credentials specific to a portlet window” on page 230.

� Using a credential set with the iSeries credentials portlet

See 7.4.2, “Authenticating by using credentials set in the iSeries credentials portlet” on 
page 232.

� Using a shared credential set by the Workplace Services Express administrator

See 7.4.3, “Authenticating using shared credentials” on page 233.

Figure 7-32   My iSeries tab added to Workplace Services Express server

7.4.1  Authenticating using credentials specific to a portlet window
This method of authentication allows a user to authenticate to i5/OS by entering their own 
credentials. It does not allow any other users to use these credentials, nor does it allow the 
user who enters them to reuse them in other portlets without re-entering them.

To use portlet window-specific credentials to authenticate to i5/OS, perform the following 
steps:

1. Log in to the Workplace Services Express server and click the My iSeries tab.

2. Select the sub-category tab which you want to use. In this example, we click Files.

3. Select the portlet for which you want to set the authentication information and click the edit 
mode icon (Figure 7-33).

Figure 7-33   Selecting the edit mode icon
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4. The portlet is displayed in edit mode (Figure 7-34). Under Authentication, complete these 
steps:

a. Select Use credential specific to this portlet window.

b. In the User field, type the name of the i5/OS user profile for which you want to 
authenticate to your iSeries server.

c. In the Password field and in the Confirm password field, type the password of the i5/OS 
user profile for which you want to authenticate to your iSeries server.

d. Click OK. 

Figure 7-34   Setting portlet window specific credentials

The portlet returns to view mode and should authenticate to your iSeries server 
successfully (Figure 7-35).

Figure 7-35   iSeries File List portlet authenticating to an iSeries server

5. Repeat these steps for each of the iSeries Access for Web portlets that you want to use.
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7.4.2  Authenticating by using credentials set in the iSeries credentials portlet
By storing credentials in the iSeries credentials portlet, you can reuse them in all the iSeries 
Access for Web portlets without re-entering the i5/OS user profile name and password for 
each portlet. To store credentials in the iSeries credentials portlet, follow these steps:

1. Log in to Workplace Services Express server and click the My iSeries tab.

2. Select the Other subcategory.

3. In the iSeries Credentials portlet, click New Credential (Figure 7-36).

Figure 7-36   Storing a new credential using the iSeries Credentials portlet

4. In the next pane, complete these steps:

a. In the Slot Name field, type a name for the new credential. It is convenient to set this to 
the name of the i5/OS user profile for which you are storing credentials.

b. In the Description field, type a description of the new credential.

c. In the User field, type the i5/OS user profile name.

d. In the Password and Confirm Password fields, type the password for the i5/OS user 
profile.

e. Click OK. 

The new credential should be displayed in the iSeries Credentials portlet (Figure 7-37).

Figure 7-37   iSeries Credentials portlet
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To use the newly stored credentials to authenticate to i5/OS in an iSeries Access for Web 
portlet, perform the following steps:

1. Log in to Workplace Services Express server and click the My iSeries tab.

2. Select the subcategory that you want to use. In this example, we click Files.

3. Select the portlet which you want to set the authentication information for and click the edit 
mode icon (Figure 7-33 on page 230).

4. The portlet is displayed in edit mode (Figure 7-38). Under the Authentication section, 
complete these steps:

a. Select Use credential set with iSeries Credentials portlet.

b. From the Slot name dropdown list, select the name of the user profile for which you 
want to authenticate to your iSeries server.

c. Click OK.

Figure 7-38   Selecting credentials set with the iSeries Credentials portlet

The portlet is returned to view mode and should authenticate to your iSeries server 
successfully (Figure 7-35 on page 231).

5. Repeat these steps for each of the iSeries Access for Web portlets which you want to use.

7.4.3  Authenticating using shared credentials
If you want all users of the iSeries Access for Web portlets to authenticate to i5/OS using the 
same user profile, setting up shared credentials is the best approach. This is a two-step 
process. First you must add the shared credentials to a new slot in the credential vault. Then 
you must select those credentials in each of the iSeries Access for Web portlets.
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Perform the following steps to add shared credentials to a new slot in the credential vault:

1. Log in to Workplace Services Express server as the administrator user.

2. Click the Administration link in the top right side of the main page (Figure 7-39).

Figure 7-39   Selecting the Administration page in Workplace Services Express

3. Click the Access tab on the Administration page.

4. Click Credential Vault in the left pane.

5. In the Credential Vault portlet, click Add a vault slot (Figure 7-40).

Figure 7-40   Adding a new slot to the credential vault
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6. In the next pane (Figure 7-41), complete these steps:

a. In the Name field, type a name for the new shared credential slot. This is not required 
to match the name of the i5/OS user profile for which you are storing the credentials, 
but giving it the same name makes it easier to recognize.

b. Make sure the Vault slot is shared check box is selected.

c. In the Shared userid field, type the i5/OS user profile name.

d. In the Shared password field and in the Confirm password field, type the i5/OS user 
profile password.

e. Click OK to save the credentials to the credential vault.

Figure 7-41   Entering details of the new credential vault slot
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To use the newly stored credentials to authenticate to i5/OS from an iSeries Access for Web 
portlet, perform the following steps:

1. Log in to the Workplace Services Express server and click the My iSeries tab.

2. Select the subcategory which you want to use. In this example, we click Files.

3. Select the portlet for which you want to set the authentication information and click the edit 
mode icon (Figure 7-33 on page 230).

4. The portlet is displayed in edit mode (Figure 7-42). In the Authentication section, complete 
these steps:

a. Select Use system shared credentials set by administrator.
b. In the Slot name drop-down list, select the name of the new credential vault slot.
c. Click OK. 

Figure 7-42   Selecting system shared credentials

The portlet is returned to view mode and should authenticate to your iSeries server 
successfully (Figure 7-35 on page 231).

5. Repeat these steps for each of the iSeries Access for Web portlets which you want to use.
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Chapter 8. Enabling SSO between 
Workplace Services Express and 
Domino

Single sign-on (SSO) is the process that allows users of one Web application to move to 
another application, either on the same system or on a different one, without clicking Run All 
to perform the create index scriptauthenticate with the second application. In our 
environment, this means that, when users log into Workplace Services Express and want to 
access their Domino mail file or other Domino-based information, they do not have to enter 
their user name and password again. The system authenticates the user automatically.

This chapter describes the concept of SSO. It explains the necessary steps to enable it 
between Workplace Services Express and Domino, using the Domino server to provide the 
directory information and mail capabilities.

First we introduce the concept of SSO, its importance, and possible ways to implement it. 
Then we discuss how to enable SSO so that users who are signed into Workplace Services 
Express do not have to enter their password to access, for example, their Domino mail file.

8

Note: This chapter covers only SSO between Workplace Services Express and Domino 
using the native capabilities of those products to provide it. It does not cover other solutions 
such as Tivoli Access Manager.
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8.1  How SSO works
The process of SSO between Workplace Services Express and Domino is achieved using 
Lightweight Third Party Authentication (LTPA). The WebSphere Application Server that runs 
beneath Workplace Services Express, the Domino servers, and other Web servers in the 
SSO domain all share the same LTPA key.

The authentication process works in the following way:

1. From a Web browser, the user enters the user name and password required to 
authenticate to Workplace Services Express. This validation is done by the underlying 
WebSphere Application Server.

2. The WebSphere Application Server validates this information against a Lightweight 
Directory Access Protocol (LDAP) directory.

3. After confirmation of the given information, the WebSphere Application Server generates 
an LTPA token. This token is sent to the user’s Web browser as a session cookie.

4. When making a request to either the Workplace Services Express server or a Domino 
server, the Web browser sends this cookie. Because both the Domino server and 
Workplace Services Express server share the same LTPA keys, they both can decode the 
information that is stored in the cookie. Therefore, they can also guarantee that the user’s 
identity has been validated and can accept the user.

The LTPA cookie contains the domain for SSO and encrypted user information that gets 
decoded with the shared keys available in all of the SSO participating servers.

To enable SSO between Workplace Services Express and Domino, there are a few steps that 
users must take to make sure that both servers can communicate and provide the necessary 
information. SSO is accomplished by passing LTPA cookies that contain information used to 
authenticate the users. Because these keys are encrypted, all servers in the domain in which 
SSO is being configured must share the same key in order to successfully decrypt the 
information contained in the cookie.

Figure 8-1 outlines the path to enable SSO between Workplace Services Express and 
Domino.
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Figure 8-1   Steps to enabling SSO between Workplace Services Express and Domino
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8.2  Enabling SSO in WebSphere Application Server
The process of enabling SSO involves having the same set of LTPA keys in both WebSphere 
Application Server and the Domino server. When the Workplace Services Express server 
was configured, step 10 of the iSeries Create Workplace wizard asks about SSO 
configuration. To enable SSO between Workplace Services Express and Domino, you might 
have selected the option to include other Web servers in your SSO environment. If you 
selected this option, you were then able to select the SSO domain and set the LTPA 
password. See Figure 4-31 on page 100 for details.

The following steps show you how to create new LTPA keys, if they are not already generated. 
They also explain how to export those keys from WebSphere Application Server and import 
them into the Domino server.

To enable SSO, you must first share the same LTPA keys between all servers. If you specified 
a domain for SSO and the LTPA password, the keys are already generated. Therefore, you 
must next export the key. Perform the following steps:

1. Log into the WebSphere Application Server Administrative Console. You can do this from 
the IBM Web Administration for iSeries window. Select your Workplace Services Express 
server from the Manage Application Servers tab. Then click Launch Administrative 
Console as shown in Figure 8-2.

Figure 8-2   Launching the WebSphere Application Server Administrative Console
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2. If the security alert window (Figure 8-3) opens, click Yes.

Figure 8-3   Security Alert window

3. Log in to the WebSphere Application Server Administrative Console (Figure 8-4) with the 
Workplace Services Express administrative user ID and password. Click OK.

Figure 8-4   Logging in to the WebSphere Application Server Administrative Console
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4. On the WebSphere Application Server Administrative Console, select Security → 
Authentication Mechanisms → LTPA, as shown in Figure 8-5.

Figure 8-5   Accessing the LTPA section of the WebSphere Application Server Administrative Console

5. Ensure that SSO is enabled and the correct domain is selected in the SSO properties. 
Navigate to the bottom of the LTPA pane. Under the Additional Properties section, click 
Single Signon (SSO) as shown in Figure 8-6.

Figure 8-6   Accessing the Single Signon (SSO) properties pane
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6. In the SSO configuration pane, you must first ensure that the Enabled check box is 
selected. The check the domain name. If you configure SSO correctly on the iSeries 
Create Workplace wizard, that field has the domain that was set up in the wizard. In our 
example, the domain is RCHLAND.IBM.COM. See Figure 8-7.

If the fields are correct, you can click Cancel to go back to the LTPA pane. If any you made 
any changes, you must save the changes into the master configuration and generate new 
LTPA keys. Then you can go back to the LTPA properties pane.

Figure 8-7   Verifying the SSO domain

Tip: The domain name must include all servers that will be used for SSO.
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7. To generate new LTPA keys, after you save the changes made in the previous pane, go 
back to the LTPA window (Figure 8-8). In the password field, type a password and confirm 
it. Then, click the Generate Keys button. After generating new keys, you must save the 
changes into the master configuration.

Figure 8-8   Generating new LTPA keys

Important: You must only generate new keys if you did not specify a domain and LTPA 
password in the iSeries Create Workplace wizard. If you specified a domain and 
password, you can skip this step and proceed to exporting the keys.
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8. Export the LTPA keys (see Figure 8-9). The password field contains the password 
specified on the configuration wizard. In the Key File Name field, type a name. This 
includes the path and file name in which the keys will be saved in integrated file system of 
the iSeries server. For our example, we entered the Key File Name of /keyfile.jks.

Click Export Keys. For our example, this generates a file called keyfile.jks in the root 
directory of the iSeries server.

Figure 8-9   Exporting the LTPA keys

9. After exporting the LTPA keys, save the changes. The local configuration changes are 
saved after exporting the keys. However, you must apply the changes to the master 
configuration. Click the Save link as shown in Figure 8-10.

Figure 8-10   Saving the changes
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10.In the Save pane (Figure 8-11), in the Save to Master Configuration frame, click the Save 
button.

Figure 8-11   Saving the master configuration

11.Click the Logout button at the top of the pane to log out of the WebSphere Application 
Server Administrative Console.

A file called keyfile.jks that contains the LTPA keys is now saved in the root directory of the 
iSeries server. This file must be accessible from the Domino Administrator client. To do this, 
map a drive to the iSeries server or copy the file to an accessible location from the Domino 
Administrator client. In our example, we mapped a drive to the root directory of the iSeries 
server.

Now you are ready to import the LTPA keys into your Domino server configuration as 
explained in the next section.
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8.3  Enabling the Domino server for SSO
After exporting the LTPA keys from the WebSphere Application Server, you must import them 
into Domino and make the appropriate configuration changes as explained in these steps:

1. Open the Domino Administrator client and click the Configuration tab.

2. In the left pane, select Web → Web Server Configurations and in the right pane, select 
your Domino server configuration document as shown in Figure 8-12.

Figure 8-12   Accessing the Web Server Configuration document on the Domino server

3. From the Domino server configuration document, create a new Web SSO configuration 
document. Click Create Web and select SSO Configuration as shown in Figure 8-13.

Figure 8-13   Creating a new Web SSO Configuration document

 

 

 

Chapter 8. Enabling SSO between Workplace Services Express and Domino 247



 

4. In the Web SSO Configuration document, import the LTPA keys. Click the Keys button and 
select Import WebSphere LTPA Keys. See Figure 8-14.

Figure 8-14   Importing WebSphere LTPA keys

5. In the Enter Import File Name window (Figure 8-15), enter the path and file name of the 
LTPA key file. In our example, the path is a mapped drive to the iSeries server. Click OK.

Figure 8-15   Entering the path and file name of the WebSphere LTPA keys

6. You are prompted to enter the password of the LTPA keys as shown in Figure 8-16. Enter 
the password and click OK.

Figure 8-16   Entering the password for the LTPA keys

7. If the key file was found and the password is correct, you see a message indicating that 
the keys were successfully imported (Figure 8-17).

Figure 8-17   Success message after importing WebSphere LTPA keys into Domino
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8. Update the Web SSO Configuration document with the information shown in Table 8-1. 
Figure 8-18 shows our completed example.

Table 8-1   Values for the Web SSO Configuration document

Figure 8-18   Web SSO Configuration document

9. After you modify the appropriate fields, save and close the Web SSO Configuration 
document.

10.In the Domino server document, navigate to Internet Protocols → Domino Web Engine.

Section Field Our example Comment

Token 
Configuration

DNS Domain .RCHLAND.IBM.COM The SSO domain.

Participating 
Servers

Domino 
Server Names

dom654/itso654 This can be selected from a 
drop down list.

WebSphere 
Information

LDAP Realm dom654.RCHLAND.IBM.COM\:389 Make sure you have a “\” 
after the domain name.

Note: The Organization field must be left blank. If you are using Internet site 
documents, the Organization field must match exactly the Internet site - Web site 
document. In our example, we do not use Internet site documents.
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11.In the HTTP Sessions section, click the drop-down list for the Session Authentication field. 
In the Select Keywords window (Figure 8-19) that opens, select Multiple Servers (SSO) 
and click OK.

Figure 8-19   Selecting the Session Authentication method

12.In the HTTP Sessions section, click the drop-down list for the Web SSO Configuration 
field. In the Select Keywords window (Figure 8-20) that opens, select Ltpa Token and click 
OK.

Figure 8-20   Selecting Web SSO Configuration document
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13.Figure 8-21 shows the Domino server document with the HTTP Sessions options 
selected. After you make the appropriate changes, save and close the document.

Figure 8-21   Domino Server document after HTTP Sessions changes

14.Restart the Domino HTTP task by running the following command in the Domino server 
console:

restart task http

15.After the Domino HTTP task restarts, you must restart the Workplace Services Express 
server. It is important that you start the Domino server before you stop or start the 
Workplace Services Express server. For information about how to stop and start the 
Workplace Services Express server, see 5.1, “Starting and stopping a Workplace 
Services Express server” on page 106.

8.4  Testing SSO
After you restart both the Domino and Workplace Services Express servers, you can test 
SSO. There two tests that you can do at this point.

For the first test, open a Web browser and log into the Workplace Services Express server 
with a user that has access to the Domino Directory (names.nsf file). After logging into the 
Workplace Services Express server, from the same Web browser window, enter the following 
URL:

http://yourDominoServer.domain.com/names.nsf

If SSO is enabled, you can access the Domino Directory without being prompted to enter your 
user name and password. If you are prompted to enter your user name and password, SSO 
was not properly configured.

If you successfully configured the Domino Web Access portlet as discussed in 6.2, 
“Configuring the Domino Web Access portlet” on page 175, you can test SSO there as well. If 
SSO is configured properly, you are not prompted for a user name and password. If you are 
prompted to enter your user name and password, SSO was not properly configured.
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8.5  Troubleshooting SSO
If you had problems configuring SSO, here are a few pointers and tests to help you determine 
and correct the problem:

� If you had a problem importing the keys into Domino, you might have entered a wrong 
password. To fix this, generate new LTPA keys on the WebSphere Application Server 
Administrative Console. Refer to step 7 on page 244. When the keys are generated, you 
can export them again.

� If the problem continues, the path is probably is wrong. Try copying the Import LTPA keyfile 
to your local workstation and then importing it into Domino. Also make sure that you type 
the path name and file name exactly as it should be.

� For SSO to work, all servers must have the clocks synchronized. If there are different 
servers on different time zones, the time zone value must be set. If servers do not have the 
times synchronized, an LTPA cookie can be created with a wrong expiration time, so SSO 
will fail.
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Chapter 9. Performance tuning

In this chapter, we provide tuning tips ranging from optimizing i5/OS performance to tuning 
the various aspects of a Workplace Services Express environment. We take you through the 
iSeries architecture and explain how the components of Workplace Services Express fit 
within this architecture. With this base understanding, you learn how you can optimize your 
Workplace Services Express iSeries computing environment to achieve the best 
performance.

9
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9.1  iSeries architecture
The iSeries architecture implements many different functions in subsystems. Subsystems can 
be thought of as isolated areas in the operating system memory that allow functions to run, 
segmented from other workloads.

There are a number of components that comprise a Workplace Services Express server. This 
includes the IBM HTTP Server that services HTTP traffic to and from the Workplace Services 
Express server. The jobs that comprise the IBM HTTP Server associated with a Workplace 
Services Express server are shown in Table 9-1. These server jobs run under the subsystem 
QHTTPSVR. The IBM HTTP Server jobs have a run priority of 25. We discuss the effect of 
run priorities in 9.3.3, “Run priority tuning” on page 261.

Table 9-1   IBM HTTP Server jobs

1 By default, the name of the HTTP job is the same name as the Workplace Services Express
server instance name.

Table 9-2 lists the three server jobs that are associated with each Workplace Services 
Express server. These jobs run in the QEJBAS5 subsystem by default. You can optionally 
change these jobs to run in a separate subsystem. To use specially created CL commands to 
change the Workplace Services Express jobs so they run in a separate subsystem, see 9.3.4, 
“Changing the subsystem Workplace Services Express jobs run in” on page 263.

The Workplace Services Express server jobs have a run priority of 20. This is important to 
note if you have any 5250-based interactive workloads running on the same iSeries server or 
in the same logical partition (LPAR).

Table 9-2   Workplace Services Express server jobs

The two Lightweight Directory Access Protocol (LDAP) server choices that run on the iSeries 
are the IBM Directory Server and Lotus Domino. The IBM Directory Server runs under the 
QSYSWRK subsystem and is comprised of the QDIRSRV job shown in Table 9-3. The run 
priority of the IBM Directory Server is 50.

Job name Run priority Job function

WSEServer1 25 QZHBMAIN

WSEServer1 25 QZSRLOG

WSEServer1 25 QZSRHTTP

Job name Run priority Job function

QJVAEXEC 20 Started by the Websphere_Portal (WEBSPHERE_) job and is 
required for instant messaging functionality.

SERVER1 20 Used during the initial configuration process of a Workplace 
Services Express server. It also provides administration services 
for the Workplace Services Express server through the 
WebSphere Application Server Administrative Console. During 
normal server operation, this server might be ended.

WEBSPHERE_ 20 Responsible for responding to all Workplace Services Express 
user requests.
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Table 9-3   IBM Directory Server job

Each Lotus Domino server also runs in its own subsystem. Table 9-4 lists the Lotus Domino 
jobs associated with providing LDAP services for a Workplace Services Express server. Lotus 
Domino jobs run at run priority 20 by default.

Table 9-4   Lotus Domino jobs associated with providing LDAP services

9.2  Performance assessment and tuning methodology
With the number of different environments involved in supporting a Workplace Services 
Express server, this section is designed to help you understand where you should start when 
working on a performance issue with a Workplace Services Express implementation.

When addressing a performance concern, you must look at the whole application 
environment to properly assess what is causing the performance problem and to determine 
how to remedy the situation. This means that you must look at the iSeries server to see if 
there are any bottlenecks on the system. To learn how to get the most out of your iSeries 
performance by using the automatic performance adjustor and properly tuning memory, run 
priorities, and disk on the system, see 9.3, “i5/OS tuning” on page 256 discusses.

Figure 9-1 shows the different services that are required for running a Workplace Services 
Express server. 

Figure 9-1   Workplace Services Express environment

Job name Run priority Job function

QDIRSRV 50 IBM Directory Server

Job name Run priority Job function

DIIOP 20 Required for integration between Domino and Workplace Services 
Express

HTTP 20 Enables a Domino server to act as a Web server

LDAP 20 Enables a Domino server to provide LDAP directory services to 
LDAP clients

QNNINSTS 20 A watch-dog job that makes sure the Domino server is active

SERVER 20 Executes requests made to the Domino server
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We see that all end-user interaction comes from a Web browser and flows over TCP/IP to 
communicate with the server. If your iSeries server does not have any bottlenecks, it is 
important to address network performance and make sure there are not any bottlenecks for 
TCP/IP. For tips about optimizing TCP/IP on your iSeries server, see 9.4, “Network tuning” on 
page 269. Additionally, refer to 9.7.3, “Enabling GZIP compression” on page 306, for help with 
improving overall network bandwidth.

When you know that the iSeries server and the network are not a bottleneck, you must look at 
the different aspects of Workplace Services Express to determine which areas can cause 
performance issues. Looking at Figure 9-1, you must assess and tune as appropriate the 
Workplace Services Express server, the IBM HTTP Server, the LDAP server being used by 
the Workplace Services Express server, and the underlying DB2 Universal Database files 
that support the Workplace Services Express server. Additionally, each Workplace Services 
Express server implements a Java Virtual Machine (JVM). Therefore, the JVM also must be 
examined and tuned as appropriate.

You can find recommendations for Workplace Services Express tuning in 9.5, “Workplace 
Services Express tuning” on page 276. For tuning advice regarding the underlying JVMs that 
support a Workplace Services Express server, see 9.6, “Java tuning” on page 300.

We address performance recommendations for the IBM HTTP Server in 9.7, “IBM HTTP 
Server tuning” on page 302. For DB2 Universal Database performance optimization 
information, see 9.8, “Database tuning” on page 314.

The discussion in 9.1, “iSeries architecture” on page 254, presents two LDAP server choices 
that run on the iSeries. If you have chosen to use the IBM Directory Server, refer to 9.9, “IBM 
Directory Server tuning” on page 333, for tuning tips. If you have chosen Lotus Domino for 
your LDAP server, refer to 9.10, “Lotus Domino LDAP tuning” on page 336, to learn how to 
optimize Domino LDAP for a Workplace Services Express implementation.

9.3  i5/OS tuning
There are a number of different aspects to i5/OS performance. This section shows you how to 
use and optimize:

� Automatic performance adjustor
� Memory tuning
� Run priority tuning
� Running a Workplace Services Express server in its own subsystem
� System values affecting i5/OS performance
� Disk tuning

9.3.1  Automatic performance adjustor
The i5/OS ships with a utility called the automatic performance adjustor. It continuously 
analyzes and dynamically adjusts where CPU and memory resources are applied. The 
automatic performance adjustor uses a set of algorithms that look at the run characteristics of 
jobs in the system to determine how much memory and CPU should be allocated to different 
memory pools in the system.
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By default, there are four memory pools on each iSeries server:

� Machine pool (*MACHINE) is reserved for executing below the machine interface (MI) 
operating system code.

� Base pool (*BASE) is the memory pool where various jobs run including:

– Workplace Services Express
– IBM HTTP Server
– Lotus Domino
– IBM Directory server
– Batch jobs

� Interactive pool (*INTERACT) is the memory pool where interactive workloads run.

� Spool pool (*SPOOL) is the memory pool where printing functions run.

The automatic performance adjustor is controlled through a system value called QPFRADJ. 
This system value can be set to one of the following values:

0 Turns off automatic adjustment
1 Automatic adjustment happens only at initial program load (IPL)
2 Automatic adjustment occurs at IPL and dynamically throughout system operation
3 Automatic adjustment only occurs during normal system operation; no adjustment is 

made during IPL

The default setting for this value is 2, meaning that automatic adjustment occurs when the 
system does an IPL and continues while the system is running. This is the best setting for this 
system value and allows the tool to move resources where they are most needed.

To see the value that the automatic performance adjustor is set to on your system, enter the 
following Display System Value (DSPSYSVAL) command:

DSPSYSVAL QPFRADJ

9.3.2  Memory tuning
It is important to make sure that you can use memory appropriately. Each memory pool has a 
setting specified for the minimum and maximum percentage of memory that should be 
allocated to the pool. These minimums and maximums are used by the automatic 
performance adjustor to determine to which pools to move more memory or from which pools 
to take memory.

Minimum settings for memory pools
The default minimum settings leave 5% of memory in the interactive pool and 1% of memory 
in the spool pool. If you are not using this memory with your workload requirements, you must 
lower the minimum memory sizes for these memory pools, allowing the automatic 
performance adjustor to move the memory to pools where it is needed the most.

Note: There might be additional memory pools on your system. These memory pools can 
either be shared or private memory pools.

Tip: If the automatic performance adjustor is turned off on your system, use the following 
Change System Value (CHGSYSVAL) CL command to enable automatic performance 
adjustment:

CHGSYSVAL SYSVAL(QPFRADJ) VALUE(2)
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The system used in our environment for this redbook has 32 Gb of memory installed. We use 
services from Workplace Services Express servers, IBM HTTP Server, IBM Directory server, 
and Lotus Domino servers. All of these servers run out of the base memory pool by default. 
Because of the default minimum settings of 5% for interactive and 1% for spool, we have 
almost 1.6 Gb of memory that is unable to be utilized on our iSeries server. 

Use the Work with System Status (WRKSYSSTS) CL command to show how memory is 
allocated on your system. Figure 9-2 shows an example. With the default minimum memory 
settings on our system, 1580.70 Mb of memory resides in the interactive memory pool 
(system pool 3) that is unable to be utilized. An additional 15.25 Mb of memory is left 
unutilized in the spool pool (system pool 4).

Figure 9-2   WRKSYSSTS showing memory being wasted in the interactive and spool pools

The following list explains each of the columns shown in the Work with System Status display 
(Figure 9-2):

� System Pool: Lists the number of the memory pool

� Pool Size (M): Shows the size of the memory pool in MB

� Reserved Size (M): Shows the minimum amount of memory that is required to remain in 
the memory pool

� Max Active: Represents the number of jobs or threads that can be concurrently active in 
the memory pool at the same time

� DB Fault: The number of faults per second that is associated with DB2 Universal 
Database database objects

� DB Pages: The number of pages per second that is happening with DB2 Universal 
Database database objects

                            Work with System Status                    RCHAS12  
                                                             10/25/05  16:31:30 
 % CPU used . . . . . . . :        2.2    Auxiliary storage:                    
 % DB capability  . . . . :         .2      System ASP . . . . . . :    246.1 G 
 Elapsed time . . . . . . :   00:00:04      % system ASP used  . . :    83.8144 
 Jobs in system . . . . . :       3956      Total  . . . . . . . . :    246.1 G 
 % perm addresses . . . . :       .022      Current unprotect used :    24032 M 
 % temp addresses . . . . :       .062      Maximum unprotect  . . :    24403 M 
                                                                                
 Type changes (if allowed), press Enter.                                        
                                                                                
 System    Pool    Reserved    Max   -----DB-----  ---Non-DB---                 
  Pool   Size (M)  Size (M)  Active  Fault  Pages  Fault  Pages                 
    1     1048.80    569.18   +++++     .0     .0     .0     .0                 
    2    28969.31     10.69    1428     .0     .0     .0     .0                 
    3     1580.70       .00     527     .0     .0    1.1    1.3                 
    4       15.25       .00       5     .0     .0     .0     .0                 
                                                                                
                                                                         Bottom 
 Command                                                                        
 ===>                                                                           
 F3=Exit   F4=Prompt   F5=Refresh   F9=Retrieve   F10=Restart   F12=Cancel      
 F19=Extended system status         F24=More keys                               
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� Non-DB Fault: The number of non-DB2 Universal Database faults per second that is 
happening in a memory pool

� Non-DB Pages: The number of pages per second that is happening with non-DB2 
Universal Database database objects

Enabling utilization of memory
To remedy the situation of having unused memory remain in the interactive and spool pools, 
use the Work with Shared Pools (WRKSHRPOOL) command to change the minimum amount 
of memory that is required to remain in these memory pools:

1. From a 5250 emulation command line, enter the WRKSHRPOOL CL command.

2. On the Work with Shared Pools display, press the F11 key to display the tuning data. 
Figure 9-3 shows the default minimum memory sizes of 5% and 1% respectively for the 
interactive (*INTERACT) and spool (*SPOOL) memory pools.

Figure 9-3   Work with Shared Pools display showing the tuning data

3. To change the minimum amount of memory allocated to these memory pools, type over 
the existing values.

Press Enter for the changes to take effect. 

                             Work with Shared Pools                             
                                                             System:   RCHAS12  
 Main storage size (M)  . :       31614.06                                      
                                                                                
 Type changes (if allowed), press Enter.                                        
                                                                                
                       -----Size %-----  -----Faults/Second------               
 Pool        Priority  Minimum  Maximum  Minimum  Thread  Maximum               
 *MACHINE         1      2.53      100    10.00     .00    10.00                
 *BASE            1      4.99      100     5.00     .50      200                
 *INTERACT        2      5.00      100    10.00    2.00      100                
 *SPOOL           2      1.00      100     5.00    1.00      100                
 *SHRPOOL1        2      1.00      100    10.00    2.00      100                
 *SHRPOOL2        2      1.00      100    10.00    2.00      100                
 *SHRPOOL3        2      1.00      100    10.00    2.00      100                
 *SHRPOOL4        2      1.00      100    10.00    2.00      100                
 *SHRPOOL5        2      1.00      100    10.00    2.00      100                
 *SHRPOOL6        2      1.00      100    10.00    2.00      100                
                                                                        More... 
 Command                                                                        
 ===>                                                                           
 F3=Exit   F4=Prompt   F5=Refresh   F9=Retrieve   F11=Display text              
 F12=Cancel                                                                     

Tip: If you are not using interactive or spool services on your iSeries server, you can 
reduce these values to smaller amounts such as 0.50 and 0.05, respectively.
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When you complete the changes, the display should look similar to the one shown in 
Figure 9-4.

Figure 9-4   Reduced minimum sizes for the interactive and spool memory pools

Faulting rates
Faulting occurs when a running job requests a page of information that is not in main memory. 
The job that requested the page is now forced to wait for the page of information to be 
retrieved from disk. When the page is retrieved and is ready to be used, the job can continue 
processing. Because the job is interrupted and must stop and wait for the page to be read or 
“faulted” into memory, it is important to keep the number of faults per second at acceptable 
faulting rates.

                             Work with Shared Pools                             
                                                             System:   RCHAS12  
 Main storage size (M)  . :       31614.06                                      
                                                                                
 Type changes (if allowed), press Enter.                                        
                                                                                
                       -----Size %-----  -----Faults/Second------               
 Pool        Priority  Minimum  Maximum  Minimum  Thread  Maximum               
 *MACHINE         1      2.53      100    10.00     .00    10.00                
 *BASE            1      4.99      100     5.00     .50      200                
 *INTERACT        2       .50      100    10.00    2.00      100                
 *SPOOL           2       .05      100     5.00    1.00      100                
 *SHRPOOL1        2      1.00      100    10.00    2.00      100                
 *SHRPOOL2        2      1.00      100    10.00    2.00      100                
 *SHRPOOL3        2      1.00      100    10.00    2.00      100                
 *SHRPOOL4        2      1.00      100    10.00    2.00      100                
 *SHRPOOL5        2      1.00      100    10.00    2.00      100                
 *SHRPOOL6        2      1.00      100    10.00    2.00      100                
                                                                        More... 
 Command                                                                        
 ===>                                                                           
 F3=Exit   F4=Prompt   F5=Refresh   F9=Retrieve   F11=Display text              
 F12=Cancel                                                                     
 *INTERACT changed, but may be adjusted.                                      + 

Important: If you have workloads that run in the evening that cause memory to be moved 
from the memory pool hosting the Workplace Services Express servers, we recommend 
that you set the minimum size of that memory pool to a larger value than the default. This is 
necessary to ensure the JVM has ample memory to accommodate the JVM heap size.

The default memory pool for Workplaces Services Express servers is pool 2 or *BASE. 
This pool has a minimum memory size of 4.99% of the memory on the system. If you are 
running Workplace Services Express servers in this memory pool and have other 
workloads executing that would reduce the memory significantly in the *BASE pool, 
change the minimum value for *BASE to a higher value.

For details about how to set the JVM heap size, see “Setting the JVM heap size” on 
page 300. When you know the optimal JVM heap size for your environment, you will have 
the information required to set the minimum size for the memory pool in which the 
Workplace Services Express servers are running.
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Table 9-5 summarizes acceptable faulting rates for the machine and base memory pools.

Table 9-5   Memory pool faulting guidelines

1. Workplace Services Express, IBM HTTP Server, IBM Directory server, and Lotus Domino
servers all run in the base memory pool by default. If you have moved any of these services to
a different memory pool, apply these faulting guidelines to the appropriate memory pool.

2. The number of faults per second that can be tolerated on a system before it affects perfor-
mance depends on the number of disk arms. Systems that have a large number of disk arms,
for example 30 arms or more, can handle much higher faulting rates before performance is af-
fected.

If you are using the automatic performance adjustor (QPFRADJ), this utility looks for a pattern 
of three consecutive intervals of unacceptable faulting rates in a memory pool. If 
unacceptable faulting rates occur, QPFRADJ moves more memory to the pool that is in most 
need of additional memory. QPFRADJ might also reduce the activity level to lower the 
number of jobs executing concurrently in a memory pool to reduce faulting rates.

9.3.3  Run priority tuning
The automatic performance adjustor uses the run priority of specific jobs to determine which 
memory pools should receive more memory and CPU run cycles. The run cycles are set by 
controlling the maximum activity level of a memory pool. The maximum activity level is shown 
in the Max Act column in Figure 9-2 on page 258. Activity level is particularly important in a 
Workplace Services Express environment because of the number of threads running under 
each of the jobs providing services to each server.

Refer to the following tables to see the run priorities of each of the components that can 
comprise a Workplace Services Express environment:

� For IBM HTTP Server, see Table 9-1 on page 254.
� For Workplace Services Express, see Table 9-2 on page 254.
� For IBM Directory server, see Table 9-3 on page 255.
� For Lotus Domino, see Table 9-4 on page 255.

It is necessary to understand the runtime priorities of these components so you can adjust 
runtime priorities if appropriate. When adjusting runtime priorities, you must also understand 
how the dynamic priority scheduler works on the iSeries.

The dynamic priority scheduler uses runtime priorities to determine which jobs are in most 
need of memory, CPU resources, or both. It is responsible for making sure that no jobs are 
starved for resources while ensuring that no one high priority job monopolizes the CPU. It 
analyzes the runtime priority of a job in addition to the amount of time that the job has been 
waiting for CPU. If a job has been starved for CPU, the dynamic priority scheduler internally 
bumps up the runtime priority of a job until it gets the required CPU resources.

Memory pool Maximum database and non-database faults per second

Machine pool (pool 1) 10

Base pool (pool 2) 1 100-150 per physical processor 2

Important: If the amount of memory available in the memory pool the Workplace Services 
Express server is running in drops to a level below the JVM heap size, faulting rates can 
quickly climb into the 1000s. To determine the heap size requirements for your Workplace 
Services Express server, refer to “Setting the JVM heap size” on page 300.
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The rate at which the dynamic priority scheduler increases the run priority of a specific job 
depends on which band it is in. The run priority bands on the iSeries are as follows:

� Band 0: 0-9 (system tasks)
� Band 1: 10-16
� Band 2: 17-22
� Band 3: 23-35
� Band 4: 36-46
� Band 5: 47-51
� Band 6: 52-89
� Band 7: 90
� Band 8: 91
� Band 9: 92
� Band 10: 93
� Band 11: 94
� Band 12: 95
� Band 13: 96
� Band 14: 97
� Band 15: 98
� Band 16: 99

A memory pool has an activity level associated with it which specifies the number of threads 
than can actively use the processor or processors at the same time from that memory pool. 
When more threads are started than are allowed to concurrently execute due to the activity 
level control, the excess threads are forced to wait for an available activity level slot before 
they can run. The number of threads running (active threads) refers to the number of threads 
that are eligible to compete for a processor and that count against the activity level for a 
memory pool. Active threads do not include threads that are:

� Waiting for input
� Waiting for a message
� Waiting for a device to be allocated
� Waiting for a file to be opened
� Ineligible (threads that are ready to run but the memory pool activity is at its maximum)

When more threads are concurrently active than available memory, paging and faulting can 
become a problem. For details about acceptable paging and faulting rates, see “Faulting 
rates” on page 260.

Note: A plus sign (+) next to the run priority of a job indicates that the dynamic priority 
scheduler has internally increased its priority to ensure that it is getting the required CPU 
resources.

Tip: The lower a run priority number is on the i5/OS, the higher a job’s run priority is. This 
means that a job with a run priority of 20 receives more CPU and memory resources than 
a job with a run priority of 30 or 40.

Activity level: The activity level does not restrict the number of jobs that can be initiated. It 
specifies the maximum number of threads that can be in memory at the same time. A job 
can have multiple threads active under it.
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9.3.4  Changing the subsystem Workplace Services Express jobs run in
The default subsystem for all Workplace Services Express servers is the QEJBAS5 
subsystem. There are times when it might be more appropriate to run a Workplace Services 
Express server in a separate subsystem. Some reasons include, but are not limited to, better 
control over memory management, better control over run priorities, or aid in JVM heap 
analysis.

A sample utility allows Workplace Services Express servers to be moved to a run in a 
different subsystem. This utility is a set of CL programs that are packaged in a save file. See 
Appendix C, “Additional material” on page 359, for information about downloading this save 
file.

Installing the utility on the iSeries server
Perform the following steps to install the library that contains the CL programs for changing 
the subsystem in which the Workplace Services Express server jobs run.

1. Download the save file. See Appendix C, “Additional material” on page 359, for 
information about downloading this save file.

2. Create a library on the iSeries to hold the contents of the save file using the Create Library 
(CRTLIB) CL command. In this example, we enter: 

crtlib wsetools

3. Create a save file in the library that you just created to hold the save file that you 
downloaded in step 1 using the Create Save File (CRTSAVF) CL command, for example:

crtsavf file(wsetools/wsetools)

4. Send the utility from your PC to the iSeries server using File Transfer Protocol (FTP):

a. Open a DOS prompt command and change to the directory on the PC where you 
downloaded the savefile.

b. Using FTP as explained in the following steps, send the savefile to the savefile that you 
just created on your iSeries server. See Figure 9-5 for an example.

i. Type the following command

ftp iSeriesServerName

ii. Enter your iSeries user name.

iii. Enter your iSeries password.

iv. Type the following commands in the order shown when prompted:

bin
put wsetools.savf /qsys.lib/wsetools.lib/wsetools.savf
quit
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Figure 9-5   Sending the WSETOOLS savefile to the iSeries using FTP

5. Now that the utility is sent to the iSeries server, restore the objects from the save file, using 
the following Restore Objects (RSTOBJ) CL command:

RSTOBJ OBJ(*ALL) SAVLIB(WSETOOLS) DEV(*SAVF) SAVF(WSETOOLS/WSETOOLS)

6. Add the WSETOOLS library to your library list using the following Add Library List Entry 
(ADDLIBLE) CL command:

ADDLIBLE LIB(WSETOOLS)

You are now ready to use the CL programs in WSETOOLS library to change the subsystem in 
which the Workplace Services Express server jobs run.

Creating a new subsystem description
The CL program provided in the WSETOOLS library to start a Workplace Services Express 
server requires that a new subsystem description is created. The name of the subsystem 
description should match the name of your Workplace Services Express server.

To create the new subsystem description, use the following CRTWSESBS command:

WSETOOLS/CRTWSESBS INSTANCE(itsowse2)

This command creates a subsystem called ITSOWSE2 in library WSETOOLS. Replace the 
instance name, itsowse2, with the name of your Workplace Services Express server.

Starting a Workplace Services Express server in its own subsystem
Next you must start the Workplace Services Express server in the new subsystem that you 
just created. You do this by issuing the Start Workplace Express Server (STRWSESVR) 
command, for example: 

WSETOOLS/STRWSESVR

When you type this command, you see the Start Workplace Express Server display shown in 
Figure 9-6. Provide the name of the Workplace Services Express server and specify which 
server jobs you want to start.

C:\>ftp rchas12
Connected to RCHAS12.rchland.ibm.com.
220-QTCP at RCHAS12.RCHLAND.IBM.COM.
220 Connection will close if idle more than 166666 minutes.
User (RCHAS12.rchland.ibm.com:(none)): kgreene
331 Enter password.
Password:
230 KGREENE logged on.
ftp> bin
200 Representation type is binary IMAGE.
ftp> put wsetools.savf /qsys.lib/wsetools.lib/wsetools.savf
200 PORT subcommand request successful.
150 Sending file to member WSETOOLS in file WSETOOLS in library WSETOOLS.
250 File transfer completed successfully.
ftp: 494208 bytes sent in 0.98Seconds 501.73Kbytes/sec.
ftp> quit
221 QUIT subcommand received.
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Figure 9-6   Starting a Workplace Services Express server in its own subsystem

Example 9-1 shows the code behind the STRWSESVR command.

Example 9-1   Contents of CL program STRWSESVR 

PGM       PARM(&INSTANCE &STR_WPS &STR_SVR1 &CLR_LOGS)                       
 DCL        VAR(&INSTANCE) TYPE(*CHAR) LEN(10)                                                      
 DCL        VAR(&STR_WPS)  TYPE(*CHAR) LEN(4)                                                      
 DCL        VAR(&STR_SVR1) TYPE(*CHAR) LEN(4)                                                       
 DCL        VAR(&CLR_LOGS) TYPE(*CHAR) LEN(4)                                                       
                                                                                                                    
 DCL        VAR(&TOOLSLIB) TYPE(*CHAR) LEN(10) +                                                    
                VALUE(WSETOOLS)                                                                       
 DCL        VAR(&LWP_HOME)   TYPE(*CHAR) LEN(100)                                                   
 DCL        VAR(&STRWPSCMD)  TYPE(*CHAR) LEN(200)                                                   
 DCL        VAR(&STRSVR1CMD) TYPE(*CHAR) LEN(200)                                                  
 DCL        VAR(&CLRLOGCMD)  TYPE(*CHAR) LEN(200)                                                  
  
 CHGVAR     VAR(&LWP_HOME) +                                                                       
                      VALUE('/qibm/userdata/webas5/base/' *TCAT +                                          
                      &INSTANCE *TCAT '/workplaceserver')                                                  
/****************************************************************************/                                  
/* START THE SUBSYSTEM IN CASE IT IS STOPPED               */                                 
 STRSBS     SBSD(&TOOLSLIB/&INSTANCE)                                                              
 MONMSG     MSGID(CPF1010)                                                                          
 
 /****************************************************************************/                                  
 IF         COND(&CLR_LOGS *EQ *NO) THEN(GOTO +                                                     
               CMDLBL(LBL_WPS_1))                                                                    
                                                                                                                  
  /* BUILD THE QSHELL COMMAND TO CLEAR THE WEBSPHERE_PORTAL LOGS               */                                 
 CHGVAR     VAR(&CLRLOGCMD) VALUE('rm ' *CAT +                                                      
                      &LWP_HOME *TCAT +                                                                     
                      '/../PortalServer/log/*.log')                                                        
 SBMJOB     CMD(QSH CMD(&CLRLOGCMD)) JOB(CLRLOGWPS) +                                              
                     JOBD(*USRPRF) JOBQ(&TOOLSLIB/&INSTANCE)                                               
 /* BUILD THE QSHELL COMMAND TO START WEB_SPHERE_PORTAL                       */                                 
 LBL_WPS_1:  CHGVAR     VAR(&STRWPSCMD) +                                                                       
                                            VALUE('/qibm/userdata/webas5/base/' *TCAT +                                           
                                            &INSTANCE *TCAT +                                                                     
                                            '/workplaceserver/bin/strlwpsvr.sh +                                                  

                   Start Workplace Express Server (STRWSESVR)                   
                                                                                
 Type choices, press Enter.                                                     
                                                                                
 WSE Instance Name  . . . . . . .   itsowse2      NAME                          
 Start WebSphere_Portal . . . . .   *YES          *YES *NO                      
 Start server1  . . . . . . . . .   *NO           *YES *NO                      
 Clear logs . . . . . . . . . . .   *YES          *YES *NO                      
                                                                                
                                                                                                                                                                
                                                                                
                                                                                
                                                                         Bottom 
 F3=Exit   F4=Prompt   F5=Refresh   F12=Cancel   F13=How to use this display    
 F24=More keys                                                                  
 Parameter INSTANCE required. 
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                                            WebSphere_Portal -instance ' *CAT +                                                   
                                            &INSTANCE *CAT ' -toolslib ' *CAT &TOOLSLIB)                                          
/* START THE WEBSPHERE_PORTAL                                                */                                 
SBMJOB     CMD(QSH CMD(&STRWPSCMD)) JOB(STRWSESVR) +                                               
                     JOBD(*USRPRF) JOBQ(&TOOLSLIB/&INSTANCE)                                               
 
 
/****************************************************************************/                                  
LBL_SVR1_0: IF         COND(&STR_SVR1 *EQ *NO) THEN(GOTO +                                                     
                                   CMDLBL(LBL_END))                                                                      
  
 IF         COND(&CLR_LOGS *EQ *NO) THEN(GOTO +                                                     
               CMDLBL(LBL_SVR1_1))                                                                   
 
/* BUILD THE QSHELL COMMAND TO CLEAR THE SERVER1 LOGS                        */                                 
CHGVAR     VAR(&CLRLOGCMD) VALUE('rm ' *CAT &LWP_HOME +                                            
                     *TCAT '/../logs/server1/*.log')                                                       
SBMJOB     CMD(QSH CMD(&CLRLOGCMD)) JOB(CLRLOGSV1) +                                               
                    JOBD(*USRPRF) JOBQ(&TOOLSLIB/&INSTANCE)                                               
                                                                                                                   
 /* BUILD THE QSHELL COMMAND TO START SERVER1                                 */                                 
LBL_SVR1_1: CHGVAR     VAR(&STRSVR1CMD) +                                                                      
                                          VALUE('/qibm/userdata/webas5/base/' *TCAT +                                           
                                          &INSTANCE *TCAT +                                                                    
                                           '/workplaceserver/bin/strlwpsvr.sh +                                                  
                                           server1 -instance ' *CAT &INSTANCE *CAT +                                             
                                           ' -toolslib ' *CAT &TOOLSLIB)                                                         
 /* START THE SERVER1                                                         */                                 
 SBMJOB     CMD(QSH CMD(&STRSVR1CMD)) JOB(STRWSESVR) +                                              
                     JOBD(*USRPRF) JOBQ(&TOOLSLIB/&INSTANCE)                                               
  
/* START THE HTTP SERVER                                                     */                                 
SBMJOB     CMD(SBMJOB CMD(STRTCPSVR SERVER(*HTTP) +                                                
                     HTTPSVR(&INSTANCE))) JOB(STRWSESVR) +                                                 
                     JOBD(*USRPRF) JOBQ(&TOOLSLIB/&INSTANCE)                                               
/****************************************************************************/                                  
LBL_END:    ENDPGM 

9.3.5  System values that affect i5/OS performance
There are two system values that you should check on your system to make sure that you can 
obtain the best performance. These are the maximum activity level of the system 
(QMAXACTLVL) and processor multi tasking (QPRCMLTTSK) values.

QMAXACTLVL
The QMAXACTLVL system value specifies the number of threads that can compete at the 
same time for memory and processor resources. For all active subsystems, the sum of all 
threads running in all memory pools cannot exceed the value you specify. If a thread cannot 
be processed because the activity level has been reached, the thread waits until another 
thread reaches a time slice or a long wait. The default setting for this value is *NOMAX.

You can use the Display System Value (DSPSYSVAL) CL command to see the value that this 
system value is set to. If the value is not set to *NOMAX, use the Change System Value 
(CHGSYSVAL) CL command to change the value to *NOMAX, for example:

CHGSYSVAL SYSVAL(QMAXACTLVL) VALUE(*NOMAX)
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QPRCMLTTSK
The QPRCMLTTSK system value controls whether to enable the individual SMP processors 
to concurrently execute multiple instruction streams. Each instruction stream belongs to 
separate tasks or threads. When enabled, each individual processor is concurrently executing 
multiple tasks at the same time. The effect of its use is likely to increase the performance 
capacity of a system or improve the responsiveness of a multi threaded application. Running 
multiple instruction streams at the same time does not improve the performance of any given 
task. Changes to this system value do not take effect until the next IPL.

The default setting of the i5/OS system value QPRCMLTTSK might be incorrect for some 
V5R3M0 installations. The QPRCMLTTSK system value determines whether the hardware 
multithreading feature of the processor, if available, is enabled, disabled, or controlled by the 
operating system.

For details about how to set this system value appropriately for your specific system, see 
APAR II13981 available on the Web at:

http://www-912.ibm.com/n_dir/nas4apar.nsf/0/a4eaa9d8cb2ab5dd86256f690056c078?OpenDocument

9.3.6  Disk tuning
The single-level store architecture of the iSeries server ensures that data is spread evenly 
across all disk units on the system. There are also special I/O processors that help retrieve 
data from the disk to provide for efficient I/O processing. Because of this architecture, it is 
important that you have enough disk arms on your iSeries server to properly balance the I/O.

To determine if disk is a bottleneck on your iSeries server, look at the disk utilization of each 
individual disk unit. It is important that no one disk arm exceeds the % busy utilization 
guideline for the specific disk units in your system. Table 9-6 lists the different disk unit types 
and acceptable utilization guidelines based on the type of input/output adapter (IOA) used 
with the disk units.

Table 9-6   Disk utilization guidelines

Use the Work with Disk Status (WRKDSKSTS) CL command to monitor disk utilization. 
Figure 9-7 shows an example of a healthy disk configuration. This system has eight disk 
arms. The I/O is spread evenly among the disk arms with the highest disk utilization at 34% 
and the lowest at 29%. The disk utilization guidelines for these disk units is 40%.

Disk type Speed 
(RPM)

Utilization guideline (% busy) 
with older IOAs

Utilization guideline (% busy) 
with 2757 or 2780 IOAs

6717 10K 30% 40%

6718 10K 30% 40%

6719 10K 30% 40%

4326 15K 40% 50%

4327 15K 40% 50%

4328 15K 40% 60%

Important: When looking at disk utilization, use the % Busy column. The % Used column 
shows how full each disk unit is.
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Figure 9-7   Healthy disk I/O percent busy

Figure 9-8 shows an example of an unhealthy disk configuration. The disk utilization ranges 
from 63% to 74%. Not only is the utilization too high, but the utilization across disk arms is 
quite unbalanced. To remedy the over utilization situation, more disk arms are required to be 
added to the system. To address the disk arm balance issue, refer to “Balancing I/O across 
disk arms” on page 268.

Figure 9-8   Unhealthy disk I/O percent busy

Balancing I/O across disk arms
When data is added to the iSeries server, the operating system attempts to balance the data 
across all disk arms. When data is deleted and added to the system, some disk arms can 
contain data that is more frequently accessed than data on other arms.

                             Work with Disk Status                     RCHAS12  
                                                             11/03/05  15:35:28 
 Elapsed time:   00:08:24                                                       
                                                                                
                Size    %     I/O   Request   Read  Write   Read  Write    %    
 Unit  Type      (M)  Used    Rqs  Size (K)    Rqs   Rqs     (K)   (K)   Busy   
    1  4326    30769  83.4   38.7      9.9    11.3   27.3   18.3    6.4    30   
    2  4326    30769  83.4   40.8      8.4    10.9   29.8   15.4    5.8    34   
    3  4326    30769  83.5   38.9      8.7     9.9   28.9   15.9    6.2    30   
    4  4326    30769  83.4   35.8     11.1    11.6   24.2   21.9    5.8    29   
    5  4326    30769  83.4   32.9     10.2    10.9   22.0   17.7    6.5    30   
    6  4326    30769  83.4   39.6      9.4    11.2   28.4   18.0    6.0    30   
    7  4326    30769  83.4   43.9      8.9    12.1   31.7   16.7    5.9    31   
    8  4326    30769  83.4   38.1      9.8    11.3   26.8   17.5    6.5    30   
                                                                                                                                                                                                                                                
                                                                         Bottom 
 Command                                                                        
 ===>                                                                           
 F3=Exit   F5=Refresh   F12=Cancel   F24=More keys                              

                             Work with Disk Status                     RCHAS12  
                                                             11/07/05  16:33:21 
 Elapsed time:   00:01:03                                                       
                                                                                
                Size    %     I/O   Request   Read  Write   Read  Write    %    
 Unit  Type      (M)  Used    Rqs  Size (K)    Rqs   Rqs     (K)   (K)   Busy   
    1  4326    30769  98.5   78.3     13.0    19.2   59.0   12.8   13.0    72   
    2  4326    30769  98.5   68.4     12.5    14.2   54.1   12.5   12.6    74   
    3  4326    30769  98.5   78.4     11.4    15.5   62.9   12.5   11.2    68   
    4  4326    30769  98.6   67.3     11.7    17.5   49.7   11.5   11.7    74   
    5  4326    30769  98.5   72.5     13.1    16.5   55.9   14.4   12.7    73   
    6  4326    30769  98.5   68.3     12.1    16.5   51.8   12.6   11.9    63   
    7  4326    30769  98.5   68.6     13.5    16.1   52.4   14.9   13.0    72   
    8  4326    30769  98.5   68.4     12.0    15.8   52.6   11.7   12.1    64   
                                                                                                                                                                
                                                                         Bottom 
 Command                                                                        
 ===>                                                                           
 F3=Exit   F5=Refresh   F12=Cancel   F24=More keys                              
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Operating system utilities can help to rebalance data across disk arms. The Trace ASP 
Balance (TRCASPBAL) CL command is used to collected usage statistics. After the data is 
collected, the Start ASP Balance (STRASPBAL) CL command is used to rebalance data as 
appropriate.

For more details about using these utilities, refer to IBM Software Technical Document 
number 16803317, available on the Web at:

http://www-912.ibm.com/s_dir/slkbase.NSF/0/80a0c71876d5a872862567ca00770cb0?OpenDocument

9.4  Network tuning
In this section, we provide tips on optimizing your i5/OS network by adjusting the TCP/IP 
buffer sizes, duplex settings, frame sizes, and maximum transmission unit (MTU) sizes. 
Additionally we show you how to identify if your network is experiencing Address Resolution 
Protocol (ARP) storms and how to fix this problem if it exists.

9.4.1  TCP/IP buffer sizes
The communication mechanism used extensively by Workplace Services Express is TCP/IP 
sockets. A TCP/IP socket connection uses send and receive buffer sizes to define the size of 
the packet of data that is sent over the wire. You can adjust the size of the send and receive 
buffer sizes to determine flow control. The buffer sizes determine how much data can be sent 
before flow control is interrupted to send or receive another packet of data.

If the window size as defined by the TCP/IP buffers is too small, the receive window buffer can 
be frequently overrun, and the flow control mechanism halts sending data until the application 
can empty the receive buffer. Flow control can use a significant amount of CPU time. It can 
also result in additional network latency due to the stop and start nature on the receive and 
send side of the socket connection.

Because of this fact, we recommend that you increase the send and receive buffer sizes from 
their default 8K values to avoid flow control under normal operating conditions. A larger buffer 
size reduces the potential for flow control to occur, thus improving CPU utilization. If the 
TCP/IP buffers are too large and applications are not consuming data fast enough, system 
performance might be adversely affected. The goal is to avoid flow control, but not allow more 
data to buffer up than the system has the capacity to process.

The optimal buffer size depends on several network environment factors including:

� Types of switches and systems
� Acknowledgment timing
� Error rates and network topology
� Memory size
� Data transfer size

System wide settings can override the default 8K size for TCP/IP socket connections. The 
recommended send and receive buffer size to reduce flow control and not adversely affect 
performance is 65536. This reduces both flow control occurrences and CPU cost.

To change the system-wide value, you use the Change TCP/IP Attributes (CHGTCPA) CL 
command. This command allows you to change both the send and receive buffer sizes. 
Perform the following steps to change the TCP/IP send and receive buffer sizes:
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1. Log on to the iSeries server with a user profile that has *SECADMIN authority.

2. Enter the CHGTCPA CL command and press F4 to prompt it.

3. In the Change IP Attributes (CHGTCPA) display, specify the TCP receive buffer size 
(TCPRCVBUF) and TCP send buffer size (TCPSNDBUF). In our testing environment, 
these parameters were set to 65536, as shown in Figure 9-9. Press Enter. Changes to the 
TCP/IP attributes take effect immediately.

Figure 9-9   Change TCP/IP Attributes (CHGTCPA) command

9.4.2  Optimizing line description settings
In this section, we show you how to optimize line description settings.

Duplex settings
The duplex settings for a line description are either HALF or FULL. The best performance is 
with FULL duplex. However, the duplex setting on the line description must match the setting 
on the port on the switch if the line is hooked up to a switch.

� If the line is connected directly to a 8271 Ethernet switch, the switch’s port is FULL duplex, 
therefore set the duplex setting on the Ethernet line description to FULL.

� If the line is connected to a “stackable” hub, then set the duplex setting on the line to HALF 
to match the hub setting.

 Change TCP/IP Attributes (CHGTCPA)                       
                                                                                
 Type choices, press Enter.                                                     
                                                                                
 TCP keep alive . . . . . . . . . TCPKEEPALV     120                            
 TCP urgent pointer . . . . . . . TCPURGPTR      *BSD                           
 TCP receive buffer size  . . . . TCPRCVBUF    > 65536 
 TCP send buffer size . . . . . . TCPSNDBUF    > 65536 
 TCP R1 retransmission count  . . TCPR1CNT       3                              
 TCP R2 retransmission count  . . TCPR2CNT       16                             
 TCP minimum retransmit time  . . TCPMINRTM      250                            
 TCP closed timewait timeout  . . TCPCLOTIMO     120                            
 TCP close connection message . . TCPCNNMSG      *THRESHOLD                     
 UDP checksum . . . . . . . . . . UDPCKS         *YES                           
 Path MTU discovery:              IPPATHMTU                                     
   Enablement . . . . . . . . . .                *YES                           
   Interval . . . . . . . . . . .                10                             
 IP datagram forwarding . . . . . IPDTGFWD       *NO                            
 IP source routing  . . . . . . . IPSRCRTG       *YES                           
 IP reassembly time-out . . . . . IPRSBTIMO      10                             
                                                                        More... 
 F3=Exit   F4=Prompt   F5=Refresh   F10=Additional parameters   F12=Cancel      
 F13=How to use this display        F24=More keys 

Note: Use care when setting the TCP/IP buffer size on older networks. You also want to 
monitor the number of retransmissions taking place on a given line before you change this 
setting to the 65536 send and receive buffer size. If there are several retransmits on a 
given line, we recommend that you do not set the size of the TCP/IP buffer size to 65536.
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Be aware that setting the duplex setting to AUTO might not have the results that you are 
expecting. You want to explicitly set the duplex setting to HALF or FULL. To set the duplex 
setting, use the Change Line Desc (Ethernet) (CHGLINETH) CL command, for example:

CHGLINETH LIND(<line_name>) DUPLEX(*FULL)

MAXFRAME size
This line description parameter specifies the maximum frame size that can be transmitted and 
received on a line description. Maximizing the frame size in a LAN environment is important 
and supplies best performance for large transfers. Having configured a large frame size does 
not negatively impact performance for small transfers. Both the iSeries server and the other 
link stations must be configured for large frames. Otherwise, the smaller of the two maximum 
frame size values is used in transferring data. Bridges might also limit the maximum frame 
size.

The MAXFRAME size parameter should be set as follows:

� 1496 for < 1 Gb Ethernet
� 8996 for 1 Gb Ethernet

To set the maximum frame size, use the Change Line Desc (Ethernet) (CHGLINETH) 
command, for example:

CHGLINEETH LIND(line_name) MAXFRAME(xxxx)

MTU size
The MTU is the maximum number of bytes allowed in any datagram. By increasing the value 
of this parameter, you can reduce the overall number of transmissions, and therefore, 
increase the potential capacity of the CPU and the input/output processor (IOP).

Similar parameters exist on the client. The negotiated value is the minimum of the server and 
client (and perhaps any bridges or routers). Therefore, increase them all. The recommended 
setting varies depending on the communications protocol that is being used:

� 4 Mb Token Ring = 4060
� 16 Mb Token Ring = 16388
� Ethernet 802.3 = 1492
� Ethernet Version 2 = 1500

To change the MTU size, perform the following steps:

1. On an i5/OS command line, type the Configure TCP/IP (CFGTCP) command and press 
Enter. 

2. In the Configure TCP/IP display, type option 2 (Work with TCP/IP Routes) and press Enter. 

3. In the Work with TCP/IP Routes display, type option 2 in the Opt column next to the IP 
address used by your Workplace Services Express server and press Enter. 

4. On the Change TCP/IP Route display, enter the recommendation from the previous list in 
the Maximum transmission unit parameter and press Enter.

9.4.3  Network routing: ARP storms
This section describes an issue that can occur with the load balancing feature of the iSeries 
network. This problem can occur on your system only if you have more than one network 
interface card (NIC) installed and have intelligent switches that use dynamic route tables.
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Summary of the problem
You can configure the iSeries server to load balance network traffic across any number of 
network interfaces that share a common route. For example, serverA has four network 
interfaces on four separate network adapters:

� 10.1.1.1
� 10.1.1.2
� 10.1.1.3
� 10.1.1.4

A single default route is defined to 10.1.1.5 as shown in the default route configuration in 
Figure 9-10.

Figure 9-10   CFGTCP option 2 - Work with TCP/IP Routes

As a result, any adapter can be used to send data from the system. Requests received on 
10.1.1.1 might be responded to from the network adapter with the 10.1.1.4 interface. The 
response carries the 10.1.1.1 return address and the 10.1.1.4 MAC address.

All TCP network traffic contains the IP address and the MAC address of the network adapter. 
In this situation, the address 10.1.1.1 can be sent with the MAC address of any one of the 
network adapters. This is a valid configuration on the iSeries server.

Some intelligent switches, such as the Cisco 6509 series, dynamically generate a route table, 
which includes not only the IP address of each host but the MAC address of the adapter 
which owns the IP address. As a result, when the iSeries sends a frame with the IP address 
of 10.1.1.1 and the MAC address from the 10.1.1.4 adapter, the switch purges the entries for 
both adapters from its internal table assuming that both are in error. The switch then sends an 
ARP broadcast to generate new table entries. This creates two performance issues:

� Traffic inbound to the iSeries server is held at the switch, pending the update to its table.
� The ARP broadcast is repeated frequently, creating a network constraint.

Identifying the problem
The following steps help you to determine if you are experiencing this problem. This issue 
cannot occur unless you have more than one active NIC. 

1. Determine the number of active NICs on your system:

a. Start iSeries Navigator.

b. Expand Network → TCP/IP Configuration → Lines.

 Work with TCP/IP Routes                             
                                                             System: RCHAS12 
 Type options, press Enter.                                                     
   1=Add   2=Change   4=Remove   5=Display                                      
                                                                                
      Route            Subnet           Next             Preferred              
 Opt  Destination      Mask             Hop              Interface              
                                                                                
      *DFTROUTE        *NONE 10.1.1.5 *NONE                  

Bottom 
 F3=Exit      F5=Refresh   F6=Print list   F11=Display type of service          
 F12=Cancel   F17=Top      F18=Bottom 
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c. One line corresponds to one NIC; count the number of active lines.

• Do not count the line called LOOPBACK.

• Confirm that the status of the line is Active.
• Figure 9-11 shows only one active line. That means there is only one active NIC on 

this iSeries server at this time, and the problem cannot occur in this example. If 
multiple NICs are active, then you continue with the next step.

Figure 9-11   iSeries Navigator displaying active lines

2. If more than one NIC is active on the system, then you must check the TCP/IP routes and 
see if they are bound to specific interfaces. This issue cannot occur if each active NIC has 
its own preferred route defined.

a. Enter the Configure TCP/IP (CFGTCP) command in a 5250 emulation session.

b. Type option 2 (Work with TCP/IP Routes).

3. Determine if your hardware (router or switch) is configured to use dynamic route tables. 
Each router or switch is different, so you might have to ask your network administrator. If 
the router or switch is configured to use dynamic route tables, then you can experience 
this problem. If your router or switch is using static route tables or does not store the Media 
Access Control (MAC) address, then this issue is not occurring.

4. Even if your configuration can experience this problem, it does not mean that you are 
experiencing performance problems because of it. To see how much this type of 
configuration is affecting your network performance, do a communications trace and look 
for ARP broadcasts and changing MAC addresses.

a. Start a communications trace using the Start Communication Trace (STRCMNTRC) 
CL command:

STRCMNTRC CFGOBJ(ETHLINE) CFGTYPE(*LIN) MAXSTG(16M) USRDTA(*CALC)

The CFGOBJ parameter is the name of one of the active lines that you found in step 1.

Note: The problem described in this section can occur at your site if you have 
multiple active NICs, but only one configured route for all interfaces as shown in 
Figure 9-10.

Notes: You might have to run a trace on each active line to look for this problem. Do 
not trace the LOOPBACK line.
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b. Let the trace run for a few minutes and then end it using the End Communication Trace 
(ENDCMNTRC) CL command:

ENDCMNTRC CFGOBJ(ETHLINE) CFGTYPE(*LIN)

c. Print the communications trace with the Print Communication Trace (PRTCMNTRC) 
CL command:

PRTCMNTRC CFGOBJ(ETHLINE) CFGTYPE(*LIN) CODE(*ASCII) SLTCTLD(*ALL) FMTTCP(*YES) 
FMTBCD(*YES)

Notice that the data is formatted for TCP/IP and Broadcast data.

d. Review the communications trace and look for:

• A high number of ARP broadcasts 
• Changing MAC addresses in a single conversation

You can use the following command and select option 5 to display the QPCSMPRT file 
that contains the communications trace data:

WRKJOB OPTION(*SPLF)

e. To find ARP broadcasts, search for the word ARP (all uppercase letters). Use the Find 
field and the F16 key to search the spool file.

f. Count the number of times that an ARP broadcast occurs in your trace.

Use your own judgment to determine if you are seeing too many ARP broadcasts. For 
example, if you run a three-minute trace and count 50 ARP broadcasts, then consider 
changing your TCP/IP configuration to fix this problem.

Figure 9-12 shows an example of an ARP broadcast in an iSeries communications 
trace.

Figure 9-12   Example of an ARP broadcast in a communications trace

g. To identify a changing MAC address, search for a conversation on the port that is 
providing the communication service. In this example, we use port 1352, which is used 
by Lotus Domino.

 Display Spooled File                              
 File  . . . . . :   QPCSMPRT                         Page/Line   20/31         
 Control . . . . . ______ Columns     1 - 78        
 Find  . . . . . .   ARP  
 *...+....1....+....2....+....3....+....4....+....5....+....6....+....7....+... 
      70   S       40  13:33:53.49525               00000C07AC01  0006299C7C99  
                       Frame Type :  IP            DSCP: 0         Length:    4 
                                     Src Addr: 10.1.1.14   Dest Addr: 1

IP Options :  NONE                                       
                       TCP  . . . :  Src Port:    80,Unassigned    Dest Port:   
                                     SEQ Number:           0 ('00000000'X)  ACK 
                                     Code Bits: ACK RST                  Window 

71   R       50  13:33:58.13039               FFFFFFFFFFFF  0004AC5EB196  
                       Frame Type :  ARP           Src Addr: 10.1.1.5  D 
                       ARP Header :  00010800060400010004AC5EB19609055C2F000000 
          Data . . . . . :  0000000000000000 0000000000000000  000036CA5863     
  COMMUNICATIONS TRACE       Title:                                   11/11/05 
  Record       Data    Record           Controller  Destination   Source        
  Number  S/R  Length  Timer            Name        MAC Address   MAC Address   
                                                                        More... 
 F3=Exit   F12=Cancel   F19=Left   F20=Right   F24=More keys 
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Search for 1352 followed by a comma. Use the Find field and F16 to follow a 
conversation and watch the MAC addresses.

Figure 9-13 shows an example of a conversation where the source MAC address is 
changing even though the source IP address is the same.

Figure 9-13   Example of a changing MAC address in a conversation

Tip: Communications traces can be difficult to read. An option in the IBM Support 
Library Tools (QSPTLIB) can take a communications trace and break out a single 
conversation. Use option 6 of the QSPTLIB/CMTMNU menu or the 
QSPTLIB/EXTTCPTRC command to extract TCP/IP trace information.

You can order the IBM Support Library Tools for OS/400 as PTF SE16633 for 
V5R3M0. Follow the instructions received with the download to restore the library to 
your iSeries server.

If you are not using the QSPTLIB tools, keep in mind the following points:

� A single conversation is defined by the port pair (that is the source port and the 
destination port) and the source and destination addresses. In Figure 9-13, the 
port pair is 1352 and 3853.

� To determine if the MAC address is changing, you must find two packets that are 
sent from the iSeries in a single conversation to the same destination that has 
different source MAC addresses. In Figure 9-13, notice that:

– The two packets are in the same conversation (port pair: 1352/3853) and are 
both going in the same direction (source address for both packets: 10.1.1.4, 
which is the iSeries in this example).

– The Source MAC address for those two packets is different; one is 
000944AF54BC, and one is 00000C07AC01.

 Display Spooled File                              
 File  . . . . . :   QPCSMPRT                         Page/Line   22/4          
 Control . . . . .   ______  Columns     23 - 100      
 Find  . . . . . .   1352, 
 ..+....3....+....4....+....5....+....6....+....7....+....8....+....9....+....0 
 Record           Controller  Destination   Source        Frame            Numb 
 Timer            Name        MAC Address   MAC Address   Format  Command  Sent 
 ---------------  ----------  ------------  ------------  ------  -------  ---- 
 13:34:02.14924               0006299C7C99  000944AF54BC   ETHV2   Type: 0800   
 Frame Type :  IP            DSCP: 0         Length:    40        Protocol: TCP 
               Src Addr: 10.1.1.4  Dest Addr: 10.1.1.16  Fra 
IP Options :  NONE                                                             
 TCP  . . . :  Src Port: 1352,Unassigned    Dest Port: 3853,Unassigned   
               SEQ Number:  1276843135 ('4C1B147F'X)  ACK Number: 1771096846 (' 
               Code Bits: ACK                      Window: 65340  TCP Option: N 
13:34:02.20190 0006299C7C99 00000C07AC01 ETHV2   Type: 0800  
 Frame Type :  IP            DSCP: 0         Length:   158        Protocol: TCP 
               Src Addr: 10.1.1.4  Dest Addr: 10.1.1.16 Fra 
IP Options :  NONE                                                             
 TCP  . . . :  Src Port:  1352,Unassigned    Dest Port: 3853,Unassigned  

SEQ Number:  1276843135 ('4C1B147F'X)  ACK Number: 1771096846 ('
               Code Bits: ACK PSH                  Window:  8192  TCP Option: N 
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Fixing the problem
If you determine that ARP storms are happening on your system and they are affecting your 
network performance, then you must change the TCP/IP routing to fix this problem. There are 
two methods to correct this problem (you must only use one method):

� Change the router or switch to use static entries for the system. By creating static entries, 
the device never purges its table, thus avoiding the performance issues.

� Change the TCP/IP configuration on the iSeries server so that each active NIC has its own 
preferred route. Run the Add TCP/IP Route (ADDTCPRTE) CL command to create a 
TCP/IP route for each interface:

ADDTCPRTE RTEDEST(*DFTROUTE) SUBNETMASK(*NONE) NEXTHOP('10.1.1.5') BINDIFC('10.1.1.2')

Figure 9-14 shows an example of preferred bindings on the Work with TCP/IP Routes 
display.

Figure 9-14   CFGTCP option 2 with preferred bindings

9.5  Workplace Services Express tuning
Workplace Services Express performance can be impacted in a number of different ways. 
This section shows you how to:

� Optimize startup times by using a classloader cache file

� Tune the WebSphere Portal server associated with your Workplace Services Express 
server

� Take advantage of Edge Side Include (ESI) caching

� Use XVFB to improve document rendering services

Note: Adding the additional TCP/IP routes is the preferred method for solving ARP 
storms.

 Work with TCP/IP Routes                             
                                                             System: RCHAS12 
 Type options, press Enter.                                                     
   1=Add   2=Change   4=Remove   5=Display                                      
                                                                                
      Route            Subnet           Next             Preferred              
 Opt  Destination      Mask             Hop              Interface              
                                                                                
      *DFTROUTE        *NONE 10.1.1.5 10.1.1.1  
      *DFTROUTE        *NONE 10.1.1.5 10.1.1.2  

*DFTROUTE  *NONE 10.1.1.5 10.1.1.3
*DFTROUTE  *NONE 10.1.1.5 10.1.1.4

                                                                         Bottom 
 F3=Exit      F5=Refresh   F6=Print list   F11=Display type of service          
 F12=Cancel   F17=Top      F18=Bottom 

Note: Many of the tuning adjustments discussed in this section will be applied 
automatically by a Workplace Services Express deployment script in a future release of the 
Workplace Services Express product.
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9.5.1  Startup performance tuning
The startup time of the Workplace Services Express server can be improved by making call 
caching changes to the JVM environment. In our lab environment, this change reduced the 
overall startup time of the WebSphere_Portal server from over 30 minutes to 10 to 12 
minutes. The caching change involves two steps:

1. Creating a Classloader Cache file on the i5/OS file system
2. Configuring the Workplace JVMs to use the classloader cache file

For more information about the classloader cache, reference page 4 of the Basic Java 
Performance for iSeries guide, which is available on the Web at:

http://www.ibm.com/servers/eserver/iseries/perfmgmt/pdf/BasicJavaPerf.pdf

Creating a classloader cache file on the i5/OS file system
The first step in improving the startup times of a Workplace Services Express server is to 
create the classloader cache file. This file resides in the integrated file system on the i5/OS. 
The classloader cache is a feature that allows the JVM to remember classes that have been 
loaded with user classloaders. This features improves the startup performance of classes 
loaded by user classloaders. It allows Java programs created by user classloaders to be 
cached for reuse, avoiding Java program creation and bytecode verification during the initial 
class loading.

You must select a location for the classloader cache file. We recommend that you do not 
place the classloader cache file in a temporary directory, because it might get deleted. In our 
example, we created the classloadercache.jar file in a directory called /cache.

The following steps explain how to create this file from the Qshell environment on the iSeries 
server. 

1. From an i5/OS command line, run the STRQSH command to access the Qshell environment.

2. Switch to the directory where the JAR file will reside. Make the directory first using the 
mkdir command if necessary.

mkdir /cache
cd /cache

3. Create a dummy file to place the JAR file. The name can be anything; we used example:

touch example

4. Build the JAR file using the jar command. In this example, we create a .jar file called 
classloadercache.jar:

jar -cf classloadercache.jar example

Note: You must only create the classloader cache file one time on an iSeries server 
because multiple Workplace Services Express servers can use this file.
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5. Clean up the dummy file that was created using the touch command from step 3.

rm example

Figure 9-15 shows the results of these commands from within Qshell.

Figure 9-15   Creating the classloadercache.jar file from Qshell environment

6. Press F3 to exit Qshell.

The classloadercache.jar file is now created on the i5/OS file system and is ready for use by 
the Workplace Services Express server or servers. We recommend that you change the 
ownership of this file to the QEJBSVR profile. Use the Change Owner (CHGOWN) CL 
command to change the ownership:

CHGOWN OBJ('/cache/classloadercache.jar') NEWOWN(QEJBSVR)

Configuring the JVMs to use the classloader cache
Now that the classloader cache file has been created, we must enable its use in the JVMs 
that will be used by the Workplace Services Express servers. You use the WebSphere 
Application Server Administrative Console to enable the Workplace JVMs to use the 
classloader cache.

In this section you define new Java system properties that is set in the memory of this JVM to 
improve startup performance of the Websphere_Portal server. You define the following 
properties:

� os400.define.class.cache.file is required to enable the Java user classloader cache 
function. This property is set to the full path name of a valid .jar file that holds the Java 
program objects. This is the classloader cache file that you created in “Creating a 
classloader cache file on the i5/OS file system” on page 277.

� os400.define.class.cache.hours specifies how long an unused Java program persists in 
the cache. When the timeout is reached, the Java program is removed from the class. This 
value is specified in an interval of hours.

� os400.define.class.cache.maxpgms specifies the maximum number of Java programs 
that the cache can hold. When the value specified is reached, the least recently accessed 
Java program is replaced.

                               QSH Command Entry                                
                                                                                
   $                                                                            
 > mkdir /cache                                                                 
   $                                                                            
 > cd /cache                                                                    
   $                                                                            
 > touch example                                                                
   $                                                                            
 > jar -cf classcacheloader.jar example                                         
   $                                                                            
 > rm example                                                                   
   $ 
                                                                                
 ===> 
 F3=Exit   F6=Print F9=Retrieve F12=Disconnect                                  
 F13=Clear F17=Top  F18=Bottom  F21=CL command entry 
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To define these new properties, perform the following steps:

1. Open the WebSphere Application Server Administrative Console for the Workplace 
Services Express server. For details, see 5.6, “Accessing the WebSphere Application 
Server Administrative Console” on page 127.

2. Log in as the Workplace Services Express administrator.

3. Navigate to the Servers → Application Servers view as shown in Figure 9-16.

Figure 9-16   WebSphere Application Server Administrative Console
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4. In the right pane, select the WebSphere_Portal server. See Figure 9-17.

Figure 9-17   Selecting the WebSphere_Portal server

5. In the WebSphere_Portal pane, scroll down to the Additional Properties section and select 
Process Definition as shown in Figure 9-18.

Figure 9-18   Selecting the Process Definition property
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6. In the Process Definition pane, under the Additional Properties section, select Java 
Virtual Machine as shown in Figure 9-19.

Figure 9-19   Selecting the Java Virtual Machine property

7. In the Java Virtual Machine pane, under the Additional Properties section, select Custom 
Properties as shown in Figure 9-20.

Figure 9-20   Selecting Custom Properties

8. You now add the following three Java system properties that will be associated with the 
JVM for this WebSphere_Portal server:

– os400.define.class.cache.file 
– os400.define.class.cache.hours
– os400.define.class.cache.maxpgms

a. Click the New button to define a new custom property.

b. Set the following Name and Value parameters as shown in Figure 9-21 and click OK.

Name: os400.define.class.cache.file
Value: /cache/classloadercache.jar

Figure 9-21   Defining the new custom property for os400.define.class.cache.file

c. Under Additional Properties, select Custom Properties (see Figure 9-20).

d. Click the New button to define a new custom property.

 

 

 

Chapter 9. Performance tuning 281



 

e. Set the following Name and Value parameters as shown in Figure 9-22 and click OK.

Name: os400.define.class.cache.hours
Value: 168

Figure 9-22   Defining the new custom property for os400.define.class.cache.hours

f. Under Additional Properties, select Custom Properties (see Figure 9-20).

g. Click the New button to define a new custom property. 

h. Set the following Name and Value parameters as shown in Figure 9-23 and click OK.

Name: os400.define.class.cache.maxpgms
Value: 40000

Figure 9-23   Defining the new custom property for os400.define.class.cache.maxpgms
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i. Click Save to save and apply the changes to the master configuration file as shown in 
Figure 9-24.

Figure 9-24   Applying the changes to the master configuration

9. Click Save as shown in Figure 9-25 to save the changes to the master configuration.

Figure 9-25   Saving the changes to the master configuration

10.Stop and restart the WebSphere_Portal server to enable the custom properties that you 
just created. Refer to 5.1, “Starting and stopping a Workplace Services Express server” on 
page 106, for details.

Verifying the classloader cache file is being used
When the WebSphere_Portal server is restarted, the JVM in which it is running uses the new 
properties that you just created. Any typos in the properties that you added cause them to not 
be used by the WebSphere_Portal server’s JVM. To verify that the JVM is really using the 
classloader cache file that you created and have now pointed the WebSphere_Portal server 
to, use the Display Java Program Information (DSPJAVPGM) CL command:

DSPJVAPGM CLSF('/cache/classloadercache.jar') 
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Figure 9-26 shows an example of displaying the information for this file. The key value to 
observe is the number associated with Java programs. The value here should grow as the 
Workplace Services Express server’s portal server starts and user activity begins.

Figure 9-26   Display Java Program Information

9.5.2  Workplace Services Express portal tuning
The critical elements that you should address to optimize the Workplace Services Express 
portal server include:

� Connection pools
� WebSphere Portal server settings
� Statement cache size

We examine each of these tuning elements in the sections that follow.

Connection pools
This section focuses on setting the minimum and maximum connections in each of the 
connection pools. The minimum and maximum connection pool values that are changed in 
this section from the WebSphere Application Server Administrative Console are listed in 
Table 9-7, Table 9-8, and Table 9-9. These are initial values that you should use as starting 
points. We recommend that you do not keep the minimum connections at the default value 
of 1 when running on i5/OS.

Note: Displaying the classloader cache file from the i5/OS is not dynamically updated. Exit 
and display the file again to view updated statistics.

                        Display Java Program Information                        
 File name  . . . . . . . . . . . . . . . :   /cache/classloadercache.jar       
 Owner  . . . . . . . . . . . . . . . . . :   QEJBSVR                           
                                                                                                                                                               
                                                                                
 Java program creation information:                                             
   File change date/time  . . . . . . . . . . . . . :   11/01/05  17:15:22      
   Java program creation date/time  . . . . . . . . :   11/02/05  15:52:49      
   Java programs  . . . . . . . . . . . . . . . . . :   5765                    
   Total classes in source  . . . . . . . . . . . . :   0                       
   Classes with current Java programs . . . . . . . :   0                       
   Classes without current Java programs  . . . . . :   0                       
   Classes containing errors  . . . . . . . . . . . :   0                       
   Optimization . . . . . . . . . . . . . . . . . . :   *INTERPRET              
   Enable performance collection  . . . . . . . . . :   *NONE                   
   Use adopted authority  . . . . . . . . . . . . . :   *NO                     
   User profile . . . . . . . . . . . . . . . . . . :   *USER                   
                                                                        More... 
 Press Enter to continue.                                                       
                                                                                
 F3=Exit   F12=Cancel   F22=Display entire field                                
 (C) COPYRIGHT IBM CORP. 1980, 2003. 
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You adjust the connection pool minimum and maximum settings for the following JDBC 
providers:

� lwp25JDBC
� wpcp50JDBC
� wps50JDBC

Table 9-7 shows the recommended maximum and minimum connection pool sizes for the 
lwp25JDBC provider. The Default value max/min column lists the default setting for the 
values, and the Recommended value max/min column lists the recommended initial setting.

Table 9-7   Recommended initial values for the lwp25JDBC provider

Table 9-8 lists the maximum and minimum connection pool sizes for the wpcp50JDBC 
provider.

Table 9-8   Recommended initial values for the wpcp50JDBC JDBC provider

Table 9-9 shows the recommended maximum and minimum connection pool settings for the 
wps50JDBC provider.

Table 9-9   Recommended initial values for the wps50JDBC JDBC provider

The WebSphere Application Server Administrative Console is used to access the connection 
pool settings for the Workplace Services Express server.

Note: Monitor the initial recommended values and adjust them to optimize performance in 
your specific Workplace Services Express environment.

Connection pool value Default value 
max/min

Recommended 
value max/min

Resources → JDBC Providers → lwp25JDBC → Data 
Sources → lwpApp → Connection Pool

40/1 50/50

Connection pool value Default value 
max/min

Recommended 
value max/min

Resources → JDBC Providers → wpcp50JDBC → Data 
Sources → feedback5 → Connection Pool

10/1 50/30

Resources → JDBC Providers → wpcp50JDBC → Data 
Sources → wpcpdfds → Connection Pool

10/1 50/30

Resources → JDBC Providers → wpcp50JDBC → Data 
Sources (Version 4) → feedbackDS → Connection Pool

30/1 50/30

Resources → JDBC Providers → wpcp50JDBC → Data 
Sources (Version 4) → persDS → Connection Pool

30/1 50/30

Resources → JDBC Providers → wpcp50JDBC → Data 
Sources (Version 4) → wcmDS → Connection Pool

30/1 64/64

Connection pool value Default value 
max/min

Recommended 
value max/min

Resources → JDBC Providers → wps50JDBC → Data 
Sources → wmmDS → Connection Pool

10/1 50/30

Resources → JDBC Providers → wps50JDBC → Data 
Sources → wps50DS → Connection Pool

10/1 50/50
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Perform the following steps to set the recommended initial values of the connection pools:

1. Open the WebSphere Application Server Administrative Console for the Workplace 
Services Express server. For details, see 5.6, “Accessing the WebSphere Application 
Server Administrative Console” on page 127.

2. Log in as the Workplace Services Express administrator.

3. Under the Workplace Services Express server, expand the Resources view and select 
JDBC Providers as shown in Figure 9-27.

Figure 9-27   WebSphere Application Server Administrative Console

4. In the JDBC Providers pane, scroll down and click lwp25JDBC as shown in Figure 9-28.

Figure 9-28   Selecting lwp25JDC from the JDBC Providers pane

Important: Changes to the connection pool settings require that you restart the Workplace 
Services Express server to enable them.
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5. In the lwp25JDBC pane, under Additional Properties, select Data Sources (Figure 9-29).

Figure 9-29   Selecting Data Sources under Additional Properties for lwp25JDBC

6. In the Data Sources pane, select lwpApp as shown in Figure 9-30.

Figure 9-30   Selecting lwpApp under Resources → JDBC Providers → lwp25JDBC → Data Sources

7. In the lwpApp pane, under Additional Properties, select Connection Pool as shown in 
Figure 9-31.

Figure 9-31   Selecting Connection Pool
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8. Under General Properties, set both Max Connections and Min Connections to an initial 
value of 50 as shown in Figure 9-32. These values are represented in Table 9-7 on 
page 285.

Figure 9-32   Setting the Min and Max Connections

9. Click Apply to begin the process of saving these values.

10.Click Save to save the values as shown in Figure 9-33.

Figure 9-33   Saving the changes

Note: The value of 50 connections is used as a starting point and can be adjusted to 
meet a Workplace Services Express environment. We recommend that you do not keep 
the minimum connections at the default value of 1 when running on i5/OS.

 

 

 

288 Deploying IBM Workplace Services Express on the IBM Eserver iSeries Server



 

11.Click the Save button to complete the saving of the connection pool values to the master 
configuration as shown in Figure 9-34.

Figure 9-34   Saving the connection pool values to the master configuration

12.You return to the main page for the Workplace Services Express server that you are 
administering.

13.Under Resources, click JDBC Providers again as shown in Figure 9-27 on page 286.

14.Using Table 9-8 on page 285 as a guide, change the connection pool settings for the 
wpcp50JDBC JDBC provider.

15.Save the maximum and minimum wpcp50JDBC connection pool values.

16.Under Resources, click JDBC providers again. See Figure 9-27 on page 286.

17.Using Table 9-9 on page 285 as guide, change the connection pool settings for the 
wps50JDBC JDBC provider. 

18.Save the minimum and maximum wps50JDBC connection pool values.

19.After all the connection pool values are changed, stop and restart the Workplace Services 
Express server.

After the new Connection Pool values are enabled, monitor the performance and adjust these 
values to meet your WorkPlace Services Express server environment needs. Use the Tivoli 
Performance Viewer to monitor performance. For details about how to use the Tivoli 
Performance Viewer, see “Monitoring performance with Tivoli Performance Viewer (TPV)” in 
the WebSphere Application Server Express Version 6.0.x Information Center at:

http://publib.boulder.ibm.com/infocenter/wasinfo/v6r0/index.jsp?topic=/com.ibm.websphere.ex
press.doc/info/exp/ae/tprf_tpvmonitor.html

Important: Before you move on to the next step, save the changes made to each 
connection pool.
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WebSphere Portal server settings
This section discusses that recommended changes in the Workplace Services Express 
server to optimize performance when running on i5/OS. The WebSphere Application Server 
Administrative Console is used to set these values to begin optimizing performance. 
Table 9-10 provides the recommended WebSphere_Portal values.

Table 9-10   WebSphere_Portal recommended settings

After you log into the WebSphere Application Server Administrative Console, perform the 
following steps to set the initial recommended values.

1. Under the Workplace Services Express server, expand the Servers view and select 
Application Servers as shown in Figure 9-35.

Figure 9-35   WebSphere Application Server Administrative Console

Note: Since the service server1 is only used as a SOAP connection during the Workplace 
Services Express server configuration and for some administrative functions, we only 
document the Websphere_Portal server changes here.

Websphere_Portal server settings Default value 
min/max

Recommended 
value min/max

Server → Application Server → WebSphere_Portal → Web 
Container → Thread Pool

10/50 50/50

Server → Application Server → WebSphere_Portal → 
Logging and Tracing → IBM Service Logs → Message 
Filtering

Log all 
messages

Log error
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2. In the Application Servers pane (Figure 9-36), click Websphere_Portal server. 

Figure 9-36   Selecting WebSphere_Portal from Servers → Application Servers

3. In the WebSphere_Portal pane, under the Additional Properties section, click Web 
Container (Figure 9-37). 

Figure 9-37   Selecting Web Container under Additional Properties

4. In the Web Container pane, under the Additional Properties section, click Thread Pool 
(Figure 9-38).

Figure 9-38   Selecting Thread Pool under Additional Properties
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5. In the Thread Pool pane, under General Properties, set the Minimum and Maximum Size 
to 50. See Figure 9-39.

Figure 9-39   Setting the Minimum and Maximum Size threads

6. Click Apply to begin the process of saving these values.

7. Click Save to continue saving the values. See Figure 9-33 on page 288 for an example.

8. Click the Save button to complete the saving of the Thread Pool Properties as shown in 
Figure 9-34 on page 289.

9. Navigate back to Servers → Application Servers → Websphere_Portal.

10.In the WebSphere_Portal pane, click Logging and Tracing (Figure 9-40).

Figure 9-40   Selecting Logging and Tracing for Websphere_Portal

Note: The default maximum size for the thread pool is 50. You are not required to 
change this setting unless it was previously altered.
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11.In the Logging and Tracing pane, click IBM Service Logs as shown in Figure 9-41.

Figure 9-41   Selecting IBM Service Logs under Logging and Tracing

12.In the IBM Service Logs page, change the Message Filtering field from Log all messages 
to Log error as shown in Figure 9-42.

Figure 9-42   Setting the Message Filtering field to Log error

13.Click Apply to begin the process of saving these values.

14.Click Save to continue saving the values. See Figure 9-33 on page 288 as an example.

15.Click the Save button to complete the saving of the properties as shown Figure 9-34 on 
page 289.

16.Stop and restart the Websphere_Portal server to enable these settings.

Note: Lowering the level of logging is a trade-off between optimizing performance and 
providing the necessary logging required in your operating environment. Consider this 
trade-off for each individual Workplace Services Express server prior to making the 
error logging change.
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Statement cache size
The statement cache is used to hold database queries that have gone through the prepare 
phase. The prepare phase is required so the database engine, DB2 Universal Database in 
our case, can parse the SQL text and perform the steps necessary to put the query into a 
form the database can understand. After a database query is prepared, it can be run over and 
over again without going through the prepare step. These prepared statements are placed in 
the statement cache, making it important that the size of the statement cache is set correctly.

For most implementations, you must increase the size of the default statement cache of a 
Workplace Services Express server. The actual increase varies by environment. The default 
statement cache size of 10 is typically too low for most production environments and therefore 
must be increased.

For details about how to determine whether you must increase the statement cache size on 
your Workplace Services Express server, refer to the white paper Tuning the WebSphere 
Prepared Statement Cache, which you can find on the Web at:

http://www.ibm.com/servers/eserver/iseries/perfmgmt/pdf/stmntcache.pdf

You can change the statement cache size from the WebSphere Application Server 
Administrative Console. After you log into the WebSphere Application Server Administrative 
Console, perform the following steps to set the initial recommended values:

1. Under the Workplace Services Express server, expand the Resources view and select 
JDBC Providers, as shown in Figure 9-27 on page 286.

2. In the JDBC Providers pane, scroll down and select lwp25JDBC. See Figure 9-43.

Figure 9-43   Selecting lwp25JDBC from Resources → JDBC Providers

3. In the lwp25JDBC pane, under the Additional Properties section, click Data Sources 
(Figure 9-44).

Figure 9-44   Selecting Data Sources from JDBC Providers → lwp25JDBC

Tip: It is important to increase the statement cache size when the connection pool sizes 
are increased. You can monitor the statement cache by using the Tivoli Performance 
Viewer.
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4. In the Data Sources page, click lwpApp (see Figure 9-45).

Figure 9-45   Selecting lwpApp

5. In the lwpApp pane, change the Statement Cache Size field to a higher value than the 
default of 10. The recommended starting value is 100. See Figure 9-46.

Figure 9-46   Changing the Statement Cache Size field

6. Click Apply to begin the process of saving these values.

7. Click Save to continue saving the values. See Figure 9-33 on page 288 for an example.

8. Click the Save button to complete the saving of the Statement Cache Size as shown in 
Figure 9-34 on page 289.

9. Stop and restart the Workplace Services Express server to enable the change.

9.5.3  Configuring Edge Side Include caching
This section explains how to enable the Web server plug-in containing the built-in Edge Side 
Include (ESI) processor. The ESI processor has the ability to cache whole pages, as well as 
fragments, providing a higher cache hit ratio. The cache implemented by the ESI processor is 
an in-memory cache, not a disk cache. Therefore, the cache entries are not saved when the 
Web server is restarted.

For more information, refer to Configuring Edge Side Include caching in the Information 
Center on the Web at:

http://publib.boulder.ibm.com/infocenter/wsphelp/index.jsp?topic=/com.ibm.websphere.nd.doc/
info/ae/ae/tprf_esiedgecaching.html

Important: The ESI cache is effective only while the Workplace Services Express server is 
running. If you restart the server, all pages must be recached.

 

 

 

Chapter 9. Performance tuning 295

http://publib.boulder.ibm.com/infocenter/wsphelp/index.jsp?topic=/com.ibm.websphere.nd.doc/info/ae/ae/tprf_esiedgecaching.html
http://publib.boulder.ibm.com/infocenter/wsphelp/index.jsp?topic=/com.ibm.websphere.nd.doc/info/ae/ae/tprf_esiedgecaching.html
http://publib.boulder.ibm.com/infocenter/wsphelp/index.jsp?topic=/com.ibm.websphere.nd.doc/info/ae/ae/tprf_esiedgecaching.html
http://publib.boulder.ibm.com/infocenter/wsphelp/index.jsp?topic=/com.ibm.websphere.nd.doc/info/ae/ae/tprf_esiedgecaching.html


 

We recommend that you end the Workplace Services Express server to enable the ESI 
processor. Perform the following steps to enable the ESI processor:

1. Stop the Workplace Services Express server. See 5.1, “Starting and stopping a 
Workplace Services Express server” on page 106, for details.

2. From an i5/OS command line, edit the plugin-cfg.xml file using the Edit File (EDTF) CL 
command. This file is in the /QIBM/UserData/WebAS5/base/WSEServerName/
config/cells/directory of the integrated file system of the iSeries server. In this directory 
name, WSEServerName is the name of your Workplace Services Express server.

For example, to edit the plugin-cfg.xml file for the Workplace Services Express server 
called ITSOWSE2, run the following EDTF command:

EDTF '/QIBM/UserData/WebAS5/base/ITSOWSE2/config/cells/plugin-cfg.xml'

Figure 9-47 shows an example of the contents of this file.

Figure 9-47   Editing the plugin-cfg.xml file

3. Find the parameter <Property Name="ESIEnable" Value="false"/> and change it to 
<Property Name="ESIEnable" Value="true"/>, as shown in Figure 9-48.

4. Adjust the value of the parameter that follows to <Property Name="ESIMaxCacheSize" 
Value="1024"/> also shown in Figure 9-48.

Set the EISMaxCacheSize to a size that is large enough to hold statically served images 
and pages that the Workplace Services Express server will be serving up. If you have a lot 

Important: If Secure Sockets Layer (SSL) is enabled, enabling the ESI processor is not 
supported and should be left disabled.

Note: You are unable to edit the plugin-cfg.xml file from the iSeries Navigator interface.

 Edit File: /qibm/userdata/webas5/base/itsowse2/config/cells/plugin-cfg.xml     
 Record :       1   of     359 by   8            Column :    1     91 by  74    
 Control :                                                                      
                                                                                
CMD ....+....1....+....2....+....3....+....4....+....5....+....6....+....7....+ 
     ************Beginning of data**************                                
    <?xml version="1.0" encoding="ISO-8859-1"?>                                 
    <Config ASDisableNagle="false" AcceptAllContent="false"                     
        AppServerPortPreference="HostHeader" ChunkedResponse="false"            
        IISDisableNagle="false" IISPluginPriority="High"                        
        IgnoreDNSFailures="false" RefreshInterval="60"                          
        ResponseChunkSize="64" VHostMatchingCompat="false">                     
        <Log LogLevel="Error" Name="/QIBM/UserData/WebAS5/Base/ITSOWSE2/logs/ht 
        <Property Name="ESIEnable" Value="false"/>                              
        <Property Name="ESIMaxCacheSize" Value="1024"/>                         
        <Property Name="ESIInvalidationMonitor" Value="false"/>                 
        <VirtualHostGroup Name="default_host">                                  
            <VirtualHost Name="*:10222"/>                                       
            <VirtualHost Name="*:80"/>                                          
            <VirtualHost Name="*:10223"/>                                       
                                                                                
 F2=Save   F3=Save/Exit   F12=Exit   F15=Services   F16=Repeat find             
 F17=Repeat change  F19=Left  F20=Right 
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of statically served pages and images, increase the size upward from the default 1 Mb 
value.

Figure 9-48   Changing the plugin-cfg.xml file to enable ESI caching

5. Press F3 twice to save and exit the file.

6. Start the Workplace server to enable the ESI processor.

Setting the ESI timeout for the JVM
An ESI timeout value is also associated with the JVM. The value specified for the 
KeepAliveTimeout and JVM ESI timeout values must match. If you change the default setting 
for KeepAliveTimeout, you must increase the ESI timeout value from the default of 300 
seconds (5 minutes). To increase the ESI timeout value to a higher value, set the property 
-Dcom.ibm.com.servlet.file.esi.timeOut for the JVM associated with the WebSphere_Portal 
server.

To set the JVM ESI timeout value, perform the following steps:

1. Open the WebSphere Application Server Administrative Console for the Workplace 
Services Express server. For details, see 5.6, “Accessing the WebSphere Application 
Server Administrative Console” on page 127.

2. Log in as the Workplace Services Express administrator.

Note: Refer to the article “Optimizing Static-File Serving in a WebSphere Application,” 
which contains information about how to set the ESI cache size. You can find this article 
on the Web at:

http://www.eservercomputing.com/ME2/Audiences/dirmod.asp?sid=&nm=&type=Publishing&mod
=Publications%3A%3AArticle&mid=8F3A7027421841978F18BE895F87F791&AudID=1E8FEE745A28452
1B6CFB3FD70B49099&tier=4&id=54E37DA2F24341BC84C0F25B5A41218D

 Edit File: /qibm/userdata/webas5/base/itsowse2/config/cells/plugin-cfg.xml     
 Record :       1   of     359 by   8            Column :    1     91 by  74    
 Control :                                                                      
                                                                                
CMD ....+....1....+....2....+....3....+....4....+....5....+....6....+....7....+ 
     ************Beginning of data**************                                
    <?xml version="1.0" encoding="ISO-8859-1"?>                                 
    <Config ASDisableNagle="false" AcceptAllContent="false"                     
        AppServerPortPreference="HostHeader" ChunkedResponse="false"            
        IISDisableNagle="false" IISPluginPriority="High"                        
        IgnoreDNSFailures="false" RefreshInterval="60"                          
        ResponseChunkSize="64" VHostMatchingCompat="false">                     
        <Log LogLevel="Error" Name="/QIBM/UserData/WebAS5/Base/ITSOWSE2/logs/ht 
        <Property Name="ESIEnable" Value="true/>                                
        <Property Name="ESIMaxCacheSize" Value="1024"/>                         
        <Property Name="ESIInvalidationMonitor" Value="false"/>                 
        <VirtualHostGroup Name="default_host">                                  
            <VirtualHost Name="*:10222"/>                                       
            <VirtualHost Name="*:80"/>                                          
            <VirtualHost Name="*:10223"/>                                       
                                                                                
 F2=Save   F3=Save/Exit   F12=Exit   F15=Services   F16=Repeat find             
 F17=Repeat change  F19=Left  F20=Right 
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3. Navigate to Servers → Application Servers as shown in Figure 9-49.

Figure 9-49   Selecting Server -> Application Servers

4. In the Application Servers pane, click the WebSphere_Portal link.

5. In the WebSphere_Portal pane, under the Additional Properties section, click the Process 
Definition link.

6. In the Process Definition pane, under the Additional properties section, click the Java 
Virtual Machine link.

7. In the Java Virtual Machine pane, scroll down to the Generic JVM arguments field. Add the 
value -Dcom.ibm.servlet.file.esi.timeOut=900 to this Generic JVM argument 
parameter as shown in Figure 9-50. If you set the ESI timeout value to something other 
than 15 minutes, change the value here as appropriate. Click OK.

Figure 9-50   Setting the Generic JVM arguments field to -Dcom.ibm.servlet.file.esi.timeOut=900 

Note: If there is already an argument in the Generic JVM arguments parameter, place a 
space after that argument and add the new -Dcom.ibm.servlet.file.esi.timeOut=900 
value.
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8. Click Save to save and apply the changes to the master configuration file shown in 
Figure 9-33 on page 288.

9. Click Save as shown Figure 9-34 on page 289 to save the changes to the master 
configuration.

10.Restart the Workplace Services Express server.

9.5.4  X virtual frame buffer verses virtual network computing
When you start your Workplace Services Express server, you are asked to choose a 
document rendering service. This document rendering capability is required for the document 
management portal. Documents produced by many standard applications (such as word 
processors or spreadsheets) can be viewed as HTML pages using the document conversion 
services of Workplace Services Express. This document conversion service is provided via 
one of two mechanisms on the iSeries server:

� X virtual frame buffer (XVFB) 
� Virtual network computing (VNC)

The XVFB document rendering service is much more efficient than using the VNC server. To 
obtain the XVFB server, you must have installed the following items on your iSeries server:

� 5722-SS1 Option 43
� 5722-DG1 PTF SI20496

For more details about obtaining PTFs, refer to 5.9, “Obtaining and applying fixes” on 
page 152.

The option of selecting which document rendering server will be used for a Workplace 
Services Express server occurs when you start the server. Figure 9-51 shows how you select 
the XVFB document rendering service.

Figure 9-51   Selecting XFVB as the document rendering service

Note: If you do not have PTF SI20496 installed, the only document rendering service you 
see is VNC.
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9.6  Java tuning
There are several JVMs running within the Workplace Services Express server. Each has 
specific tuning requirements that must be monitored to determine the exact values for a 
particular installation. The following section discusses how to set the heap size of the JVM 
used by the WebSphere Portal server within a Workplace Services Express server.

You can find additional Java tuning recommendations in “Configuring the JVMs to use the 
classloader cache” on page 278 and “Connection pools” on page 284.

9.6.1  JVM heap sizes
Tuning the initial heap size of the JVM so the garbage collector runs at a suitable interval is 
critical to achieving optimal performance. The garbage collector should run infrequently 
enough that it does not cause unnecessary overhead and often enough that the heap size 
does not grow too large.

The default heap size is 256 MB, but larger values are sometimes necessary, especially on 
systems with multiple processors. It is key to adjust the heap size for the specific 
requirements of a Workplace Services Express server to obtain the best performance.

Set the initial heap size for the WebSphere_Portal server in the Workplace Services Express 
server to:

� Initial heap size = 512
� Maximum heap size = 0

For the Server1 server in the Workplace Services Express server, set the heap size to:

� Initial heap size = 256
� Maximum heap size = 0

Setting the JVM heap size
Perform the following steps to change the JVM heap size:

1. Open the WebSphere Application Server Administrative Console for the Workplace 
Services Express server. For details, see 5.6, “Accessing the WebSphere Application 
Server Administrative Console” on page 127.

2. Log in as the Workplace Services Express administrator.

Note: Setting the maximum heap size to 0 is equivalent to setting it to *NOMAX. This 
means that garbage collection runs only when the garbage collection threshold is reached. 
In scenarios where memory is limited, it is helpful to set the maximum heap size to a value 
that impacts memory less. In limited memory scenarios, we recommend that you use a 
maximum heap size of 256 MB.

If you set the maximum heap size to a value other than 0, reduce the initial heap size 
setting as well.
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3. Navigate to Servers → Application Servers as shown in Figure 9-52 and click 
WebSphere_Portal server.

Figure 9-52   WebSphere Application Server Administrative Console

4. In the WebSphere_Portal pane, scroll down to the Additional Properties section and select 
Process Definition (Figure 9-53).

Figure 9-53   Selecting Process Definition

5. In the Process Definition pane, under the Additional Properties section, select Java 
Virtual Machine (Figure 9-54).

Figure 9-54   Selecting Java Virtual Machine
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6. In the Java Virtual Machine pane (Figure 9-55), change the Initial Heap Size parameter as 
needed. We recommend that you start with 512 MB and adjust it from there. Set the 
Maximum Heap Size to 0 to allow for an unlimited maximum heap size. Click OK.

Figure 9-55   Setting the Initial and Maximum Heap Sizes

7. Click Save to save and apply the changes to the master configuration file shown in 
Figure 9-33 on page 288.

8. Click the Save button as shown Figure 9-34 on page 289 to save the changes to the 
master configuration.

9. Stop and restart the Workplace Services Express server. For details, refer to 5.1, “Starting 
and stopping a Workplace Services Express server” on page 106.

For additional information related to setting the initial heap size, see the Tuning Garbage 
Collection for Java and WebSphere on iSeries white paper, which is available on the Web at:

http://www.ibm.com/servers/eserver/iseries/perfmgmt/pdf/tuninggc.pdf

9.7  IBM HTTP Server tuning
The IBM HTTP Server passes requests to the Workplace Services Express server. Therefore, 
it is necessary to make sure that this piece of the overall architecture is not causing any 
bottlenecks. This section discusses methods for tuning the IBM HTTP Server.

9.7.1  Monitoring HTTP real-time statistics
You can use the IBM Web Administration for iSeries interface to access real-time HTTP 
server statistics for monitoring. These statistics help you to tune the HTTP server to best 
handle the Workplace Services Express environment workload.

Tip: We recommend that you do not set the initial heap size to a size greater than or 
equal to one-fourth of the total amount of memory in the memory pool where the 
Workplace Services Express server is running.

Note: If you make multiple changes, wait until you change all settings before you restart 
the Workplace Services Express server.
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Perform the following steps to monitor HTTP real-time statistics for the IBM HTTP Server 
associated with your Workplace Services Express server:

1. Access the IBM Web Administration for iSeries by pointing your Web browser to your fully 
qualified iSeries host name on port 2001:

http://iSeriesHostName.domain:2001

In our example, we enter:

http://rchas12.rchland.ibm.com:2001

2. When prompted, enter your i5/OS user profile and password to log on to the IBM Web 
Administration for iSeries. Click OK.

3. From the iSeries Tasks menu, click IBM Web Administration for iSeries. You return to 
the last server that you administered.

4. Click the Manage tab and then click the HTTP Servers subtab.

5. Make sure the correct HTTP server for the Workplace Services Express server is 
selected. As shown in Figure 9-56, we select the IBM HTTP Server of ITSOWSE2 - 
Apache.

Figure 9-56   Selecting the HTTP server for the Workplace Services Express server

6. Scroll down in the left pane, and under the Tools menu, click Real Time Server Statistics 
as shown in Figure 9-57.

Figure 9-57   Selecting Real Time Server Statistics

Tip: The IBM Redbook IBM HTTP Server (powered by Apache): An Integrated Solution for 
IBM Eserver iSeries Servers, SG24-6716, provides performance information for the IBM 
HTTP Server. 
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7. Figure 9-58 shows an example of the HTTP Real Time Server Statistics. For a quick 
glance at how the HTTP server is performing, click the Averages tab. This tab provides 
statistics for the averages for the total time of activity shown for the type of associated 
server which is identified at the top of the column. You also see the average time of 
noncached and cached activity completed by the enabled function.

If you see a concern with a specific average statistic, such as the average time spent 
serving noncached data, look at the Absolute or Absolute and Delta tabs for more details. 
The IBM Redbook IBM HTTP Server (powered by Apache): An Integrated Solution for 
IBM Eserver iSeries Servers, SG24-6716, provides more information about these 
performance statistics. 

Figure 9-58   HTTP server Real Time Server Statistics data

9.7.2  HTTP connection time-outs and Max Keep Alive
You can access the HTTP connection parameters from the IBM Web Administration for 
iSeries interface. This section addresses the following parameters:

� KeepAliveTimeout
� KeepAlive
� MaxKeepAliveRequests

KeepAliveTimeout
The KeepAliveTimeout setting is used to control whether the HTTP server works with 
persistent connections. Persistent connections enable a single TCP/IP connection to be used 
for multiple HTTP requests. When the server runs with persistent connections, the 
KeepAliveTimeout setting determines the number of seconds that the server waits for 
subsequent requests before it closes the connection.

If this value is too low, the server can be impacted in terms of performance since connections 
can close frequently. If this value is too high, the HTTP server can have many connections 
open, and the server can run out of resources.

We recommend that you set the KeepAliveTimeout to 10 - 15 minutes as a starting point. The 
default setting is 5 minutes.
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KeepAlive
The KeepAlive setting enables a single TCP/IP connection to be used for multiple HTTP 
requests (persistent connections). Normally, each HTTP request uses a separate connection. 
Reusing a single connection reduces the connection open and close overhead, thereby 
improving performance for the client. The KeepAlive setting should be set to Enabled.

MaxKeepAliveRequests
The MaxKeepAliveRequests setting allows an unlimited number of requests on a single 
TCP/IP connection. We recommend that you set MaxKeepAliveRequests to 0. Setting this 
value to 0 means that there is no maximum setting for MaxKeepAliveRequests.

Changing or verifying the parameter settings
To change or verify the parameter settings mentioned in the previous sections, perform the 
following steps:

1. Access the IBM Web Administration for iSeries by pointing your Web browser to your fully 
qualified iSeries host name on port 2001:

http://iSeriesHostName.domain:2001

In our example, we enter:

http://rchas12.rchland.ibm.com:2001

2. When prompted, enter your i5/OS user profile and password to log on to the IBM Web 
Administration for iSeries. Click OK.

3. From the iSeries Tasks menu, click IBM Web Administration for iSeries. You return to 
the last server that you administered.

4. Click the Manage tab and then click the HTTP Servers subtab.

5. Make sure that the correct HTTP server for the Workplace Services Express server is 
selected.

6. In the left navigation pane, select System Resources as shown in Figure 9-59.

Figure 9-59   Accessing the HTTP System Resources

Tip: When increasing the setting for KeepAliveTimeout, keep in mind that a higher value 
might increase contention for HTTP server processes. If you are running out of HTTP 
processes, decrease this value.
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7. Verify or change the following System Resources parameters, as shown in Figure 9-60.

a. For Connection time-out (KeepAliveTimeout), specify 10 - 15 minutes.
b. For Allow persistent connections (KeepAlive), select Enabled.
c. For Maximum requests per connection (MaxKeepAliveRequests), type 0.

Figure 9-60   System resources settings for the IBM HTTP Server

8. Click Apply and then click OK to save the changes.

9. Stop and restart the Workplace Services Express HTTP server to apply the changes.

9.7.3  Enabling GZIP compression
Enabling GZIP compression can result in a significant improvement in bandwidth utilization. 
Enabling GZIP compresses the data between the server and the Web browser, typically 
improving the response time. The amount of response time improvement varies depending on 
your network bandwidth. If you already have a fast network, the amount of improvement seen 
by end users is smaller than if you have a slower network infrastructure. Even if end users do 
not see much of a performance improvement with this change, it is still worthwhile to enable it 
because overall network bandwidth improves.

To enable GZIP compression, modify the HTTP Configuration File as explained in the 
following steps:

Tip: These values are recommendations that we found in our testing to improve the 
performance of the HTTP server. The actual values might vary in your environment and 
should be tested.

Note: Enabling GZIP compression requires additional CPU cycles, making it a trade-off 
with increased network bandwidth. Consider this trade-off when choosing to enable GZIP 
compression. Typically the extra CPU resources required are off-set by the performance 
improvement seen in bandwidth constrained environments.

Important: We recommend that you back up the configuration file prior to making any 
changes. A damaged configuration file can cause the server to not restart.
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1. Access the IBM Web Administration for iSeries by pointing your Web browser to your fully 
qualified iSeries host name on port 2001:

http://iSeriesHostName.domain:2001

In our example, we enter:

http://rchas12.rchland.ibm.com:2001

2. When prompted, enter your i5/OS user profile and password to log on to the IBM Web 
Administration for iSeries. Click OK.

3. From the iSeries Tasks menu, click IBM Web Administration for iSeries. You return to 
the last server that you administered.

4. Click the Manage tab and then click the HTTP Servers subtab.

5. Make sure the correct HTTP server for the Workplace Services Express server is 
selected.

6. For Server area, select Directory /www/server/htdocs, where server is the name of your 
IBM HTTP Server as shown in Figure 9-61.

Figure 9-61   Selecting the Server area for the IBM HTTP Server
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7. In the left navigation pane, under the Tools menu, select Edit Configuration File 
(Figure 9-62).

Figure 9-62   Selecting Edit Configuration File

The selected file /www/server/conf/httpd.conf (where server is the name of your IBM 
HTTP Server) is now displayed for editing as shown in Figure 9-63.

Figure 9-63   The IBM HTTP Server configuration file
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8. Use Figure 9-64 as a guide when editing this configuration file. The parameters in 
Table 9-11 explain some of the more common parameters that you might want to add to 
the configuration file of your Workplace Services Express HTTP server.

Refer to the following Web address for additional information about these parameters and 
their functionality being added to the IBM HTTP configuration file:

http://httpd.apache.org/docs-2.0/mod/mod_deflate.html

Table 9-11   Parameters to add to the IBM HTTP Server configuration file

Figure 9-64 shows an example of the IBM HTTP Server configuration file for the 
Workplace Services Express server, ITSOWSE2, after GZIP compression was enabled.

Important: You must add the LoadModule parameter before any of the other 
parameters shown in Table 9-11. The best practice is to add this parameter to the first 
line of the configuration file. Besides the LoadModule parameter, the location of these 
parameters in the configuration file is not critical.

Parameter Description

LoadModule deflate_module 
/QSYS.LIB/QHTTPSVR.LIB/QZSRCORE.SRVPGM

Add the LoadModule necessary for the Apache module to 
support gzip.

LogFormat "\"%r\" %{outstream}n/%{instream}n 
(%{ratio}n%%)" deflate

Define a new log type for the deflated output.

CustomLog logs/deflate_log deflate Define the location for the deflate log (path relative to the 
www/server directory).

LogMaint logs/deflate_log 7 0 Define log maintenance for the deflate log. This deletes all logs 
older than seven days.

AddType application/zip .jar Define a new mime type for the WCT client. This improves the 
download performance of the WCT client.

SetOutputFilter DEFLATE Define the gzip output filter, in this case, only compressing 
outbound traffic.

DeflateFilterNote Input instream
DeflateFilterNote Output outstream
DeflateFilterNote Ratio ratio

Define the variables used in the deflate log.

SetEnvIf "User-Agent" "^." no-gzip Disable compression for all requests.

SetEnvIf "User-Agent" "MSI[E].(5\.5|6\.0);" !no-gzip Enable compression for Microsoft Internet Explorer V5.x and 
V6.x browsers.

SetEnvIf "User-Agent" "^Mozilla/5.0" !no-gzip Enable compression for a Mozilla V5.0-based Web browser.

SetEnv gzip-only-text/html 1 Enable compression only for content with a text/html mime 
content type.

SetEnvIfNoCase Request_URI "\.(js|css)$" 
gzip-only-text/html=0

Enable compression for content URI that ends with .js 
(JavaScript™) or .css (cascading style sheets).

Tip: Click Wider at the bottom of the edit configuration file display to increase the edit 
window. Make sure that you complete the resizing the edit window prior to making any 
changes to the configuration file. Otherwise your changes will be lost.
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Figure 9-64   Example of the IBM HTTP Server configuration file after enabling GZIP compression

9. In the Edit Configuration File display, click Apply to save the IBM HTTP Server 
configuration file changes. Then click OK.

WebSpherePluginConfig /QIBM/UserData/WebAS5/Base/ITSOWSE2/config/cells/plugin-cfg.xml
LoadModule ibm_app_server_http_module /QSYS.LIB/QEJBAS5.LIB/QSVTIHSAH.SRVPGM
# Added the necessary Apache module to support GZIP compression
LoadModule deflate_module /QSYS.LIB/QHTTPSVR.LIB/QZSRCORE.SRVPGM
# HTTP server (powered by Apache) configuration
DocumentRoot /www/itsowse2/htdocs
ServerRoot /www/itsowse2
Options -ExecCGI -FollowSymLinks -SymLinksIfOwnerMatch -Includes -IncludesNoExec 
-Indexes -MultiViews
Listen 9.5.92.26:80
MaxKeepAliveRequests 0
LogFormat "%h %l %u %t \"%r\" %>s %b \"%{Referer}i\" \"%{User-Agent}i\"" combined
LogFormat "%{Cookie}n \"%r\" %t" cookie
LogFormat "%{User-agent}i" agent
LogFormat "%{Referer}i -> %U" referer
LogFormat "%h %l %u %t \"%r\" %>s %b" common
# Define a new log type for the deflated output
LogFormat "\"%r\" %{outstream}n/%{instream}n (%{ratio}n%%)" deflate
CustomLog logs/access_log combined
# Define the location for the deflate log (path relative to the www/<server> directory)
CustomLog logs/deflate_log deflate
#Define custom maintenance for the deflate log. Will delete all logs older than 7 days
LogMaint logs/deflate_log 7 0
SetEnvIf "User-Agent" "Mozilla/2" nokeepalive
SetEnvIf "User-Agent" "JDK/1\.0" force-response-1.0
SetEnvIf "User-Agent" "Java/1\.0" force-response-1.0
SetEnvIf "User-Agent" "RealPlayer 4\.0" force-response-1.0
SetEnvIf "User-Agent" "MSIE 4\.0b2;" nokeepalive
SetEnvIf "User-Agent" "MSIE 4\.0b2;" force-response-1.0
# Define the gzip output filter. In this case we are only compressing outbound traffic
SetOutputFilter DEFLATE
# Define variables used in the deflate log
DeflateFilterNote Input instream
DeflateFilterNote Output outstream
DeflateFilterNote Ratio ratio
# Enable compression for MS IE Browsers v5.x and v6.x
SetEnvIf "User-Agent" "MSI[E].(5\.5|6\.0);" !no-gzip
# Enable compression for Mozilla v5.0 based browser
SetEnvIf "User-Agent" "^Mozilla/5.0" !no-gzip
# Enable compression for content with text/html mime content type
SetEnv gzip-only-text/html 1
# Enable compression for content URI that ends with .js (JavaScript) or .css (Cascading 
# style sheets)
SetEnvIfNoCase Request_URI "\.(js|css)$" gzip-only-text/html=0
<Directory />
   Order Deny,Allow
   Deny From all
</Directory>
<Directory /www/itsowse2/htdocs>
   Order Allow,Deny
   Allow From all
</Directory>

 

 

 

310 Deploying IBM Workplace Services Express on the IBM Eserver iSeries Server



 

10.Stop and restart the Workplace Services Express HTTP server to apply any changes. For 
details, see 5.4, “Managing an IBM HTTP Server for iSeries server” on page 123.

Example of the deflate_log
As a result of enabling a new custom log file, a new log file is created call deflate_log. This log 
is located in the directory specified in the HTTP server configuration file. In our example, we 
specified a directory of logs within the HTTP server’s directory. We accomplished this by 
adding the following line to the HTTP server configuration file:

CustomLog logs/deflate_log deflate

In our example, the complete directory path to the deflate_log file is 
/www/server/logs/deflate_log, where server is the IBM HTTP Server name.

Figure 9-65 provides an example of this log file’s contents. The values displayed to the right of 
HTTP/1.1 show the output size sent to the Web browser and the original size of the content. 
The percentage is the difference. Refer to the deflate_log to determine by how much the 
over-the-wire content is reduced. For example, Figure 9-65 shows that over-the-wire size of 
content was reduced by 32%.

It is important to understand that only content that uses the mime type of text/html and any 
files with the extension of .js (JavaScript) or .css (cascading style sheets) are compressed.

Figure 9-65   Example of the deflate_log content

Note: After you verify that GZIP compression is enabled for your server, follow the steps in 
9.7.4, “Disabling HTTP logging” on page 312, to disable any unnecessary logging.

"GET /lwp/myworkplace/!ut/p/.scr/LoggedIn HTTP/1.1" 7841/41657 (18%)
"GET /lwp/themes/html/workplace/dragNdrop.css HTTP/1.1" 424/1710 (24%)
"GET /lwp/themes/html/workplace/dragNdrop.js HTTP/1.1" 5565/27497 (20%)
"GET /lwp/themes/html/workplace/flyout.js HTTP/1.1" 2477/17055 (14%)
"GET /lwp/themes/html/workplace/ie/en/Styles.css HTTP/1.1" 9099/57722 (15%)
"GET /lwp/themes/html/workplace/ie/en/HelpStyles.css HTTP/1.1" 960/4391 (21%)
"GET /lwp/themes/html/workplace/ie/en/LWP_Styles.css HTTP/1.1" 4482/25855 (17%)
"GET /lwp/themes/html/workplace/actionMenu.js HTTP/1.1" 864/3649 (23%)
"GET /lwp/menu/menu_service.js HTTP/1.1" 3428/10529 (32%)
"GET /lwp/peopleawareness/peopleawareness_service.js HTTP/1.1" 2171/5900 (36%)
"GET /lwp/peopleawareness/person.js HTTP/1.1" 10754/42886 (25%)
"GET /lwp/peopleawareness/context_ie.js HTTP/1.1" 8138/41006 (19%)
"GET /lwp/themes/html/workplace/bannerGraphicTop.jpg HTTP/1.1" -/- (-%)
"GET /lwp/images/dot.gif HTTP/1.1" -/- (-%)
"GET /lwp/themes/html/workplace/lotusWordmark.jpg HTTP/1.1" -/- (-%)
"GET /lwp/themes/html/workplace/clearPixel.gif HTTP/1.1" -/- (-%)
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9.7.4  Disabling HTTP logging
The level of HTTP logging required depends on the environment. For example, in a 
development and test environment, logging levels are often required to be set at the highest 
levels possible. This requirement changes when you move to a production environment. 
HTTP logging takes additional resources on the server. All unnecessary HTTP logging should 
be disabled for a production server.

The only logging that should be enabled for a production environment is error logging. To 
disable all other logging, edit the HTTP server configuration file and comment out the 
following lines as explained in the following steps:

� CustomLog logs/access_log combined
� CustomLog logs/deflate_log deflate

1. Access the IBM Web Administration for iSeries by pointing your Web browser to your fully 
qualified iSeries host name on port 2001:

http://iSeriesHostName.domain:2001

In our example, we enter:

http://rchas12.rchland.ibm.com:2001

2. When prompted, enter your i5/OS user profile and password to log on to the IBM Web 
Administration for iSeries. Click OK.

3. From the iSeries Tasks menu, click IBM Web Administration for iSeries. You return to 
the last server that you administered.

4. Click the Manage tab and then click the HTTP Servers subtab.

5. Make sure the correct HTTP server for the Workplace Services Express server is 
selected.

6. For Server area, select Directory /www/server/htdocs, where server is the name of your 
IBM HTTP Server (see Figure 9-66).

Figure 9-66   Selecting the Server area for the IBM HTTP Server

Important: We recommend that you back up the configuration file prior to making any 
changes. A damaged configuration file can cause the server to not restart.
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7. In the left navigation pane, under the Tools menu, select Edit Configuration File 
(Figure 9-67).

Figure 9-67   Selecting Edit Configuration File

The selected file /www/server/conf/httpd.conf, where server is the name of your IBM HTTP 
Server, is now displayed for editing as shown in Figure 9-68.

Figure 9-68   The IBM HTTP server configuration file
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8. Comment out the following lines by typing a number sign (#) in front of each line:

# CustomLog logs/access_log combined
# CustomLog logs/deflate_log deflate

9. In the Edit Configuration File window, click Apply and then click OK to save the IBM HTTP 
Server configuration file changes.

10.Stop and restart the Workplace Services Express HTTP server to apply any changes. For 
details, see 5.4, “Managing an IBM HTTP Server for iSeries server” on page 123.

9.8  Database tuning
The storage container for Workplace Services Express on iSeries is DB2 Universal Database. 
In this section, we address how you can fine-tune this storage container to achieve the best 
performance for your Workplace Services Express servers.

9.8.1  System value for the SQL Query Engine
V5R2 introduced a new optimizer called the SQL Query Engine (SQE). The system value 
QDBFSTCCOL, the database file statistics collection, controls the level of database statistics 
that are collected and used by the query optimizer. The statistics gathered are used to control 
runtime behavior of the query optimizer.

QDBFSTCCOL: Database file statistics collection
You can set the QDBFSTCCOL system value to one of the following four values:

*ALL This value is the default setting and allows all statistics to be collected in the 
background.

*SYSTEM This value allows only system-requested statistics to be collected in the 
background.

*USER This value allows only user-requested statistics to be collected in the background.

*NONE This value restricts everyone from creating statistics in the background. It does 
not prevent immediate user-requested statistics from being collected.

The setting chosen for QDBFSTCCOL system value affects the level of database statistics 
that are available to the new query optimizer when processing queries.

Note: You can turn off the i5/OS system value QDBFSTCCOL to disable database 
statistics auto refresh, since the auto refresh uses CPU during run time. We recommend 
that you leave on the auto refresh to keep the database statistics up to date.
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9.8.2  Monitoring database performance
i5/OS provides statistics that can be used to monitor performance of your database 
environment. You can use a tool, called the database monitor, to collect and view statistics for 
all columns of data in all tables for a given library on the system. You access this tool using 
iSeries Navigator. 

We use the database monitor tool to monitor the DB2 Universal Database databases that 
provide the underlying infrastructure for a Workplace Services Express server. We want to 
monitor a particular the library, which contains the WebSphere Portal databases. Use the 
procedure explained in 5.2, “Reviewing the Workplace Services Express configuration” on 
page 110, to determine the WebSphere Portal database, or schema, associated with your 
Workplace Services Express server.

The portal schema associated with the Workplace Services Express server in our example is 
ITSOWSE26. We create a database monitor over that library to capture statistics about the 
databases in this library used by the Workplace Services Express server.

Creating an SQL performance monitor
Before you create the performance monitor, you must create or identify a library in which to 
store the data. In our example, we create a library called ITSOWSE2 to hold database 
statistics for our Workplace Services Express server database access.

You can create a summary or detailed SQL performance monitor against the Workplace 
Services Express databases using iSeries Navigator. Perform the following steps to create 
the library to store SQL performance monitor data and to create the SQL performance 
monitor:

1. Use the Create Library (CRTLIB) CL command to create a library to store the SQL 
performance data. In the following example, replace ITSOWSE2 with the name you want 
to give this library.

CRTLIB LIB(ITSOWSE2) TEXT('Library to store SQL performance statistics')

2. Start iSeries Navigator and access your iSeries server. When prompted, enter a valid 
i5/OS user profile and password with at least *ALLOBJ, *IOSYSCFG, and *JOBCTL 
special authorities.

Tip: Monitoring database performance helps to determine whether performance issues 
with Workplace Services Express servers are related to the underlying DB2 Universal 
Database libraries or with the LDAP server.

 

 

 

Chapter 9. Performance tuning 315



 

3. Click My Connections → iSeries system name → Databases → S65d0acd → 
Schemas to view the database or databases and their schemas, as shown in Figure 9-69.

Figure 9-69   Database expanded to Schemas in iSeries Navigator

4. Right-click Schemas and select Select Schemas to Display as shown in Figure 9-70.

Figure 9-70   Selecting the option Select Schemas to Display

Note: The schema name shown is the relational database directory entry for the iSeries 
server. In our example, the relational database directory entry is S65d0acd.
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5. In the Select Schemas to Display window (Figure 9-71), follow these steps:

a. Enter the name of the schema or library to display. This is the name of the database 
that you decided to use to collect the SQL performance statistics in. For our example, 
we enter the name of the library, called itsowse2, that we created in step 1 on 
page 315. 

b. Click the Add button.

Figure 9-71   Entering the schema name to display

c. Add the library that contains the WebSphere Portal databases associated with your 
Workplace Services Express server. In our example, this database is called 
ITSOWSE26.

If you haven’t already done so, use the procedure explained in 5.2, “Reviewing the 
Workplace Services Express configuration” on page 110, to determine the WebSphere 
Portal database, or schema, associated with your Workplace Services Express server.

The WebSphere Portal database for your Workplace Services Express server is now 
added to the library list (schema list). This is necessary because you select this library 
when you create the SQL performance monitor.

d. Click OK.
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6. Click Schemas and the Database tasks are displayed in the lower panel of iSeries 
Navigator as shown in Figure 9-72. In the right side of the lower panel, click Create a new 
summary SQL performance monitor.

Figure 9-72   Database tasks pane of iSeries Navigator
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7. In the New Summary SQL Performance Monitor window (Figure 9-73), provide the 
following information:

a. In the General tab, provide the following values:

i. For Name, type the name of the database monitor. In our example we enter Monitor 
ITSOWSE26 portal db.

ii. For Schema for save data, select the library to store the statistics. We selected 
library ITSOWSE2, which as stated previously was created to store this data.

Figure 9-73   Creating the new summary SQL Performance Monitor: The General tab

b. Click the Monitored Jobs tab.

i. Change the selection from All to Select from list below.

ii. Click the Subsystem column to sort the list of jobs by subsystem.

iii. Scroll down to the QEJBAS5 subsystem. Find the QEJBAS5 jobs associated with 
your Workplace Services Express server. If you have more than one Workplace 
Services Express server running, see 5.3, “Verifying a Workplace Services Express 
server is active” on page 112, to determine which jobs are associated with your 
Workplace Services Express server.

Note: ITSOWSE26 is the name of the library that contains the WebSphere Portal 
databases for our Workplace Services server.

Note: When using this method to determine which jobs are associated with your 
Workplace Services Express server, take note of the job numbers at the top of 
each job log.
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iv. Highlight a server job and click the Select button to add the server job to the list of 
selected jobs. Do this for the three server jobs associated with the Workplace 
Services Express server:

• QJVAEXEC
• SERVER1
• WEBSPHERE_

See Figure 9-74.

Figure 9-74   Creating the new summary SQL Performance Monitor: The Monitored Jobs tab

Tip: To focus on monitoring Workplace Services Express SQL performance, we 
recommend that you monitor only the server jobs associated with the Workplace 
Services Express server for which you are gathering performance statistics.
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c. Click the Data to Collect tab (Figure 9-75) and enable the following data to be 
collected:

• Summary data
• Statement text
• Host variable use

Figure 9-75   Creating the new summary SQL Performance Monitor, Data to Collect tab

d. Click OK to finish creating the new SQL performance monitor.

Note: The database performance monitor starts automatically after it is created.
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Viewing the SQL performance monitors
After collecting database performance monitor statistics for the underlying databases that 
support your Workplace Services Express server, you can view the database statistics that 
were collected. Perform the following steps to view the database statistics:

1. To view the SQL performance monitor, under the Schemas view in iSeries Navigator, 
select SQL Performance Monitors (Figure 9-76).

Figure 9-76   Viewing the SQL Performance Monitors

2. End the monitor to view the report details. Right-click the summary monitor and select 
End as shown in Figure 9-77.

Figure 9-77   Ending the SQL performance monitor
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3. After the monitor is ended, right-click the summary monitor and select Analyze Results 
as shown in Figure 9-78.

Figure 9-78   Analyze Report options for SQL performance monitor

4. In the Summary SQL Results window (Figure 9-79), complete these steps:

a. From the Summary Results tab, select the Collection period and the summary 
queries.

b. Click the Detailed Results and review and select the necessary options.

c. Click the Composite View tab and review and select the necessary options.

d. Click the View Results button.

e. Click OK.

Figure 9-79   Summary SQL Results
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The result is a composite query of the summary SQL performance monitor settings. For 
information about how to interpret the results, refer to the IBM Redbook Preparing for and 
Tuning the V5R2 SQL Query Engine on DB2 Universal Database for iSeries, SG24-6598.

9.8.3  Creating database indexes
Creating database indexes can improve performance between a Workplace Services Express 
server and the database server. Using iSeries Navigator or i5/OS SQL commands, creating 
database indexes can be a fairly quick and easy procedure. In this section, we provide an 
example of both of these procedures.

The databases that you want to create the indexes over reside in the WebSphere Portal 
library or schema associated with your Workplace Services Express server. To determine the 
name of the portal library for your Workplace Services Express server, refer to 5.2, 
“Reviewing the Workplace Services Express configuration” on page 110.

Creating database indexes from iSeries Navigator
You can create the database indexes for a Workplace Services Express server using iSeries 
Navigator.

1. Open iSeries Navigator and access your iSeries server. 

2. When prompted, enter a valid i5/OS user profile and password with at least *ALLOBJ, 
*IOSYSCFG, and *JOBCTL special authorities.

3. Click My Connections → iSeries system name → Databases → S65d0acd → 
Schemas to view the database or databases and their schemas. See Figure 9-80.

In our example, the relational database directory entry name is S65d0acd. In your 
environment, select the relational database directory name on your iSeries server.

Figure 9-80   i5/OS connection via iSeries Navigator
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4. By default, iSeries Navigator does not display all the database schemas on the system. To 
add the database schemas for the Workplace Services Express server, follow these steps:

a. Right-click Schemas and click Select Schemas to Display as shown in Figure 9-81.

Figure 9-81   Selecting the option Select Schemas to Display

Note: If you already selected the schemas to display as explained in “Creating an 
SQL performance monitor” on page 315, you can skip to step 5 on page 327.
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b. In the Select Schemas to Display window, choose either Enter schemas names or 
Search for schemas. Figure 9-82 shows an example of entering the WebSphere 
Portal database for Workplace Services Express server ITSOWSE2.

c. Click the Add button to add the schema name to the selected schema list.

Figure 9-82   Adding a schema name to the select schema list

Figure 9-83 shows the schemas added to the list.

Figure 9-83   Selected Schemas after adding

d. Click OK. iSeries Navigator now shows the Workplace Services Express WebSphere 
Portal library.
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5. In the Database tasks panel, located in the lower pane of iSeries Navigator, select Run an 
SQL script as shown in Figure 9-84. This launches an SQL script window to perform the 
indexing.

Figure 9-84   Run an SQL script

6. In the Run SQL Script window (Figure 9-85), run the following scripts individually to 
create the database indexes.

– create index portaldb.IX2110D on portaldb.prot_res ( parent_oid, oid )

– create index portaldb.IX2140B on portaldb.lnk_user_role ( role_inst_oid )

– create index portaldb.lambr_idxfix1 on portaldb.wmmlambr (WMMLAMBR_ID, MEMBER_TYPE)

– create index portaldb.laasval_idxfix3 on portaldb.wmmlaasval (WMMLAMBR_ID, 
WMMLAATR_ID)

– create index portaldb.laasval_idxfix2 on portaldb.wmmlaasval (WMMLAMBR_ID, 
HAS_CONTEXT)

– create index portaldb.disresidx2 on portaldb.DISCUSSIONRESOURCE (uri, parenturi, 
path)

– create index portaldb.disresidx3 on portaldb.DISCUSSIONRESOURCE (uri, rooturi, 
projectid, workspace)

– create index portaldb.disres_midx2 on portaldb.DISCUSSIONRES_M (uri, wpcpguid)

– create index portaldb.metaidx4 on portaldb.wpcpmetadata ( wpcpguid, wpcpdeleted)

Note: Replace portaldb with the WebSphere Portal database that you are indexing.
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Figure 9-85 shows an example of entering the first create index script against the 
WebSphere Portal database ITSOWSE26. Click Run All to run the create index script.

Figure 9-85   Entering the create index SQL script

This results in a “Statement ran successfully” message, as shown in Figure 9-86.

Figure 9-86   Statement ran successfully message
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7. Clear the create index script to continue running the next SQL script.

8. Create the remaining indexes listed in step 6 on page 327 using the same procedure that 
you used to create the first index.

9. After all of the indexes are created, exit the Run SQL Scripts window. Saving the 
information is optional.

Changing the object owner of database indexes via iSeries Navigator
For each of the new indexes that you created, change the owner to the user profile used 
during the Workplace Services Express server configuration.

1. Open iSeries Navigator and access your iSeries server. 

2. When prompted, enter a valid i5/OS user profile and password with at least *ALLOBJ, 
*IOSYSCFG, and *JOBCTL special authorities.

3. Click My Connections → iSeries system name → Databases → S65d0acd → 
Schemas to view the database or databases and their schemas. See Figure 9-80 on 
page 324.

In our example, the relational database directory entry name was S65d0acd. In your 
environment, select the relational database directory name on your iSeries server.

4. Expand Schemas and select the WebSphere Portal schema for your Workplace 
Services Express server.

5. Click Indexes to view the database indexes created. Figure 9-87 shows an example of 
selecting the WebSphere Portal database of ITSOWSE26.

Figure 9-87   Selecting Indexes for the WebSphere Portal database of ITSOWSE26
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The indexes for the database are now displayed. Notice the owner column in Figure 9-88.

Figure 9-88   Displaying the database indexes

6. Right-click a newly created index and select Permissions as shown in Figure 9-89.

Figure 9-89   Selecting the index permissions

Note: Click the column labeled Owner to sort the database indexes to see the indexes 
you created in 9.8.3, “Creating database indexes” on page 324.

Note: The Owner column also shows who the original user was that was used to create 
the initial indexes and databases in our WebSphere Portal schema. In our example, this 
is user WSE2DBUSER. Make note of this index owner, which you must know later.
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7. In the Permissions window (Figure 9-90), click the Owner button.

Figure 9-90   Changing ownership of an index

8. In the Owner window (Figure 9-91), change the owner to the database profile used to 
create the databases during the Workplace Services Express server creation. Scroll down 
to find the original WebSphere Portal schema owner. In our example, this was user 
WSEDB2USER. Highlight the user and click OK.

Figure 9-91   Setting the database profile as the owner of the index
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9. In the Permissions window, click Apply to see the new owner updated. Click OK to exit the 
Permissions window.

10.Perform step 6 on page 330 through step 9 for each of the remaining newly created 
indexes.

Creating database indexes from an i5/OS command line
You can also create the database index for a Workplace Services Express server from an 
i5/OS command line as explained in the following steps:

1. Connect to the iSeries server via a 5250 emulation session or access the system console. 

2. When prompted, enter a valid i5/OS user profile and password with at least *ALLOBJ, 
*IOSYSCFG, and *JOBCTL special authorities.

3. From an i5/OS command line, run the following command to start the SQL Interactive 
Session interface with the naming convention set to *SQL.

STRSQL NAMING(*SQL)

Figure 9-92 displays a successful connection to the relational lab database S65D0ACD.

Figure 9-92   Example results of running STRSQL NAMING(*SQL)

4. Run the following scripts individually to create the database indexes.

– create index portaldb.IX2110D on portaldb.prot_res ( prot_00001, oid )
– create index portaldb.IX2140B on portaldb.lnk_u00001 ( role_00001 )
– create index portaldb.LMidxfix1 on portaldb.wmmlambr (wmmla00001, membe00001) 
– create index portaldb.LAidxfix3 on portaldb.wmmlaasval (wmmla00004, wmmla00002) 
– create index portaldb.LAidxfix2 on portaldb.wmmlaasval (wmmla00004, has_c00001) 
– create index portaldb.disresidx2 on portaldb.DISCU00001 (uri, parenturi, path)
– create index portaldb.disresidx3 on portaldb.DISCU00001 (uri, rooturi, projectid, 

workspace)
– create index portaldb.disresmidx2 on portaldb.DISCU00002 (uri, wpcpguid)
– create index portaldb.metaidx4 on portaldb.wpcpm00001 (wpcpguid, wpcpd00001) 

Note: DB2 Query Manager and SQL Developer Kit (5722-ST1) *BASE must be installed to 
run SQL commands from the i5/OS command line.

                              Enter SQL Statements                              
                                                                                
 Type SQL statement, press Enter.                                               
      Current connection is to relational database S65D0ACD.                    
 ===>                                                                           

                                                                                
                                                                        Bottom  
 F3=Exit   F4=Prompt   F6=Insert line   F9=Retrieve   F10=Copy line             
 F12=Cancel            F13=Services     F24=More keys 

Note: Replace portaldb with the WebSphere Portal library you are indexing.
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Figure 9-93 shows an example of running the first create index script against the 
WebSphere Portal schema of ITSOWSE26.

Figure 9-93   Creating an index

5. Run the remaining create index commands in step 4 on page 332 on the schema.

6. Press F3 to exit the SQL Statements and type option 1 to save and exit the interactive SQL 
session (Figure 9-94).

Figure 9-94   Exiting the Interactive SQL session

Changing the object owner of database indexes via i5/OS command line
For each of the new indexes created, change the owner to the database profile used during 
the Workplace Services Express server configuration. You can verify this as explained in 5.2, 
“Reviewing the Workplace Services Express configuration” on page 110.

From an i5/OS command line, run the Change Object Owner (CHGOBJOWN) CL command 
against each of the newly created indexes. Set the new owner as the user profile that was 
used during the Workplace Services Express server configuration. 

The following command shows an example of setting the owner of WSE2DBUSER against 
the newly created index IX2110D in the ITSOWSE26 library: 

CHGOBJOWN OBJ(ITSOWSE26/IX2110D) OBJTYPE(*FILE) NEWOWN(WSE2DBUSER)

9.9  IBM Directory Server tuning
If you have chosen to use the IBM Directory Server for your LDAP server in your Workplace 
Services Express server deployment, we recommend that you implement the tuning tips in 
this section.

                              Enter SQL Statements                              
                                                                                
 Type SQL statement, press Enter.                                               
    > create index itsowse26.IX2110D on itsowse26.prot_res (prot_00001, oi      
      d)                                                                        
      Index IS2110D created in ITSOWSE26 on table PROT_RES in ITSOWSE26.        
 ===>                                                                           

                                                                        Bottom  
 F3=Exit   F4=Prompt   F6=Insert line   F9=Retrieve   F10=Copy line             
 F12=Cancel            F13=Services     F24=More keys                           

 Exit Interactive SQL                              
                                                                                
 Type choice, press Enter.                                                      
                                                                                
   Option . . . . . . . . .   1       1=Save and exit session                   
                                      2=Exit without saving session             
                                      3=Resume session                          
                                      4=Save session in source file             
                                                                                
F12=Cancel 

 

 

 

Chapter 9. Performance tuning 333



 

9.9.1  Nested groups
To obtain the best performance, we recommend that you avoid nested groups within your 
LDAP directory. Nested groups are groups within groups and can cause performance issues 
with resolution of the groups that are either nested several levels deep or that contain many 
users.

The reason why nested groups can be a performance concern is because of the security 
checks that Workplace Services Express performs when a user requests a page. When the 
page request is received by the server, permission levels of the user are checked against that 
page and the individual portlets present on that page. Different security levels can be set for 
each of these elements, meaning that a security check is required to serve up the individual 
portlets, the portlet contents, and the page as a whole.

The Workplace Services Express server must check the user access before rendering the 
page, so it can decide what to render according to the different security levels assigned to that 
user for the different components. When users are in nested groups, getting the nested 
member can be an intensive task on the LDAP server.

9.9.2  Database connections and server threads
The IBM Directory Server defaults to allowing four database connections and server threads. 
Increasing this value can improve performance. In our testing, we increased this value to 10 
and saw some positive results. To access the IBM Directory properties:

1. Open iSeries Navigator and access your iSeries server.

2. When prompted, enter a valid i5/OS user profile and password with at least *ALLOBJ, 
*IOSYSCFG, and *JOBCTL special authorities.

3. Click My Connections → iSeries system name → Network → Servers → TCP/IP. In the 
right pane, scroll down and right-click Directory server and select Properties as shown in 
Figure 9-95.

Figure 9-95   Accessing the IBM Directory server properties
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4. In the Directory Properties window (Figure 9-96), click the Database/Suffixes tab. 
Increase the Database connections and server threads field to a desired setting. In our 
testing, we set this value to 10. Click OK.

Figure 9-96   Increasing the Database connections and server threads for the IBM Directory server

5. In the Directory Server Properties window (Figure 9-97), select to either restart the 
directory server now or later. Then click OK.

Figure 9-97   Selecting an option for restarting the IBM Directory server

6. If you have chosen the not restart the directory server now, stop and restart the IBM 
Directory server for the changes to be enabled.

Tip: The changes made to the iSeries Navigator to optimize performance are written to 
the integrated file system /QIBM/UserData/OS400/DirSrv/ibmslapd.conf directory on 
the i5/OS server. We recommend that you make all IBM Directory Server configuration 
changes using iSeries Navigator.
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9.10  Lotus Domino LDAP tuning
Lotus Domino might be your choice for an LDAP server within your Workplace Services 
Express deployment. This section contains tips to help you optimize the performance of your 
Lotus Domino LDAP implementation.

9.10.1  Nested groups
For the best performance, we recommend that you avoid nested groups within your LDAP 
directory. Nested groups are groups within groups and can cause performance issues with 
resolution of the groups that are either nested several levels deep or that contain many users.

The reason why nested groups can be a performance concern is because of the security 
checks Workplace Services Express performs when a user requests a page. When the page 
request is received by the server, permission levels of the user are checked against that page 
and the individual portlets that are present on that page. Different security levels can be set 
for each of these elements, meaning that a security check is required to serve up the 
individual portlets, the portlet contents, and the page as a whole. 

The Workplace Services Express server must check the user access before rendering the 
page, so it can decide what to render according to the different security levels assigned to that 
user for the different components. When users are in nested groups, getting the nested 
member can be an intensive task on the LDAP server.

9.10.2  Full text indexing of the Domino Directory
When using Lotus Domino to provide LDAP services for the Workplace Services Express 
server, it is important to make sure that the Domino Directory is full text search enabled. 
Without the full text index created, each Domino LDAP search is a linear search. This means 
that the more users you have in your directory, the worse the problem becomes.

Make sure that your Domino Directory has full text indexing enabled as explained here:

1. Open the Domino Administrator client.

2. Click the Configuration tab.

3. In the left frame, click Server → Configurations.
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4. Open the Global Configuration document, or create one if it doesn’t already exist. The 
Global Configuration document has a server name of * - [All Servers]. To create a new 
Global Configuration document, click Add Configuration and select Use these settings 
as the default settings for all servers as shown in Figure 9-98.

Figure 9-98   Creating or modifying the Global Configuration document

5. In the Configuration Settings document, click the LDAP tab. For the Automatically Full Text 
Index Domino Directory? field, select Yes as shown in Figure 9-99.

Figure 9-99   Specifying to automatically full text index the Domino Directory
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6. Save and close the document.

7. Enter the following command from the Domino server console to reload the LDAP 
schema:

tell ldap reloadschema

Tip: Our testing has shown that reloading the schema is not always sufficient. To be 
safe, consider restarting the Domino server.
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Appendix A. Using existing LDAP servers with 
Workplace Services Express

This appendix describes the object classes and hierarchy required by an existing Lightweight 
Directory Access Protocol (LDAP) server to interface with Workplace Services Express. For 
specific information about using a Microsoft Active Directory server with Workplace Services 
Express, refer to the IBM Redbook IBM Workplace Services Express, SG24-6758.

A
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Recommended object classes and attributes
Each supported LDAP server can base their implementation on different object classes as 
listed in Table A-1.

Table A-1   Supported LDAP servers and their recommended property values

For each directory server’s user LDAPUserObjectClass, as well as, each group’s 
LDAPGroupObjectClass, Workplace Services Express requires unique identifiers, which are 
listed in Table A-2.

Table A-2   Supported LDAP servers and their unique identifier attributes

In addition, each user LDAPUserObjectClass requires the following attributes:

� uid: User ID or short name
� cn: Common name
� givenName: Given name
� sn: Sir name
� Mail: Local e-mail address

Property IBM Directory Server Domino

LDAPSuffix dc=yourco,dc=com 1

1. The Domino LDAP directory does not have an LDAP suffix. In the iSeries Create IBM Work-
place wizard, you can select your organization (for example, o=itso) or *ROOT as your users
container.

LDAPUserPrefix uid cn

LDAPUserSuffix cn=users o=yourco

LDAPGroupPrefix cn cn

LDAPGroupSuffix cn=groups 2

2. In Domino, groups are not created under an LDAP suffix. In the iSeries Create IBM Work-
place wizard, select *ROOT as the LDAP suffix.

LDAPUserObjectClass inetOrgPerson dominoPerson

LDAPGroupObjectClass groupOfUniqueNames dominoGroup

LDAPGroupMember uniqueMember member

Object class IBM Directory Server Domino

LDAPUserObjectClass inetOrgPerson dominoPerson

LDAPGroupObjectClass groupOfUniqueNames dominoGroup

Unique identifier ibm-entryUuid dominoUNID

Important: Do not attempt to configure a Workplace Services Express instance without 
the paired attribute=value unique identifier attribute for your respective LDAP server. 
Otherwise, the enable-security-ldap task fails when you configure a new Workplace 
Service Express server or configure security on an existing one.
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Each group, LDAPGroupObjectClass requires the following attributes:

� cn: Common name
� member: Group member

Required users in the LDAP directory
If you do not allow write access to your existing LDAP directory, you must manually create a 
Workplace Services Express administrator and an administration group (for example 
wpsadmin user and wpsadmins group) in your LDAP directory. Doing so enables the 
configuration of your Workplace Services Express instance to properly complete. Refer to 
your LDAP administrator or the documentation for your directory server for instructions on 
how to do this. When completed, you should have a Workplace Services Express 
administrator which is part of administrator group, for example, a wpsadmin user which is a 
member of the wpsadmins group.

For steps on adding users in the IBM Directory server, refer to 3.3.4, “Adding a Workplace 
Services Express administrator to the LDAP server” on page 40. For steps on adding users to 
the Domino Directory, see 3.4, “Preparing the Domino server for LDAP” on page 51.

Tip: It is possible to extend these classes by creating new class, including new attributes, 
or doing both actions. Refer to your LDAP documentation on how to perform these tasks.
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Appendix B. Setting up IBM Directory Server 
for i5/OS

This appendix explains how to configure and administer the IBM Directory Server on i5/OS 
V5R3. It discusses how to manage and test the IBM Directory Server on i5/OS. And it 
explains how to configure and use the Tivoli Directory Server Web Administration Tool.

B
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Managing the IBM Directory Server on i5/OS
Perform the following steps to access the IBM Directory Server on i5/OS properties:

1. Before you view the IBM Directory Server on i5/OS properties, make sure that the 
appropriate default suffix exists by performing the following steps:

a. Open a 5250 session on your iSeries server.

b. On an i5/OS command line, enter the Configure TCP/IP (CFGTCP) CL command and 
press Enter.

c. From the Configure TCP/IP menu, type option 12 (Change TCP/IP domain information) 
and press Enter.

d. In the Change TCP/IP Domain (CHGTCPDMN) display, make sure the Host name and 
Domain name fields contain values. If they do not contain values, contact your iSeries 
administrator for assistance configuring TCP/IP on your iSeries server.

When constructing the suffix, we replace the periods in the fully qualified host name 
with dc=. For our example shown in Figure B-1, the suffix for our Lightweight Directory 
Access Protocol (LDAP) server is dc=RCHAS55, dc=rchland, dc=ibm, dc=com.

Figure B-1   Change TCP/IP Domain (CHGTCPDMN) display

Note: By default, the suffix is the same as the iSeries system’s fully qualified host 
name.

                        Change TCP/IP Domain (CHGTCPDMN)                        
                                                                                
 Type choices, press Enter.                                                     
                                                                                
 Host name  . . . . . . . . . . .   'RCHAS55'                                   
                                                                                
 Domain name  . . . . . . . . . .   'rchland.ibm.com'                           

                                                                                
 Domain search list . . . . . . .   *DFT                                        
                                                                                
                                                                                
                                                                                
 Host name search priority  . . .   *LOCAL        *REMOTE, *LOCAL, *SAME        
 Domain name server:                                                            
   Internet address . . . . . . .   '9.10.244.200'                              
                                    '9.10.244.100'                              

                                                                         Bottom 
 F3=Exit   F4=Prompt   F5=Refresh   F10=Additional parameters   F12=Cancel      
 F13=How to use this display        F24=More keys 
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2. From iSeries Navigator, click Network → Servers → TCP/IP. Right-click IBM Directory 
Server and then select Properties as shown in Figure B-2.

Figure B-2   Selecting the Properties option for IBM Directory Server on i5/OS
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3. You can manage the IBM Directory Server administrator’s user name and password from 
the IBM Directory Server Properties window as shown in Figure B-3. At the time when 
i5/OS is installed, a default password is created for internal usage. 

On the General tab, click the Password button and enter a password for the IBM Directory 
Server administrator.

Figure B-3   Administering the IBM Directory Server Administrator user name and password

Tip: Depending on your network requirements, you might want to click IP Addresses 
button on the Network tab, and confirm whether your LDAP server should be bound to 
all IP addresses.
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4. Confirm the default suffix entry in the IBM Directory Server. In most cases, the default 
suffix is created for you when i5/OS is installed and is based on the iSeries server name. 
The system objects suffix is also created at the same time. To verify the entry:

a. In the IBM Directory Server Properties window, click the Database/Suffixes tab.

b. Make sure the appropriate default suffix and system objects suffix exist, as shown in 
Figure B-4.

Figure B-4   IBM Directory Server default suffix and system objects suffix

5. Click OK to close the IBM Directory Server Properties window.

Testing the IBM Directory Server on i5/OS
Test your IBM Directory Server by performing the following steps:

1. Verify anonymous access by searching your directory tree using the ldapsearch 
command. For example, the following steps search our host rchas55.rchland.ibm.com on 
port 389, basing the search from the root, for any object classes:

a. Open a 5250 session on your iSeries server.

b. On the i5/OS command line, type STRQSH and press Enter to start the Qshell 
environment.

c. Type an LDAP search command similar to the following example:

ldapsearch -h rchas55.rchland.ibm.com -p 389 -s base -b "" objectclass=* 

Example B-1 shows how the output should look. If you do not see the 
ibmdirectoryversion= line, you must enable anonymous access in order for the 
iSeries Create Workplace wizard to run successfully.
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Example: B-1   Verification of LDAP anonymous access

port=389                                                                     
supportedsaslmechanisms=OS400-PRFTKN                                         
supportedldapversion=2                                                       
supportedldapversion=3                                                       
ibmdirectoryversion=5.1                                                      
ibm-serverId=7b427001-36af-188c-8cb1-0004ac087ce7                            
ibm-supportedacimechanisms=1.3.18.0.2.26.3                                   
ibm-supportedacimechanisms=1.3.18.0.2.26.2                                   
vendorname=International Business Machines (IBM)                             
vendorversion=5.1                                                            
ibm-slapdisconfigurationmode=FALSE                                           
ibm-osregistrycontext=OS400-SYS=RCHAS55.RCHLAND.IBM.COM                      
ibm-osregistrytype=1.3.18.0.2.33.2-caseIgnore 

2. Verify LDAP administrator access by performing the following steps:

a. Perform an ldapsearch command similar to one from the previous step. This time, 
specify the distinguished name of the IBM Directory Server administrator, such as 
cn=administrator, and a password, basing the search from the default suffix, for 
example:

ldapsearch -h rchas55.rchland.ibm.com -p 389  -D 'cn=administrator' -w password
-s base -b 'dc=rchas55,dc=rchland,dc=ibm,dc=com' objectclass=* 

b. Verify that your output resembles the output shown in Example B-2.

Example: B-2   Verification of LDAP administrator access

dc=rchas55,dc=rchland,dc=ibm,dc=com                                          
dc=RCHAS55                                                                   
objectclass=domain                                                           
objectclass=top 

3. Verify the unique identifier ID attribute:

a. Enter an ldapsearch command similar to the following example:

ldapsearch -h rchas55.rchland.ibm.com -p 389  -D 'cn=administrator' -w password
-b 'dc=rchas55,dc=rchland,dc=ibm,dc=com' '(objectclass=domain)' ibm-entryUuid

b. Verify that the unique attribute and paired value exists as shown in Example B-3.

Example: B-3   Verification of unique identifier ID attribute

dc=rchas55,dc=rchland,dc=ibm,dc=com                                          
ibm-entryUuid=5c656804-f40e-1898-8cb9-0004ac087ce7 

Tip: By default, anonymous access is enabled on the IBM Directory Server. If the 
default configuration was modified, contact your LDAP administrator or see the 
iSeries Information Center V5R3 for information about modifying the configuration to 
enable anonymous access:

http://publib.boulder.ibm.com/infocenter/iseries/v5r3/index.jsp

Note: Instead of using the ldapsearch command to verify your LDAP entries, from 
iSeries Navigator, you can click Network → Servers → TCP/IP. Then right-click IBM 
Directory Server, and select Tools → Export file. This exports an LDIF text file of all 
your entries.
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Enabling the Tivoli Directory Server Web Administration Tool
Prior to i5/OS V5R3, the directory management tool supplied with the iSeries server was the 
client-server based iSeries Navigator and IBM Directory Management Tool. With i5/OS V5R3, 
this tool has been replaced with the Web browser-based Tivoli Directory Server Web 
Administration Tool. Since this tool is browser-based, WebSphere Application Server V5.0 
Express or Base must be running in order to use this tool.

Configuring the HTTP Administration server
Perform the following steps to configure the HTTP Administration server to use the Tivoli 
Directory Server Web Administration Tool:

1. Ensure that the HTTP Administration server is started. If it is not already started, use one 
of the following options to start it:

– From iSeries Navigator, click Network → Servers → TCP/IP. Right-click HTTP 
Administration and then click Start.

– From an i5/OS command line, type the Start TCP/IP Server (STRTCPSVR) command:

STRTCPSVR SERVER(*HTTP) HTTPSVR(*ADMIN)

2. To access the iSeries Tasks Web page, point your Web browser to your fully qualified 
iSeries host name on port 2001:

http://iSeriesHostName.domain:2001

In our example, we enter:

http://rchas55.rchland.ibm.com:2001

3. When prompted, enter your i5/OS user profile and password to log on to the IBM Web 
Administration for iSeries. Click OK.

4. Click the IBM Web Administration for iSeries link as shown in Figure B-5.

Figure B-5   iSeries Tasks page

Important: IBM WebSphere Application Server, V5.0 Express (5722-IWE Base and 
Option 2) and associated prerequisite software must be running in order to proceed. 
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5. From the IBM Web Administration for iSeries page, perform the following steps:

a. Click the Manage tab.

b. Click the HTTP Servers tab beneath it.

c. In the Server drop-down list, make sure that ADMIN - Apache is selected.

d. In the left pane, expand Server properties and select General Server Configuration.

e. In the Server area drop-down list box, make sure that Include 
QIBM/UserData/HTTPA/admin/config/admin-cust.conf is selected as shown in 
Figure B-6.

Figure B-6   Selecting Server area Include /QIBM/UserData/HTTPA/admin/config/admin-cust.conf
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6. In the Global Server Configuration pane (Figure B-7), complete these steps:

a. Set Start the system application server instance when the 'Admin' server is started to 
Yes. 

b. Set the Stop the system application server instance when the 'Admin' server is stopped 
to Yes. 

c. Click OK. 

Figure B-7   General Server Configuration pane
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7. Set the WebSphere Application Server to use the SYSINST instance. 

a. From the left navigation pane, click WebSphere Application Server.

b. On the WebSphere Application Server pane, select WebSphere Application Server - 
Express 5.0.

c. From the WebSphere Instance drop-down list, select SYSINST.

d. From the Start all WebSphere application server(s)... drop-down list, select Yes.

e. From the Stop all WebSphere application server(s)... drop-down list, select Yes. Your 
window should resemble the view shown in Figure B-8. 

f. Click OK.

Figure B-8   Setting the HTTP Administration server, WebSphere Application Server to SYSINST

Important: Depending on your level of the IBM HTTP Server for iSeries group PTF (for 
i5/OS, this is SF99099), you might no longer be required to do this step. You can verify 
that the WebSphere Application Server, SYSINST, is associated with the HTTP 
Administration server by clicking the Display Configuration File link located in the left 
navigation pane.

Note: If SYSINST is not present in the drop-down list, stop and start the HTTP 
Administration server.
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8. Click the restart button (see Figure B-9) to restart the HTTP Administration server.

Figure B-9   Restarting the HTTP Administration server

You can also stop and start the HTTP Administration server using iSeries Navigator or an 
i5/OS command line.

To stop the HTTP Administration server:

– From iSeries Navigator, click Network → Servers → TCP/IP. Right-click HTTP 
Administration and then click Stop.

– From an i5/OS command line, type the End TCP/IP Server (ENDTCPSVR) CL 
command:

ENDTCPSVR SERVER(*HTTP) HTTPSVR(*ADMIN)

To start the HTTP Administration server:

– From iSeries Navigator click Network → Servers → TCP/IP. Right-click HTTP 
Administration, and then click Start.

– From an i5/OS command line, type the Start TCP/IP Server (STRTCPSVR) CL 
command: 

STRTCPSVR SERVER(*HTTP) HTTPSVR(*ADMIN)
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Configuring the Tivoli Directory Server Web Administration Tool
Perform the following steps to configure the IBM Tivoli Directory Server Web Administration 
Tool:

1. Access the Tivoli Directory Server Web Administration Tool using one of the following 
options:

– From iSeries Navigator, select your iSeries server and click Network → Servers → 
TCP/IP, right-click IBM Directory Server, and click Server Administration.

– From the iSeries Tasks page (Figure B-10), click IBM Directory Server for iSeries.

Figure B-10   Accessing IBM Directory Server for iSeries from iSeries Task Web page

2. In the Tivoli Directory Server Web Administration Tool Login page (Figure B-11), enter the 
following values:

– In the LDAP Hostname field, select Console Admin.
– In the Username field, type superadmin.
– In the Password field, type secret.

Click Login.

Figure B-11   Tivoli Directory Server Web Administration Tool Login page

Tip: Superadmin and secret are the default values. Change them to prevent 
unauthorized access to the LDAP Console Admin.
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3. Change the console administration login (optional):

a. In the left navigation pane, click Console administration and then click Change 
console administrator login.

b. In the Console administrator login field, type a new console administration login name. 

c. In the Current password field, type the current password (secret). 

d. Click OK.

4. Change the console administration password (optional):

a. In the left navigation pane, click Change console administrator password.

b. In the Current password field, type the current password (secret).

c. In the New password and Confirm new password fields, enter values for the new 
password. 

d. Click OK.

5. Configure the IBM Directory servers that you want to manage:

a. In the left navigation pane, click Manage console servers.

b. In the Manage console servers pane (Figure B-12), click the Add button.

Figure B-12   Managing console servers
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c. In the Add server pane (Figure B-13), enter the LDAP server that you want to 
administer and click OK.

Figure B-13   Adding an LDAP server to manage

The Manager console servers pane should look like the example in Figure B-14. 

d. In the left navigation pane, click Logout.

Figure B-14   IBM Tivoli Directory Server Web Administration with newly added LDAP server

Using the Tivoli Directory Server Web Administration Tool
Perform the following steps to use the IBM Tivoli Directory Server Web Administration Tool:

1. Make sure you know the LDAP administrator name and password as explained in 
“Managing the IBM Directory Server on i5/OS” on page 344.

2. Make sure that your HTTP Administration server is started.

3. In iSeries Navigator, select Network → Servers → TCP/IP to verify that the IBM Directory 
Server is running. If the IBM Directory Server status is Stopped, then right-click the server 
and select Start.

4. Launch the iSeries Tasks page:

http://iSeries.domain:2001

5. Enter your i5/OS user profile and password and click OK.

6. Click IBM Directory Server for iSeries as shown in Figure B-10 on page 354.

Note: When adding an i5/OS Directory Server, the Administration port is not used 
and is ignored. 
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7. Log in to your IBM Directory Server:

a. From the LDAP Hostname drop-down list, select your iSeries server name.

b. Enter the IBM Directory Server administrator’s distinguished name (DN), for example 
cn=Administrator, that you use to log in or bind to the directory server. This is the 
administrator that you configured in step 3 on page 346 as shown in Figure B-3 on 
page 346.

c. Enter the IBM Directory Server administrator’s password. See Figure B-15.

d. Click Login.

Figure B-15   Logging into LDAP Server with IBM Tivoli Directory Server Web Administration

8. In the left navigation pane, click Directory management → Manage entries. Your 
window should resemble the example in Figure B-16.

Figure B-16   Managing LDAP entries from the Tivoli Directory Server Web Administration Tool

Now that you have configured your LDAP server, refer to 3.3, “Preparing the IBM Directory 
Server” on page 39, to determine if any additional modifications are required before you 
configure a Workplace Services Express server.
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Appendix C. Additional material

This roadbed refers to additional material that can be downloaded from the Internet as 
described below.

Locating the Web material
The Web material associated with this roadbed is available in softball on the Internet from the 
IBM Roadbeds Web server. Point your Web browser to:

ftp://www.redbooks.ibm.com/redbooks/SG246664

Alternatively, you can go to the IBM Roadbeds Web site at:

ibm.com/roadbeds

Select the Additional materials and open the directory that corresponds with the roadbed 
form number, SG246664.

Using the Web material
The additional Web material that accompanies this roadbed includes the following files:

File name Description

rchas55.ldif Sample .ldif file

ExtIdUpdate.java Sample Java agent to populate the DominoUNID field into existing 
person, group, or certifier documents in the Domino Directory 
database

prepareinstall.sh Install preparation script to facilitate the preparation of the downloaded 
Workplace Services Express Version 2.5 files for installation

wsetools.savf A sample utility that allows Workplace Services Express servers to be 
moved to a run in a different subsystem. This utility is a set of CL 
programs that are packaged in an i5/OS save file

C
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SAVEWSE25.txt Sample CL program to assist you in backing up or saving a Workplace 
Services Express server configuration data and user data along with 
the IBM HTTP Server
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Related publications

The publications listed in this section are considered particularly suitable for a more detailed 
discussion of the topics covered in this redbook.

IBM Redbooks
For information about ordering these publications, see “How to get IBM Redbooks” on 
page 363. Note that some of the documents referenced here might be available in softcopy 
only. 

� Preparing for and Tuning the V5R2 SQL Query Engine on DB2 Universal Database for 
iSeries, SG24-6598

� Deploying IBM Workplace Collaboration Services on the IBM Eserver iSeries Server, 
SG24-6640

� IBM HTTP Server (powered by Apache): An Integrated Solution for IBM Eserver iSeries 
Servers, SG24-6716

� IBM Workplace Services Express, SG24-6758

� IBM Rational Application Developer V6 Portlet Application Development and Portal Tools, 
SG24-6681

� Domino 6 for iSeries Best Practices Guide, SG24-6937

� IBM Lotus Domino Application Portlet: Configuration and Tips, REDP-3917

� IBM Express Software Buying and Selling Guide, REDP-3975

Other publications
These publications are also relevant as further information sources:

� IBM OS/400 or IBM i5/OS Disk Balancing Support

http://www-912.ibm.com/s_dir/slkbase.NSF/0/80a0c71876d5a872862567ca00770cb0?OpenDocument

� Basic Java Performance for iSeries

http://www.ibm.com/servers/eserver/iseries/perfmgmt/pdf/BasicJavaPerf.pdf

� Tuning the WebSphere Prepared Statement Cache

http://www.ibm.com/servers/eserver/iseries/perfmgmt/pdf/stmntcache.pdf

� Tuning Garbage Collection for Java and WebSphere on iSeries

http://www.ibm.com/servers/eserver/iseries/perfmgmt/pdf/tuninggc.pdf
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Online resources
These Web sites are also relevant as further information sources:

� IBM Workplace for iSeries

http://www.ibm.com/servers/eserver/iseries/software/workplace/

� IBM Workplace

http://www.ibm.com/software/info/workplace/index.jsp

� IBM Workplace Solutions

http://www.ibm.com/software/info/workplace/solutions.jsp

� IBM Workplace Solutions Catalog

http://catalog.lotus.com/wps/portal/wse

� IBM Workplace Services Express 2.5.x Information Center

http://publib.boulder.ibm.com/infocenter/wseic/v2r5/index.jsp

� IBM Workplace Services Express product documentation 

http://www-142.ibm.com/software/workplace/products/product5.nsf/wdocs/productdoc

� IBM ~ Workload Estimator

http://www-912.ibm.com/wle/EstimatorServlet

� IBM ~ iSeries Information Center for V5R3

http://publib.boulder.ibm.com/iseries/v5r3/ic2924/index.htm

� IBM Workplace Services Express 2.6 Technical specifications

http://www-142.ibm.com/software/workplace/products/product5.nsf/wdocs/wsetechspecs

� iSeries fixes

http://www.ibm.com/servers/eserver/support/iseries/fixes/index.html

� WebSphere Portal Update Installer

http://www.ibm.com/support/docview.wss?rs=899&uid=swg24006942

� WebSphere Portal Catalog 

http://catalog.lotus.com/wps/portal/portal

� Monitoring performance with Tivoli Performance Viewer

http://publib.boulder.ibm.com/infocenter/wasinfo/v6r0/index.jsp?topic=/com.ibm.websphere
.express.doc/info/exp/ae/tprf_tpvmonitor.html

� Optimizing Static-File Serving in a WebSphere Application

http://www.eservercomputing.com/ME2/Audiences/dirmod.asp?sid=&nm=&type=Publishing&mod=Pu
blications%3A%3AArticle&mid=8F3A7027421841978F18BE895F87F791&AudID=1E8FEE745A284521B6CFB
3FD70B49099&tier=4&id=54E37DA2F24341BC84C0F25B5A41218D
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How to get IBM Redbooks
You can search for, view, or download Redbooks, Redpapers, Hints and Tips, draft 
publications and Additional materials, as well as order hardcopy Redbooks or CD-ROMs, at 
this Web site: 

ibm.com/redbooks

Help from IBM
IBM Support and downloads

ibm.com/support

IBM Global Services

ibm.com/services
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